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Nom et fonction des pièces
1. Présentation

Alimentation

2 31 4 5

6

1. Commutateur LIGHT (lampe vidéo)
Détermine la manière dont une lampe vidéo 
raccordée au connecteur LIGHT (page 4) 
est allumée ou éteinte.
AUTO : si le commutateur POWER de la lampe 

vidéo est sur ON, la lampe vidéo s’allume 
automatiquement lorsque le caméscope 
enregistre.

MANUAL : vous pouvez allumer ou éteindre 
manuellement la lampe vidéo avec son 
propre commutateur.

[Remarque]
Lorsque le caméscope est réglé pour l’enregistrement 
en mode Picture Cache Rec, il n’est pas possible 
d’allumer la lampe avant de démarrer l’enregistrement 
(ou lorsque des données sont en cours de stockage 
dans la mémoire).

2. Commutateur POWER
Ce commutateur permet d’activer () et de 
désactiver () l’alimentation principale.

3. Connecteur DC IN (entrée d’alimentation 
CC) (de type XLR, 4 broches, mâle)

4. Connecteur DC OUT 12V (sortie 
d’alimentation CC) (4 broches, femelle)

Alimente l’adaptateur USB CBK-DL1 et le viseur 
HDVF-L750 (1,8 A maximum).

5. Griffe de fixation de la batterie
Cette griffe permet de fixer un pack batterie 
BP-GL95B. La fixation d’un adaptateur CA AC-
DN10A permet également de faire fonctionner 
le caméscope sur une source d’alimentation 
CA.

« Préparation de l’alimentation » (page 22)

[Remarque]
Pour votre sécurité et afin d’assurer le fonctionnement 
correct du caméscope, Sony recommande l’utilisation du 
pack batterie BP-GL95B.

6. Connecteur d’adaptateur de caméra 
(modèle japonais uniquement)

Permet le raccordement d’un adaptateur de 
caméra HD CA-TX70/FB70. Pour raccorder un 
adaptateur, enlevez le cache.

[Remarque]
Non pris en charge par le caméscope dans l’affichage 
vidéo de retour.
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Fixation d’accessoires

3 4

7
8

2

6
9

11

12

1

14 17 18 1916

5

1513

10

1. Logement d’insertion du récepteur sans 
fil (page 27)

« Installation d’un récepteur sans fil » (page 27)

2. Point de fixation de la bandoulière 
(page 29)

3. Griffe d’accessoires (page 29)

4. Levier de positionnement avant/arrière 
du viseur (page 23)

5. Bague de positionnement gauche/droite 
du viseur (page 23)

6. Griffe de fixation du viseur (page 23)

7. Connecteur VF (viseur) (type rond à 
20 broches)

Le connecteur d’interface analogique (20 
broches) sert au raccordement d’un viseur de 
la série HDVF.

[Remarque]
Lors du raccordement ou de la déconnexion d’un 
câble d’interface à ce connecteur, mettez d’abord le 
caméscope hors tension.

8. Caoutchouc de fixation de la monture 
d’objectif

Après le verrouillage en position de l’objectif 
à l’aide du levier de verrouillage, placez 
ce caoutchouc sur la projection inférieure. 
Cet accessoire fixe la monture d’objectif et 
l’empêche de se détacher.

9. Bouton de positionnement avant/arrière 
du viseur (page 23)

10. Fixation pour le support de microphone 
en option et fixation pour la garde 
protectrice fournie (page 27, 
page 63)

11. Connecteur LIGHT (lampe vidéo) (2 
broches, femelle) (page 29)

12. Protège-épaule (page 29)

13. Attache du câble d’objectif
Permet de fixer le câble d’objectif.

14. Connecteur MIC IN (entrée de 
microphone) (+48 V) (de type XLR, 
5 broches, femelle)

Ce connecteur permet de raccorder un 
microphone stéréo. L’alimentation (+48 V) est 
assurée par ce connecteur.

15. Connecteur LENS (12 broches) 
(page 26)

[Remarque]
Lors du raccordement ou de la déconnexion d’un câble 
d’objectif à ce connecteur, mettez d’abord le caméscope 
hors tension.

16. Monture de trépied
Lors de l’utilisation du caméscope sur un 
trépied, fixez-y l’adaptateur de trépied 
(optionnel).

17. Monture d’objectif (monture à baïonnette 
spéciale) (page 26)

18. Levier de verrouillage de l’objectif 
(page 26)

19. Capuchon de la monture d’objectif
Retirez le capuchon en relevant le levier de 
verrouillage de l’objectif. Si aucun objectif 
n’est monté, gardez ce capuchon en place 
pour éviter que de la poussière ne pénètre à 
l’intérieur.
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Commandes à proximité de 
l’objectif

1

3

4
5

62

1. Touche REC START (démarrage de 
l’enregistrement)

Appuyez sur cette touche pour démarrer 
l’enregistrement. Appuyez à nouveau sur 
cette touche pour arrêter l’enregistrement. 
L’opération est la même que celle de la touche 
VTR sur l’objectif.

2. Commutateur SHUTTER
Réglez ce sélecteur sur ON pour utiliser 
l’obturateur électronique. Placez-le sur 
SELECT pour basculer le réglage de la vitesse 
d’obturation ou du mode d’obturation. 
Lorsque ce commutateur est utilisé, le 

nouveau réglage apparaît sur l’écran du viseur 
pendant environ trois secondes.

« Réglage de l’obturateur électronique » (page 41)

3. Bouton FILTER
Ce sélecteur permet de basculer entre les 
quatre filtres ND intégrés à ce caméscope.

Lorsqu’il est utilisé, le nouveau réglage 
apparaît sur l’écran du viseur pendant environ 
trois secondes.

Réglage du 
bouton FILTER

Filtre ND

1 CLEAR

2 1/4 ND (atténue la lumière à 
environ 1/4)

3 1/16 ND (atténue la lumière à 
environ 1/16)

4 1/64 ND (atténue la lumière à 
environ 1/64)

Vous pouvez modifier un réglage du menu 
Maintenance pour que différents réglages de 
l’équilibre des blancs puissent être enregistrés 
sur des positions différentes du bouton FILTER. 
Cela vous permet d’obtenir automatiquement 
un équilibre des blancs optimal pour les 
conditions de la prise de vue en cours, en 
rapport avec la sélection de filtre.

« Ajustement de l’équilibre des blancs » (page 39)

4. Bouton MENU (page 96)

5. Commutateur AUTO W/B BAL (ajustement 
automatique de l’équilibre des blancs/
noirs)

Ce commutateur active les fonctions 
d’ajustement automatique de l’équilibre des 
blancs/noirs.
WHITE : ajuste automatiquement l’équilibre 

des blancs. Si le commutateur WHITE 
BAL (page 7) est réglé sur A ou B, 
le réglage de l’équilibre des blancs est 
stocké dans la mémoire correspondante. 
Si le commutateur WHITE BAL est réglé 
sur PRST, la fonction d’ajustement 
automatique de l’équilibre des blancs ne 
fonctionne pas.

BLACK : ajuste automatiquement le palier de 
noir et l’équilibre des noirs.

Vous pouvez utiliser le commutateur AUTO 
W/B BAL même lorsque la fonction ATW 
(équilibre des blancs à suivi automatique) est 
utilisée.
Si vous placez le commutateur sur le côté 
WHITE une fois de plus pendant l’ajustement 
automatique de l’équilibre des blancs, 
l’ajustement est annulé et le réglage de 
l’équilibre des blancs revient à la valeur 
d’origine.
Si vous placez le commutateur sur le 
côté BLACK une fois de plus pendant 
l’ajustement automatique de l’équilibre des 
noirs, l’ajustement est annulé et le réglage 
de l’équilibre des noirs revient à la valeur 
d’origine.

6. Bouton MIC (microphone) LEVEL 
(page 44)
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Côté moniteur LCD (1)

6 7 8 9

21

10 12 12

13
14

11

3 4 5

1. Commutateurs ASSIGN. 
(personnalisables) 1/2/3

Vous pouvez attribuer une fonction en 
utilisant Operation >Assignable Switch du 
menu de configuration (page 133).
Les commutateurs ASSIGN. 1/3 sont pourvus 
d’un indicateur montrant si une fonction est 
attribuée au commutateur (ON) ou non (OFF).

2. Touche ONLINE
Lorsque le mode de client réseau ou la 
fonction de lecture en transit est attribué(e) 
à cette touche, appuyez et maintenez-la 
enfoncée jusqu’à ce que l’indicateur s’allume 
en orange. Puis, appuyez à nouveau sur la 
touche, ce qui allumera l’indicateur en bleu, 
pour activer le mode de client réseau ou la 
fonction de lecture en transit.
Pour quitter la fonction activée, appuyez et 
maintenez la touche enfoncée jusqu’à ce que 
l’indicateur s’éteigne.
La touche peut également être utilisée comme 
commutateur personnalisable lorsque des 
fonctions différentes de celles ci-dessus lui 
sont attribuées (page 134).

3. Bouton ALARM (ajustement du volume de 
la tonalité d’alarme)

Ce bouton commande le volume de la tonalité 
d’avertissement émise par le haut-parleur 
intégré ou les écouteurs optionnels. Lorsque 
le bouton est réglé sur le niveau minimum, 
aucun son ne peut être entendu.
Cependant, si l’élément Maintenance >Audio 
>Min Alarm Volume du menu de configuration 
est réglé sur [Set], la tonalité d’alarme est 
audible même si la commande de volume est 
réglée sur le niveau minimum.

ALARM

Minimum Maximum

4. Bouton MONITOR (ajustement du volume 
du moniteur)

Ce bouton commande le volume sonore 
à l’exception de celui de la tonalité 
d’avertissement émise par le haut-parleur 
intégré ou les écouteurs. Lorsque le bouton 
est réglé sur le niveau minimum, aucun son ne 
peut être entendu.

5. Commutateurs MONITOR (sélection du 
moniteur audio)

Grâce à une combinaison des deux 
commutateurs, vous pouvez sélectionner le 
son que vous voulez entendre par le haut-
parleur intégré ou les écouteurs.

Lorsque le commutateur inférieur est réglé sur 
CH-1/2

Commutateur 
supérieur

Sortie audio

CH-1/CH-3 Audio du canal 1

MIX Audio mélangé (stéréo) des 
canaux 1 et 2 a)

CH-2/CH-4 Audio du canal 2

Lorsque le commutateur inférieur est réglé sur 
CH-3/4

Commutateur 
supérieur

Sortie audio

CH-1/CH-3 Audio du canal 3

MIX Audio mélangé (stéréo) des 
canaux 3 et 4 a)

CH-2/CH-4 Audio du canal 4

a)  En raccordant des écouteurs stéréo à la prise 
EARPHONE, vous pouvez entendre l’audio en stéréo. 
(Maintenance >Audio >Headphone Out du menu de 
configuration doit être réglé sur Stereo.)

6. Commutateur ASSIGN. (personnalisable) 
0

Vous pouvez attribuer une fonction en 
utilisant Operation >Assignable Switch du 
menu de configuration (page 133).
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Off est attribué à ces commutateurs lorsque le 
caméscope quitte l’usine.
Il s’agit d’un commutateur de type temporaire. 
A chaque fois que vous appuyez sur le 
commutateur, la fonction attribuée à ce 
commutateur est activée ou désactivée.

7. Commutateur GAIN
Ce sélecteur permet de basculer le gain 
de l’amplificateur vidéo pour l’adapter aux 
conditions d’éclairage pendant la prise de vue. 
Les valeurs de gain qui correspondent aux 
réglages L, M et H peuvent être sélectionnées 
dans Operation >Gain Switch du menu de 
configuration (page 106) (les réglages 
d’usine par défaut sont L=0 dB, M=6 dB et 
H=12 dB).
Lorsque ce commutateur est ajusté, le 
nouveau réglage apparaît sur l’écran du viseur 
pendant environ trois secondes.

8. Commutateur OUTPUT/DCC (signal de 
sortie/commande de contraste 
dynamique)

Ce commutateur permet de basculer le signal 
vidéo émis par le module de caméra entre les 
deux valeurs suivantes.
BARS : émet le signal de barres de couleur.
CAM : émet le signal vidéo capturé. Lorsque 

ce réglage est sélectionné, vous pouvez 
activer et désactiver le DCC 1).

1)  DCC (commande de contraste dynamique) : sur un 
arrière-plan très lumineux avec le diaphragme ouvert 
et ajusté sur le sujet, les objets à l’arrière-plan sont 
perdus dans le reflet. La fonction DCC supprime 
l’intensité élevée, rétablit la plupart des détails 
perdus. Elle est particulièrement efficace lors des 
prises de vue dans les situations suivantes.
ˎˎ Prise de vue d’un sujet à l’ombre un jour ensoleillé
ˎˎ Prise de vue d’un sujet en intérieur sur un arrière-

plan, à travers une fenêtre
ˎˎ Toutes les scènes à contraste élevé

9. Commutateur WHITE BAL (mémoire 
d’équilibre des blancs)

Ce commutateur permet de commander 
l’ajustement de l’équilibre des blancs.
PRST : ajuste la température de couleur sur 

la valeur prédéfinie (le réglage d’usine 
par défaut est 3200K). Utilisez ce réglage 
si vous n’avez pas le temps d’ajuster 
l’équilibre des blancs.

A ou B : récupère les réglages d’ajustement 
de l’équilibre des blancs déjà stockés en 
A ou B. Placez le commutateur AUTO W/B 
BAL (page 5) sur la position WHITE 
pour régler automatiquement l’équilibre 
des blancs et sauvegarder les réglages 
d’ajustement dans la mémoire A ou la 
mémoire B.

B (ATW 1)) : lorsque ce commutateur est réglé 
sur B et Operation >White Setting >White 
Switch <B> est réglé sur [ATW] dans le 
menu de configuration, ATW est activé.  
Vous pouvez utiliser le commutateur AUTO 
W/B BAL même lorsque ATW est en cours 
d’utilisation.  
Lorsque ce commutateur est ajusté, le 
nouveau réglage apparaît sur l’écran du 
viseur pendant environ trois secondes.

1)  ATW (équilibre des blancs à suivi automatique) : 
l’équilibre des blancs de l’image filmée est 
automatiquement ajusté aux variations des 
conditions d’éclairage.

[Remarque]
Il peut ne pas être possible de s’ajuster sur les couleurs 
appropriées à l’aide d’ATW, en fonction des conditions 
d’éclairage et de sujet.
Exemples :
ˎˎ Lorsqu’une seule couleur domine le sujet, comme 

dans le cas du ciel, de la mer, du sol ou des fleurs. 
ˎˎ Lorsque le sujet est exposé à une source lumineuse 

d’une température de couleur extrêmement faible ou 
élevée. 

Si l’exécution du suivi automatique par le biais 
de la fonction ATW dure particulièrement 
longtemps ou si le résultat ne correspond pas 
à l’effet escompté, exécutez alors la fonction 
AWB.

10. Cache du commutateur
Ouvrez ce cache pour utiliser le commutateur 
MENU ON/OFF ou le commutateur MENU 
CANCEL/PRST/ESCAPE.

11. Commutateur MENU ON/OFF
Pour utiliser le commutateur, ouvrez le cache.
Ce commutateur est utilisé pour afficher le 
menu sur l’écran du viseur ou l’écran du signal 
de test. A chaque fois que vous basculez le 
commutateur vers le bas, l’écran de menu est 
activé et désactivé.
La fonction de ce commutateur est la même 
que celle de la touche MENU dans la section 
des opérations dans l’écran de miniatures.

[Remarque]
Il n’est pas possible de désactiver l’écran de menu en 
fermant le cache.

12. Commutateur MENU CANCEL/PRST 
(prédéfini)/ESCAPE

Pour utiliser le commutateur, ouvrez le cache.
Ce commutateur a des fonctions différentes 
selon si un menu est affiché ou non.

Utilisez le commutateur de la manière 
suivante quand le menu est affiché.
CANCEL/PRST : si vous placez ce commutateur 

dans cette position après la modification 
d’un réglage dans le menu de 
configuration, vous affichez le message 
qui confirme l’annulation des réglages 
précédents. Si vous placez ce commutateur 
à nouveau dans cette position, les 
réglages précédents sont annulés.  
Si vous placez ce commutateur dans 
cette position avant la modification d’un 
réglage dans le menu de configuration ou 
après l’annulation d’une modification de 
réglage dans le menu de configuration, 
un message s’affichera pour confirmer la 
réinitialisation du réglage. Si vous placez 
de nouveau ce commutateur dans cette 
position, les réglages sont réinitialisés sur 
leurs valeurs par défaut.

ESCAPE : utilisez ce commutateur lorsque la 
page de menu, qui possède une structure 
hiérarchique, est ouverte. Chaque fois 
que le commutateur est placé dans 

cette position, la page revient au niveau 
hiérarchique supérieur.

Utilisez le commutateur de la manière 
suivante quand le menu n’est pas affiché.
CANCEL/PRST : chaque fois que ce 

commutateur est basculé vers le haut, 
une fenêtre de confirmation des réglages 
du menu et de l’état du caméscope 
apparaît sur l’écran du viseur (page 14). 
La fenêtre est composée de plusieurs 
pages, qui changent à chaque fois que le 
commutateur est basculé vers le haut.

ESCAPE : pour effacer la page, placez ce 
commutateur sur la position OFF.

13. Logement pour cartes UTILITY SD
Insérez une carte SD pour sauvegarder les 
réglages du caméscope.

14. Indicateur ACCESS
S’allume en orange lorsque le système accède 
à la carte SD.
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Côté moniteur LCD (2)

1
2

7 8 9

3

5

4

6

13

10

14 15 16 17

[1]
[2]

11 12

1. Haut parleur intégré
Le haut-parleur peut être utilisé pour contrôler 
le son E-E 1) pendant l’enregistrement et le 
son de lecture pendant la lecture. Le haut-
parleur fait également retentir des alarmes 
afin de renforcer les avertissements visuels 
(page 156).
Si vous raccordez des écouteurs à la prise 
EARPHONE, le son du haut-parleur est 
automatiquement coupé.
1)  E-E : abréviation de « Electric-to-Electric ». En 

mode E-E, les signaux vidéo et audio reçus par le 
caméscope sont émis uniquement après leur passage 
à travers les circuits électriques internes. Ce mode 
peut être utilisé pour contrôler les signaux d’entrée.

2. Moniteur LCD
Il indique la capacité restante de la batterie, 
la capacité restante du support, les niveaux 
audio, les données temporelles, etc. Il vous 
permet également de vérifier la caméra et de 
lire les images (page 14).
Vous pouvez ajuster la position et l’angle du 
moniteur LCD.

3. Indicateur WARNING
L’indicateur s’allume ou clignote lorsqu’une 
anomalie se produit (page 156).

4. Indicateur ACCESS
Ce voyant s’allume en bleu lorsque des 
données sont écrites ou lues sur le support 
d’enregistrement.

5. Section de commande audio (page 10)

6. Section du fonctionnement de l’écran de 
miniatures (page 10)

7. Indicateur et touche F REV (lecture 
accélérée arrière)

Cette touche permet la lecture rapide en 
arrière. La vitesse de lecture change dans 
l’ordre ×4  ×15  ×24 chaque fois que vous 
appuyez sur la touche. L’indicateur s’allume 
lors de la lecture rapide en arrière.

8. Indicateur et touche PLAY/PAUSE
Appuyez sur cette touche pour visualiser 
les images vidéo sur l’écran du viseur ou le 
moniteur LCD. L’indicateur s’allume pendant la 
lecture.
Appuyez à nouveau sur cette touche pendant 
la lecture pour l’interrompre et obtenir une 
image fixe. A ce moment-là, l’indicateur 
clignote toutes les secondes.
Une pression sur la touche F REV ou F FWD 
pendant la lecture ou la pause lance la lecture 
rapide en avant ou en arrière.

9. Indicateur et touche F FWD (lecture 
accélérée avant)

Cette touche permet la lecture rapide en 
avant. La vitesse de lecture change dans 
l’ordre ×4  ×15  ×24 chaque fois que vous 
appuyez sur la touche. L’indicateur s’allume 
lors de la lecture rapide en avant.

10. Touche PREV (précédent)
Cette touche permet d’accéder à la première 
image du plan actuel.
Si vous appuyez sur cette touche en même 
temps que sur la touche F REV, vous accédez à 
la première image du premier plan enregistré 
sur le support d’enregistrement.
Si vous appuyez deux fois rapidement sur 
cette touche, vous accédez à la première 
image du plan précédent (ou à la première 
image du plan actuel si aucun plan précédent 
n’existe).
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11. Touche STOP
Appuyez sur cette touche pour arrêter la 
lecture.

12. Touche NEXT
Cette touche permet d’accéder à la première 
image du plan suivant.
Si vous appuyez sur cette touche en même 
temps que sur la touche F FWD, vous accédez 
à la dernière image du dernier plan enregistré 
sur le support d’enregistrement.

13. Touche DISP SEL (sélection d’affichage)/
EXPAND (fonction extension)

A chaque pression de cette touche, l’affichage 
du moniteur LCD change comme suit.

Indication 
d’affichage

Description

Vidéo avec 
information 
superposée (CHAR)

Le moniteur LCD affiche 
les mêmes informations 
textuelles que le viseur.

Vidéo sans 
information 
superposée (MONI)

Seule la vidéo apparaît.

Affichage d’état 
(STATUS)
(page 14)

Les compteurs, les 
avertissements, les 
niveaux audio et des 
informations de ce type 
apparaissent. Aucune 
image vidéo n’apparaît.

La fonction de la touche EXPAND sera prise en 
charge lors d’une future mise à jour.

14. Touche HOLD (figeage de l’affichage)
Une pression de cette touche fige 
instantanément les données temporelles 
affichées sur le moniteur LCD. (Le générateur 
de code temporel continue à défiler.) Une 
nouvelle pression de cette touche permet de 
revenir à l’affichage normal.

Pour plus de détails sur l’affichage des données 
temporelles, consultez page 14.

15. Touche RESET/RETURN
Cette touche réinitialise la valeur indiquée 
dans l’affichage des données temporelles 
du moniteur LCD. En fonction des réglages 
du commutateur PRESET/REGEN/CLOCK 
(page 10) et du commutateur F-RUN/SET/
R-RUN (page 10), cette touche réinitialise 
l’affichage comme suit.

Réglages des 
commutateurs

Fonctionnement de la 
touche RESET/RETURN

Commutateur 
DISPLAY :

COUNTER

Réinitialiser le compteur 
sur 00:00:00:00.

Commutateur 
DISPLAY :

TC
Commutateur 
PRESET/REGEN/
CLOCK :

PRESET
Commutateur 
F-RUN/SET/R-RUN :

SET

Réinitialiser le code 
temporel sur 00:00:00:00.

Commutateur 
DISPLAY :

U-BIT
Commutateur 
PRESET/REGEN/
CLOCK :

PRESET
Commutateur 
F-RUN/SET/R-RUN :

SET

Réinitialiser les données 
de bits d’utilisateur a) sur 
00:00:00:00.

a)  Parmi les bits de code temporel pour chaque image 
enregistrée sur le support, les bits pouvant être 
utilisés pour enregistrer des informations utiles pour 
l’utilisateur comme le numéro de scène, le lieu de la 
prise de vue, etc.

« Réglage des données temporelles » (page 46)

Cette touche permet de revenir à l’écran 
précédent lorsqu’elle est enfoncée pendant 
l’affichage de l’écran de miniatures ou 
l’affichage de l’écran de miniatures de repères.

16. Commutateur DISPLAY
Ce commutateur fait défiler l’affichage des 
données temporelles du moniteur LCD dans 
l’ordre COUNTER, TC et U-BIT (page 14).
COUNTER : affiche le compteur de durée 

d’enregistrement/lecture.
TC : affiche le code temporel.
U-BIT : affiche les données de bits d’utilisateur.

17. Touche BRIGHT (luminosité)
Cette touche change la luminosité du 
rétroéclairage du moniteur LCD.
Chaque pression de cette touche sélectionne 
le réglage suivant dans l’ordre indiqué par 
le tableau ci-dessous. Si vous appuyez sur la 
touche avec le moniteur LCD éteint, le LCD se 
rallume en état H.

Réglage Rétroéclairage du moniteur LCD

H Haut (à sélectionner pour voir le 
moniteur LCD à l’extérieur en plein 
jour)

M Luminosité entre H et L

L Bas (à sélectionner pour voir le 
moniteur LCD à l’intérieur ou à 
l’extérieur la nuit)

OFF Désactivé (l’affichage est également 
désactivé)
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Section des opérations dans l’écran de miniatures et section de commande audio

1 2 3 5

8

6

9 1011 12

74

1. Indicateur de miniatures
Cet indicateur s’allume lors de l’affichage de 
l’écran de miniatures.

2. Touche THUMBNAIL
Appuyez sur cette touche pour afficher l’écran 
de miniatures (page 87) et pour effectuer 
une opération sur les miniatures.
Appuyez à nouveau sur cette touche pour 
revenir à l’affichage original.

3. Touche SET et touches fléchées
Utilisez ces touches pour configurer les 
réglages du code temporel et des bits 
d’utilisateur, ainsi que pour les opérations 
dans l’écran de miniatures.
Lorsque le menu s’affiche, appuyez sur cette 
touche pour sélectionner un élément ou 
confirmer la modification du réglage.

4. Touche MENU
Chaque pression sur cette touche active 
et désactive l’affichage du menu de 
configuration.
La fonction de cette touche est la même que 
celle du commutateur MENU ON/OFF.

5. Commutateur F-RUN/SET/R-RUN 
(défilement libre/réglage/défilement 
d’enregistrement)

Ce commutateur permet de sélectionner 
le mode de fonctionnement du générateur 
de code temporel interne. Le mode de 
fonctionnement est réglé comme indiqué 
ci-dessous, en fonction de la position du 
commutateur.
F-RUN : le code temporel continue de 

défiler, que le caméscope enregistre 
ou non. Utilisez ce réglage lors de la 
synchronisation du code temporel avec un 
code temporel externe.

SET : règle le code temporel ou les bits 
d’utilisateur.

R-RUN : le code temporel ne défile que lors 
de l’enregistrement. Choisissez ce réglage 
pour avoir un code temporel continu sur le 
support d’enregistrement.

« Réglage du code temporel » (page 46)

« Réglage des bits d’utilisateur » (page 46)

6. Boutons LEVEL CH1/CH2/CH3/CH4 (niveau 
d’enregistrement des canaux audio 
1/2/3/4)

Ces boutons permettent d’ajuster les niveaux 
audio à enregistrer sur les canaux 1, 2, 3 et 4 
lorsque les commutateurs AUDIO SELECT CH1/
CH2 et AUDIO SELECT CH 3-4 sont réglés sur 
MANUAL.

7. Commutateurs AUDIO SELECT CH 3-4 
(sélection de la méthode d’ajustement 
des canaux audio 3/4)

Sélectionnez la méthode d’ajustement du 
niveau audio pour les canaux audio 3 et 4.
AUTO : ajustement automatique
MANUAL : ajustement manuel

8. Touche ESSENCE MARK
En appuyant sur cette touche quand 
l’affichage de miniatures est à l’écran, vous 
pouvez visualiser les affichages suivants de 
miniatures des images avec des repères du 
plan sélectionné, en fonction de l’élément 
sélectionné dans une liste affichée à l’écran.
All : affichage des miniatures de toutes les 

images marquées d’un repère.
Rec Start : affichage des miniatures des 

images avec un repère Rec Start et 
des premières images des plans (si les 
premières images ne sont pas marquées 
de repères Rec Start).

Shot Mark1 : affichage des miniatures des 
images avec un repère Shot Mark 1.

Shot Mark2 : affichage des miniatures des 
images avec un repère Shot Mark 2.

Vous pouvez également sélectionner Shot 
Mark 0 et Shot Mark 3 à Shot Mark 9.
Si un plan est enregistré en utilisant des 
métadonnées de planification qui définissent 
des noms pour Shot Mark 0 à Shot Mark 9, les 
options de sélection dans la liste s’affichent en 
fonction des noms définis.

9. Touche SHIFT
Utilisez cette touche en combinaison avec 
d’autres touches.

10. Commutateur PRESET/REGEN 
(régénération)/CLOCK

Sélectionne le type de code temporel à 
enregistrer.
PRESET : enregistre le nouveau code temporel 

sur le support.
REGEN : enregistre le code temporel en 

continu avec le code existant enregistré 
sur le support. Quel que soit le réglage 
du commutateur F-RUN/SET/R-RUN, le 
caméscope fonctionne en mode R-RUN.

CLOCK : enregistre un code temporel 
synchronisé avec l’horloge interne. Quel 
que soit le réglage du commutateur 
F-RUN/SET/R-RUN, le caméscope 
fonctionne en mode F-RUN.

11. Commutateurs AUDIO SELECT CH1/CH2 
(sélection de la méthode d’ajustement 
des canaux audio 1/2)

Sélectionnez la méthode d’ajustement du 
niveau audio pour les canaux audio 1 et 2.
AUTO : ajustement automatique
MANUAL : ajustement manuel

12. Commutateurs AUDIO IN CH1/CH2/CH3/
CH4 (sélection d’entrée des canaux audio 
1/2/3/4)

Ces commutateurs permettent de sélectionner 
les signaux d’entrée audio à enregistrer sur les 
canaux 1, 2, 3 et 4.
FRONT : signaux d’entrée audio en provenance 

du microphone raccordé au connecteur 
MIC IN

REAR : signaux d’entrée audio en provenance 
d’un dispositif audio raccordé aux 
connecteurs AUDIO IN CH-1/CH-2

WIRELESS : les signaux d’entrée audio en 
provenance du tuner portable UHF s’il est 
attaché



1. Présentation : Nom et fonction des pièces11

Côté poignée et logement de carte mémoire

10

13 14

11 12

1

7

23456

9
8

Logements pour carte mémoire SxS (page 30)

1. Commutateurs ASSIGNABLE 4/5
Vous pouvez attribuer une fonction en 
utilisant Operation >Assignable Switch du 
menu de configuration (page 134).

Off est attribué à ces commutateurs lorsque le 
caméscope quitte l’usine.

2. Module GPS
Contient un module GPS intégré.

« Obtention d’informations de lieu (GPS) » (page 61)

[Remarque]
Ne saisissez pas cette partie du caméscope lorsque la 
fonction GPS est en cours d’utilisation.

3. Connecteur PC
Ce connecteur est utilisé pour mettre ce 
caméscope en mode de connexion USB et 
l’utiliser comme périphérique de stockage 
externe pour un ordinateur. Lorsqu’un 
ordinateur est raccordé à ce connecteur, 
chaque carte mémoire insérée dans le 
caméscope est reconnue comme lecteur pour 
cet ordinateur.

4. Connecteur de dispositif externe
Effectuez une connexion à un disque dur de 
stockage (HDD) portable de la série PSZ-HA/
HB/HC (en option), un disque dur portable 
à mémoire flash (SSD) PSZ-SA25 (en option), 
un disque dur externe USB à usage général, 
ou un disque flash USB pour copier des plans 
du support d’enregistrement inséré dans un 
logement pour carte SxS du caméscope vers 
un support USB.

[Remarque]
Ce connecteur ne doit être utilisé que pour le 
raccordement des dispositifs mentionnés ci-dessus. 
Il ne peut pas être utilisé pour la connexion à un 
concentrateur USB ou d’autres dispositifs.

5. Connecteur du module USB LAN sans fil
Effectuez une connexion au module USB LAN  
sans fil IFU-WLM3 (fourni), à l’adaptateur LAN 
sans fil CBK-WA02 (optionnel), à l’adaptateur 
réseau CBK-NA1 (optionnel) ou au modem 
(optionnel) afin d’activer les communications 
avec les périphériques et les réseaux LAN sans 
fil.

« Connexion de dispositifs à l’aide du LAN sans fil » 
(page 63)

« Connexion à Internet » (page 67)

6. Logements pour cartes PROXY SD 
(page 56)

Insérez une carte SD pour sauvegarder les 
données proxy.

7. Repère  (NFC) 
Une antenne NFC intégrée est fournie.

8. Touche SLOT SELECT (sélection de la carte 
mémoire SxS)

Lorsque des cartes mémoire SxS sont 
chargées dans les logements pour carte A et 
B, appuyez sur cette touche pour sélectionner 
la carte que vous souhaitez utiliser 
(page 31).

9. Connecteur réseau 
Se connecte à un réseau via une connexion 
LAN filaire au moyen d’un câble LAN (vendu 
séparément).

[ATTENTION]
ˎˎ Par mesure de sécurité, ne raccordez pas le 

connecteur pour le câblage de périphériques pouvant 
avoir une tension excessive à ce port.  
Suivez les instructions pour ce port.
ˎˎ Lors de la connexion du câble LAN de l’appareil au 

périphérique, utilisez un câble blindé afin d’empêcher 
tout dysfonctionnement dû au bruit de rayonnement.

« Connexion à Internet » (page 67)

10. Connecteur HDMI
Connectez un dispositif HDMI, comme un 
moniteur ou une unité d’enregistrement, pour 
émettre des signaux audio et vidéo QFHD ou 
HD.
Pour la connexion, utilisez un câble HDMI 
haute vitesse disponible dans le commerce.

[Remarque]
La sortie SD n’est pas prise en charge.

11. Connecteur GENLOCK IN (entrée de signal 
de verrouillage de synchronisation) (de 
type BNC)

Ce connecteur reçoit un signal de référence 
lorsque la synchronisation du caméscope doit 
être verrouillée ou lorsque le code temporel 
doit être synchronisé avec un équipement 
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externe. Les signaux de référence pris en 
charge dépendent de la fréquence de système 
actuelle comme illustré dans le tableau 
suivant.

Fréquence de 
système

Signaux de référence pris en 
charge

59.94i 1080/59.94i, 480/59.94i

59.94P 1080/59.94i, 480/59.94i

50i 1080/50i, 576/50i

50P 1080/50i, 576/50i

29.97P 1080/59.94i, 480/59.94i

25P 1080/50i, 576/50i

23.98P 1080/23.98PsF

12. Connecteur TC IN (entrée de code 
temporel) (de type BNC)

Pour appliquer un verrouillage externe au 
code temporel de ce caméscope, activez 
l’entrée du code temporel de référence.

« Réglage du code temporel » (page 46)

13. Connecteur SYNC OUT (de type BNC)
Ce connecteur émet un signal de 
synchronisation à trois niveaux pour 
synchroniser d’autres dispositifs.

14. Connecteur TC OUT (sortie de code 
temporel) (de type BNC)

Pour synchroniser le code temporel de ce 
caméscope à celui d’un magnétoscope 
externe, raccordez ce connecteur au 
connecteur d’entrée de code temporel du 
magnétoscope externe.

Section d’indicateur de signalisation et de connecteur

43

1 118 107 9

65

2

1

1. Indicateur TALLY (signalisation arrière) 
(rouge)

S’allume pendant l’enregistrement. Il ne 
s’allume pas si le commutateur TALLY est 
réglé sur OFF. Il clignote également lorsque 
l’indicateur WARNING fonctionne. L’indicateur 
de signalisation à l’avant du viseur et 
l’indication REC sur l’écran du viseur s’allument 
ou clignotent de la même manière.

« Système d’erreur/d’avertissement » (page 156)

2. Commutateur TALLY
Réglez-le sur ON pour activer l’indicateur 
TALLY.

3. Prise EARPHONE (stéréo, mini prise)
Vous pouvez contrôler le son E-E pendant 
l’enregistrement et le son de lecture 
pendant la lecture. En cas d’alarme, vous 
pouvez entendre la tonalité d’alarme dans 
les écouteurs. Le haut-parleur intégré est 
automatiquement coupé lors du branchement 
d’écouteurs dans la prise.
Vous pouvez sélectionner entre mono ou 
stéréo dans Maintenance >Audio >Headphone 
Out dans le menu de configuration.

[Remarques]
ˎˎ Utilisez des écouteurs de type monaural (2 pôles) ou 

stéréo (3 pôles). L’utilisation d’autres écouteurs risque 
d’endommager le caméscope.
ˎˎ Utilisez les écouteurs avec une impédance de 16 Ω.

4. Commutateur de sélection AUDIO IN
Sélectionnez la source audio que vous 
raccordez aux connecteurs AUDIO IN CH1/CH2.
LINE : lors du raccordement d’un amplificateur 

stéréo ou d’une autre source de signal 
audio externe

AES/EBU : lors de la connexion d’une source 
de signal audio numérique

MIC : lors de la connexion d’un microphone.
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5. Commutateur +48V/OFF (activation/
désactivation d’une source d’alimentation 
externe +48V)

Bascule entre les différents réglages, en 
fonction du microphone utilisé pour l’entrée 
audio.
+48V : microphone nécessitant une source 

d’alimentation externe (alimentation 
fantôme)

OFF : microphone utilisant la source 
d’alimentation interne ou ne nécessitant 
pas de source d’alimentation

6. Connecteur REMOTE (8 broches)
Se connecte à une télécommande pour 
commander le caméscope à distance.

[Remarque]
Avant de raccorder/débrancher la télécommande au/du 
caméscope, veillez à régler le commutateur POWER du 
caméscope sur OFF.

7. Connecteurs SDI OUT 1/2 (de type BNC)
Ce connecteur émet un signal 12G/3G/HD 
(avec l’audio intégré). Le signal émis par 
ce connecteur peut être activé/désactivé 
avec Operation >Input/Output >SDI Out1 
Output ou SDI Out2 Output dans le menu de 
configuration.
Utilisez un câble coaxial de 75 Ω disponible 
dans le commerce pour le raccordement.

[Remarque]
Assurez-vous que le raccordement à la terre entre le 
caméscope et le dispositif externe est correctement 
effectué avant de mettre sous tension. 
(Il est recommandé d’allumer le caméscope et le 
dispositif externe après avoir branché le câble coaxial 
de 75 Ω.) 
Si le dispositif externe doit être raccordé au caméscope 
pendant que le caméscope est allumé, raccordez 
d’abord le câble coaxial de 75 Ω au dispositif externe, 
puis raccordez-le au caméscope.

8. Cache inférieur
Il est fourni pour protéger les câbles raccordés 
aux connecteurs du panneau arrière.
En desserrant les vis qui maintiennent le cache 
au bas du caméscope, vous pouvez ajuster la 
position du cache en fonction de la taille et 

de la forme des fiches du microphone ou des 
câbles audio. Après avoir ajusté la position, 
serrez les vis pour fixer le cache.

9. Connecteurs AUDIO IN CH-1/CH-2 (entrée 
audio du canal 1 et du canal 2) (de type 
XLR, 3 broches, femelle)

Connectez-les à un équipement audio ou un 
microphone.

10. Connecteur AUDIO OUT (de type XLR, 5 
broches, mâle)

Ce connecteur émet les signaux audio 
enregistrés sur les canaux audio 1 et 2 ou les 
canaux audio 3 et 4.
Les signaux audio sont sélectionnés par le 
biais du commutateur MONITOR.

11. Connecteur SDI IN (entrée SDI) (de type 
BNC)

Connecteur utilisé lors de la connexion d’une 
source de signal SDI externe au caméscope.
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Affichage de l’écran

Écran d’informations du moniteur LCD (Affichage d’état)

L’écran d’informations du moniteur LCD 
s’affiche en appuyant sur la touche DISP 
SEL/EXPAND (sélection d’affichage/fonction 
extension) (page 9).

1 2 3 4 5

6

78

910
11

1213

1. Indicateur du système de fichiers

2. Indicateur du format de fichier

3. Affichage de l’état
PB : apparaît pendant la lecture de support.
NDF : apparaît quand le code temporel non 

réel est sélectionné.
EXT-LK : apparaît lorsque le générateur de 

code temporel interne est verrouillé 
sur une entrée de signal externe via 
le connecteur TC IN (entrée de code 
temporel).

HOLD : apparaît lorsque le mode de 
fonctionnement du générateur de code 
temporel interne est réglé sur R-RUN et 
arrêté.

4. Indicateur de la fréquence de système
Indique la fréquence de système de la vidéo 
en cours de lecture ou d’enregistrement.

5. Indicateur du format audio
Indique le format d’enregistrement audio ou le 
format audio du plan en cours de lecture.

Indicateur Format d’enregistrement

16bit HD420 HQ

24bit HD422 50
XAVC Intra
XAVC Long

6. Vumètres audio
Indiquent les niveaux de lecture ou 
d’enregistrement audio des canaux 1 à 4.

7. Indicateur de capacité restante de la 
batterie

Affiche l’icône de capacité restante de la 
batterie et la durée d’enregistrement restante.

8. Indicateur de capacité restante du 
support

Affiche des barres indiquant la capacité 
restante du support d’enregistrement dans les 
logements.

9. Zone d’indicateur d’avertissement
Affiche des avertissements lorsqu’un 
problème d’enregistrement se produit.

Pour les détails, consultez « Système d’erreur/
d’avertissement » (page 156).

10. Affichage des noms de plans
Affiche le nom du plan en cours 
d’enregistrement pendant l’enregistrement ou 
affiche le nom du prochain plan à enregistrer 
lorsque l’enregistrement est en veille.

11. Affichage des données temporelles
Bascule entre l’affichage de la durée, du code 
temporel et des données de bits d’utilisateur, 
en fonction de la position du commutateur 
DISPLAY.
Affiche le type de données actuellement 
affichées sur l’affichage des données 
temporelles, comme suit.
TCG : code temporel enregistré
TCR : code temporel de lecture
UBG : bits d’utilisateur enregistrés
UBR : bits d’utilisateur de lecture
CNT : compteur
DUR : durée
CLK : affichage de l’heure (quand le 

commutateur PRESET/REGEN/CLOCK est 
réglé sur CLOCK)

Lorsque vous appuyez sur la touche HOLD 
pour figer la valeur du code temporel, le code 
temporel est affiché au format indiqué ci-
dessous. Lorsque vous appuyez à nouveau 
sur la touche HOLD pour revenir à l’affichage 
normal, le code temporel est affiché au format 
normal.

Les trois points indiquent que le code temporel 
et la progression du compteur sont affichés en 
mode de figeage.

12. Indicateur de résolution
Indique la résolution de la sortie vidéo.

13. Indicateur du format d’enregistrement
Indique le format d’enregistrement actuel ou 
le format d’enregistrement du plan en cours 
de lecture.

Ecrans d’état

Les écrans d’état vous permettent de contrôler 
les réglages du caméscope et différents types 
d’informations d’état.
Lorsqu’aucun menu n’est affiché, appuyez sur 
le commutateur MENU CANCEL/PRST/ESCAPE 
vers le haut sur la position CANCEL/PRST pour 
afficher l’écran d’état. Chaque pression permet 
de sélectionner l’écran d’état suivant.
Les écrans d’état suivants peuvent s’afficher.

Écran d’état Indication d’affichage

Écran Camera 
Status

Réglages et informations d’état 
relatifs à la prise de vue

Écran Audio 
Status

Réglages et informations d’état 
relatifs à l’entrée et à la sortie 
audio

Écran System 
Status

Réglages et informations d’état 
relatifs à l’enregistrement

Écran Video 
Output Status

Réglages et informations d’état 
relatifs à la sortie vidéo

Écran 
Assignable 
Button Status

Noms des fonctions attribuées 
aux commutateurs 
personnalisables

Écran Battery 
Status

État de la batterie installée sur 
le caméscope
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Écran d’état Indication d’affichage

Écran Media 
Status

Informations d’état sur le 
support d’enregistrement

Écran Network 
Status 1

Réglages et informations d’état 
relatifs au réseau

Écran Network 
Status 2

Réglages et informations d’état 
relatifs à la lecture en transit

Ecran Camera Status

Elément 
affiché

Description

Gain Niveau de gain en dB
Lorsque Operation >Base 
Setting >High Sensitivity Mode 
dans le menu de configuration 
est réglé sur On, une icône  
s’affiche à droite de 
l’augmentation du gain en dB.

Shutter Etat de l’obturateur 
électronique

Gamma Courbe et catégorie Gamma

White Réglage du mode d’équilibre 
des blancs

Gain Switch Etat du commutateur GAIN

Zebra Etat des zébrures

Iris Valeur f-stop du diaphragme

Focal Length Longueur focale

Focus 
Distance

Distance de mise au point

Depth Of Field Profondeur de champ

Zoom Speed Vitesse de zoom configurée 
pour la touche ZOOM de 
l’objectif

Ecran Audio Status

Elément 
affiché

Description

CH 1/CH 2/CH 
3/CH 4

Niveau audio, source d’entrée, 
niveau d’entrée de référence et 
réglages du filtre de réduction 
anti-vent pour chaque canal

Ecran System Status

Elément affiché Description

System 
Frequency

Fréquence de système

File System Système de fichiers

Rec Format Format d’enregistrement

Clip Continuous 
Rec

Réglage d’activation/
désactivation de la fonction 
Clip Continuous Rec

Title Prefix Préfixe des noms de plans

Picture Size Taille d’image

Simul Rec Réglage d’activation/
désactivation de la fonction 
2-slot Simul Rec

Rec Function Réglages et format 
d’enregistrement spécial 
activé

Elément affiché Description

Picture Cache 
Rec

Réglage d’activation/
désactivation de la fonction 
Picture Cache Rec

Number Suffixe des noms de plans

Gamma Catégorie Gamma utilisée

4K&HD (Sub) Rec Réglage d’activation/
désactivation de la fonction 
1-slot Simul Rec

XAVC Proxy Rec Réglage d’activation/
désactivation de la fonction 
d’enregistrement de 
données proxy

Ecran Video Output Status

Elément 
affiché

Description

SDI Réglages de sortie du 
connecteur SDI OUT (taille 
d’image de sortie, taux de 
sortie, mappage, HDR/SDR, 
superposition)

HDMI Réglages de sortie du 
connecteur HDMI (taille 
d’image de sortie, mappage, 
HDR/SDR, superposition)

HDR Gamma Réglage de gamma HDR

HDR Color 
Space

Réglage de l’espace 
colorimétrique HDR

Écran Assignable Button Status

Ecran Battery Status

Elément 
affiché

Description

Detected 
Battery

Type de batterie détecté

Remaining Capacité restante (%)

Charge Count Nombre de rechargements

Capacity Capacité restante (Ah)

Voltage Tension

Manufacture 
Date 

Date de fabrication de la 
batterie

Power Source Source d’alimentation 
électrique

Supplied 
Voltage 

Tension de source 
d’alimentation fournie
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Ecran Media Status

Elément 
affiché

Description

SxSA Capacité restante (affichage du 
bargraphe et temps restant) et 
durée de vie du support dans le 
logement A (indication allant de 
0% à 100%. Remplacement 
recommandé à 0%. S’affiche 
seulement pour les supports 
qui prennent en charge cette 
fonction.)

SxSB Capacité restante (affichage du 
bargraphe et temps restant) et 
durée de vie du support dans le 
logement B (indication allant de 
0% à 100%. Remplacement 
recommandé à 0%. S’affiche 
seulement pour les supports 
qui prennent en charge cette 
fonction.)

SD Proxy Capacité restante (affichage du 
bargraphe et temps restant) et 
durée de vie (affichée 
uniquement si disponible) du 
support dans le logement de 
carte PROXY SD

SD Utility Capacité restante (affichage du 
bargraphe et capacité restante) 
et durée de vie (affichée 
uniquement si disponible) du 
support dans le logement de 
carte UTILITY SD

Un repère  s’affiche si le support est 
protégé.

Ecran Network Status 1

Elément 
affiché

Description

Setting Etat des réglages réseau

Wireless 
Network

Etat des réglages réseau sans fil

Device Name Nom du dispositif installé sur le 
module USB LAN sans fil

IP Address 
(Wireless)

Adresse IP de la connexion LAN 
sans fil

MAC Addr. 
(Wireless)

Adresse MAC du périphérique 
installé sur le connecteur du 
module USB LAN sans fil

Wireless 
Network

État des réglages du modem

Device Name Nom du dispositif installé sur le 
modem

IP Address  
(Modem)

Adresse IP du dispositif installé 
sur le modem

Wired LAN Etat de connexion réseau LAN 
sans fil

Wired LAN 
Remote

Etat d’activation/de 
désactivation de la 
télécommande lors d’une 
connexion par l’intermédiaire 
d’un câble LAN

IP Address 
(Wired)

Adresse IP de la connexion LAN 
filaire

Ecran Network Status 2

Elément 
affiché

Description

NW Client 
Mode Status

État du mode client réseau
Pour plus de détails sur l’état, 
consultez « Etat du mode client 
réseau » (page 16).

CCM Name Nom du CCM connecté lors de 
l’utilisation du mode client 
réseau

Streaming 
Status

Etat de distribution de lecture 
en transit

Streaming 
Size

Taille d’image du réglage de 
lecture en transit actuellement 
sélectionné

Streaming Bit 
Rate

Débit binaire du réglage de 
lecture en transit actuellement 
sélectionné

Streaming 
Type

Type de réglage de lecture en 
transit actuellement sélectionné

Streaming 
Dest. Add.

Adresse de destination de 
lecture en transit

Streaming 
Dest. Port

Port de destination de lecture 
en transit

Number of 
Distribution

Nombre de destinations de 
diffusion de lecture en transit

File Transfer Etat de la progression du 
transfert de fichiers

Transfer to: Nom de serveur de la 
destination de transfert de 
fichier

Etat du mode client réseau 

Affichage 
de l’état

État Description

Off CCM non 
connecté

Le mode client réseau 
est désactivé.

Connected CCM 
connecté

Le mode client réseau 
est activé, le CCM est 
connecté et le 
contrôle CCM est 
activé.

Connecting Connexion 
au CCM 
(déconnecté)

Tentative de 
connexion au CCM (ou 
déconnexion). 
Attendez jusqu’à ce 
que la connexion 
(déconnexion) 
aboutisse. Si le statut 
ne change pas et reste 
sur « Connecting », le 
paramètre d’adresse 
CCM est peut-être 
incorrect. Vérifiez que 
l’adresse est 
configurée 
correctement.

Awaiting Veille de 
connexion 
du CCM

Le mode client réseau 
est activé, mais le 
paramètre réseau est 
désactivé. Activez le 
paramètre réseau 
pour effectuer la 
connexion au CCM.

Address 
Error

Erreur 
relative à 
l’adresse 
CCM

Le nom de l’hôte ou 
l’adresse IP du CCM 
pour la connexion est 
peut-être incorrect(e). 
Vérifiez que le réglage 
est correct.
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Affichage 
de l’état

État Description

Auth. Failed Erreur 
relative 
au nom/
mot de 
passe 
utilisateur 
CCM

Le nom ou le mot de 
passe utilisateur 
utilisé pour la 
connexion au CCM est 
peut-être incorrect. 
Vérifiez que le réglage 
est correct.

No Inet 
Access

Erreur de 
connexion 
Internet

Connexion au réseau 
impossible. Les 
réglages réseau sont 
peut-être incorrects. 
Vérifiez les réglages 
réseau.

Cert. not 
Valid

Erreur 
certification 
CCM non 
valide

Le certificat CCM n’est 
pas valide. Le réglage 
de la date n’est 
peut-être pas valide. 
Vérifiez le réglage de 
la date.

Ecran du viseur

L’écran du viseur affiche les images pendant 
le tournage (enregistrement ou veille 
d’enregistrement) et la lecture en superposant 
les informations du caméscope sur l’affichage.
Vous pouvez activer/désactiver l’affichage 
des informations à l’aide du commutateur 

DISPLAY.
Les informations à afficher sont liées aux 
réglages de Operation >Super Impose dans le 
menu de configuration ainsi qu’aux réglages 
des commutateurs correspondants.

1 2 5 6 843
7

9 10 11 12

13 14
15 16
17
19
21

24
23

25

18
20
22

2629

30
31

32

34

36
38

33

2728

35
37

1. Indicateur du dispositif d’extension
« EX » apparaît lorsque la fonction d’extension 
d’objectif est activée (ON).

2. Indicateur de position de zoom (avec 
l’objectif monté)

Cette zone affiche la position de zoom de 
l’objectif zoom, dans une plage de 0 à 99.
Les valeurs affichées varient en fonction de 
l’objectif utilisé.

3. Indicateur de température de couleur
Affiche la température de couleur de 
l’équilibre des blancs.

4. Indicateur de position de mise au point 
(avec l’objectif monté)

Cette zone affiche la position de mise au point 
en tant que distance par rapport au sujet 
(unité : mètres).

5. Indicateur de position du diaphragme 
(avec l’objectif monté)

Affiche le réglage de position du diaphragme.

6. Indicateur de filtre de température de 
couleur électrique

Apparaît lorsque la fonction CC5600K est 
activée.

7. Indicateur de la profondeur de champ 
(objectif série installé)

Affiche la profondeur de champ à l’aide d’une 
barre. Les unités d’affichage sont définies 
dans Operation >Display On/Off >Lens Info 
du menu de configuration, elles peuvent des 
mètres ou des pieds.

8. Indicateur de mode d’enregistrement
Affiche les états d’opération d’enregistrement 
suivants du caméscope.

Indicateur Signification

Rec Pendant l’enregistrement

Stby Veille d’enregistrement

Cont Rec Enregistrement continu de plan 
en cours

Cont Stby Veille d’enregistrement en mode 
d’enregistrement continu de plan

S&Q Rec Enregistrement en cours en mode 
ralenti et accéléré

S&Q Stby Veille d’enregistrement en mode 
ralenti et accéléré

HFR Rec Enregistrement en mode de 
fréquence d’images élevée.

HFR Stby Veille d’enregistrement en mode 
de fréquence d’images élevée.

Rec Enregistrement en mode Picture 
Cache Rec

Cache Veille d’enregistrement en mode 
Picture Cache Rec

Int Rec Enregistrement en cours en mode 
d’enregistrement par intervalles

Int Stby Veille d’enregistrement en mode 
d’enregistrement par intervalles

Int Stby Enregistrement en pause en 
mode d’enregistrement par 
intervalles (durant des intervalles 
de pause)

Sml Rec Enregistrement en cours en mode 
Simul Rec

Sml Stby Veille d’enregistrement en mode 
Simul Rec
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Indicateur Signification

CALL Appel reçu depuis un dispositif 
externe raccordé

L’indicateur de signalisation vert s’allume 
lorsque le caméscope se trouve dans les états 
suivants.
ˎˎ Maintenance >Camera Config >HD SDI 
Remote I/F est réglé sur Green Tally dans 
le menu de configuration et un signal de 
commande d’enregistrement est émis par le 
connecteur SDI OUT.
ˎˎ Signal de signalisation vert reçu (quand un 
adaptateur de caméra (raccordement pris en 
charge par le modèle japonais uniquement) 
est installé sur le caméscope et une unité 
d’extension de caméra est raccordée)

9. Indicateur de la fonction du récepteur 
sans fil

Affiche « W » lorsqu’un récepteur est inséré 
dans le caméscope, et affiche le niveau de 
réception de chaque canal pouvant être utilisé 
par le récepteur (1c, 2c ou 4c).
Normal : affiche la force du niveau du signal 

reçu en fonction du nombre de segments 
blancs.

Sourdine du récepteur analogique/
avertissement taux d’erreur du récepteur 
numérique : affiche la force du niveau 
du signal reçu en fonction du nombre de 
segments gris.

Si le niveau reçu dépasse le niveau crête : 
affiche « P » au lieu de l’indicateur.1)

Si l’émetteur est en mode d’économie 
d’énergie : « S » s’affiche.

La batterie du récepteur est faible : le 
nombre de canaux correspondants et les 
indicateurs clignotent. 1)

1)  Lorsque vous utilisez le DWR-S02DN (en option)

10. Indicateur de la fréquence d’images S&Q 
Motion (ralenti et accéléré)

Affiche la fréquence d’image de tournage 
lorsque le caméscope est réglé en mode 
ralenti et accéléré.

11. Indicateur GPS (page 61)

12. Affichage de la tension/capacité de la 
batterie

Affiche les indicateurs suivants selon le type 
de batterie d’alimentation.

Type de batterie Indicateur

Infos batterie Icône de capacité restante 
de la batterie et durée 
d’enregistrement restante

Batterie Anton/
Bauer

Capacité restante de la 
batterie (indicateur en %)

Autres batteries Tension d’entrée

13. Indicateur du format d’enregistrement 
(taille d’image)

Affiche la taille de l’image des plans 
enregistrés sur les cartes mémoire SxS.

14. Indicateur du format d’enregistrement 
(fréquence du système et méthode de 
balayage)

Affiche la fréquence de système du 
caméscope actuellement configurée 
et la méthode de balayage du format 
d’enregistrement.

15. Indicateur du format d’enregistrement 
(codec)/indicateur 1-slot Simul Rec

Affiche le nom du format des plans enregistrés 
sur les cartes mémoire SxS.
« /Sub » est affiché en mode 1-slot Simul Rec 
(page 54).

16. Indicateur Gamma
Affiche le réglage de gamma.

Réglages du menu Indicateur

Operation 
>Display 
On/Off 
>Gamma

Réglage Paint >Gamma

Gamma Gamma 
Category

Gamma 
Select

Off – – – –

On Off – – Gamma 
Off

On STD STD1 DVW STD1

STD2 x4.5 STD2

STD3 x3.5 STD3

STD4 
240M

STD4

STD5 R709 STD5

STD6 x5.0 STD6

HG HG1 
3250G36

HG1

HG2 
4600G30

HG2

HG3 
3259G40

HG3

HG4 
4609G33

HG4

On On User User 1 User 1

User 2 User 2

User 3 User 3

User 4 User 4

User 5 User 5

Les éléments suivants sont affichés lorsque 
Operation >Base Setting >Shooting Mode 
dans le menu de configuration est réglé sur 
HDR et Operation >Display On/Off >Gamma 
est réglé sur On.

Réglages du menu Indicateur

Operation >HDR 
Setting

Paint >Gamma

4K(QFHD) 
Rec/Out

HD Rec/
Out

Gamma Gamma 
Select

HDR 
(HLG)

HDR 
(HLG)

– – HLG

SDR Off – HLG

On STD1 
DVW

HLG 
STD1

STD2 ×4.5 HLG 
STD2

STD3 ×3.5 HLG 
STD3

STD4 
240M

HLG 
STD4

STD5 
R709

HLG 
STD5

STD6 ×5.0 HLG 
STD6

HG1 
3250G36

HLG HG1

HG2 
4600G30

HLG 
HG2

HG3 
3259G40

HLG 
HG3

HG4 
4609G33

HLG 
HG4

User 1 HLG 
User1

User 2 HLG 
User2

User 3 HLG 
User3

User 4 HLG 
User4

User 5 HLG 
User5
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Réglages du menu Indicateur

Operation >HDR 
Setting

Paint >Gamma

4K(QFHD) 
Rec/Out

HD Rec/
Out

Gamma Gamma 
Select

HDR 
(S-Log3)

SDR Off – S-Log3

On STD1 
DVW

S-Log3 
STD1

STD2 ×4.5 S-Log3 
STD2

STD3 ×3.5 S-Log3 
STD3

STD4 
240M

S-Log3 
STD4

STD5 
R709

S-Log3 
STD5

STD6 ×5.0 S-Log3 
STD6

HG1 
3250G36

S-Log3 
HG1

HG2 
4600G30

S-Log3 
HG2

HG3 
3259G40

S-Log3 
HG3

HG4 
4609G33

S-Log3 
HG4

User 1 S-Log3 
User1

User 2 S-Log3 
User2

User 3 S-Log3 
User3

User 4 S-Log3 
User4

User 5 S-Log3 
User5

17. Indicateur de verrouillage externe du 
code temporel

Affiche le verrouillage du code temporel 
lorsque le code temporel est émis d’une 
source externe.

18. Indicateur d’état de la connexion LAN 
filaire/modem

Affiche des icônes pour le réseau LAN filaire 
ou pour l’état des réglages/de la connexion 
du modem.

État des réglages/de la connexion du LAN 
filaire

État État/icône 
de la 
connexion 
réseau

Operation 
>Display 
On/Off 
>Network 
Condition

Maintenance 
>Network 
>Setting

Maintenance 
>Network 
>Wired LAN

Off – – –

On Off – –

On – –

Disable –

Enable Connexion 
au LAN

(clignotement)

Connecté au 
LAN

Erreur de 
connexion 
LAN

État des réglages/de la connexion du modem 
3G/4G

État État/icône 
de la 
connexion 
réseau

Operation 
>Display 
On/Off 
>Network 
Condition

Maintenance 
>Network 
>Setting

Maintenance 
>Network 
>Modem

Off – – –

On Off – –

On – –

Off –

On Connexion 
du modem 
en cours

(clignotement)

Modem 
connecté

Erreur de 
connexion 
du modem

19. Indicateur de lecture en transit
Affiche l’état de la lecture en transit par 
l’intermédiaire d’icônes.

État État/icône 
de lecture 
en transit

Operation 
>Display 
On/Off 
>Streaming 
Status

Maintenance 
>Streaming 
>Setting

Maintenance 
>Network 
Client Mode 
>Setting

Off – – –

On Off Off –

On Off Pas de 
lecture en 
transit

Lecture en 
transit

Erreur

Les icônes suivantes sont affichées lors de la 
lecture en transit depuis un CCM.

État État/icône 
de lecture 
en transit

Operation 
>Display 
On/Off 
>Streaming 
Status

Maintenance 
>Streaming 
>Setting

Maintenance 
>Network 
Client Mode 
>Setting

On Off On Pas de 
lecture en 
transit

Lecture en 
transit

[Remarque]
Les icônes ne sont pas affichées avant le début de la 
lecture en transit.
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20. Indicateur d’état du mode Wi-Fi
Affiche les réglages LAN sans fil et l’ état de la 
connexion par l’intermédiaire d’icônes.

État État/icône 
de la 
connexion 
réseau

Operation 
>Display 
On/Off 
>Network 
Condition

Maintenance 
>Network 
>Setting

Maintenance 
>Network 
>Wi-Fi Mode

Off – – –
On Off – –

On Wi-Fi Access 
Point

Connexion 
au Wi-Fi

(clignotement)
Wi-Fi en 
veille 
(connecté)

État État/icône 
de la 
connexion 
réseau

Operation 
>Display 
On/Off 
>Network 
Condition

Maintenance 
>Network 
>Setting

Maintenance 
>Network 
>Wi-Fi Mode

On On Wi-Fi Station Connexion 
au Wi-Fi

(clignotement)
Recherche 
de points 
d’accès

Connexion 
au point 
d’accès

L’icône 
change en 
raison de la 
force du 
signal
Erreur de 
connexion 
point 
d’accès

Off –

21. Indicateur de l’état du transfert de fichiers
Affiche  et le taux de transfert (%) pendant 
un transfert de fichier. Une fois le transfert fini, 

 disparaît pour indiquer le transfert à 100%.

22. Indicateur proxy
Affiche « Proxy » lorsque l’enregistrement 
proxy est activé (Operation > XAVC Proxy Rec 
Mode >Setting dans le menu de configuration 
est réglé sur On). Pendant la configuration, 

« Proxy » clignote. « Proxy Rec » s’affiche 
pendant l’enregistrement.

23. Indicateur du mode client réseau
Affiche l’état de la connexion au CCM 
(Connection Control Manager) d’une station 
réseau RX ou de C3 Portal à l’aide des icônes 
lorsque le mode client réseau est activé.

État Icône

Operation 
>Display 
On/Off >NW 
Client Mode 
Status

Maintenance 
>Network 
Client Mode 
>Setting

État

Off – – –

On Off – –

On CCM 
connecté

Connexion au 
CCM 
(déconnecté) (clignotement)

Veille de 
connexion 
du CCM

–

Erreur de 
connexion 
au CCM Pour de plus 

amples 
informations 
concernant 
les erreurs, 
reportez-
vous à 
page 16.

24. Indicateur de signal vidéo
Affiche le signal de sortie vidéo en temps 
réel sous forme d’onde, de vecteurscope ou 
d’histogramme.

État Indicateur 
de signal 
vidéo

Operation >Input/
Output >Output 
Format >SDI Out

Operation >HDR 
Setting

3840×2160 Indicateur du réglage 4K(QFHD) 
Rec/Out

HDR(HLG) HDR(HLG)

HDR(S-Log3) HDR
(S-Log3)

1920×1080 Indicateur du réglage HD Rec/
Out

HDR(HLG) HDR(HLG)

SDR SDR

25. Indicateur de capacité restante/d’état du 
support d’enregistrement pour chaque 
logement

Affiche l’état et la capacité restante du support 
dans le logement SxS A, SxS B et le logement 
pour carte PROXY SD.
Indicateur icône de logement SxS
* Exemple de logement SxS A (SxSA). Les icônes pour le 
logement SxS B sont étiquetées SxSB.

Icône Etat du support

– Support non inséré ou non 
installé

Support installé

(clignotement)

Installation du support

(barre orange)

Enregistrement (actif)

(indicateur 
vert)

Lecture (actif)

(barre orange + 
indicateur vert)

Enregistrement/lecture (actif)
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Indicateur icône de carte SD (pour 
l’enregistrement des données proxy)

Icône Etat du support

– Support non inséré ou non 
installé

Support installé

(clignotement)

Installation du support

(barre orange)

Enregistrement (actif)

La durée d’enregistrement restante s’affiche 
en chiffres.

26. Indicateurs de vumètre audio
Lorsque les commutateurs MONITOR 
(sélection du moniteur audio) (page 6) 
sont réglés sur CH-1/2, les niveaux audio des 
canaux 1 et 2 sont surveillés. Avec le réglage 
sur CH-3/4, les niveaux audio des canaux 3 et 
4 sont surveillés.

27. Affichage des noms de plans
Affiche le nom du plan en cours 
d’enregistrement pendant l’enregistrement ou 
affiche le nom du prochain plan à enregistrer 
lorsque l’enregistrement est en veille.

28. Indicateur d’aide à la mise au point
Affiche un cadre de détection (repère de 
zone) indiquant la zone de détection du degré 
de mise au point, et une barre de niveau 
(indicateur d’aide à la mise au point) indiquant 
le degré de mise au point dans cette zone.

29. Affichage des données temporelles
Affiche la durée de lecture/enregistrement 
restante, le code temporel, les bits 
d’utilisateur, etc. sélectionnés par le 
commutateur DISPLAY (page 9).

30. Indicateur de carte SD pour la sauvegarde 
des données de configuration

Affiche l’état de la carte SD (pour 
l’enregistrement des données de 
configuration) insérée dans le logement de 
carte UTILITY SD.

Icône Etat du support

– Carte SD non insérée ou non 
installée

Carte SD montée

La carte SD montée est 
protégée

(clignotement)

Montage de la carte SD

31. Indicateur de déclenchement REC en 
sortie SDI

Affiche l’état de superposition de la 
commande d’enregistrement envoyée à la 
sortie du connecteur SDI.
Cela s’affiche lorsque Maintenance >Camera 
Config >HD SDI Remote I/F dans le menu de 
configuration est réglé sur « Characters ».

32. Indicateur ALAC
Affiche « ALAC » lorsque l’exécution 
automatique de la fonction ALAC 
(compensation automatique d’aberrations 
d’objectif) est définie.
ALAC s’effectuera automatiquement lorsqu’un 
objectif compatible ALAC est fixé, la fonction 
ALAC est activée, et Maintenance >Camera 
Config >ALAC est réglé sur « Auto » dans le 
menu de configuration.

33. Indicateur de mode AE (diaphragme 
automatique)

Affiche le mode de fonctionnement actuel de 
la fonction de diaphragme automatique grâce 
à une icône et le niveau de changement de 
valeur du diaphragme automatique.

Icône Signification

Mode rétroéclairage

Mode standard

Mode spot

34. Indicateur de mode de mise au point 
automatique (uniquement si un objectif à 
mise au point automatique est installé)

Affiche le mode d’ajustement de mise au 
point du caméscope.
ˎˎ AF (mise au point automatique)
ˎˎ MF (mise au point manuelle)
ˎˎ MF* (mise au point manuelle avec fonction 
d’aide à la mise au point manuelle activée)
ˎˎ Full MF (mise au point manuelle complète)

35. Indicateur de filtre ND
Affiche le numéro de position du filtre ND 
actuellement sélectionné (page 5).
Lorsque « Electrical CC » est attribué à un 
commutateur personnalisable, la position 
(A/B/C/D) du filtre électrique CC apparaît à 
droite de l’indicateur du filtre ND (1 à 4).

36. Indicateur de gain
Affiche le réglage gain (dB), défini à l’aide du 
commutateur GAIN, de l’amplificateur vidéo.
Lorsque Operation >Base Setting >High 
Sensitivity Mode dans le menu de 
configuration est réglé sur On, une icône  
s’affiche.

37. Indicateur du mode d’obturation/de la 
vitesse d’obturation

Affiche le mode ou la vitesse d’obturation.

« Réglage de l’obturateur électronique » (page 41)

38. Indicateur du mode d’équilibre des blancs
Affiche la mémoire d’ajustement automatique 
de l’équilibre des blancs actuellement 
sélectionnée.
ATW : mode ATW (équilibre des blancs à suivi 

automatique)
W:A : mode mémoire A
W:B : mode mémoire B
W:C : mode mémoire C
W:P : mode prédéfini
3200K : apparaît lorsqu’un commutateur 

personnalisable auquel Color Temp SW 
3200K est attribué est activé

4300K : apparaît lorsqu’un commutateur 
personnalisable auquel Color Temp SW 
4300K est attribué est activé

5600K : apparaît lorsqu’un commutateur 
personnalisable auquel Color Temp SW 
5600K est attribué est activé

6300K : apparaît lorsqu’un commutateur 
personnalisable auquel Color Temp SW 
6300K est attribué est activé 
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Préparation de l’alimentation
2. Préparatifs

Pour des raisons de sécurité, utilisez 
uniquement les packs de batteries et les 
adaptateurs CA Sony listés ci-dessous.
ˎˎ Pack batterie au lithium-ion BP-GL95B

[ATTENTION]
Il y a danger d’explosion s’il y a remplacement incorrect 
de la batterie.  
Remplacer uniquement avec une batterie du même 
type ou d’un type équivalent recommandé par le 
constructeur.  
Lorsque vous mettez la batterie au rebut, vous devez 
respecter la législation en vigueur dans le pays ou la 
région où vous vous trouvez.

Utilisation d’un pack batterie

Appuyez le pack batterie contre l’arrière du 
caméscope, en alignant la ligne qui se trouve 
sur le côté du pack batterie à celle située sur 
le caméscope. Faites ensuite glisser le pack 
batterie vers le bas jusqu’à ce que sa flèche 
« LOCK » soit alignée sur la ligne située sur le 
caméscope.
Pour retirer le pack batterie, soulevez le 
pack batterie tout en enfonçant la touche de 
déblocage.

[Remarques]
ˎˎ Si le pack batterie n’est pas fixé correctement, les 

bornes peuvent être endommagées.
ˎˎ Pendant l’enregistrement et la lecture (lorsque le 

témoin ACCESS sur le panneau latéral droit est allumé 
en bleu et que le témoin ACCESS dans la section de 
logements pour carte est allumé en orange), faites 
attention de ne jamais retirer le pack batterie.  
Cela pourrait corrompre les données enregistrées sur 
la carte.
ˎˎ Assurez-vous de mettre le caméscope hors tension 

avant de remplacer le pack batterie.

Utilisé avec un pack batterie BP-GL95B, le 
caméscope peut fonctionner en continu 
pendant environ 110 minutes.

[AVERTISSEMENT]

N’exposez pas les batteries à une chaleur 
excessive, au soleil ou près d’un feu par 
exemple.

[Remarque]
La durée de fonctionnement du pack batterie dépend de 
sa fréquence d’utilisation et de la température ambiante 
à laquelle il est utilisé.

Avant l’utilisation, rechargez le pack batterie à 
l’aide d’un chargeur de batterie adapté.

Pour plus de détails sur la procédure de chargement de 
la batterie, reportez-vous au manuel d’utilisation du 
chargeur de batterie.

Remarque sur l’utilisation du pack batterie
Si le pack batterie est chaud, il risque de ne 
pas se recharger complètement.

Utilisation de l’alimentation CA

Fixez l’adaptateur AC-DN10A sur le caméscope 
en suivant la même méthode que pour 
un pack batterie, puis raccordez-le à 
l’alimentation CA.
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Fixation d’un viseur
[ATTENTION]
Lorsque le viseur est fixé, ne laissez pas le caméscope 
avec l’objectif de l’oculaire en face du soleil.
Les rayons du soleil directs peuvent entrer par l’objectif, 
se concentrer dans le viseur et provoquer un incendie.

Un viseur est disponible séparément.
Cette section décrit la fixation du HDVF-EL20 
en tant qu’exemple.

Pour la procédure de fixation des autres viseurs, reportez-
vous au manuel fourni avec chaque viseur.

Fixation d’un viseur

[Remarque]
Pour fixer un viseur, tenez compte des points suivants.
ˎˎ Assurez-vous de mettre le caméscope hors 

tension avant de brancher la fiche du viseur dans 
le connecteur VF du caméscope (20 broches). Si 
vous raccordez le viseur lorsque le caméscope est 
sous tension, le viseur peut ne pas fonctionner 
correctement.
ˎˎ Branchez fermement la fiche du viseur dans le 

connecteur VF du caméscope (20 broches). Si la 
fiche n’est pas bien branchée, des parasites peuvent 
apparaître sur la vidéo ou l’indicateur de signalisation 
peut ne pas fonctionner correctement.

1 [1] Desserrez la bague de positionnement 
gauche/droite du viseur, [2] fixez le viseur 
sur la griffe de raccord du viseur et [3] 
resserrez la bague de positionnement 
gauche/droite du viseur.

[2]

[1]

[3]

Butée de glissement

Bague de positionnement gauche/droite

2 Branchez la fiche du viseur dans le 
connecteur VF (20 broches).

Connecteur VF (20 broches)

Vous pouvez retirer le viseur en suivant la 
procédure de montage à l’envers, mais, lors du 
retrait du viseur de la griffe de fixation, tirez la 
butée vers le haut.

Ajustement de la dioptrie

Tournez la bague d’ajustement de la dioptrie 
jusqu’à ce que l’image du viseur soit nette.
Bague d’ajustement 
de la dioptrie

Vous pouvez fixer un filtre de protection 
disponible dans le commerce, un objectif gros 
plan, etc. de 52 mm de diamètre.

Ajustement de l’écran

Ajustez la luminosité, le contraste et le réglage 
du contour de l’écran du viseur avec les 
commandes illustrées ci-dessous.
Outlines : ajustez à l’aide du bouton PEAKING.
Contrast : ajustez à l’aide du bouton 

CONTRAST.
Brightness : ajustez à l’aide du bouton BRIGHT.

Fixation de la bague de rotation 
du viseur BKW-401

En installant la bague de rotation du viseur 
BKW-401 optionnelle, vous pouvez écarter 
le viseur en le faisant pivoter, afin que votre 
jambe droite ne heurte pas le viseur lorsque 
vous transportez le caméscope.

1 Desserrez les leviers de positionnement 
avant/arrière du viseur et les boutons de 
positionnement avant/arrière du viseur, 
puis tirez l’ensemble coulissant du viseur 
vers l’avant.
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2 A l’aide d’une clé hexagonale d’un 
diamètre de 2,5 mm, retirez l’ensemble 
coulissant du viseur.

Ensemble coulissant 
du viseur

Boulons à six 
pans creux

3 Fixez le BKW-401 avec les boulons fournis.
Boulons fournis avec le BKW-401

4 Ajustez la position avant/arrière afin que 
le bras du BKW-401 ne touche pas la 
poignée lorsqu’il est relevé.

Ajustez la position afin que le 
bras ne touche pas la poignée
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Utilisation du caméscope pour la première fois
Lorsque vous utilisez le caméscope pour la 
première fois, configurez les réglages suivants 
dans le menu.

Pour plus de détails sur le fonctionnement des 
menus, consultez « Opérations de base du menu de 
configuration » (page 96).

Réglage du fuseau horaire

Réglez le fuseau horaire de la région à utiliser. 
La valeur par défaut est « UTC Greenwich ».

1 Sélectionnez Operation >Time Zone >Time 
Zone dans le menu de configuration.

2 Sélectionnez le fuseau horaire à utiliser.

Réglage de la date et l’heure de 
l’horloge interne

Réglez l’année, le mois, le jour et le jour de la 
semaine de l’horloge interne.

1 Sélectionnez Maintenance >Clock Set 
>Date dans le menu de configuration.
L’écran Data apparaît.

2 Tournez le bouton MENU pour 
sélectionner l’année, le mois ou le jour, 
puis appuyez sur le bouton.
L’année, le mois ou le jour sélectionné 

deviennent modifiables.

3 Tournez le bouton MENU pour définir 
l’année, le mois ou le jour, puis appuyez 
sur le bouton.

4 Répétez les étapes 2 et 3 pour régler les 
chiffres restants.

5 Appuyez sur la touche SET.
L’horloge interne est réglée sur la date 
définie aux étapes 2 à 4.
Puis réglez l’heure.

6 Sélectionnez Maintenance >Clock Set 
>Time dans le menu de configuration.
L’écran Time apparaît.

7 Réglez l’heure de la même façon que la 
date.

8 Appuyez sur la touche SET.
L’heure est enregistrée dans l’horloge 
interne.

Pour annuler le réglage, appuyez sur la touche 
Cancel.
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Montage et ajustement de l’objectif
[Remarque]
Lors du raccordement ou de la déconnexion d’un câble 
d’objectif à ce connecteur, mettez d’abord le caméscope 
hors tension.

Fixation d’un objectif

L’objectif est disponible séparément.
Cette section décrit un exemple de fixation de 
l’objectif.

Pour plus d’informations sur la fixation de l’objectif, reportez-
vous à son manuel d’utilisation.

1 Poussez le levier de verrouillage de l’objectif 
vers le haut et retirez le capuchon de la 
monture d’objectif.

2 Alignez le logement central de la monture 
d’objectif avec la broche centrale de 
l’objectif et insérez ce dernier dans la 
monture.

1

1
2

3 Tout en maintenant l’objectif en place, 
abaissez le levier de verrouillage de l’objectif 
pour le verrouiller.

[ATTENTION]

Si l’objectif n’est pas correctement verrouillé, 
il risque de se détacher pendant l’utilisation 
du caméscope. Cela peut provoquer un 
accident grave. Assurez-vous que l’objectif 
est fermement verrouillé. Il est recommandé 
de veiller à ce que le caoutchouc de fixation 
de monture de l’objectif soit placé sur le 
levier de verrouillage de l’objectif, comme 
illustré ci-dessous.

3

Caoutchouc de fixation de la 
monture d’objectif

4 Raccordez le câble d’objectif au connecteur 
LENS.

5 Fixez le câble d’objectif à l’aide de l’attache 
de câble.

Si un objectif de correction d’aberration 
est fixé

La fonction de correction d’aberration est 
automatiquement activée. 1) Le démarrage 
du caméscope avec un objectif de correction 
d’aberration peut prendre plus de temps que la 
normale en raison du chargement des données 
au démarrage.

Contactez un revendeur Sony pour obtenir plus 
d’informations sur les objectifs de correction 
d’aberration.
1) La fonction de correction d’aberration ne fonctionne pas 

si Maintenance >Camera Config >ALAC dans le menu de 
configuration est réglé sur Off.

Ajustement de la longueur focale

Si l’objectif ne conserve pas une mise au point 
correcte lorsque vous zoomez du téléobjectif 
au grand angle, ajustez la longueur focale 
(la distance entre le plan de la collerette de 
montage de l’objectif et le plan de l’image, aussi 
appelée retour de bride).
Effectuez cet ajustement une fois seulement 
après le montage ou le changement d’objectif.
Lors de l’ajustement, utilisez comme sujet un 
modèle d’ajustement de longueur focale.

Environ 3 m (10 pi)

[Remarques]
ˎˎ Si vous utilisez un sujet avec un contraste insuffisant, ou 

déplacez le caméscope ou le sujet pendant l’ajustement, 
il peut en résulter une erreur d’ajustement.
ˎˎ Placez le sujet (le modèle d’ajustement de longueur 

focale) de façon à ce qu’il apparaisse au centre de l’écran 
à l’extrémité téléobjectif. Arrangez-vous pour qu’aucun 
objet proche (aucun objet plus proche de la caméra que 
le modèle) n’apparaisse sur l’écran à l’extrémité grand 
angle.

1 Réglez le diaphragme sur manuel.

2 Placez le modèle d’ajustement de longueur 
focale fourni à environ 3 m (10 pi) devant la 
caméra.

3 Ouvrez le diaphragme.
L’ouverture du diaphragme réduit la 
profondeur de champ, ce qui facilite le 
réglage.

4 Desserrez les vis de fixation de la bague 
F.f ou F.B (bague d’ajustement de la 
longueur focale).

5 Utilisez le zoom manuel ou motorisé pour 
régler l’objectif sur téléobjectif.

6 Dirigez le caméscope vers le modèle en 
tournant la bague de mise au point pour 
effectuer la mise au point.

7 Réglez la bague de zoom sur grand angle.

8 Tournez la bague F.f ou F.B jusqu’à obtenir 
la mise au point sur le modèle, en veillant 
à ne pas bouger la bague de mise au 
point.

9 Répétez les étapes 5 à 8 jusqu’à ce que le 
modèle reste net, du grand angle au 
téléobjectif.

10 Resserrez les vis de fixation de la bague 
F.f ou F.B.
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Préparation du système d’entrée audio

Raccordement d’un microphone 
au connecteur MIC IN

Vous pouvez fixer le microphone stéréo 
(disponible séparément) au support 
de microphone du viseur (disponible 
séparément).
Cette section décrit un exemple de fixation du 
microphone.

Pour la procédure de fixation à un autre viseur, reportez-
vous au manuel fourni avec chaque viseur.

1 Desserrez la vis et ouvrez l’attache du 
support de microphone.

[1]
[2]

Attache du support de microphone

2 Placez le microphone dans le support de 
microphone.
[1] Placez le microphone dans le support 

de façon à ce que « UP » soit en haut.
[2] Refermez le support de microphone.
[3] Serrez la vis.

[2] [3]

[1]

3 Branchez le câble du microphone dans le 
connecteur MIC IN, puis réglez le 
commutateur AUDIO IN, pour le canal sur 
lequel vous voulez enregistrer l’audio à 
partir de ce microphone, sur FRONT.

4 Fixez le câble du microphone à l’aide de 
l’attache de câble.

Raccordement de microphones 
aux connecteurs AUDIO IN

Vous pouvez raccorder jusqu’à deux 
microphones monauraux aux connecteurs 
AUDIO IN CH-1/CH-2, à l’aide d’un support de 
microphone CAC-12 optionnel.
Microphones pris en charge : microphone à 

électret ECM-674/678

Pour plus de détails sur la fixation du support de 
microphone et du microphone, reportez-vous au mode 
d’emploi de chaque produit.

Installation d’un récepteur sans fil

Pour utiliser un système de microphone sans 
fil Sony, mettez le caméscope hors tension 
puis installez un récepteur sans fil.
ˎˎ Récepteur sans fil numérique DWR-S02DN/
DWR-S03D
ˎˎ Tuner synthétisé UHF URX-S03D

Pour de plus amples informations sur la façon d’installer 
un récepteur sans fil, reportez-vous au mode d’emploi de 
chaque dispositif.

Raccordement de l’équipement 
audio d’entrée de ligne

1 Raccordez le connecteur de sortie audio 
de l’équipement audio, qui fournit le 
signal d’entrée de ligne, au connecteur 
AUDIO IN CH-1 ou CH-2.

2 Réglez sur LINE le sélecteur AUDIO IN pour 
le canal auquel la source de signal audio 
est raccordée.

Fonction de détection automatique de 
connexion XLR

ˎˎ Si la fonction de détection automatique 
de connexion XLR est désactivée (réglage 
d’usine par défaut) : réglez le commutateur 
AUDIO IN CH1/CH2/CH3/CH4 sur REAR pour 
les canaux auxquels l’équipement audio est 
raccordé.
ˎˎ Si la fonction de détection automatique 
de connexion XLR est activée : lorsqu’un 
câble est raccordé au connecteur AUDIO 
IN CH-1 ou CH-2, l’entrée de ce connecteur 
est automatiquement sélectionnée pour 
l’enregistrement audio, quel que soit le 
réglage du commutateur AUDIO IN CH1/
CH2/CH3/CH4.
ˎˎ Lorsque le commutateur de sélection 
AUDIO IN est en position LINE ou MIC, le 
type d’audio enregistré sur les canaux audio 
3 et 4 ne dépend pas de la fonction de 
détection automatique de connexion XLR. Il 
est déterminé uniquement par la sélection à 
l’aide du commutateur.

La fonction de détection automatique de 
connexion XLR peut être activée/désactivée à 
l’aide de Maintenance >Audio >Rear XLR Auto 
du menu de configuration.

[2][1] [3]

[4]
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[1] Commutateurs AUDIO IN CH1/CH2/CH3/
CH4

[2] Vers connecteur AUDIO IN CH-1 ou CH-2
[3] Microphone monaural
[4] Commutateurs de sélection AUDIO IN
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Fixation et ajustement des dispositifs périphériques

Installation d’un trépied

1 Fixez l’adaptateur de trépied VCT-14/U14 
optionnel au trépied.

2 Montez le caméscope sur l’adaptateur de 
trépied.

Faites glisser le caméscope vers l’avant le 
long de la fente de l’adaptateur jusqu’à son 
déclic.

3 Assurez-vous que le caméscope est 
correctement fixé en le bougeant vers 
l’arrière et l’avant.

Pour retirer le caméscope de son trépied, 
maintenez la touche rouge enfoncée et glissez 
le levier dans la direction de la flèche.

Touche rouge

Levier

[Remarque]
La broche de l’adaptateur de trépied peut rester 
engagée, même si le caméscope a été retiré. Si c’est 
le cas, appuyez sur la touche rouge et déplacez le 
levier comme illustré ci-dessus jusqu’à ce que la 
broche revienne en position rentrée. Si la broche reste 
engagée, vous ne pourrez pas monter le caméscope sur 
l’adaptateur de trépied.

Raccordement d’une lampe vidéo

Vous pouvez utiliser la lampe vidéo Anton 
Bauer Ultralight 2 ou une lampe vidéo 
équivalente avec ce caméscope (alimenté 
en 12 V avec une consommation électrique 
maximale de 50 W).
ˎˎ Si vous raccordez la lampe vidéo au 
connecteur LIGHT sur le caméscope et si 
vous réglez le commutateur LIGHT sur AUTO, 
vous pouvez allumer et éteindre la lampe 
automatiquement lorsque vous démarrez et 
arrêtez l’enregistrement sur ce caméscope.
ˎˎ La sortie du connecteur LIGHT du 
caméscope est réglée sur 12 V, même 
lorsque le caméscope est alimenté par une 
source d’alimentation supérieure à 12 V (via 
le connecteur DC IN ou un pack batterie). 
La luminosité ou la température de couleur 
de la lampe ne change pas en réponse à 
l’augmentation de la tension.

[Remarques]
ˎˎ Ne raccordez pas de lampe vidéo dont la 

consommation électrique est égale ou supérieure à 
50 W.
ˎˎ La luminosité ou la température de couleur de la 

lampe change lorsque la tension (fournie par le 
connecteur DC IN ou le pack batterie) est inférieure 
à 12 V.

Pour fixer une lampe vidéo, installez la lampe 
vidéo sur la griffe d’accessoires sur la poignée 
du caméscope et raccordez le câble de la 
lampe vidéo au connecteur LIGHT.

[Remarque]
La griffe d’accessoires de ce caméscope est du type vis 
à trou taraudé d’1/4 pouce. Si vous désirez la remplacer 
par une griffe de type coulissant, utilisez le kit de 
fixation fourni.

Fixation de la bandoulière

1 Placez l’un des clips sur un des points de 
fixation de la bandoulière.

Tirez sur la bandoulière pour 
verrouiller au point de fixation.

Clip

2 Placez l’autre clip sur le point de fixation 
de la bandoulière situé de l’autre côté de 
la poignée de la même manière.

Pour retirer la bandoulière, consultez le 
dessin suivant.
Appuyez ici et tirez dans la direction 
indiquée par la flèche pour déverrouiller.

Ajustement de la position du 
protège-épaule

Vous pouvez déplacer le protège-épaule vers 
l’avant et l’arrière sur une distance de 40 mm. 
Cet ajustement vous permet de trouver le 
meilleur équilibre lors des prises de vue avec 
le caméscope à l’épaule.

1,3

2
Protège-épaule

1 Relevez le levier situé au centre du 
protège-épaule afin de le déverrouiller.

2 Déplacez le protège-épaule vers l’arrière 
ou l’avant, jusqu’à la position qui vous 
convient.

3 Abaissez le levier pour verrouiller le 
protège-épaule sur la position choisie.
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Manipulation des cartes mémoire SxS
Ce caméscope permet d’effectuer des 
enregistrements audio et vidéo sur des cartes 
mémoire SxS (non fournies) chargées dans le 
ou les logements pour carte mémoire.
En plus des cartes mémoire SxS, le caméscope 
peut également enregistrer sur des cartes 
SDXC/SDHC (non fournies) en utilisant 
l’adaptateur de support MEAD-SD02 (en 
option).
Le système de fichiers pris en charge pour 
chaque type de support est indiqué ci-
dessous.

Carte mémoire Système de fichiers

exFAT UDF FAT

Cartes mémoire SxS Oui Oui Non

Cartes SDXC Oui Non Non

Cartes SDHC Non Non Oui

À propos des cartes mémoire SxS

Cartes mémoire SxS

Utilisez les cartes mémoire SxS Sony (SxS 
PRO X, SxS PRO+, SxS PRO ou SxS-1) avec ce 
caméscope.

Série SxS PRO X 
Série SxS PRO+ 
Série SxS PRO 
Série SxS-1

Les cartes mémoire énumérées ci-dessus 
sont conformes à la norme de cartes mémoire 
ExpressCard.
ˎˎ SxS, SxS PRO X, SxS PRO+, SxS PRO et SxS-1 
sont des marques commerciales de Sony 
Corporation.

ˎˎ Le logo et l’étiquette ExpressCard sont la 
propriété de Personal Computer Memory 
Card International Association (PCMCIA) 
et sont accordés sous licence à Sony 
Corporation. Toutes les autres marques 
commerciales et tous les autres noms 
commerciaux sont la propriété de leurs 
détenteurs respectifs.

[Remarque]
Utilisez les cartes mémoire SxS PRO X ou SxS PRO+ lors 
d’un enregistrement au format XAVC-I 3840×2160P.

Insertion des cartes mémoire SxS

1 Faites glisser le cache vers la gauche pour 
l’ouvrir.

2 Insérez une carte mémoire SxS dans un 
logement pour carte.

Logement A

Logement B

[Remarque]
Assurez-vous d’insérer la carte SxS dans le bon 
sens. Maintenez la carte avec la flèche indiquée sur 
un côté face à la direction indiquée sur la figure, 
puis insérez la carte.

L’indicateur ACCESS s’allume en orange, 
puis s’allume en vert pour indiquer que la 
carte mémoire est utilisable.

3 Fermez le cache.

Etat de l’indicateur ACCESS

Chacun des logements pour carte A et B 
dispose d’un indicateur ACCESS pour indiquer 
l’état du logement.

Indicateur d’accès au 
logement A

Indicateur d’accès au 
logement B

Indicateur Etat du logement

Allumé en 
orange

Accès à la carte mémoire SxS 
(s’allume pendant la lecture et 
l’écriture des données)

Allumé en 
vert

Veille (la carte mémoire SxS 
chargée est prête pour 
l’enregistrement ou la lecture)

Eteint Aucune carte mémoire SxS n’est 
chargée.
Une carte non utilisable est 
chargée.
Une carte mémoire SxS est 
chargée mais l’autre logement est 
sélectionné.

Ejection des cartes mémoire SxS

1 Ouvrez le cache, puis appuyez sur la 
touche EJECT pour déverrouiller et sortez 
la touche.

Appuyez une fois 
sur la touche pour 
déverrouiller.

2 Appuyez de nouveau sur la touche EJECT 
pour éjecter la carte.

[Remarque]
Lorsque vous appuyez sur la touche EJECT, prenez 
garde à ne pas entraver la sortie de la carte 
mémoire SxS. Si vous entravez la sortie de la carte 
mémoire SxS, le verrouillage risque de ne pas se 
débloquer.

[Remarque]
L’intégrité des données ne peut être garantie si vous 
mettez le caméscope hors tension ou retirez une carte 
mémoire lorsque la carte est en cours d’accès. Toutes 
les données enregistrées sur la carte peuvent être 
supprimées. Assurez-vous toujours que l’indicateur 
ACCESS est allumé en vert ou est éteint avant de mettre 
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le caméscope hors tension ou de retirer une carte 
mémoire.

Sélection de la carte mémoire SxS 
à utiliser

Lorsque des cartes mémoire SxS sont 
chargées en même temps dans le logement A 
et dans le logement B, vous pouvez appuyer 
sur la touche SLOT SELECT pour sélectionner la 
carte mémoire SxS à utiliser.
Lorsque la durée d’enregistrement restante 
sur la carte mémoire SxS utilisée pour 
l’enregistrement est inférieure à 60 secondes, 
l’indicateur de capacité restante du logement 
du support correspondant clignote sur l’écran 
du viseur pour indiquer que le caméscope 
basculera bientôt sur une autre carte mémoire 
SxS.
Le caméscope bascule ensuite 
automatiquement sur l’autre carte lorsque 
la carte sélectionnée atteint sa capacité 
maximum, et l’enregistrement se poursuit.

[Remarques]
ˎˎ La touche SLOT SELECT est désactivée pendant la 

lecture. Les cartes mémoire ne sont pas commutées 
même si vous appuyez sur la touche. Les opérations 
des touches sont activées lorsqu’un écran de 
miniatures (page 87) est affiché.
ˎˎ En mode 1-slot Simul Rec, il est possible que 

l’enregistrement ne puisse pas se poursuivre après 
avoir basculé entre les cartes si la nouvelle carte 
contient déjà 200 plans ou plus.

Formatage (initialisation) des 
cartes mémoire SxS

Quand une carte mémoire SxS non formatée 
ou une carte mémoire SxS formatée sous 

d’autres spécifications est insérée, un 
message vous notifiant que le support a un 
système de fichier différent s’affiche. Dans ce 
cas, formatez la carte mémoire de la manière 
suivante.
Les cartes mémoire SxS sont formatées en 
exFAT ou en FAT par défaut.

[Remarque]
Les cartes mémoire SxS doivent être formatées sur 
un dispositif XDCAM prenant en charge le système de 
fichiers exFAT ou UDF sur ce caméscope. Les cartes dans 
d’autres formats ne peuvent pas être utilisées.

1 Sélectionnez Operation >Format Media 
dans le menu de configuration.

2 Sélectionnez Media(A) (logement A) ou 
Media(B) (logement B).

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Un écran de confirmation vous proposant 
de formater la carte s’affiche.

4 Tournez le bouton MENU pour 
sélectionner [Execute] sur l’écran du 
message de confirmation, puis appuyez 
sur le bouton.
Le formatage commence.
Pendant le formatage, un message 
s’affiche et l’indicateur ACCESS est allumé 
en orange.
A la fin du formatage, un message 
d’achèvement apparaît. Appuyez sur le 
bouton MENU pour faire disparaître ce 
message.

En cas d’échec du formatage

Une opération de formatage peut échouer si 
la carte mémoire SxS est protégée en écriture 
ou si le type de carte ne correspond pas au 
type indiqué pour une utilisation avec ce 
caméscope.

Dans ce cas, un message d’erreur apparaît. 
Suivez les instructions du message d’erreur et 
remplacez la carte par une carte mémoire SxS 
pouvant être utilisée avec ce caméscope.

[Remarques]
ˎˎ Le formatage d’une carte mémoire efface toutes les 

données, y compris les données vidéo et les fichiers 
de configuration enregistrés. 
ˎˎ Utilisez la fonction de formatage de ce caméscope 

pour formater les cartes mémoire SxS à utiliser sur 
ce caméscope. Les formats des cartes formatées sur 
d’autres dispositifs ne sont pas reconnus comme 
des formats valides, obligeant ainsi un nouveau 
formatage de ces cartes sur ce caméscope.

Formatage pendant l’enregistrement

Même pendant l’enregistrement, la carte 
mémoire SxS chargée dans l’autre logement 
de carte peut être formatée.

[Remarques]
ˎˎ Le formatage n’est pas pris en charge pendant 

la fonction 1-slot Simul Rec ou lorsque l’écran de 
miniatures est affiché.
ˎˎ Pendant le formatage, l’enregistrement sur une carte 

mémoire SxS chargée dans l’autre logement de carte 
ne peut pas démarrer.

Vérification de la durée 
d’enregistrement restante

Vous pouvez vérifier la capacité restante des 
cartes mémoire SxS chargées dans les deux 
logements en vérifiant le témoin de capacité 
restante du support d’enregistrement dans le 
viseur.
La durée d’enregistrement restante est 
calculée à partir de la capacité restante 
du support dans chaque logement et 
du format de vidéo actuel (débit binaire 
d’enregistrement) et est affichée en minutes.

Vous pouvez vérifier la capacité restante sur 
un bargraphe en affichant l’écran Media Status 
(page 16).

[Remarque]
Un repère  apparaît lorsqu’une carte mémoire est 
protégée en écriture.

Quand remplacer les cartes mémoire 
SxS

ˎˎ Le message d’avertissement « Media Near 
Full » apparaît, l’indicateur WARNING et 
l’indication REC clignotent sur l’écran du 
viseur, et la sonnerie retentit lorsque la 
durée d’enregistrement totale restante des 
deux cartes mémoire passe à cinq minutes 
pendant l’enregistrement.  
Remplacez l’une des cartes par un 
support dont la capacité d’enregistrement 
disponible est suffisante.
ˎˎ Si vous continuez l’enregistrement, 
le message « Media Full » apparaît et 
l’enregistrement s’arrête lorsque la durée 
d’enregistrement totale restante passe à 0.

[Remarque]
Un maximum de 600 plans environ peut être enregistré 
sur une carte mémoire SxS.
L’affichage de la durée d’enregistrement restante passe 
à « 0 » et le message « Media Full » apparaît lorsque la 
limite de plans est atteinte.

Restauration des cartes mémoire 
SxS

Si, pour quelque raison que ce soit, une erreur 
se produit dans la carte mémoire, celle-ci doit 
être restaurée avant l’utilisation.
Lorsque vous chargez une carte mémoire SxS 
devant être restaurée, un message apparaît 
dans le viseur pour vous demander si vous 
souhaitez effectuer la restauration.
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Pour effectuer la restauration, tournez le 
bouton MENU pour sélectionner [Execute] puis 
appuyez sur le bouton.
La restauration démarre.
Pendant la restauration, un message s’affiche 
et l’indicateur ACCESS est allumé en orange.
A la fin de la restauration, un message 
d’achèvement apparaît. Appuyez sur le bouton 
MENU pour faire disparaître ce message.

Si la restauration échoue

ˎˎ Les cartes mémoire SxS protégées en 
écriture et les cartes sur lesquelles des 
erreurs de mémoire se sont produites ne 
peuvent pas être restaurées. Un message 
d’avertissement apparaît pour de telles 
cartes. Suivez les instructions du message 
et désactivez la protection de la carte ou 
remplacez-la par une autre carte.
ˎˎ Les cartes mémoire SxS sur lesquelles 
des erreurs de mémoire se sont produites 
peuvent être inutilisables si vous les 
reformatez.
ˎˎ Dans certains cas, certains plans peuvent 
être restaurés et d’autres non. Les plans 
restaurés peuvent être lus normalement.
ˎˎ Si le message « Could not Restore Some 
Clips » continue à apparaître après plusieurs 
tentatives de restauration, il peut être 
possible de restaurer la carte mémoire SxS à 
l’aide de la procédure suivante.
[1] Utilisez le logiciel d’application 

(page 184) pour copier les plans requis 
sur une autre carte mémoire SxS.

[2] Formatez la carte mémoire SxS 
inutilisable sur le caméscope.

[3] Copiez de nouveau les plans requis sur 
la carte mémoire SxS venant d’être 
formatée.

[Remarque]
Pour la restauration du support enregistré sur ce 
caméscope, assurez-vous d’utiliser ce caméscope. 
Il se peut qu’un support enregistré avec un dispositif 
autre que ce caméscope ou avec un autre caméscope 
d’une version différente (même du même modèle) ne 
soit pas restauré à l’aide de ce caméscope.
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Manipulation des cartes SD pour sauvegarde des données de configuration
Les cartes SD suivantes peuvent être 
utilisée pour enregistrer des données de 
configuration.

Cartes mémoire SDHC* (classe de vitesse : 4 ou 
plus, non UHS, capacité : 4 Go à 32 Go)
* Désignées sous le nom de « Cartes SD » dans ce 

manuel.

Formatage (initialisation) des 
cartes SD

Les cartes SD doivent être formatées lors de 
leur première utilisation dans le caméscope.
Les cartes SD devant être utilisées dans le 
caméscope doivent être formatées à l’aide 
de la fonction de formatage du caméscope. 
Si un message s’affiche quand la carte SD est 
insérée dans le caméscope, formatez la carte 
SD.

1 Sélectionnez Operation >Format Media 
>SD Card(Utility) dans le menu de 
configuration.
Un écran de confirmation vous proposant 
de formater la carte s’affiche.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Le formatage commence.
Pendant le formatage, un message 
s’affiche et l’indicateur ACCESS est allumé 
en orange.
A la fin du formatage, un message 
d’achèvement apparaît. Appuyez sur le 
bouton MENU pour faire disparaître ce 
message.

[Remarque]
Le formatage d’une carte SD efface toutes les données 
sur la carte. La carte ne peut pas être restaurée.

Vérification de la capacité restante

Vous pouvez vérifier la capacité restante 
sur une carte SD sur l’écran Media Status 
(page 16).
Pour utiliser une carte SD formatée sur le 
caméscope dans la fente d’un autre dispositif, 
effectuez une copie de sauvegarde de la carte, 
puis reformatez la carte dans le dispositif à 
utiliser.
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Utilisation d’un adaptateur de support
[Remarques]
ˎˎ Pour les applications professionnelles, l’utilisation 

d’autres supports ne fournit pas la même fiabilité et 
durabilité élevées que celles obtenues avec les cartes 
mémoire SxS.
ˎˎ Le fonctionnement de toutes les cartes mémoire n’est 

pas garanti avec ce caméscope. Pour plus de détails 
sur les cartes mémoire compatibles, veuillez contacter 
votre revendeur Sony.

Cartes SD

En utilisant un adaptateur de support MEAD-
SD02 optionnel, vous pouvez insérer une carte 
SD dans un logement de carte mémoire SxS et 
l’utiliser pour l’enregistrement et la lecture.

[Remarque]
Si une carte SD et un autre support sont insérés dans 
leurs logements de carte mémoire respectifs, seul le 
premier support inséré est reconnu et le dernier support 
inséré n’est pas reconnu.

Les cartes SD suivantes sont prises en charge.
Cartes mémoire SDXC (classe de vitesse SD : 
classe 10) 1)

Cartes mémoire SDHC (classe de vitesse SD : 
classe 10) 2)

1) Pris en charge si le système de fichiers est exFAT.
2) Pris en charge si le système de fichiers est FAT.

Pour de plus amples informations concernant l’adaptateur 
de support MEAD-SD02, reportez-vous au mode d’emploi 
fourni avec l’adaptateur.

[Remarques]
ˎˎ La lecture accélérée peut ne pas être effectuée 

correctement avec une carte SD.
ˎˎ La lecture sans interruption sur plusieurs plans n’est 

pas prise en charge.
ˎˎ L’enregistrement et la lecture à l’aide de cartes SD 

ne sont pas pris en charge lors de la prise de vue en 
format XAVC-I ou XAVC-L 3840×2160P.
ˎˎ L’enregistrement ralenti à l’aide de la fonction 

d’enregistrement Slow & Quick Motion ne peut pas 
être utilisé avec une carte SDXC.

Formatage (initialisation)

Les cartes SD doivent être formatées lors de 
leur première utilisation dans le caméscope.
Les cartes SD devant être utilisées dans le 
caméscope doivent être formatées à l’aide de 
la fonction de formatage du caméscope. Si un 
message s’affiche quand la carte SD est insérée 
dans le caméscope, formatez la carte SD.
Quand une carte SD non formatée ou une 
carte SD formatée sous d’autres spécifications 
est insérée, un message demandant la 
confirmation de formatage du support ou un 
message vous notifiant que le support a un 
système de fichier différent s’affiche.
Formatez la carte en utilisant la procédure 
suivante.

1 Sélectionnez Operation >Format Media 
dans le menu de configuration.

2 Sélectionnez Media(A) (logement A) ou 
Media(B) (logement B).

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Un écran de confirmation vous proposant 
de formater la carte s’affiche.

4 Tournez le bouton MENU pour 
sélectionner [Execute] sur l’écran du 
message de confirmation, puis appuyez 
sur le bouton.
Le formatage commence.
Pendant le formatage, un message 
s’affiche et l’indicateur ACCESS est allumé 
en orange.
A la fin du formatage, un message 
d’achèvement apparaît. Appuyez sur le 
bouton MENU pour faire disparaître ce 
message.

[Remarque]
Le formatage d’une carte SD efface toutes les données 
sur la carte, y compris la vidéo protégée. Les données ne 
peuvent pas être restaurées.

Connexion entre le caméscope et un 
ordinateur

Insérez la carte SD enregistrée dans un 
logement du caméscope et connectez le 
caméscope sur un ordinateur à l’aide d’un 
câble USB.

Pour utiliser une carte mémoire 
formatée sur le caméscope dans la fente 
d’un autre dispositif

Effectuez d’abord une copie de sauvegarde 
de la carte, puis reformatez la carte dans le 
dispositif à utiliser.
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Réglages du format
3. Réglages et ajustements

Vous pouvez configurer le système de fichiers, 
la fréquence de système et le format vidéo en 
utilisant Operation >Format dans le menu de 
configuration.

Pour plus de détails sur le fonctionnement des 
menus, consultez « Opérations de base du menu de 
configuration » (page 96).

Sélection du système de fichiers

Vous pouvez sélectionner le système de 
fichiers.

1 Sélectionnez Operation >Format >File 
System dans le menu de configuration.

2 Tournez le bouton MENU pour 
sélectionner un système de fichiers, puis 
appuyez sur le bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Sélectionnez [Execute] pour exécuter ou 
[Cancel] pour annuler puis appuyez sur le 
bouton MENU.
Le caméscope redémarrera 
automatiquement après avoir effectué 
[Execute].

[Remarque]
Le système de fichiers ne peut pas être modifié pendant 
l’enregistrement/la lecture ou pendant l’affichage de 
l’écran de miniatures.

Commutation de la fréquence de 
système

Vous pouvez commuter la fréquence de 
système selon les besoins.

[Remarques]
ˎˎ La fréquence de système ne peut pas être modifiée 

pendant l’enregistrement/la lecture ou pendant 
l’affichage de l’écran de miniatures.
ˎˎ Après avoir commuté entre 29.97 et 59.94 ou 

entre 25 et 50, le caméscope ne redémarre pas 
automatiquement.
ˎˎ La commutation de la fréquence de système 

passe automatiquement le format vidéo au format 
précédemment utilisé à cette fréquence.

1 Sélectionnez Operation >Format 
>Frequency dans le menu de configuration.

2 Tournez le bouton MENU pour 
sélectionner la fréquence de système et 
appuyez sur le bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Sélectionnez [Execute] pour exécuter ou 
[Cancel] pour annuler puis appuyez sur le 
bouton MENU.
Le caméscope redémarrera automatiquement 
après avoir effectué [Execute].

Commutation du format vidéo

Reportez-vous à « Formats vidéo » 
(page 35) selon le besoin lors de la 
commutation du format vidéo.

1 Sélectionnez Operation >Format >Rec 
Format dans le menu de configuration.

2 Tournez le bouton MENU pour modifier le 
format vidéo et appuyez sur le bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Sélectionnez [Execute] pour exécuter ou 
[Cancel] pour annuler puis appuyez sur le 
bouton MENU.

Formats vidéo

Les formats d’enregistrement suivants peuvent être sélectionnés pour différentes combinaisons 
de résolution vidéo et de fréquence de système.

Fréquence du système 
(Operation >Format 
>Frequency dans le menu 
de configuration)

Système de fichiers 
(Operation >Format 
>File System dans le 
menu de configuration)

Format vidéo 
(Operation >Format >Rec 
Format dans le menu de 
configuration)

Taille d’image

exFAT UDF FAT

59.94/50 Oui – – XAVC-I 3840×2160P 3840×2160

Oui – – XAVC-I 1920×1080P 1920×1080

Oui – – XAVC-I 1920×1080i

Oui – – XAVC-L200 2160P 3840×2160

Oui – – XAVC-L 3840×2160P

Oui – – XAVC-L 50 1920×1080P 1920×1080

Oui – – XAVC-L 50 1920×1080i

Oui – – XAVC-L 35 1080P

Oui – – XAVC-L 35 1080i

Oui – – XAVC-L 25 1080i

Oui Oui – HD422 50 1080i 1920×1080

Oui Oui – HD422 50 720P 1280×720

Oui Oui Oui HQ 1920×1080i 1920×1080

Oui Oui Oui HQ 1440×1080i 1440×1080

Oui Oui Oui HQ 1280×720P 1280×720

– – Oui SP 1440×1080i 1440×1080

29.97/25/23.98 Oui – – XAVC-I 3840×2160P 3840×2160

Oui – – XAVC-I 1920×1080P 1920×1080

Oui – – XAVC-L 3840×2160P 3840×2160

Oui – – XAVC-L 50 1920×1080P 1920×1080

Oui – – XAVC-L 35 1080P

Oui Oui – HD422 50 1080P 1920×1080

Oui Oui – HD422 50 720P 1280×720

Oui Oui Oui HQ 1920×1080P 1920×1080
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Formats de sortie des connecteurs SDI OUT et HDMI Output

Les signaux pouvant être émis depuis le connecteur SDI OUT et le connecteur de sortie HDMI sont affichés dans le tableau suivant, en fonction du réglage Operation >Format dans le menu de 
configuration.
Les valeurs par défaut sont soulignées et le texte est en gras.

[Remarques]
ˎˎ Les restrictions suivantes s’appliquent lors de l’utilisation de l’enregistrement proxy XAVC (« enregistrement proxy » dans le tableau suivant), lors de l’utilisation de la fonction réseau ou lorsque la fonction XAVC Proxy Rec Start est attribuée 

à un commutateur attribuable.
ˎˋ Vous ne pouvez pas sélectionner le réglage de format de sortie 3840×2160P SDI lorsque vous enregistrez en 3840×2160P.

ˎˎ Si l’enregistrement proxy ou les fonctions réseau sont activés lors de l’utilisation du réglage de format de sortie 3840×2160P SDI, le réglage de sortie SDI passe à 1920×1080P (Level B) (59.94/50) ou 1920×1080PsF (29.97/23.98/25).

Operation >Format (codec 
omis) dans le menu de 
configuration

Format de sortie SDI sélectionnable Operation >Input/Output >Output Format dans le menu de configuration

Lorsque l’enregistrement proxy 
et les fonctions réseau sont 
désactivés

Lorsque l’enregistrement proxy 
ou la fonction réseau est activé

SDI Out1 Output SDI Out2 Output HDMI Output

59.94 3840×2160P Oui Non 3840×2160P 12G 3840×2160P 12G 3840×2160P

Oui Non 3840×2160P 12G 1920×1080P (Level A) 3840×2160P

Oui Oui 1920×1080P (Level A) 1920×1080P (Level A) 1920×1080P

Oui Oui 1920×1080P (Level B) 1920×1080P (Level B) –

Oui Oui 1920×1080i 1920×1080i 1920×1080i

1920×1080P Oui Oui 1920×1080P (Level A) 1920×1080P (Level A) 1920×1080P

Oui Oui 1920×1080P (Level B) 1920×1080P (Level B) –

Oui Oui 1920×1080i 1920×1080i 1920×1080i

1920×1080i Oui Oui 1920×1080i 1920×1080i 1920×1080i

1440×1080i Oui Oui 1920×1080i 1920×1080i 1920×1080i

1280×720P Oui Oui 1280×720P 1280×720P 1280×720P

29.97 3840×2160P Oui Non 3840×2160P 6G 3840×2160P 6G 3840×2160P

Oui Non 3840×2160P 3G Link1 3840×2160P 3G Link2 3840×2160P

Oui Oui 1920×1080PsF 1920×1080PsF 1920×1080i

1920×1080P Oui Oui 1920×1080PsF 1920×1080PsF 1920×1080i

1280×720P Oui Oui 1280×720P 1280×720P 1280×720P

23.98 3840×2160P Oui Non 3840×2160P 6G 3840×2160P 6G 3840×2160P

Oui Non 3840×2160P 3G Link1 3840×2160P 3G Link2 3840×2160P

Oui Oui 1920×1080PsF 1920×1080PsF –

Oui Oui 1920×1080i(2-3PD) 1920×1080i(2-3PD) 1920×1080i(2-3PD)

1920×1080P Oui Oui 1920×1080PsF 1920×1080PsF –

Oui Oui 1920×1080i(2-3PD) 1920×1080i(2-3PD) 1920×1080i(2-3PD)

1280×720P Oui Oui 1280×720P(2-3PD) 1280×720P(2-3PD) 1280×720P(2-3PD)
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Operation >Format (codec 
omis) dans le menu de 
configuration

Format de sortie SDI sélectionnable Operation >Input/Output >Output Format dans le menu de configuration

Lorsque l’enregistrement proxy 
et les fonctions réseau sont 
désactivés

Lorsque l’enregistrement proxy 
ou la fonction réseau est activé

SDI Out1 Output SDI Out2 Output HDMI Output

50 3840×2160P Oui Non 3840×2160P 12G 3840×2160P 12G 3840×2160P

Oui Non 3840×2160P 12G 1920×1080P (Level A) 3840×2160P

Oui Oui 1920×1080P (Level A) 1920×1080P (Level A) 1920×1080P

Oui Oui 1920×1080P (Level B) 1920×1080P (Level B) –

Oui Oui 1920×1080i 1920×1080i 1920×1080i

1920×1080P Oui Oui 1920×1080P (Level A) 1920×1080P (Level A) 1920×1080P

Oui Oui 1920×1080P (Level B) 1920×1080P (Level B) –

Oui Oui 1920×1080i 1920×1080i 1920×1080i

1920×1080i Oui Oui 1920×1080i 1920×1080i 1920×1080i

1440×1080i Oui Oui 1920×1080i 1920×1080i 1920×1080i

1280×720P Oui Oui 1280×720P 1280×720P 1280×720P

25 3840×2160P Oui Non 3840×2160P 6G 3840×2160P 6G 3840×2160P

Oui Non 3840×2160P 3G Link1 3840×2160P 3G Link2 3840×2160P

Oui Oui 1920×1080PsF 1920×1080PsF 1920×1080i

1920×1080P Oui Oui 1920×1080PsF 1920×1080PsF 1920×1080i

1280×720P Oui Oui 1280×720P 1280×720P 1280×720P
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Extension de la plage dynamique d’imagerie
Vous pouvez régler la plage dynamique 
d’imagerie sur le mode High Dynamic Range 
(HDR) pour enregistrer et envoyer des images 
avec un espace de couleurs équivalent à 
BT.2020 et une plage dynamique augmentée 
lorsque le format d’enregistrement est 4K 
QFHD ou HD.
Lorsque cette fonction est utilisée 
conjointement avec la fonction 1-slot Simul 
Rec, vous pouvez enregistrer un plan principal 
4K QFHD en plage dynamique élevée et un 
sous-plan HD en plage dynamique standard 
(SDR).
La fonction High Dynamic Range n’est 
disponible que si le système de fichiers est 
exFAT.

[Remarque]
Modifiez le réglage de mode de plage dynamique avec 
la fonction Picture Cache Rec réglée sur Off. 
Operation >Rec Function >Picture Cache Rec >Off

Réglage de la plage dynamique

1 Sélectionnez Operation >Base Setting 
>Shooting Mode dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner le mode de plage 
dynamique.
Sélectionnez HDR pour régler sur High 
Dynamic Range ou SDR pour utiliser la 
plage dynamique standard.

Réglages HDR

Lorsque vous sélectionnez HDR pour le mode 
de plage dynamique, configurez les réglages 
HDR avec Operation >HDR Setting dans le 
menu de configuration. Pour les détails, 
consultez page 102.

HDR(HLG)

HDR(HLG) peut être réglé pour 4K (QFHD) et 
HD.
Lorsque le mode High Dynamic Range est 
réglé sur HDR(HLG), l’espace de couleurs 
est réglé sur ITU-R BT.2020. Vous pouvez 
également spécifier le type de HLG en 
utilisant HLG Look. Pour les détails, consultez 
« HLG Look » (page 112).

HDR(S-Log3)

HDR(S-Log3) peut être réglé pour 4K (QFHD) 
et HD.
Lorsque le mode High Dynamic Range est 
réglé sur HDR(S-Log3), l’espace de couleurs 
peut être réglé sur ITU-R BT.2020 ou 
S-Gamut3/S-Gamut3.Cine. Pour les détails, 
consultez « HDR Setting » (page 102).

SDR Gain

Lorsque le réglage HD Rec/Out est SDR, cela 
règle le gain HD-SDR par rapport à la valeur 
4K(QHFD)-HDR. Ce réglage s’applique à 
l’enregistrement/la sortie HD-SDR, l’affichage 
du viseur et le moniteur LCD.

Fonction d’aide pour l’affichage gamma

Lorsque la fonction HDR est utilisée, le 
contraste de la vidéo affichée sur le viseur 
et sur le moniteur LCD est plus bas que 
lorsqu’une plage dynamique conventionnelle 
est utilisée, rendant l’image plus difficile à voir. 
Dans ce cas, vous pouvez régler le contraste 
de l’image affichée dans le viseur et sur le 
moniteur LCD sur un niveau approprié en 
utilisant la fonction d’aide pour l’affichage 
gamma.
La fonction d’aide pour l’affichage gamma 
s’applique automatiquement lorsque vous 
réglez HDR Setting >HD Rec/Out sur HDR(HLG) 
ou HLG(S-Log3).

Vous pouvez également affecter la 
fonction d’aide pour l’affichage gamma à 
un commutateur attribuable puis activer/
désactiver la fonction d’une simple pression 
de bouton quand cela est nécessaire.

[Remarque]
Cette fonction est appliquée à l’image du viseur et 
du moniteur LCD. Elle n’est pas appliquée à l’image 
enregistrée ou à l’image de sortie.
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Ajustement de l’équilibre des noirs et de l’équilibre des blancs
Pour obtenir une qualité d’image excellente 
dans toutes les conditions d’utilisation de ce 
caméscope, il peut se révéler nécessaire dans 
certains cas d’ajuster l’équilibre des noirs et 
l’équilibre des blancs.
Les valeurs d’ajustement de l’équilibre 
des noirs et de l’équilibre des blancs 
automatiquement définies par le caméscope 
et les différents réglages sont stockés dans 
la mémoire du caméscope, et sont conservés 
même si celui-ci est mis hors tension.

Ajustement de l’équilibre des 
noirs

L’équilibre des noirs doit être ajusté dans les 
cas suivants.
ˎˎ Lorsque le caméscope est utilisé pour la 
première fois
ˎˎ Si le caméscope n’a pas été utilisé depuis 
longtemps
ˎˎ Si le caméscope est utilisé dans des 
conditions avec de fortes variations de 
température ambiante
ˎˎ Lorsque les valeurs du sélecteur GAIN 
(L/M/H/Turbo) ont été modifiées à l’aide de 
Operation >Gain Switch dans le menu de 
configuration.

Il n’est généralement pas nécessaire d’ajuster 
l’équilibre des noirs lors de l’utilisation du 
caméscope après une mise hors tension.

En mode d’ajustement automatique de 
l’équilibre des noirs, les ajustements 
s’effectuent dans l’ordre suivant : palier 
de noir et équilibre des noirs. L’ajustement 
manuel de l’équilibre des noirs peut être 
sélectionné à partir du menu de configuration.

L’ajustement automatique de l’équilibre des 
noirs est désactivé dans les cas suivants.

ˎˎ Pendant l’enregistrement
ˎˎ Pendant les modes d’enregistrement 
spéciaux
ˎˎ Lorsque le mode d’obturation est SLS

1 Réglez le commutateur OUTPUT/DCC sur 
CAM.

2 Placez le commutateur AUTO W/B BAL sur 
BLACK et relâchez-le.
Le message « Executing… » apparaît 
pendant l’exécution et passe à « OK » 
lorsque l’ajustement est terminé.
Les valeurs d’ajustement sont 
automatiquement sauvegardées en 
mémoire.

[Remarques]
ˎˎ Pendant l’ajustement de l’équilibre des noirs, le 

diaphragme est automatiquement fermé.
ˎˎ Pendant l’ajustement de l’équilibre des noirs, le circuit 

de sélection du gain est automatiquement activé et 
par conséquent, le scintillement qui peut en résulter 
sur l’écran du viseur n’est pas une anomalie.

Si l’ajustement automatique de 
l’équilibre des noirs est impossible

Si l’ajustement de l’équilibre des noirs ne peut 
pas être achevé normalement, un message 
d’erreur apparaît pendant trois secondes 
environ sur l’écran du viseur.

Message d’erreur Signification

NG: Iris not Closed Le diaphragme de 
l’objectif n’est pas fermé; 
l’ajustement est 
impossible.

NG: Timeout L’ajustement n’a pas pu 
être terminé dans les 
limites du nombre 
standard de tentatives.

Si l’un des messages d’erreur ci-dessus est 
affiché, essayez à nouveau d’ajuster l’équilibre 
des noirs.

Si le message d’erreur s’affiche encore, une 
vérification interne est nécessaire.

Pour des informations sur cette vérification interne, 
reportez-vous au Manuel de maintenance (option).

[Remarque]
Si le câble d’objectif n’est pas fermement raccordé au 
connecteur LENS, il peut être impossible d’ajuster le 
diaphragme de l’objectif. Dans ce cas, l’équilibre des 
noirs sera incorrect.

Ajustement de l’équilibre des 
blancs

Ajustez toujours l’équilibre des blancs lorsque 
les conditions d’éclairage ont changé.

1 Réglez les commutateurs et sélecteurs 
comme indiqué ci-dessous.
ˎˎ Commutateur GAIN : L (réglé sur une 
valeur de gain aussi petite que possible)
ˎˎ Commutateur OUTPUT/DCC : CAM
ˎˎ Commutateur WHITE BAL : A ou B 1)

1) Les valeurs d’ajustement sont enregistrées dans 
la mémoire B uniquement lorsque Operation 
>White Setting >White Switch<B> dans le menu 
de configuration est réglé sur Memory.

2 Réglez le bouton FILTER en fonction des 
conditions d’éclairage comme suit.

3 Placez une carte d’essai blanche dans les 
mêmes conditions d’éclairage que le sujet 
à filmer et faites un zoom avant.
Vous pouvez également utiliser n’importe 
quel objet blanc, comme un tissu ou un 
mur.
La surface blanche minimale est la 
suivante.

Rectangle centré sur l’écran
Les longueurs des côtés sont égales à 
70 % de la longueur et de la largeur de 
l’écran. 10 % ou plus de la surface de 
l’image située dans le rectangle doit être 
de couleur blanche.

[Remarque]
Veillez à ce qu’il n’y ait pas de points brillants dans 
le rectangle.

4 Ajustez le diaphragme de l’objectif.
Diaphragme ajusté manuellement : réglez 

le diaphragme sur une valeur 
appropriée.

Diaphragme ajusté à l’aide du 
diaphragme automatique : réglez 
l’interrupteur automatique/manuel de 
l’objectif sur automatique.

5 Placez le commutateur AUTO W/B BAL sur 
WHITE et relâchez-le.
Le message « Executing… » apparaît 
pendant l’exécution et passe à « OK: 
(température de couleur du sujet) » 
lorsque l’ajustement est terminé.
Les valeurs d’ajustement sont 
sauvegardées automatiquement dans la 
mémoire sélectionnée à l’étape 1 (A ou B).

[Remarque]
Le diaphragme peut varier de manière incontrôlée 

1) pendant l’ajustement. Pour éviter cela, ajustez le 
bouton de gain du diaphragme (indiqué par IG, IS 
ou S) sur l’objectif.

1) Variation incontrôlée du diaphragme : 
éclaircissements et assombrissements successifs 
de l’image dus aux réactions répétées du 
contrôle automatique de diaphragme.
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Pour plus de détails, reportez-vous au manuel 
d’utilisation de l’objectif.

Si l’ajustement automatique de 
l’équilibre des blancs est impossible

Si l’ajustement de l’équilibre des blancs 
ne peut pas être achevé normalement, un 
message d’erreur apparaît pendant trois 
secondes environ sur l’écran du viseur.

Message d’erreur Signification

NG: Low Light Le niveau vidéo blanc est 
trop bas. Ouvrez le 
diaphragme de l’objectif ou 
augmentez le gain.

NG: High Light Le niveau vidéo blanc est 
trop élevé. Réduisez 
l’ouverture du diaphragme 
de l’objectif ou changez le 
filtre ND.

NG: Color Temp. 
High

La température de couleur 
de l’éclairage du sujet est 
trop élevée et n’a pas pu 
être ajustée. Ajustez la 
température de couleur de 
l’éclairage puis mettez à jour 
la mémoire.

NG: Color Temp. 
Low

La température de couleur 
de l’éclairage du sujet est 
trop faible et n’a pas pu être 
ajustée. Ajustez la 
température de couleur de 
l’éclairage puis mettez à jour 
la mémoire.

NG: Out of Range La valeur n’a pas pu être 
ajustée parce que la 
différence entre la valeur 
actuelle et la valeur de 
référence dépasse la plage 
d’ajustement.

NG: Poor White 
Area

La surface blanche du sujet 
est trop étroite et n’a pas pu 
être ajustée.

Message d’erreur Signification

NG: Timeout L’ajustement n’a pas pu être 
terminé dans le temps 
spécifié.

Si l’un des messages d’erreur ci-dessus est 
affiché, essayez à nouveau d’ajuster l’équilibre 
des blancs. Si le message d’erreur s’affiche 
encore, une vérification interne est nécessaire.

Pour des informations sur cette vérification interne, 
reportez-vous au Manuel de maintenance.

Si vous n’avez pas le temps d’ajuster 
l’équilibre des blancs

Réglez le commutateur WHITE BAL sur PRST.

Modification de la température de 
couleur lors du basculement des filtres 
ND

Vous pouvez attribuer des filtres CC 
électriques (correction de couleur) aux 
filtres ND (page 5), ce qui vous permet 
de changer de température de couleur 
automatiquement lorsque le filtre ND est 
modifié.

1 Réglez Maintenance >White Filter >ND 
Filter C.Temp sur On dans le menu de 
configuration (page 123).

2 Pour attribuer un filtre CC électrique à la 
position numéro 1 du bouton FILTER, 
sélectionnez [ND FLT C.Temp<1>]. Pour 
l’attribuer aux positions 2 à 4, sélectionnez 
[ND FLT C.Temp<2-4>].

3 Tournez le bouton MENU pour 
sélectionner la température de couleur 
souhaitée.

4 Répétez les étapes 2 et 3 selon le besoin.

Basculement entre les filtres CC 
électriques avec un commutateur 
personnalisable

Vous pouvez attribuer la fonction de 
basculement entre les filtres CC électriques à 
un commutateur personnalisable. Cela vous 
permet de basculer entre les températures 
de couleur (3200K/4300K/5600K/6300K), 
ayant été attribuées à quatre positions (A à D) 
maximum à chaque fois que vous appuyez sur 
le commutateur personnalisable.

1 Sélectionnez Maintenance >White Filter 
dans le menu de configuration.

2 Sélectionnez la position pour l’attribution 
du filtre CC en choisissant parmi [Electrical 
CC<A>] à [Electrical CC <D>], puis tournez 
le bouton MENU pour sélectionner la 
température de couleur souhaitée.
Sélectionnez « ----- » avec Electrical CC 
<C> ou <D> sélectionné.
Lorsque vous appuyez sur le 
commutateur personnalisable, le réglage 
pour cette position n’est pas affiché. Par 
exemple, si « ----- » est réglé pour une 
position, alors le basculement s’exécute 
entre les trois positions restantes.

3 Répétez l’étape 2 selon le besoin.

4 Attribuez la fonction de basculement des 
filtres CC électriques (ELECTRICAL CC) à un 
commutateur personnalisable 
(page 135).

Mémoire de l’équilibre des blancs

Les valeurs stockées dans la mémoire sont 
conservées jusqu’au prochain ajustement de 
l’équilibre des blancs, même si le caméscope 
est hors tension.

Le caméscope possède deux mémoires de 
l’équilibre des blancs, A et B. Vous pouvez 
sauvegarder automatiquement les valeurs 
d’ajustement pour chaque filtre ND dans 
la mémoire correspondant au réglage 
du commutateur WHITE BAL (A ou B). Le 
caméscope possède quatre filtres ND intégrés 
vous permettant de sauvegarder un total de 
huit valeurs d’ajustement (4×2). Cependant, le 
contenu des mémoires n’est pas associé aux 
réglages des filtres ND dans le cas suivant.
ˎˎ Lorsque le nombre de mémoires attribuées 
à A et à B est limité à un en réglant 
l’élément Operation >White Setting 
>Filter White Memory dans le menu de 
configuration sur Off.

De plus, lorsque l’élément Operation >White 
Setting >White Switch<B> dans le menu de 
configuration est réglé sur [ATW (Auto Tracing 
White Balance)], et le commutateur WHITE BAL 
est réglé sur B, la fonction ATW est activée 
pour ajuster automatiquement l’équilibre 
des blancs de l’image filmée en fonction des 
variations des conditions d’éclairage.
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Réglage de l’obturateur électronique

Modes d’obturation

Les modes d’obturation utilisables avec 
l’obturateur électronique et les vitesses 
d’obturation sélectionnables sont énumérés 
ci-dessous.

[Remarque]
Lorsqu’une unité de télécommande, comme la RM-B170, 
est connectée, seul le mode standard (Speed) peut être 
sélectionné.

Mode standard

Sélectionnez ce mode pour la prise de vue de 
sujets en mouvement rapide avec peu de flou.
Vous pouvez régler la vitesse d’obturation 
dans un des deux modes d’obturation : mode 
vitesse, dans lequel la vitesse est réglée en 
secondes, et mode angle, dans lequel la 
vitesse est réglée en degrés.

Mode vitesse

Fréquence 
de système

Vitesse d’obturation (unité : 
secondes)

59.94i 
59.94P
50i
50P

1/60, 1/100, 1/120, 1/125, 1/250, 
1/500, 1/1000, 1/2000

29.97P 1/40 a), 1/50 a), 1/60, 1/100, 1/120, 
1/125, 1/250, 1/500, 1/1000, 1/2000

25P 1/33 a), 1/50 a), 1/60, 1/100, 1/120, 
1/125, 1/250, 1/500, 1/1000, 1/2000

23.98P 1/32 a), 1/48 a), 1/50 a), 1/60, 1/96, 
1/100, 1/120, 1/125, 1/250, 1/500, 
1/1000, 1/2000

a) Cette vitesse ne peut pas être sélectionnée lorsque le 
caméscope est en mode ralenti et accéléré et lorsque 
l’élément Operation >Rec Function >Frame Rate 
du menu de configuration est réglé sur une valeur 
supérieure à la fréquence de système.

Mode angle
180°, 90°, 45°, 22,5°, 11,25°

Mode ECS (Extended Clear Scan)

Sélectionnez ce mode pour obtenir des 
images sans bandes horizontales parasites 
lors de la prise de vue de sujets tels que des 
écrans de moniteur.
Comme indiqué dans les tableaux suivants, la 
plage des vitesses d’obturation pouvant être 
réglées varie selon l’activation ou non de la 
fonction ralenti et accéléré (S&Q).

Fréquence 
de système

Vitesse d’obturation (unité : Hz)

S&Q : Off S&Q : On

59.94i 60,00 à 7000 –

59.94P 60,00 à 8000 60,00 à 8000

29.97P 30,00 à 8000 30,00 à 8000

23.98P 23,99 à 6000 30,03 à 6000

50i 50,00 à 7000 –

50P 50,00 à 7000 50,00 à 7000

25P 25,02 à 7000 30,00 à 7000

Mode SLS (obturation à vitesse lente)

Ce mode est utilisé pour filmer des sujets dans 
des conditions d’éclairage faible. Le nombre 
d’images cumulées pris à l’aide de la fonction 
d’obturation lente peut être réglée sur 2, 3, 4, 
5, 6, 7, 8, 16 dans l’élément Operation >Slow 
Shutter >Number of Frames dans le menu de 
configuration.

[Remarques]
ˎˎ Le mode SLS ne peut pas être utilisé lorsque le 

caméscope est en mode ralenti et accéléré.
ˎˎ Il n’est pas possible d’activer ou de désactiver le 

mode SLS ou de modifier le nombre d’images 
cumulées lors de l’enregistrement.

Réglage du mode et de la vitesse 
d’obturation

[Remarques]
ˎˎ Quand le diaphragme automatique est utilisé, il 

s’ouvre de plus en plus au fur et à mesure que la 
vitesse d’obturation augmente, réduisant ainsi la 
profondeur de champ.
ˎˎ Les vitesses d’obturation sélectionnables varient en 

fonction de la fréquence de système utilisée.

Basculement entre le mode vitesse et le 
mode angle

1 Sélectionnez Operation >Shutter >Mode 
dans le menu de configuration.

2 Tournez le bouton MENU pour 
sélectionner [Speed] ou [Angle] puis 
appuyez sur le bouton.

Réglage du mode et de la vitesse 
d’obturation (mode standard)

Une fois la vitesse d’obturation sélectionnée, 
elle est conservée en mémoire même si le 
caméscope est mis hors tension.

1 Basculez le commutateur SHUTTER de ON 
à SELECT.
L’indication du réglage d’obturation actuel 
apparaît dans le viseur pendant trois 
secondes environ.

2 Avant que le réglage d’obturation à l’étape 
1 ne disparaisse, abaissez à nouveau le 
commutateur SHUTTER et placez-le sur 
SELECT. Répétez cette étape jusqu’à ce que 
la vitesse ou le mode souhaité apparaisse.
Lorsque tous les modes et toutes les 
vitesses sont affichés, l’affichage change 
dans l’ordre suivant.

Mode vitesse (avec une fréquence de 
système de 59.94i)

Mode ECS

[Remarque]
En fonction du réglage de fréquence d’images 
(page 52), certaines vitesses d’obturation ne peuvent 
être sélectionnées en mode ralenti et accéléré. Ces 
vitesses sont remplacées par la vitesse d’obturation la 
plus lente possible.

Exemple lorsque vous filmez en XAVC-I 
1080P/29.97P, à une fréquence d’images de 
60, et Slow & Quick Motion :
ˎˎ Mode Slow & Quick Motion : Off 
1/401/501/601/100…
ˎˎ Mode Slow & Quick Motion : On 
1/601/100…

Réglage de la vitesse d’obturation 
(mode ECS)

1 Réglez le mode de vitesse d’obturation 
sur ECS (consultez le paragraphe 
précédent).

2 Tournez le bouton MENU pour 
sélectionner la fréquence ou le nombre 
d’images souhaité.

Réglage de la vitesse d’obturation 
(mode SLS)

1 Sélectionnez Operation >Slow Shutter 
>Setting dans le menu de configuration et 
réglez le mode d’obturation sur On.

2 Sélectionnez Operation >Slow Shutter 
>Number of Frames dans le menu de 
configuration et sélectionnez le nombre 
d’images souhaité.
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Réglage du diaphragme automatique
La valeur de référence pour l’ajustement 
automatique du diaphragme peut être 
modifiée pour permettre la prise de vue 
d’images nettes de sujets en contre-jour ou 
éviter l’accentuation des rehauts.

Réglage du mode de 
fonctionnement du diaphragme 
automatique

Réglez le mode de fonctionnement à utiliser 
lorsque vous ajustez les niveaux à l’aide du 
diaphragme automatique.

1 Sélectionnez Operation >Auto Iris >Mode 
dans le menu de configuration.

2 Tournez le bouton MENU pour 
sélectionner le mode de fonctionnement, 
puis appuyez sur le bouton.

Mode de 
fonctionnement

Description

Backlight Mode pour la prise de 
vue avec rétroéclairage

Standard Mode standard

Spotlight Mode pour réduire 
l’accentuation des 
rehauts lorsqu’il y a des 
spots centrés sur le sujet.

Pour régler le niveau de 
convergence cible pour le 
diaphragme automatique

1 Sélectionnez Operation >Auto Iris >Level 
dans le menu de configuration.

2 Tournez le bouton MENU pour 
sélectionner le niveau sur une plage de 
–99 à +99, puis appuyez sur le bouton.

Niveau de 
convergence

Description

–99 Règle 2 f-stops du 
diaphragme ou plus foncé

±0 Niveau de référence

+99 Règle 2 f-stops du 
diaphragme ou plus clair

Réglage de la vitesse du 
diaphragme automatique

Réglez la vitesse de fonctionnement 
lorsque vous ajustez les niveaux à l’aide du 
diaphragme automatique.

1 Sélectionnez Operation >Auto Iris >Speed 
dans le menu de configuration.

2 Tournez le bouton MENU pour 
sélectionner la vitesse sur une plage de 
–99 (la plus lente) à +99 (la plus rapide), 
puis appuyez sur le bouton.

Modification de la valeur de 
référence du diaphragme de 
l’objectif

La valeur de référence du diaphragme de 
l’objectif peut être définie dans la plage 
suivante, conformément à la valeur standard.
ˎˎ +0.25 à +1 (incréments de 0.25) : ouverture 
accrue d’environ 0.25 à 1
ˎˎ –0.25 à –1 (incréments de 0.25) : fermeture 
accrue d’environ 0.25 à 1

Vous pouvez également définir la zone de 
détection de la lumière.

1 Réglez Operation >Auto Iris >Iris Override 
dans le menu de configuration sur On.

2 Réglez le commutateur MENU ON/OFF sur 
OFF.

3 Tournez le bouton MENU pour modifier la 
valeur de référence.

[Remarque]
Assurez-vous de vérifier que le mode d’obturation 
actuel n’est pas ECS.

La valeur de référence actuelle est 
indiquée par l’indicateur de position du 
diaphragme (page 17) sur l’écran du 
viseur.
ˎˎ Pour ouvrir légèrement le diaphragme, 
tournez le bouton MENU dans le sens 
inverse des aiguilles d’une montre, vu 
de l’avant du caméscope.  
Sélectionnez une valeur parmi +0.25, 
+0.5, +0.75 ou +1.
ˎˎ Pour fermer légèrement le diaphragme, 
tournez le bouton MENU dans le sens 
des aiguilles d’une montre, vu de 
l’avant du caméscope.  
Sélectionnez une valeur parmi –0.25, 
–0.5, –0.75 ou –1.

La valeur de référence modifiée est 
gardée en mémoire jusqu’à la mise hors 
tension du caméscope. Même si la valeur 
de référence est modifiée, elle reprend la 
valeur standard à chaque mise sous 
tension de l’appareil.

Réglage de la fenêtre de détection 
du diaphragme automatique

1 Réglez Operation >Auto Iris >Detect 
Window Indication dans le menu de 
configuration sur On.
La fenêtre actuelle de diaphragme 
automatique s’affiche sur l’écran du 
viseur.
Si l’affichage de la fenêtre de diaphragme 
automatique n’est pas nécessaire, réglez 
cet élément sur Off.

2 Sélectionnez Operation >Auto Iris >Detect 
Window dans le menu de configuration.

3 Tournez le bouton MENU jusqu’à ce que la 
fenêtre de diaphragme automatique 
souhaitée apparaisse, puis appuyez sur le 
bouton.

Les parties ombrées indiquent la 
zone de détection de la lumière.

Si vous sélectionnez Var, les éléments 
suivants sont activés et vous pouvez 
définir une fenêtre de la taille souhaitée. 
Réglez Operation >Auto Iris >Iris Var 
Width, Iris Var Height, Iris Var H Position et 
Iris Var V Position dans le menu de 
configuration.
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Elément Réglage

Iris Var Width La largeur de la fenêtre

Iris Var Height La hauteur de la fenêtre

Iris Var H 
Position

La position de la fenêtre 
dans le sens horizontal

Iris Var V 
Position

La position de la fenêtre 
dans le sens vertical.

Lorsque vous quittez le menu, la fenêtre de 
diaphragme automatique sélectionnée à 
l’étape 3 s’affiche.
Si l’affichage de cette fenêtre n’est pas 
nécessaire, réglez Operation >Auto Iris 
>Detect Window Indication dans le menu de 
configuration sur Off.

Réduction de l’effet des rehauts 
lumineux

Si le sujet est trop lumineux, le diaphragme 
peut trop se fermer, noircissant l’image 
entière, phénomène connu sous le nom 
d’écrêtage des noirs. Dans de tels cas, le fait 
d’activer la fonction de plan rehaussé met le 
signal au dessus d’un certain niveau, réduisant 
ainsi les effets automatiques du diaphragme.
Réglez Operation >Auto Iris >Clip High Light 
dans le menu de configuration sur On.
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Ajustement du niveau audio
Lorsque vous réglez le commutateur AUDIO 
SELECT sur AUTO, les niveaux d’entrée des 
signaux audio analogiques enregistrés sur 
chaque canal sont ajustés automatiquement. 
Vous pouvez également effectuer des 
ajustements manuels.

[Remarque]
Même si vous réglez le commutateur AUDIO SELECT 
sur AUTO, les niveaux d’entrée des signaux audio 
numériques enregistrés sur chaque canal ne sont pas 
ajustés automatiquement.

Niveau audio cible pour 
l’ajustement manuel

Effectuez l’ajustement en utilisant –20 dB 
comme niveau cible.
Si le vumètre audio affiche un niveau maximal 
de 0 dB, alors cela indique que le niveau audio 
d’entrée est excessif.

Niveau d’entrée excessif

Niveau d’entrée cible

Ajustement manuel du niveau des 
entrées audio en provenance des 
connecteurs AUDIO IN CH-1/CH-2

1 Pour ajuster l’entrée de signal sur le 
connecteur AUDIO IN CH-1 ou CH-2, réglez 
le commutateur AUDIO IN CH1 ou CH2 sur 
REAR.
Pour ajuster les deux signaux d’entrée, 
réglez les deux commutateurs sur REAR.

2 Placez le ou les commutateurs AUDIO 
SELECT, correspondant au canal ou aux 
canaux audio sélectionnés à l’étape 1, sur 
MANUAL.

3 Avec le ou les bouton(s) LEVEL du ou des 
canaux sélectionné(s) à l’étape 1, 
effectuez les ajustements afin que le 
vumètre audio affiche jusqu’à –20 dB pour 
le volume d’entrée normal.

Sélection du bouton utilisé pour 
l’ajustement du niveau d’enregistrement

Avec l’élément Maintenance >Audio du menu 
de configuration, vous pouvez sélectionner la 
commande de niveau audio qui commande 
le niveau d’enregistrement audio d’entrée de 
chacun des connecteurs AUDIO IN CH-1/CH-
2. La correspondance entre les réglages des 
éléments de menu et les commandes est la 
suivante.

[Remarque]
Si un signal audio numérique AES/EBU est entré, le 
niveau d’enregistrement ne peut pas être réglé en 
utilisant le caméscope.

Rear1/WRR Level : niveau d’enregistrement du 
canal 1

Réglage Bouton

Side1 Bouton LEVEL (CH1)

Front Bouton MIC LEVEL

Front+Side1 Bouton LEVEL (CH1) et bouton 
MIC LEVEL (fonctionnement 
associé)

Rear2/WRR Level : niveau d’enregistrement du 
canal 2

Réglage Bouton

Side2 Bouton LEVEL (CH2)

Front Bouton MIC LEVEL

Front+Side2 Bouton LEVEL (CH2) et bouton 
MIC LEVEL (fonctionnement 
associé)

[Remarque]
Lorsque le fonctionnement des boutons LEVEL (CH1/
CH2) et du bouton MIC LEVEL est associé, si le bouton 
MIC LEVEL est réglé sur 0, les signaux audio des canaux 1 
et 2 ne peuvent pas être enregistrés. Vérifiez la position 
du bouton MIC LEVEL avant d’ajuster les boutons LEVEL 
(CH1/CH2).

Ajustement manuel du niveau 
audio du connecteur MIC IN

1 Réglez le ou les deux commutateurs 
AUDIO IN sur FRONT.

2 Placez le ou les commutateurs AUDIO 
SELECT, pour le ou les canaux sélectionnés 
à l’étape 1, sur MANUAL.

3 Tournez le bouton MIC LEVEL et effectuez 
les ajustements afin que le vumètre audio 
affiche jusqu’à –20 dB pour le volume 
d’entrée normal.

Sélection du bouton utilisé pour 
l’ajustement du niveau d’enregistrement

Avec l’élément Maintenance >Audio du menu 
de configuration, vous pouvez sélectionner la 
commande de niveau audio qui commande le 
niveau d’enregistrement audio de l’entrée de 
microphone avant. La correspondance entre 
les réglages des éléments de menu et les 
commandes est la suivante.

MIC CH1 Level : niveau d’enregistrement du 
canal 1

Réglage Bouton

Side1 Bouton LEVEL (CH1)

Front Bouton MIC LEVEL

Front+Side1 Bouton LEVEL (CH1) et bouton 
MIC LEVEL (fonctionnement 
associé)

MIC CH2 Level : niveau d’enregistrement du 
canal 2

Réglage Bouton

Side2 Bouton LEVEL (CH2)

Front Bouton MIC LEVEL

Front+Side2 Bouton LEVEL (CH2) et bouton 
MIC LEVEL (fonctionnement 
associé)

[Remarque]
Lorsque le fonctionnement du bouton MIC LEVEL et des 
boutons LEVEL (CH1/CH2) est associé, si les boutons 
LEVEL (CH1/CH2) sont réglés sur 0, les signaux audio des 
canaux 1 et 2 ne peuvent pas être enregistrés. Vérifiez la 
position des boutons LEVEL (CH1/CH2) avant d’ajuster le 
bouton MIC LEVEL.
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Enregistrement audio sur les 
canaux 3 et 4

1 Sélectionnez l’audio enregistré sur les 
canaux 3 et 4 à l’aide des commutateurs 
AUDIO IN CH3/CH4.

Commutateur 
CH3

Cible d’enregistrement du 
canal 3

FRONT Audio du microphone avant

REAR Entrée de signal audio par 
le connecteur AUDIO IN CH1

WIRELESS Audio du microphone sans 
fil

Commutateur 
CH4

Cible d’enregistrement du 
canal 4

FRONT Audio du microphone avant

REAR Entrée de signal audio par 
le connecteur AUDIO IN CH2

WIRELESS Audio du microphone sans 
fil

2 Pour procéder à l’ajustement 
automatique, réglez le commutateur 
AUDIO SELECT CH 3-4 sur AUTO.
Pour procéder à l’ajustement manuel, 
réglez le commutateur AUDIO SELECT CH 
3-4 sur MANUAL.

3 Sélectionnez les boutons pour ajuster les 
niveaux audio au moyen des éléments 
Audio CH3 Level et Audio CH4 Level dans 
Maintenance >Audio du menu de 
configuration.

Audio CH3 Level : niveau d’enregistrement 
du canal 3

Réglage Bouton

Side3 Bouton LEVEL (CH3)

Réglage Bouton

Front Bouton MIC LEVEL

Front+Side3 Bouton LEVEL (CH3) et 
bouton MIC LEVEL 
(fonctionnement associé)

Audio CH4 Level : niveau d’enregistrement 
du canal 4

Réglage Bouton

Side4 Bouton LEVEL (CH4)

Front Bouton MIC LEVEL

Front+Side4 Bouton LEVEL (CH4) et 
bouton MIC LEVEL 
(fonctionnement associé)

Vous pouvez alors ajuster le niveau des 
canaux audio 3 et 4 à l’aide des boutons 
sélectionnés ici.
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Réglage des données temporelles

Réglage du code temporel

La plage de réglage du code temporel 
figure entre 00:00:00:00 et 23:59:59:29 
(heures:minutes:secondes:images).

1 Appuyez sur la touche DISP SEL/EXPAND 
pour faire basculer l’affichage du 
moniteur LCD vers l’affichage d’état.

2 Réglez le commutateur DISPLAY sur TC.

3 Réglez le commutateur PRESET/REGEN/
CLOCK sur PRESET.

4 Réglez le commutateur F-RUN/SET/R-RUN 
sur SET.
Le premier (le plus à gauche) chiffre du 
code temporel clignote.

5 Utilisez les touches fléchées haut et bas 
pour modifier les valeurs, et utilisez les 
touches fléchées gauche et droite pour 
déplacer le chiffre clignotant. Répétez la 
procédure jusqu’à ce que tous les chiffres 
soient réglés.
Pour réinitialiser la valeur sur 
00:00:00:00, appuyez sur la touche 
RESET/RETURN.

6 Réglez le commutateur F-RUN/SET/R-RUN 
sur F-RUN ou R-RUN.
F-RUN : défilement libre (le générateur de 

code temporel continue de défiler)
R-RUN : défilement d’enregistrement (le 

générateur de code temporel défile 
uniquement pendant 
l’enregistrement)

[Remarque]
Lorsque le mode Picture Cache Rec est activé, les 
données temporelles ne peuvent pas être réglées en 
plaçant le commutateur F-RUN/SET/R-RUN sur SET. Pour 
régler les données temporelles, désactivez le mode 
Picture Cache Rec.

Basculement entre DF et NDF

Vous pouvez sélectionner le mode temps réel 
(DF) ou le mode temps non réel (NDF) dans 
Maintenance >Timecode >DF/NDF du menu 
de configuration.

Pour rendre le code temporel continu

Lorsque le commutateur F-RUN/SET/R-RUN 
est réglé sur R-RUN, l’enregistrement d’un 
certain nombre de scènes sur le support 
produit normalement des codes temporels 
continus. Toutefois, si vous retirez le support 
et que vous enregistrez sur un autre support, 
le code temporel ne sera plus continu lorsque 
vous utiliserez à nouveau le support d’origine 
pour l’enregistrement.
Dans ce cas, pour rendre le code temporel 
continu, réglez le commutateur PRESET/
REGEN/CLOCK sur REGEN.

Sauvegarde de l’heure réelle dans le 
code temporel

Pour sauvegarder l’heure réelle dans le code 
temporel, réglez le commutateur PRESET/
REGEN/CLOCK sur CLOCK. L’heure de l’horloge 
interne du caméscope s’applique en tant que 
temps réel.

Pour plus de détails sur l’ajustement de l’horloge interne, 
consultez « Réglage de la date et l’heure de l’horloge 
interne » (page 25).

Réglage des bits d’utilisateur

En réglant les bits d’utilisateur (jusqu’à 
8 chiffres hexadécimaux), vous pouvez 
enregistrer des informations utilisateur 
comme la date, l’heure ou le numéro de scène, 
sur la piste du code temporel.

1 Appuyez sur la touche DISP SEL/EXPAND 
pour faire basculer l’affichage du 
moniteur LCD vers l’affichage d’état.

2 Réglez le commutateur DISPLAY sur U-BIT.

3 Réglez le commutateur F-RUN/SET/R-RUN 
sur SET.
Le premier chiffre (le plus à gauche) 
clignote.

4 Utilisez les touches fléchées haut et bas 
pour modifier les valeurs, et utilisez les 
touches fléchées gauche et droite pour 
déplacer le chiffre clignotant. Répétez la 
procédure jusqu’à ce que tous les chiffres 
soient réglés.
Pour réinitialiser la valeur sur 00 00 00 00, 
appuyez sur la touche RESET/RETURN.

5 Réglez le commutateur F-RUN/SET/R-RUN 
sur F-RUN ou R-RUN, correspondant au 
mode de fonctionnement souhaité pour 
le générateur de code temporel.

Fonction de mémoire de bits 
d’utilisateur

Le réglage des bits d’utilisateur (à l’exception 
de l’heure réelle) est automatiquement 
mémorisé même si l’appareil est mis hors 
tension.

Verrouillage du code temporel sur 
une source externe

Vous pouvez synchroniser le générateur de 
code temporel interne de ce caméscope 
avec un générateur externe. Vous pouvez 
également synchroniser les générateurs 
de code temporel d’autres caméscopes/
magnétoscopes avec le générateur interne de 
ce caméscope.

1 Raccordez le signal vidéo de référence et 
le code temporel externe comme illustré 
ci-dessous.
Exemple 1 : synchronisation avec un signal 
externe

Code temporel externe

Signal vidéo de référence

[1] Connecteur GENLOCK IN
[2] Connecteur TC IN

Exemple 2 : interconnexion de plusieurs 
caméscopes, avec un caméscope de 
référence
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Vers le caméscope suivant

[1] Connecteur GENLOCK IN
[2] Connecteur TC IN
[3] Connecteur SYNC OUT
[4] Connecteur TC OUT

2 Réglez le commutateur POWER sur ON.

3 Réglez le commutateur PRESET/REGEN/
CLOCK sur PRESET.

4 Réglez le commutateur F-RUN/SET/R-RUN 
sur F-RUN.

5 Réglez le commutateur DISPLAY sur TC.

6 Fournissez un signal de code temporel et 
un signal vidéo de référence conforme à 
la norme SMPTE et en relation de phase 
correcte, respectivement aux connecteurs 
TC IN et GENLOCK IN.

Cette opération synchronise le générateur 
de code temporel interne avec le code 
temporel externe. Une fois que 10 
secondes environ se sont écoulées après 
le verrouillage du code temporel, l’état de 
verrouillage externe est maintenu, même 
si la source de code temporel externe est 
déconnectée.

Pour terminer la synchronisation externe, 
commencez par arrêter l’entrée de code 
temporel externe, puis réglez le 
commutateur F-RUN/SET/R-RUN sur 
R-RUN.

[Remarques]
ˎˎ Une fois la procédure ci-dessus terminée, le code 

temporel interne est immédiatement synchronisé 
avec le code temporel externe et l’affichage de 
données temporelles affiche la valeur du code 
temporel externe. Cependant, avant d’enregistrer, 
patientez quelques secondes le temps que le 
générateur de synchronisation se stabilise.
ˎˎ Si la fréquence du signal vidéo de référence est 

différente de la fréquence de système du caméscope, 
celui-ci ne pourra pas être correctement verrouillé en 
synchronisation. Si cela se produit, le code temporel 
n’acquerra pas de verrou correctement avec le code 
temporel externe.

Réglages des bits d’utilisateur pendant 
la synchronisation

Lorsque le code temporel est synchronisé 
sur un signal externe, seules les données 
temporelles sont synchronisées avec la valeur 
du code temporel externe.

Remarque concernant le passage d’une 
alimentation avec pack batterie à une 
alimentation externe pendant la 
synchronisation externe

Pour maintenir une alimentation en continu, 
raccordez l’alimentation externe au connecteur 
DC IN avant de retirer le pack batterie. Si vous 

enlevez d’abord le pack batterie, vous risquez 
de perdre la synchronisation externe du code 
temporel.

Verrouillage de synchronisation du 
caméscope pendant la synchronisation 
externe

Pendant la synchronisation externe, le 
caméscope est verrouillé en synchronisation 
sur le signal vidéo de référence reçu par le 
connecteur GENLOCK IN.
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Opérations de base
Cette section explique les procédures de prise 
de vue et d’enregistrement de base.
Avant de démarrer la prise de vue, inspectez 
le système de caméra pour vérifier qu’il 
fonctionne correctement.

1 Fixez un pack batterie complètement 
chargé (page 22).

2 Chargez une ou deux cartes mémoire SxS 
(page 30).
Si vous chargez deux cartes, le caméscope 
passe automatiquement à la seconde 
carte lorsque la première carte est pleine.

3 Réglez le commutateur POWER 
(page 3) du caméscope sur ON.

4 Configurez les réglages suivants.
Affichage de repère : activé (page 105)
Diaphragme : automatique (page 42)
Zoom : automatique
Sortie de la caméra : sélectionnez l’image 

en cours de prise de vue (image de la 
caméra) et activez la fonction DCC 
(page 7)

Mode de défilement du code temporel : 
F-RUN (défilement libre) ou R-RUN 
(défilement d’enregistrement) 
(page 46)

Sélection du canal d’entrée audio : 
automatique (page 10)

5 Placez le commutateur AUTO W/B BAL sur 
la position BLACK pour ajuster l’équilibre 
des noirs (page 39).

6 Sélectionnez un filtre en fonction des 
conditions d’éclairage et ajustez l’équilibre 
des blancs (page 39).

7 Dirigez le caméscope vers le sujet et 
ajustez la mise au point et le zoom.

8 Si vous utilisez l’obturateur électronique, 
sélectionnez un mode et une vitesse 
d’obturation (page 41).

9 Effectuez l’une des opérations suivantes 
pour démarrer l’enregistrement.

 ‒ Appuyez sur la touche REC START 
(page 5).

 ‒ Appuyez sur la touche VTR de l’objectif.
 ‒ Activez le commutateur personnalisable 
auquel la fonction Rec a été attribuée 
(page 133).

Pendant l’enregistrement, les indicateurs 
TALLY, l’indicateur de signalisation du 
panneau avant du viseur, et l’indication 
REC de l’écran du viseur s’allument. 
Ajustez le zoom et la mise au point selon 
le besoin.

[Remarques]
ˎˎ Ne retirez jamais le pack batterie lorsque le 

caméscope enregistre (lorsque l’indicateur 
ACCESS sur le panneau latéral droit est allumé en 
bleu et que l’indicateur ACCESS dans la section 
de logements pour carte est allumé en orange). 
En faisant cela, vous risquez de perdre plusieurs 
secondes de données avant l’interruption de 
l’enregistrement, car le traitement interne ne se 
terminera pas normalement.
ˎˎ Les touches de commande de la lecture (EJECT, 

F REV, F FWD, NEXT, PREV, PLAY/PAUSE, STOP) ne 
fonctionnent pas pendant l’enregistrement.

10 Pour arrêter l’enregistrement, effectuez 
l’une des opérations énumérées à l’étape 
9.
Les indicateurs TALLY, l’indicateur de 
signalisation du panneau avant du viseur, 
et l’indication REC de l’écran du viseur 
s’éteignent, et le caméscope entre en 
mode de veille d’enregistrement (Stby).
Un plan est créé à partir des données 
audio et vidéo et des métadonnées 
enregistrées entre les étapes 9 et 10.

Pour revoir l’enregistrement (revue 
de l’enregistrement)

Avec le caméscope en mode de veille 
d’enregistrement, appuyez sur le 
commutateur personnalisable auquel la 
fonction Rec Review a été attribuée pour 
lire les deux dernières secondes du plan à 
une vitesse normale. Maintenez appuyé le 
commutateur personnalisable auquel la 
fonction Rec Review a été attribuée 
pendant une seconde ou plus pour 
commencer la lecture à partir de l’image à 
deux secondes de la fin avec une vitesse 
quatre fois dans le sens inverse. Relâchez, 
ensuite, la touche pour lire le plan à partir 
de ce point avec une vitesse normale. Le 
plan est lu jusqu’à la fin, Rec Review se 
termine et le caméscope revient sur le 
mode Stby.
Lorsque la fonction Rec Review est 
attribuée à la touche RET de l’objectif, 
vous pouvez également passer en revue 
l’enregistrement à l’aide de la touche RET.

11 Répétez les étapes 9 et 10 pour continuer 
l’enregistrement.
A chaque répétition, un autre plan est 
créé sur la carte mémoire.

Plan 1 Plan 2 Plan 3

[Remarques]
ˎˎ Vous ne pouvez par reprendre l’enregistrement 

pendant une seconde environ après l’avoir arrêté.
ˎˎ Le nombre maximum de plans pouvant être 

enregistrés sur une carte mémoire est 600. Même si 
la carte mémoire dispose de suffisamment d’espace 
libre pour enregistrer des plans supplémentaires, il 
n’est plus possible d’enregistrer lorsque 600 plans ont 
été enregistrés.
ˎˎ Les plans de moins de 2 secondes ne peuvent pas 

être crées. Par exemple, même si l’enregistrement 
démarre, puis est arrêté dans les 2 secondes, 

l’enregistrement continue pendant une durée de 
2 secondes. De plus, si l’enregistrement démarre, 
est immédiatement arrêté, puis redémarré dans les 
2 secondes qui suivent le début de l’enregistrement 
initial, deux plans sont créés.
ˎˎ Le temps d’enregistrement maximum en continu sur 

plusieurs cartes mémoire est de 24 heures. Une fois 
les 24 heures écoulées, l’enregistrement s’arrête.

Noms de plans

Des noms de plans à huit caractères 
(composés d’un préfixe à quatre caractères et 
d’un nombre à quatre chiffres) sont générés 
automatiquement pour les plans enregistrés 
par ce caméscope.
Exemple : ABCD0001
Vous pouvez également utiliser Operation 
>Clip >Title Prefix dans le menu de 
configuration pour régler le préfixe des 
noms de plans sur une chaîne de caractères 
indiquée par l’utilisateur (d’une longueur de 
quatre à 46 caractères). (Un préfixe indiqué 
par l’utilisateur ne peut pas être modifié après 
l’enregistrement.)
Le nombre à quatre chiffres à la fin des noms 
de plans est généré automatiquement, 
augmentant au fur et à mesure que les plans 
sont enregistrés.

Pour supprimer un plan

Vous pouvez supprimer le dernier plan 
enregistré en utilisant la fonction Last Clip 
Delete (page 134). Pour supprimer tous les 
plans ou des plans spécifiques, effectuez 
l’opération depuis l’écran de miniatures 
(page 87).

Lecture de plans enregistrés

1 Insérez la carte mémoire SxS à lire 
(page 30).
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2 Appuyez sur la touche PREV (page 8) 
ou F REV (page 8) pour vous 
positionner sur le plan à lire.

3 Appuyez sur la touche PLAY/PAUSE.
L’indicateur PLAY/PAUSE s’allume et 
l’image de lecture apparaît dans le viseur.

Lecture sans interruption

La lecture sans interruption sur plusieurs 
plans n’est prise en charge que si chaque plan 
enregistré sur une carte mémoire SxS PRO+ ou 
SxS PRO X a le statut suivant.
ˎˎ Le format vidéo est XAVC-I/XAVC-L (HD) et la 
durée du plan est de 4 secondes ou plus, ou 
le format vidéo est XAVC-I/XAVC-L (QFHD) et 
la durée du plan est de 8 secondes ou plus
ˎˎ Le format vidéo est MPEG HD et la durée du 
plan est de 2 secondes ou plus

[Remarques]
ˎˎ Pour les cartes SxS-1, il est nécessaire de doubler la 

durée mentionnée ci-dessus.
ˎˎ La lecture sans interruption n’est pas prise en charge 

sur les cartes SD.

Pause de la lecture

Appuyez sur la touche PLAY/PAUSE.
L’indicateur PLAY/PAUSE clignote quand la 
lecture est en pause.
Appuyez de nouveau sur la touche pour 
revenir au mode de lecture.

Lecture à haute vitesse

Appuyez sur la touche F FWD (page 8) ou 
F REV (page 8).
Pour revenir à la lecture normale, appuyez sur 
la touche PLAY/PAUSE.

Arrêt de la lecture

Appuyez sur la touche STOP : la lecture 
s’arrête et le caméscope passe en mode 
E-E.

Appuyez sur la touche THUMBNAIL : la 
lecture s’arrête et l’écran de miniatures 
(page 87) apparaît dans le viseur.

La lecture s’arrête également et l’écran de 
code temporel apparaît dans le viseur lorsque 
vous démarrez l’enregistrement pendant 
la lecture et lorsque vous éjectez une carte 
mémoire SxS.

Basculement entre les cartes mémoire

Lorsque deux cartes mémoire sont chargées, 
appuyez sur la touche SLOT SELECT 
(page 31) pour sélectionner le logement 
actif.
Il n’est pas possible de basculer entre les 
cartes mémoire pendant la lecture.
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Opérations avancées

Enregistrement des repères de 
prise de vue

Sur ce caméscope, deux types de repères de 
prise de vue sont disponibles. Vous pouvez les 
enregistrer à des emplacements définis par 
l’utilisateur pour faciliter le positionnement 
sur ces emplacements pour les monteurs.
Le nombre maximum de repères de prise de 
vue par plan est 999.

Vous pouvez également utiliser le menu Thumbnail pour 
ajouter et supprimer des repères de prise de vue dans les 
plans. Pour les détails, consultez « Ajout/suppression de 
repères dans les plans » (page 92).

Pour enregistrer les repères de prise 
de vue, activez l’un des commutateurs 
personnalisables avec la fonction Shot Mark 1 
ou Shot Mark 2 attribuée.
Lorsqu’un repère de prise de vue est 
enregistré, une indication « Shot Mark 1 » 
ou « Shot Mark 2 » apparaît dans le viseur 
pendant environ trois secondes près de 
l’indication de code temporel.

[Remarque]
Une carte SD insérée dans un logement de carte SxS à 
l’aide de l’adaptateur de support MEAD-SD02 (en option) 
ne peut pas être utilisée pour l’enregistrement.

Définition de balises de plans

Pour faciliter la sélection de bons plans pour 
les monteurs, vous pouvez régler des balises 
de plan dans les plans enregistrés.
Les balises de plans sont réglées dans le 
menu Thumbnail. Pour les détails, consultez 
« Ajout de balises sur les plans » (page 91) 
et « Suppression d’une balise de plan » 
(page 91).

[Remarque]
Une carte SD insérée dans un logement de carte SxS à 
l’aide de l’adaptateur de support MEAD-SD02 (en option) 
ne peut pas être utilisée pour l’enregistrement.

Enregistrement rétroactif 
d’images (fonction Picture Cache 
Rec)

Le caméscope conserve toujours un cache 
des données vidéo et audio pendant une 
durée définie (maximum de 15 secondes) 
dans la mémoire de stockage interne 
pendant l’enregistrement, ce qui vous permet 
d’enregistrer plusieurs secondes de prise de 
vue avant le début de l’enregistrement.
Pour de plus amples informations sur les 
formats vidéo pris en charge pour cette 
fonction, consultez « Prise en charge des 
enregistrements spéciaux par format 
d’enregistrement » (page 176).

Pour commencer l’enregistrement en mode 
Picture Cache Rec, le mode Picture Cache 
Rec et la durée de stockage des images dans 
la mémoire (durée de Picture Cache Rec) 
doivent être réglés au préalable dans le menu 
Operation.
Lorsque l’enregistrement est démarré, la durée 
de prise de vue pouvant être enregistrée de 
manière rétroactive est déterminée par la 
durée du mode Picture Cache Rec. La durée 
pouvant être enregistrée de façon rétroactive 
peut être réduite dans certaines conditions, 
comme indiqué dans les [Remarques] ci-
dessous.

[Remarques]
ˎˎ Le stockage de la vidéo dans la mémoire démarre 

lorsque le mode Picture Cache Rec est sélectionné. 
Cependant, si l’enregistrement est démarré 
immédiatement après avoir sélectionné ce mode, 
une partie des images filmées immédiatement avant 
la sélection du mode Picture Cache Rec ne sera pas 
enregistrée.
ˎˎ Les images ne sont pas stockées dans la mémoire 

pendant la lecture, la revue de l’enregistrement ou 
l’affichage des miniatures, l’enregistrement d’images 
pendant ces périodes n’est donc pas pris en charge.

Réglage de la durée du mode Picture 
Cache Rec

1 Sélectionnez Operation >Rec Function 
>Picture Cache Rec dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [On], puis appuyez sur le 
bouton.

3 Sélectionnez Operation >Rec Function 
>Cache Rec Time dans le menu de 
configuration.

4 Tournez le bouton MENU pour 
sélectionner le réglage de durée du mode 
Picture Cache Rec, puis appuyez sur le 
bouton.
Les options varient en fonction du format 
d’enregistrement et des réglages de 
fréquence du système. Consultez 
« Réglages du mode Picture Cache Rec » 
(page 177) en annexe.

Une fois le mode Picture Cache Rec 
sélectionné, il est maintenu jusqu’au 
changement des réglages.
Vous pouvez également, plutôt que de réaliser 
les étapes 1 et 2, sélectionner le mode Picture 
Cache Rec en utilisant un commutateur 
personnalisable (page 133) auquel a été 

attribuée la fonction Picture Cache Rec.

[Remarques]
ˎˎ A l’exception de certaines fonctionsa), seule une 

fonction spéciale d’enregistrement, telle que Picture 
Cache Rec, peut être utilisée à tout moment.
ˎˎ A l’exception de certaines fonctionsa), si un autre 

mode d’enregistrement spécial est activé pendant 
que Picture Cache Rec est utilisée, Picture Cache Rec 
est automatiquement arrêtée.
ˎˎ Le fait de changer les réglages du système, tels que 

le format vidéo, efface toutes les images stockées 
dans la mémoire. Les images filmées juste avant 
le changement des réglages ne peuvent donc 
pas être enregistrées, si l’enregistrement débute 
immédiatement après le changement des réglages. 
Le mode Picture Cache Rec est automatiquement 
libéré.
ˎˎ La durée du mode Picture Cache Rec ne peut pas être 

réglée pendant l’enregistrement.
a) Picture Cache Rec est également pris en charge en 

mode 1-slot Simul Rec.

Démarrage de l’enregistrement en 
mode Picture Cache Rec

Filmez, tel qu’indiqué dans « Opérations de 
base » (page 48).

Lorsque l’enregistrement démarre, l’indication 
« Cache » dans le viseur passe à l’indication 
« Rec ». Les indicateurs TALLY et l’indicateur 
de signalisation du panneau avant du viseur 
s’allument de la même façon que lors d’un 
enregistrement normal.

Pour quitter, arrêtez l’enregistrement.

Annulation du mode Picture Cache Rec

En mode de veille d’enregistrement, réglez 
Operation >Rec Function >Picture Cache Rec 
dans le menu de configuration sur Off.
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Fonctionnement de l’appareil lors de 
l’enregistrement en mode Picture Cache 
Rec

La procédure d’enregistrement est presque la 
même, à l’exception des points suivants, pour 
lesquels le fonctionnement diffère.
ˎˎ Si l’enregistrement est démarré pendant 
l’accès à un support, le point de démarrage 
réel de l’enregistrement peut même être 
retardé plus longtemps que la durée 
de Picture Cache Rec définie. Le délai 
augmente avec le nombre de plans 
enregistrés. L’arrêt et le redémarrage rapide 
de l’enregistrement doivent donc être évités 
en mode Picture Cache Rec.
ˎˎ Quel que soit le réglage du commutateur 
F-RUN/SET/R-RUN, le caméscope 
fonctionne en mode F-RUN.
ˎˎ En mode Picture Cache Rec, les données 
temporelles ne peuvent pas être réglées en 
plaçant le commutateur F-RUN/SET/R-RUN 
sur SET.  
Pour régler les données temporelles, 
commencez par arrêter le mode Picture 
Cache Rec.
ˎˎ Si la durée d’enregistrement restante 
du support situé dans le logement 
actuellement sélectionné est inférieure à 
la durée de Picture Cache Rec, les images 
sont enregistrées sur le support (si la durée 
d’enregistrement restante est suffisante) 
situé dans le logement non sélectionné.  
Cependant, les images ne sont pas 
enregistrées si aucun support ne se trouve 
dans le logement non sélectionné ou si 
la durée d’enregistrement restante du 
support de ce logement n’est pas suffisante. 
(Un message vous notifiant que la durée 
d’enregistrement restante est insuffisante 
apparaît sur l’écran du viseur.)

ˎˎ Les repères de prise de vue ne sont pas 
enregistrés, même si les repères de prise 
de vue sont définis avant l’opération de 
démarrage de l’enregistrement.

Si le caméscope est hors tension 
pendant l’enregistrement

ˎˎ Si le commutateur POWER sur le caméscope 
est placé en position OFF, le support est en 
cours d’accès pendant plusieurs secondes 
pour enregistrer les images stockées 
jusqu’ici dans la mémoire, puis l’appareil se 
met automatiquement hors tension.
ˎˎ Si la batterie est retirée, le câble DC 
déconnecté ou l’adaptateur CA désactivé 
pendant l’enregistrement, les données 
vidéo et audio stockées dans la mémoire 
sont effacées, et les images jusqu’à ce 
moment ne sont pas enregistrées. Faites 
preuve de prudence lors du remplacement 
de la batterie.

Enregistrement de vidéo en time-
lapse (fonction d’enregistrement 
par intervalles)

La fonction d’enregistrement par intervalles 
du caméscope vous permet d’enregistrer une 
vidéo en time-lapse dans la mémoire interne 
du caméscope. Cette fonction permet la prise 
de vue efficace de sujets en déplacement lent.  
Lorsque vous commencez l’enregistrement, le 
caméscope enregistre automatiquement un 
nombre d’images spécifié à un intervalle de 
temps spécifié.

Cette fonction est activée lorsque le 
caméscope est réglé sur l’un des formats 
vidéo suivants (page 35).

XAVC-I
XAVC-L
MPEG HD 422

Intervalle d’enregistrement 
(Interval Time)

Nombre d’images en une prise
(Number of Frames)

Une fonction de pré-allumage est disponible 
lorsque Interval Rec est activé. Cette fonction 
allume automatiquement la lampe vidéo 
avant le démarrage de l’enregistrement, ce 
qui vous permet d’enregistrer des images 
dans des conditions d’illumination et de 
température de couleur stables.

[Remarques]
ˎˎ Seul un mode spécial d’enregistrement, tel que 

l’enregistrement Interval Rec, peut être utilisé à tout 
moment.  
Si un autre mode d’enregistrement spécial est 
activé alors que le mode Interval Rec est en cours 
d’utilisation, Interval Rec est automatiquement libéré.
ˎˎ Les réglages de l’enregistrement par intervalles ne 

peuvent pas être modifiés pendant l’enregistrement.

Réglage d’Interval Rec

1 Sélectionnez Operation >Rec Function 
>Interval Rec dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [On], puis appuyez sur le 
bouton.
Le caméscope passe en mode Interval 
Rec, et « Int Stby » s’affiche au niveau de 
l’indicateur REC sur l’écran du viseur. (Pour 
la série HDVF, l’indicateur de signalisation 
vert du viseur clignote également.)

3 Sélectionnez [Number of Frames], tournez 
le bouton MENU pour sélectionner le 
nombre d’images souhaité pour une 
prise, puis appuyez sur le bouton.
Vous pouvez sélectionner 2, 6, ou 12 
lorsque le format est 50P ou 59.94P.
Vous pouvez sélectionner 1, 3, 6, ou 9 
lorsque le format est 23.98P, 25P, 29.97P, 
50i, ou 59.94i.

4 Sélectionnez [Interval Time], puis tournez 
le bouton MENU pour sélectionner 
l’intervalle souhaité, puis appuyez sur le 
bouton.
Vous pouvez sélectionner de 1 à 
10/15/20/30/40/50 sec, de 1 à 
10/15/20/30/40/50 min, ou de 1 à 
4/6/12/24 heure(s).

5 Si vous avez besoin d’allumer la lampe 
vidéo avant de démarrer l’enregistrement, 
sélectionnez [Pre-Lighting], tournez le 
bouton MENU pour sélectionner la durée 
d’éclairage avant le démarrage de 
l’enregistrement, puis appuyez sur le 
bouton.
Vous pouvez sélectionner 2, 5, 10 
secondes ou Off.
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[Remarques]
ˎˎ Si vous souhaitez allumer la lampe vidéo 

avant de démarrer l’enregistrement, réglez 
le commutateur LIGHT du caméscope sur 
AUTO. Le commutateur de la lampe vidéo doit 
également être activé. Lorsque ce réglage a 
été effectué, la lampe vidéo s’allume et s’éteint 
automatiquement. Cependant, la lampe vidéo 
reste allumée si la durée de non-activation de la 
lampe est de cinq secondes ou moins.
ˎˎ Si vous réglez le commutateur LIGHT sur 

MANUAL et que vous activez le commutateur 
de la lampe vidéo, celle-ci restera allumée. 
(La lampe vidéo ne s’allume et ne s’éteint pas 
automatiquement.)

Le caméscope quitte le mode Interval 
Rec lorsqu’il est mis hors tension, mais 
les réglages relatifs au nombre d’images, 
à l’intervalle de temps et à l’allumage de 
la lampe sont conservés. Il ne sera pas 
nécessaire de les définir à nouveau la 
prochaine fois que vous utiliserez le mode 
Interval Rec.

Démarrage de l’enregistrement Interval 
Rec

Consultez « Opérations de base » (page 48) 
pour effectuer les réglages et la préparation, 
assurez-vous que le caméscope est bien 
attaché afin qu’il ne bouge pas, puis 
commencez la prise de vue.

Lorsque le mode Interval Rec est réglé sur 
On, « Int Stby » s’affiche à la position REC sur 
l’écran du viseur. Lorsque vous commencez 
l’enregistrement, « Int Rec » et « Int Stby » 
s’affichent successivement. Les indicateurs 
TALLY et l’indicateur de signalisation du 
panneau avant du viseur s’allument de la 
même façon que lors d’un enregistrement 
normal. (Pour la série HDVF, l’indicateur de 
signalisation vert du viseur clignote également 
en vitesse rapide.)

Si vous utilisez la fonction de pré-allumage, la 
lampe vidéo s’allume avant le démarrage de 
l’enregistrement.

Pour quitter, arrêtez l’enregistrement.
Lorsque la prise de vue s’arrête, les données 
vidéo stockées jusqu’ici dans la mémoire sont 
écrites sur le support.

Annulation du mode Interval Rec

Effectuez l’une des opérations suivantes.
ˎˎ Réglez le commutateur POWER sur OFF.
ˎˎ En mode de veille d’enregistrement, réglez 
Operation >Rec Function >Interval Rec dans 
le menu de configuration sur Off.

[Remarque]
Redémarrer le caméscope automatiquement lance le 
mode Interval Rec.

Restrictions pendant l’enregistrement

ˎˎ Quel que soit le réglage du commutateur 
F-RUN/SET/R-RUN, le mode de défilement 
du générateur de code temporel interne est 
toujours R-RUN.
ˎˎ L’audio n’est pas enregistré.
ˎˎ La revue de l’enregistrement (Rec Review) 
n’est pas possible.
ˎˎ Le verrouillage de la synchronisation n’est 
pas possible.

Si le caméscope est hors tension 
pendant l’enregistrement

ˎˎ Si le commutateur POWER sur le caméscope 
est placé en position OFF, le support est en 
cours d’accès pendant plusieurs secondes 
pour enregistrer les images stockées 
jusqu’ici dans la mémoire, puis l’appareil se 
met automatiquement hors tension.
ˎˎ Lorsque l’alimentation est coupée en cas 
d’extraction de la batterie, de déconnexion 
du cordon d’alimentation CC ou de coupure 

de l’alimentation au niveau de l’adaptateur 
CA, les données vidéo et audio tournées 
jusqu’ici risquent d’être perdues (maximum 
de 10 secondes). Faites preuve de prudence 
lors du remplacement de la batterie.

Prise de vue avec ralenti et 
accéléré

Vous pouvez spécifier une fréquence d’images 
d’enregistrement différente de la fréquence 
d’images de lecture.

[Remarque]
Lors d’une prise de vue en format d’enregistrement 
XAVC, utilisez des cartes mémoire SxS type SxS PRO X ou 
SxS PRO+.

Format 
d’enregistrement

Fréquence de 
système

Fréquence 
d’images S

XAVC-I 3840P 59.94P/50P/ 
29.97P/23.98P/ 
25P

1 IPS à 60 IPS 
(unités de 
1 IPS)XAVC-L200 

XAVC-L 3840P 

XAVC-I 1080P 1 IPS à 60 IPS  
(unités de 
1 IPS), 
72/75/90/96/ 
100/120 IPS

XAVC-L 50 
1080P

XAVC-L 35 
1080P

HD422 50 
1080P a)

29.97P 1 IPS à 30 IPS 
(unités de 
1 IPS)

23.98P

25P 1 IPS à 25 IPS 
(unités de 
1 IPS)

a) Les systèmes de fichiers exFAT et UDF sont pris en 
charge. Seul exFAT est pris en charge pour les autres 
formats d’enregistrement.

En filmant avec une fréquence d’images 

différente de la fréquence d’images de lecture, 
vous pouvez obtenir des effets de ralenti et 
accéléré plus fluides que la lecture ralentie ou 
accélérée de contenu enregistré à la fréquence 
d’images normale.

Réglage de ralenti et accéléré

1 Sélectionnez Operation >Rec Function 
>Slow & Quick Motion dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [On], puis appuyez sur le 
bouton.
Le mode Slow & Quick Motion démarre et 
« S&Q Stby » s’affiche dans la zone 
d’indicateur d’état d’enregistrement dans 
le viseur.
Si une fréquence d’images de 60 IPS ou 
plus a été réglée préalablement, « HFR 
Stby » apparaît.
Ensuite, réglez la fréquence d’images.

3 Sélectionnez Operation >Rec Function 
>Slow & Quick Motion >Frame Rate dans 
le menu de configuration.

4 Tournez le bouton MENU pour 
sélectionner la fréquence d’images, puis 
appuyez sur le bouton.

Lorsque ces réglages sont configurés, la 
fréquence de système et la fréquence 
d’images apparaissent en haut de l’écran du 
viseur. Vous pouvez modifier la fréquence 
d’images tout en regardant l’affichage du 
viseur en tournant le bouton MENU.
Le réglage du mode ralenti et accéléré et la 
fréquence d’images sont conservés même 
après la mise hors tension du caméscope.
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[Remarques]
ˎˎ Seul un mode spécial d’enregistrement, tel que le 

mode Slow & Quick Motion peut être utilisé à tout 
moment.
ˎˎ Si un autre mode spécial d’enregistrement est activé 

pendant l’utilisation du mode Slow & Quick Motion, 
Slow & Quick Motion est automatiquement annulé.
ˎˎ Le mode Slow & Quick Motion ne peut pas être réglé 

pendant l’enregistrement, la lecture ou pendant 
l’affichage de l’écran de miniatures.
ˎˎ Le mode Slow & Quick Motion ne peut pas être réglé 

si le mode d’obturation lente est activé.
ˎˎ À un réglage de 72 IPS ou plus, le champ de vision est 

réduit à la moitié de la taille d’image normale.

Démarrage de l’enregistrement de 
ralenti et accéléré

Filmez, tel qu’indiqué dans « Opérations de 
base » (page 48).

Lorsque l’enregistrement démarre, l’indication 
« S&Q Stby » dans le viseur passe à l’indication 
« S&Q Rec ». Si une fréquence d’images de 
60 IPS ou plus a été réglée préalablement, 
« HFR Rec » apparaît. Les indicateurs TALLY 
et l’indicateur de signalisation du panneau 
avant du viseur s’allument de la même façon 
que lors d’un enregistrement normal.

Pour quitter, arrêtez l’enregistrement.

[Remarque]
L’arrêt de l’enregistrement est plus long que la normale 
lorsque la fréquence d’images est réglée sur une valeur 
faible (pour une fréquence d’images lente).

Annulation du mode ralenti et accéléré

Avec le caméscope en mode de veille 
d’enregistrement, réglez Operation >Rec 
Function >Slow & Quick dans le menu de 
configuration sur Off.

Restrictions pendant l’enregistrement

ˎˎ Quel que soit le réglage du commutateur 
F-RUN/SET/R-RUN, le mode de défilement 

du générateur de code temporel interne est 
toujours R-RUN.
ˎˎ L’audio ne peut pas être enregistré lorsque 
les fréquences d’images d’enregistrement 
et de lecture sont différentes.
ˎˎ La revue de l’enregistrement (Rec Review) 
n’est pas possible.
ˎˎ Si vous changez la fréquence d’images 
d’enregistrement sur une valeur plus élevée 
que la vitesse d’obturation actuelle, la 
vitesse d’obturation passe à la valeur la plus 
lente permettant l’enregistrement.  
Exemple : si la fréquence d’images est 32 
et la vitesse d’obturation est 1/40, et si vous 
changez la fréquence d’images sur 55, la 
vitesse d’obturation passe à 1/60.  
Il est impossible de sélectionner une vitesse 
d’obturation plus lente que la fréquences 
d’images d’enregistrement.
ˎˎ Le verrouillage de la synchronisation n’est 
pas possible.

Enregistrement avec la fonction 
d’enregistrement continu de plan

Un plan est normalement créé comme 
fichier indépendant chaque fois que vous 
lancez et arrêtez l’enregistrement. Mais cette 
fonction vous permet de démarrer et arrêter 
l’enregistrement tout en enregistrant en 
continu sur le même plan, aussi longtemps 
que la fonction reste activée. Cette fonction 
est pratique lorsque vous ne souhaitez pas 
générer un grand nombre de plans courts, et 
lorsque vous souhaitez enregistrer sans vous 
soucier de dépasser la limite de plans.
Il reste facile de trouver le point de départ 
de l’enregistrement, parce qu’un repère de 
début d’enregistrement est enregistré au 
point de départ chaque fois que vous lancez 
l’enregistrement.

Cette fonction est activée lorsque le 
caméscope est réglé sur l’un des formats 
vidéo suivants (page 35).

XAVC-I (XAVC-I 3840×2160P exclu)
XAVC-L (XAVC-L 3840×2160P, XAVC-L 200 
2160P exclu)
MPEG HD 422

Réglage de Clip Continuous Rec

1 Sélectionnez Operation >Rec Function 
>Clip Continuous Rec dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [On], puis appuyez sur le 
bouton.
« Cont Stby » clignote dans le viseur et la 
fonction est activée.
Il reste illuminé de manière stable une fois 
l’enregistrement arrêté.

[Remarques]
ˎˎ Seul un mode spécial d’enregistrement, tel que le 

mode Clip Continuous Rec, peut être utilisé à tout 
moment.
ˎˎ Si un autre mode d’enregistrement spécial est activé 

alors que le mode Clip Continuous Rec est en cours 
d’utilisation, le mode actuellement sélectionné est 
automatiquement libéré.

Vous pouvez attribuer la fonction d’activation/
de désactivation d’enregistrement continu de 
plan à l’un des commutateurs ASSIGN. 1/2/3, à 
l’un des commutateurs ASSIGNABLE 4/5 ou à 
la touche ONLINE.

Pour les détails, consultez « Attribution de fonctions aux 
commutateurs personnalisables » (page 133).

Démarrage de l’enregistrement Clip 
Continuous Rec

Filmez, tel qu’indiqué dans « Opérations de 
base » (page 48).

Lorsque l’enregistrement démarre, l’indication 
« Cont Stby » dans le viseur passe à 
l’indication « Cont Rec ».
Les indicateurs TALLY et l’indicateur de 
signalisation du panneau avant du viseur 
s’allument de la même façon que lors d’un 
enregistrement normal.

[Remarque]
Pendant l’enregistrement ou en mode de veille 
d’enregistrement (lorsque l’indication « Cont Stby » 
est affichée), si vous retirez le support, la batterie ou 
la source d’alimentation, le support nécessite une 
restauration. Il n’est pas possible de restaurer le support 
sur un dispositif autre que ce caméscope.
Quittez le mode d’enregistrement continu de plan 
(page 53) puis retirez le support.

Pour quitter, arrêtez l’enregistrement.

[Remarque]
Arrêtez l’enregistrement après un enregistrement de 
deux secondes ou plus.

Annulation du mode Clip Continuous 
Rec

Avec le caméscope en mode de veille 
d’enregistrement, réglez Operation >Rec 
Function >Clip Continuous Rec dans le menu 
de configuration sur Off.

Restrictions pendant l’enregistrement

Un seul plan continu ne peut pas être créé 
si vous effectuez l’une des opérations 
suivantes quand le caméscope est en 
mode d’enregistrement ou de veille 
d’enregistrement. (Un nouveau plan est créé 
lorsque vous lancez l’enregistrement suivant.)
ˎˎ Opération sur un plan (verrouillage, 
suppression ou renommage d’un plan)
ˎˎ Fentes des commutateurs
ˎˎ Changement du format d’enregistrement
ˎˎ Réglage du commutateur POWER sur OFF
ˎˎ Lecture
ˎˎ Basculer vers l’écran de miniatures
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Enregistrement simultané de 
vidéo sur deux cartes mémoire 
SxS (2-slot Simul Rec)

Lorsque le format vidéo (page 35) est réglé 
sur l’une des options du tableau suivant, 
vous pouvez enregistrer la même vidéo sur 
deux cartes mémoire SxS. Cette fonction peut 
être utile pour réaliser une sauvegarde vidéo 
pendant la prise de vue.

[Remarques]
ˎˎ Il est recommandé de formater (initialiser) les deux 

cartes mémoire SxS grâce au caméscope avant 
utilisation.
ˎˎ L’enregistrement simultané n’est pas pris en charge 

lorsque le système est UDF.
ˎˎ Les cartes SD ne peuvent pas être utilisées.

Operation >Format 
>Rec Format dans le 
menu de 
configuration

Operation >Format 
>Frequency dans le menu 
de configuration

XAVC-I 1920×1080P 59.94/59/29.97/25/23.98

XAVC-I 1920×1080i 59.94/50

XAVC-L 50 
1920×1080P

59.94/50/29.97/25/23.98

XAVC-L 50 
1920×1080i

59.94/50

XAVC-L 35 1080P 59.94/50/29.97/25/23.98

XAVC-L 35 1080i 59.94/50

XAVC-L 25 1080i 59.94/50

HD 422 50 1080P 29.97/25/23.98

HD 422 50 1080i 59.94/50

HD 422 50 720P 59.94/50/29.97/25/23.98

HQ 1920×1080P 29.97/25/23.98

HQ 1920×1080i 59.94/50

HQ 1440×1080i 59.94/50

HQ 1280×720P 59.94/50

Réglage de 2-slot Simul Rec

1 Sélectionnez Operation >Rec Function 
>Simul Rec dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [On], puis appuyez sur le 
bouton.

[Remarques]
ˎˎ Seul un mode spécial d’enregistrement, tel que 

le mode 2-slot Simul Rec peut être utilisé à tout 
moment.
ˎˎ Si un autre mode spécial d’enregistrement est activé 

pendant l’utilisation du mode 2-slot Simul Rec, 2-slot 
Simul Rec est automatiquement libéré.
ˎˎ Le mode 2-slot Simul Rec ne peut pas être réglé 

pendant l’enregistrement, la lecture ou pendant 
l’affichage de l’écran de miniatures.

Démarrage de l’enregistrement 2-slot 
Simul Rec

1 Insérez des cartes mémoire SxS dans les 
deux logements pour cartes mémoire A et 
B.
Les indicateurs ACCESS pour les 
logements SxS A et B sont allumés. De 
même, les icônes des logements SxS A et 
B apparaissent sur le viseur (page 20).

2 Filmez, tel qu’indiqué dans « Opérations 
de base » (page 48).

[Remarques]
ˎˎ L’enregistrement simultané n’est pas possible si le 

support est défectueux ou si le support est protégé 
en écriture.
ˎˎ Pendant l’enregistrement simultané, si le support 

se remplit et atteint sa capacité maximale ou si une 
erreur se produit et que l’enregistrement ne peut pas 
se poursuivre, l’enregistrement sur ce support s’arrête, 
mais l’enregistrement sur l’autre support se poursuit.

Pour quitter, arrêtez l’enregistrement.

Annulation du mode 2-slot Simul Rec

En mode de veille d’enregistrement, réglez 
Operation >Rec Function >Simul Rec dans le 
menu de configuration sur Off.

Enregistrement simultané de 
plans 4K et HD sur une carte 
mémoire SxS (1-slot Simul Rec)

Cette fonction vous permet d’enregistrer, en 
même temps et sur une seule carte mémoire 
SxS, une vidéo 4K QFHD à fichier de grande 
taille (plan principal) et une vidéo HD à fichier 
de petite taille (sous-plan), qui peuvent être 
utilisées pour le prémontage.
Le format d’enregistrement des cartes SxS 
utilisable pour la fonction 1-slot Simul Rec est 
4K QFHD (XAVC-I QFHD ou XAVC-L QFHD).
La taille de l’image et le format 
d’enregistrement des sous-plans varie selon la 
fréquence du système.

Format 
d’enregistrement 
du plan principal

Fréquence 
de 
système

Format 
d’enregistrement 
du sous-plan

ˎˎ XAVC-I 
3840×2160P
ˎˎ XAVC L200 2160P
ˎˎ XAVC-L 
3840×2160P

29.97, 25, 
23.98

MPEG HD422 
1920×1080P, 
XAVC-L50 
1920×1080P

59.94, 50 MPEG HD422 
1920×1080i, 
XAVC-L50 
1920×1080P

[Remarque]
Les cartes SD ne peuvent pas être utilisées en mode 
1-slot Simul Rec.

Réglage de 1-slot Simul Rec

1 Sélectionnez Operation >Rec Function >4K 
& HD (Sub) Rec dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [On], puis appuyez sur le 
bouton.

[Remarques]
ˎˎ A l’exception de certaines fonctions a), seule 

une fonction spéciale d’enregistrement, telle 
que 1-slot Simul Rec, peut être utilisée à tout 
moment.
ˎˎ A l’exception de certaines fonctions a), si un 

autre mode spécial d’enregistrement est activé 
pendant l’utilisation de 1-slot Simul Rec, 1-slot 
Simul Rec est automatiquement libérée.
ˎˎ Le mode 1-slot Simul Rec ne peut pas être réglé 

pendant l’enregistrement, la lecture ou pendant 
l’affichage de l’écran de miniatures.

a) Picture Cache Rec est également pris en charge 
en mode 1-slot Simul Rec.

3 Sélectionnez HD (Sub) Rec Format et 
spécifiez le format d’enregistrement du 
sous-plan.

Démarrage de l’enregistrement 1-slot 
Simul Rec

Filmez, tel qu’indiqué dans « Opérations de 
base » (page 48).
Lors de l’enregistrement, « /Sub » est 
affiché à droite de l’indicateur de format 
d’enregistrement (codec) sur l’écran du viseur 
(page 18).
Pour quitter, arrêtez l’enregistrement.

Annulation du mode 1-slot Simul Rec

Avec le caméscope en mode de veille 
d’enregistrement, réglez Operation >Rec 
Function >4K & HD (Sub) Rec dans le menu de 
configuration sur Off.
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Lecture au format d’enregistrement de 
sous-plan

1 Sélectionnez Operation >Input/Output 
>Output Format >HD 1920×1080 dans le 
menu de configuration.

2 Sélectionnez Operation >Rec Function 
>HD (Sub) Playback Mode >On dans le 
menu de configuration.

3 Appuyez sur la touche PLAY pour lancer la 
lecture.
Dans ce mode, seuls les sous-plans 
peuvent être lus. Les plans principaux 4K 
QFHD sont sautés.
Les sous-plans peuvent également être 
sélectionnés sur l’écran de miniatures.

[Remarques]
ˎˎ Les sous-plans ne peuvent pas être lus lorsque 

la fonction 1-slot Simul Rec est réglé sur Off.
ˎˎ Les opérations sur les plans dans le menu 

Thumbnail (page 87) sur l’écran de miniatures 
s’appliquent au plan principal. Les opérations 
de sous-plans ne sont pas prises en charge. 
Pour effectuer des opérations sur un sous-plan, 
copiez-le en tant que plan principal comme 
décrit ci-dessous « Copie et sauvegarde d’un 
sous-plan en tant que plan principal » puis 
effectuez les opérations sur le plan.

Copie et sauvegarde d’un sous-
plan en tant que plan principal

Vous pouvez copier un sous-plan créé en 
utilisant 1-slot Simul Rec et le sauvegarder en 
tant que plan principal sur un autre support.

1 Insérez dans un logement de carte le 
support sur lequel le sous-plan créé avec 
1-slot Simul Rec a été enregistré.

2 Insérez un support dans l’autre logement 
de carte.

3 Sélectionnez Thumbnail >Copy Sub Clip 
>All Clips dans le menu de configuration.

[Remarque]
Les sous-plans ne peuvent pas être sélectionnés 
individuellement.

4 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Une boîte de dialogue de confirmation 
apparaît.

5 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Tous les sous-plans sont copiés en tant 
que plans principaux, et un message 
d’achèvement apparaît.

6 Appuyez sur le bouton MENU pour faire 
disparaître ce message.
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Données proxy
Les données proxy sont constituées de 
données vidéo (H.264) et de données audio 
basse résolution (AAC-LC). Ces données proxy 
légères peuvent être utilisées de la même 
façon que les données originales, mais elles 
peuvent être transférées plus rapidement, 
pour une visualisation et un montage plus 
efficace.
Pendant l’enregistrement d’un plan, des 
données proxy sont enregistrées sur la carte 
SD insérée dans la fente de carte PROXY SD.

Logements pour cartes 
PROXY SD

En important les données proxy enregistrées 
sur la carte SD sur un ordinateur, vous pouvez 
vérifier rapidement le contenu enregistré 
ou effectuer un montage rapide en étant 
déconnecté.
Vous pouvez enregistrer des données proxy 
simultanément lors de l’enregistrement 
sur des cartes mémoire SxS, mais aussi 
indépendamment à partir de l’enregistrement 
sur des cartes mémoire SxS.

Enregistrement proxy grâce au 
caméscope

ˎˎ Lors de l’enregistrement simultané, 
l’enregistrement proxy ne démarre pas tant 
qu’aucune carte mémoire SxS n’est insérée.

ˎˎ Lorsque le caméscope est sous tension 
depuis environ 30 secondes, l’icône  
(indicateur d’état du support pour le 
logement Proxy SD) s’allume sur le moniteur 
LCD et sur l’écran du viseur pour indiquer 
que l’enregistrement proxy est activé.  
Si vous démarrez la prise de vue pendant 
que l’icône  clignote ou est éteinte, les 
fichiers proxy ne sont pas enregistrés.
ˎˎ Avant de retirer une carte SD du caméscope, 
vérifiez toujours que l’indicateur ACCESS 
pour le logement de carte PROXY SD n’est 
pas allumé, puis mettez le caméscope 
hors tension ou désactivez la fonction de 
connexion LAN sans fil/enregistrement 
proxy.  
Pour désactiver la fonction de connexion 
LAN sans fil/enregistrement proxy, réalisez 
les réglages suivants dans le menu de 
configuration.
–  Réglez Operation >XAVC Proxy Rec Mode 

>Setting sur Off.
–  Réglez Maintenance >Network >Setting 

sur Off.
ˎˎ Essayer de retirer la carte SD pendant que 
la fonction d’enregistrement proxy ou la 
fonction de connexion LAN sans fil est 
activée peut afficher un avertissement (E91-
1C0), dans certains cas. Si l’avertissement 
apparaît pendant l’enregistrement, les 
données sont toujours enregistrées 
correctement sur les cartes mémoire 
SxS, mais les fichiers proxy ne sont pas 
enregistrés. Le message d’avertissement 
peut être effacé en mettant le caméscope 
hors tension, puis à nouveau sous tension.
ˎˎ L’enregistrement proxy ne démarrera pas 
si Picture Cache Rec, Interval Rec, Slow & 
Quick Motion ou Streaming est activé.
ˎˎ L’enregistrement proxy ne peut pas 
s’effectuer lorsque le format de sortie SDI 
est réglé sur 3840×2160P.

Cartes SD

Cartes SD prises en charge pour 
l’enregistrement de données proxy

ˎˎ Cartes mémoire SDHC* (classe de vitesse : 4 
ou plus, non UHS, capacité : 4 Go à 32 Go)
ˎˎ Cartes mémoire SDXC* (classe de vitesse : 4 
ou plus, non UHS, capacité : 64 Go à 256 Go)

* Désignées sous le nom de « Cartes SD » dans ce 
manuel.

Formatage (initialisation) des cartes SD

Les cartes SD doivent être formatées lors de 
leur première utilisation dans le caméscope.
Les cartes SD devant être utilisées dans le 
caméscope doivent être formatées à l’aide 
de la fonction de formatage du caméscope. 
Si un message s’affiche quand la carte SD est 
insérée dans le caméscope, formatez la carte 
SD.

1 Sélectionnez Operation >XAVC Proxy Rec 
Mode >Setting dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [On], puis appuyez sur le 
bouton.

3 Sélectionnez Operation >Format Media 
>SD Card(Proxy) dans le menu de 
configuration.

4 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Un écran de confirmation vous proposant 
de formater la carte s’affiche.

5 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Le formatage commence.
Pendant le formatage, un message et 
l’état de progression (%) s’affichent et 
l’indicateur ACCESS est allumé en orange.
A la fin du formatage, un message 
d’achèvement apparaît. Appuyez sur le 
bouton MENU pour faire disparaître ce 
message.

[Remarque]
Le formatage d’une carte SD efface toutes les données 
sur la carte. La carte ne peut pas être restaurée.

Vérification de la capacité 
d’enregistrement restante

Vous pouvez vérifier la capacité restante 
sur une carte SD sur l’écran Media Status 
(page 16).

Pour utiliser une carte SD formatée sur 
le caméscope dans la fente d’un autre 
dispositif

Effectuez d’abord une copie de sauvegarde 
de la carte, puis reformatez la carte dans le 
dispositif à utiliser.
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Enregistrement des données 
proxy

Pour enregistrer des données proxy 
simultanément

Vous pouvez enregistrer des données 
proxy sur une carte SD simultanément à 
l’enregistrement sur des cartes mémoire SxS.

1 Sélectionnez Operation >XAVC Proxy Rec 
Mode >Setting dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [On], puis appuyez sur le 
bouton.

3 Insérez une carte SD pour 
l’enregistrement de données proxy dans 
le logement de carte PROXY SD.

4 Démarrez l’enregistrement.
Le fichier de données proxy est 
sauvegardé dans le  
répertoire « /PRIVATE/PXROOT/Clip » de 
la carte SD en même temps que 
l’enregistrement des données d’origine 
sur la carte mémoire SxS.
L’enregistrement de données proxy 
s’arrête automatiquement lorsque vous 
arrêtez l’enregistrement.

[Remarque]
L’enregistrement simultané de données proxy lorsque 
le format de sortie SDI est 3840×2160P provoque un 
basculement automatique du réglage du format de 
sortie SDI sur 1920×1080P (Level-B).

Pour enregistrer des données proxy 
indépendamment des données 
d’enregistrement originales

Vous pouvez enregistrer des données proxy 
sur une carte SD indépendamment des cartes 
mémoire SxS en attribuant la fonction XAVC 
Proxy Rec Start à un commutateur attribuable.

[Remarques]
ˎˎ Si l’enregistrement proxy simultané est démarré 

pendant l’enregistrement des données proxy 
indépendant est en cours, l’enregistrement des 
données proxy se poursuivra sans interruption. 
Ensuite, lorsque l’enregistrement simultané est 
arrêté, l’enregistrement des données proxy s’arrêtera 
également.
ˎˎ L’enregistrement proxy ne peut pas être arrêté de 

façon indépendante pendant l’enregistrement proxy 
simultané.

Limites d’enregistrement proxy

L’enregistrement proxy n’est pas pris en 
charge lorsque l’une des fonctions suivantes 
est activée.
ˎˎ Lors de la lecture en transit (Maintenance 
>Streaming >Setting dans le menu de 
configuration réglé sur On)
ˎˎ Lors de l’enregistrement à intervalles 
(Operation >Rec Function >Interval Rec dans 
le menu de configuration réglé sur On)
ˎˎ Enregistrement de cache d’image 
(Operation >Rec Function >Picture Cache 
Rec dans le menu de configuration réglé sur 
On)
ˎˎ En mode ralenti et accéléré (Operation >Rec 
Function >Slow & Quick Motion dans le 
menu de configuration réglé sur On)
ˎˎ Lorsque le mode client réseau est activé 
(Maintenance >Network Client Mode 
>Setting est réglé sur On dans le menu de 
configuration), Maintenance >Network Client 
Mode >Preset 1, Preset 2 ou Preset 3 >NCM 
with Proxy est réglé sur Disable dans le 
menu de configuration.

ˎˎ Lorsque Operation >Format >Frequency 
dans le menu de configuration est réglé sur 
23.98P et Operation >XAVC Proxy Rec Mode 
>Size est réglé sur HD Auto(9Mbps) ou HD 
Auto(6Mbps)
ˎˎ L’enregistrement proxy n’est pas possible 
lorsque l’alimentation est fournie au 
connecteur de dispositif externe (Operation 
>USB dans le menu de configuration).
ˎˎ Il est possible d’enregistrer un maximum de 
600 plans.

Au sujet des fichiers enregistrés

ˎˎ L’extension de fichier est « .mp4 ».
ˎˎ Le code temporel est également enregistré 
simultanément.
ˎˎ Une image fixe de la première image est 
également enregistrée simultanément.
ˎˎ Les informations de lieu et un fichier journal 
sont enregistrés simultanément lorsque la 
fonction GPS est activée. Le fichier journal 
est sauvegardé dans « Root/PRIVATE/SONY/
GPS ».

Annulation de l’enregistrement de 
données proxy

Réglez Operation >XAVC Proxy Rec Mode 
>Setting dans le menu de configuration sur 
Off.

Lorsque la capacité restante sur une 
carte SD est insuffisante

Un avertissement s’affiche pour indiquer un 
manque d’espace libre.

Modification des paramètres 
d’enregistrement proxy

Sélectionnez Operation >XAVC Proxy Rec 
Mode >Size et Audio Channel dans le menu de 
configuration pour modifier les paramètres de 

taille pour le format d’enregistrement proxy 
et le canal audio pour l’enregistrement proxy, 
respectivement.

[Remarque]
Lorsque Operation >XAVC Proxy Rec Mode >Size dans le 
menu de configuration est réglé sur HD Auto(9Mbps) ou 
HD Auto(6Mbps) et la fréquence du système est réglée 
sur 29.97 ou 25, la taille d’image des données proxy 
sera réglée sur 1920×1080 même si la taille d’image du 
format vidéo d’enregistrement est réglée sur 1280×720.

Vérification des paramètres 
d’enregistrement proxy

Sélectionnez Operation >XAVC Proxy Rec 
Mode >Frame Rate et Bit Rate dans le menu 
de configuration, pour visualiser les réglages 
de fréquence d’images vidéo et le débit 
binaire vidéo, respectivement.
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Métadonnées de planification
Les données de planification sont des 
informations sur les plans de tournage et 
d’enregistrement, enregistrées dans un fichier 
XML.
Vous pouvez filmer avec des noms de plans et 
des noms de repères de prise de vue définis 
à l’avance dans un fichier de métadonnées de 
planification.
Vous pouvez envoyer et recevoir des 
métadonnées de planification à l’aide de 
l’application « Content Browser Mobile ».

[Remarque]
Utilisez un réglage de police compatible avec la langue 
définie à l’aide de Maintenance >Language dans le 
menu de configuration lors de la définition des noms de 
plans et des noms de repères de prise de vue. Utiliser 
des polices pour une langue différente du réglage de 
langue sur le caméscope peut engendrer un affichage 
anormal du texte.

Chargement d’un fichier de 
métadonnées de planification 
dans la mémoire du caméscope 
lors de l’enregistrement d’un plan

1 Auparavant, sauvegardez le fichier de 
métadonnées de planification sur une 
carte mémoire SxS.
Les fichiers de métadonnées de 
planification sont stockés dans le 
répertoire « General/Sony/Planning ».

2 Insérez une carte mémoire SxS dans le 
logement A ou B.

3 Sélectionnez Operation >Planning 
Metadata >Load from Media(A) ou Load 
from Media(B) dans le menu de 
configuration.

Un écran de liste de fichiers s’affiche.
Jusqu’à 512 fichiers de méta-données de 
planification sont affichés dans la liste.
Vous pouvez modifier l’ordre de tri de la 
liste de fichiers à l’aide de Operation 
>Planning Metadata >Sort by dans le 
menu.

Réglage « Sort 
by »

Ordre de tri

Date/Time (0-9) Permet de trier la liste 
de fichiers en ordre 
croissant dans la 
colonne Date/Time 
(date de création la plus 
ancienne en haut).

Date/Time (9-0) Permet de trier la liste 
de fichiers en ordre 
décroissant dans la 
colonne Date/Time 
(date de création la plus 
récente en haut).

4 Tournez le bouton MENU pour 
sélectionner un fichier à charger puis 
appuyez sur le bouton MENU.

5 Tournez le bouton MENU pour 
sélectionner [Load] et appuyez sur le 
bouton, puis sélectionnez [Execute] et 
appuyez à nouveau sur le bouton.

[Remarque]
Les fichiers de métadonnées de planification peuvent 
être chargés à partir de cartes SDXC en utilisant 
un adaptateur de support MEAD-SD02 optionnel. 
Cependant, les données ne peuvent pas être chargées à 
partir de cartes SDHC/SD.

Affichage des informations 
détaillées des métadonnées de 
planification

Après avoir chargé les métadonnées de 
planification dans ce caméscope, vous pouvez 
vérifier les informations détaillées qu’il 
contient, comme les noms de fichiers, la date 
et l’heure de création et les titres.

1 Sélectionnez Operation >Planning 
Metadata >Properties dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [Execute] puis appuyez sur le 
bouton.
Les informations de métadonnées de 
planification s’affichent.

Elément Informations

File Name Nom du fichier

Assign ID Identifiant attribué

Created Date et heure de création

Modified Date et heure de la dernière 
modification

Modified by Nom de la personne qui a 
modifié le fichier

Title Titre 1 spécifié dans le 
fichier (nom de plan au 
format ASCII)

Title2 Titre 2 spécifié dans le 
fichier (nom de plan au 
format UTF-8)

Material 
Group

Nombre de groupe de 
données a)

Shot Mark0 à 
Shot Mark9

Noms définis dans le fichier 
pour Shot Mark 0 à Shot 
Mark 9

a) Groupe de données : un groupe de plans 
enregistrés avec les mêmes données de 
planification.

Vous pouvez tourner le bouton MENU 
pour faire défiler la liste.

Effacement des métadonnées de 
planification chargées

1 Sélectionnez Operation >Planning 
Metadata >Clear Memory dans le menu 
de configuration.

2 Tournez le bouton MENU pour 
sélectionner [Execute] puis appuyez sur le 
bouton.
La suppression démarre.  
Lorsque la suppression est terminée, le 
message suivant apparaît.
Clear Planning Metadata File
Done

Définition des noms de plans 
dans les métadonnées de 
planification

Les deux types suivants de chaînes de nom 
de plan peuvent être écrits dans un fichier de 
métadonnées de planification.
ˎˎ Le nom au format ASCII qui apparaît dans le 
viseur
ˎˎ Le nom au format UTF-8 qui est enregistré 
en fait comme nom de plan

Vous pouvez sélectionner quel type de nom 
de plan est affiché à l’aide de Operation 
>Planning Metadata >Clip Name Disp dans le 
menu de configuration.
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Lorsqu’un nom de plan est réglé avec les 
métadonnées de planification, le nom de plan 
est affiché.

[Remarque]
Lorsque vous définissez aussi bien le nom au format 
ASCII que le nom au format UTF-8 avec les métadonnées 
de planification, la chaîne au format UTF-8 est utilisée 
comme chaîne de nom de plan. Si vous définissez le 
nom au format ASCII ou le nom au format UTF-8 avec les 
métadonnées de planification, le nom au format défini 
est affiché bien qu’il n’ait pas été sélectionné par un 
réglage de menu.

Exemple de chaîne de nom de plan

Utilisez un éditeur de texte pour modifier 
les deux champs dans la balise <Title> qui 
contiennent les chaînes de nom de plan.
Les champs grisés dans l’exemple sont les 
chaînes de nom de plan. « Typhon » est 
décrit au format ASCII (jusqu’à 44 caractères). 
« Typhon_frappe_Tokyo » est décrit au format 
UTF-8 (jusqu’à 44 octets).
« sp » indique un espace et  indique un 
retour chariot.

<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadataspxmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
P0001"spcreationDate="
2019-10-06T17:00:00+09:00"sp

lastUpdate="
2019-10-06T17:00:00+09:00"sp

version="1.00">
<PropertiessppropertyId="
assignment"spupdate="
2019-10-06T17:00:00+09:00"sp

modifiedBy="Chris">
<TitlespusAscii="Typhon"sp

xml:lang="fr">Typhon_frappe_Tokyo
</Title>
</Properties>

</PlanningMetadata>

[Remarques]
ˎˎ Lorsque vous créez un fichier, saisissez chaque 

énoncé sur une seule ligne avec un CRLF après 
le dernier caractère de la ligne de l’énoncé, et ne 
saisissez pas d’espace sauf là où c’est spécifié.
ˎˎ Les caractères suivants ne peuvent pas être utilisés 

dans les noms de plans. S’ils sont utilisés, ils sont 
remplacés par un tiret bas (_). 
"  *  /  :  <  >  ?  \  |
ˎˎ Jusqu’à 44 octets (ou caractères) peuvent être saisis 

pour le nom du plan.  
Si la chaîne au format UTF-8 dépasse 44 octets, les 44 
premiers octets sont utilisés comme nom du plan.  
Si seul un nom au format ASCII est spécifié, une 
chaîne de 44 caractères est utilisée comme nom du 
plan.  
Lorsqu’une chaîne au format ASCII ni une chaîne au 
format UTF-8 peuvent être utilisées, le nom de plan 
de format standard est utilisé.

Réglage des noms de plans

1 Chargez un fichier de métadonnées de 
planification contenant des noms de 
plans dans la mémoire du caméscope 
(page 110).

2 Réglez Operation >Clip >Clip Naming dans 
le menu de configuration sur Plan.
A chaque fois que vous enregistrez un 
plan, le caméscope génère 
automatiquement un nom composé du 
nom de plan défini dans le fichier de 
métadonnées de planification suivi d’une 
barre de soulignement (_) et d’un numéro 
de série à cinq chiffres (00001 à 99999).  
Exemples : Typhon_frappe_Tokyo_00001, 
Typhon_frappe_Tokyo_00002, …Une fois 
que le numéro atteint 99999, la valeur du 
prochain numéro revient à 00001.

[Remarque]
Lorsque vous chargez un autre fichier de métadonnées 
de planification, le numéro de série continue à 
augmenter. Vous pouvez changer la numérotation dans 
Operation >Clip >Number Set du menu de configuration.

Sélection du format d’affichage des 
noms de plans

Lorsque les noms sont définis aussi bien au 
format ASCII qu’au format UTF-8, vous pouvez 
utiliser Operation >Planning Metadata >Clip 
Name Disp dans le menu de configuration 
pour sélectionner lequel des deux noms 
afficher sur le moniteur LCD et sur l’écran du 
viseur.
Pour afficher les noms au format ASCII : 

sélectionnez Title1(ASCII).  
Le nom de plan devient « Typhon_frappe_
Tokyo_NuméroSérie », mais « Typhon_
NuméroSérie » est affiché sur l’écran.

Pour afficher les noms au format UTF-8 : 
sélectionnez Title2(UTF-8).  
Le nom de plan devient « Typhon_frappe_
Tokyo_NuméroSérie », et le même nom est 
affiché sur l’écran.

Définition des noms de repères de 
prise de vue dans les 
métadonnées de planification

Lorsque vous utilisez les métadonnées de 
planification pour régler les repères de prise 
de vue, vous pouvez définir les noms pour les 
repères Shot Mark 0 à Shot Mark 9.
Lorsque vous enregistrez des repères de prise 
de vue, vous pouvez ajouter les chaînes de 
nom de repère de prise de vue définies dans 
les métadonnées de planification.

[Remarque]
Les repères Shot Mark 1 et Shot Mark 2 peuvent être 
enregistrés sur le caméscope.

Exemple de chaîne de nom de repère de 
prise de vue

Utilisez un éditeur de texte pour modifier les 
champs dans la balise <Meta name>.
Les champs grisés dans l’exemple sont les 
chaînes de nom de repère. Les noms peuvent 
être au format ASCII (jusqu’à 32 caractères) ou 
au format UTF-8 (jusqu’à 16 caractères).
« sp » indique un espace et  indique un 
retour chariot.

[Remarque]
Si une chaîne de nom contient ne fût-ce qu’un caractère 
de format autre que ASCII, sa longueur maximale est de 
16 caractères.

<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadata xmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
H00123"spcreationDate="
2019-10-27T08:00:00Z"splastUpdate="
2019-10-27T15:00:00Z"spversion=
"1.00">
<PropertiessppropertyId=
"assignment"spclass="original"sp

update="2019-10-27T15:00:00Z"sp

modifiedBy="Chris">
<TitlespusAscii="Football
Game"spxml:lang="en">
Football Game 27/10/2019</
Title>

<Metaspname="_ShotMark1"sp

content="Goal"/>
<Metaspname="_ShotMark2"sp

content="Shoot"/>
<Metaspname="_ShotMark3"sp

content="Corner Kick"/>
<Metaspname="_ShotMark4"sp

content="Free Kick"/>
<Metaspname="_ShotMark5"sp

content="Goal Kick"/>
<Metaspname="_ShotMark6"sp
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content="Foul"/>
<Metaspname="_ShotMark7"sp

content="PK"/>
<Metaspname="_ShotMark8"sp

content="1st Half"/>
<Metaspname="_ShotMark9"sp

content="2nd Half"/>
<Metaspname="_ShotMark0"sp

content="Kick Off"/>
</Properties>

</PlanningMetadata>

[Remarque]
Lorsque vous créez un fichier de définition, saisissez 
chaque énoncé sur une seule ligne avec un CRLF 
après le dernier caractère de la ligne de l’énoncé, et ne 
saisissez pas d’espace sauf là où c’est spécifié, excepté 
dans les chaînes de nom de repère.
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Obtention d’informations de lieu (GPS)
Lorsque la géolocalisation est activée, les 
informations de lieu et d’heure de la vidéo 
tournée sont enregistrées par le caméscope. 
Ces informations sont également superposées 
sur la sortie du signal SDI.
La fonction GPS est réglée sur Off par défaut.

Formats pris en charge pour 
l’enregistrement GPS

L’enregistrement GPS est pris en charge 
dans les formats d’enregistrement XAVC-I et 
XAVC-L.
Lorsqu’un format d’enregistrement qui ne 
prend pas en charge l’enregistrement GPS 
est réglé, les informations de lieu peuvent 
toujours être obtenues sur une sortie SDI si la 
sortie SDI est réglée sur On (Operation >Input/
Output >SDI Out1 Output ou SDI Out2 Output 
réglé sur On).

[Remarque]
Les informations de lieu ne sont pas émises lorsque le 
format est SD SDI. Elles ne sont pas non plus émises 
pendant la lecture.

1 Vérifiez que le caméscope est en mode de 
veille.

2 Réglez Operation >GPS sur On dans le 
menu de configuration.

 s’affiche dans le viseur quand le 
caméscope cherche des satellites GPS. 
Lorsque la géolocalisation est établie, les 
informations de lieu sont enregistrées lors 
du tournage d’une vidéo.

L’icône affichée dans le viseur varie, en 
fonction de la réception du signal des 
satellites GPS.

État de 
géolocalisation

Affichage État de réception 
GPS

Désactivé Pas 
d’affichage

GPS est réglé sur 
Off ou une erreur 
s’est produite.

Géolocalisation 
non disponible

Les informations 
de lieu n’ont pas 
pu être obtenues 
car aucun signal 
GPS n’a pu être 
reçu. Déplacez-
vous vers un lieu 
présentant une 
vision dégagée 
du ciel.

Recherche de 
satellites

Recherche de 
satellites GPS. 
L’acquisition des 
satellites peut 
prendre plusieurs 
minutes.

Géolocalisation Un signal GPS 
faible est reçu.

Un signal GPS est 
reçu. Les 
informations de 
lieu peuvent être 
acquises.

Un signal GPS fort 
est reçu. Les 
informations de 
lieu peuvent être 
acquises.

ˎˎ Il peut falloir un certain temps pour 
commencer à acquérir des informations de 
lieu après la mise en marche du caméscope.
ˎˎ Si une icône de positionnement ne s’affiche 
pas au bout de plusieurs minutes, il se 
peut qu’il y ait un problème de réception 
du signal. Commencez à filmer sans 
informations de lieu ou déplacez-vous vers 
un endroit disposant d’une vision dégagée 
du ciel. Le fait de filmer quand l’icône de 
géolocalisation n’est pas affichée signifie 

que les informations de lieu ne sont pas 
enregistrées.
ˎˎ Le signal de GPS peut ne pas être reçu en 
intérieur à proximité de structures élevées. 
Déplacez-vous vers un lieu présentant une 
vision dégagée du ciel.
ˎˎ L’enregistrement des informations de lieu 
peut être interrompu, en fonction de la 
force du signal reçu, même si une icône de 
positionnement est affichée.
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Fonctions de réseau prises en charge par le caméscope
5. Configuration du réseau

Le caméscope prend en charge diverses 
fonctions de réseau. Cette section fournit 
un aperçu et une description détaillée des 
connexions et des fonctions réseau.
Configurez un mot de passe afin d’utiliser 
les fonctions réseau à l’aide de Access 
Authentication >Password.

[Remarques]
ˎˎ Le réglage Access Authentication >Password est 

vide lorsque les fonctions réseau sont utilisées pour 
la première fois et après la mise à jour du logiciel 
à la version 2.0 ou ultérieure à partir d’une version 
antérieure à 2.0 ou bien après la mise à jour du 
logiciel à la version 3.1 ou ultérieure à partir d’une 
version antérieure à 3.1.
ˎˎ Si aucun mot de passe n’est configuré, les éléments 

du menu Network dans le menu de configuration 
sont désactivés (grisés), et les réglages de réseau ne 
peuvent pas être configurés.

Aperçu de la connexion réseau

Connexion de dispositifs à l’aide du LAN 
sans fil

Le caméscope peut se connecter à des 
smartphones, tablettes et autres dispositifs 
à l’aide d’une connexion LAN sans fil en 
utilisant le module USB LAN sans fil IFU-WLM3 
(fourni) ou l’adaptateur LAN sans fil CBK-WA02 
(optionnel).

1 Sélectionnez le dispositif de connexion 
sans fil.
Module USB LAN sans fil IFU-WLM3 
(fourni)  (page 63)
Adaptateur LAN sans fil CBK-WA02 
(optionnel)  (page 63)

2 Sélectionnez le mode d’accès LAN sans fil.
Mode Wi-Fi Access Point  (page 64)
Mode Wi-Fi Station  (page 65)

Connexion à Internet avec un câble LAN

Connectez le caméscope à Internet via un 
routeur en utilisant le connecteur réseau.

1 Raccordez le caméscope au routeur à 
l’aide d’un câble LAN.
 (page 67)

Connexion à Internet avec le LAN sans fil

Connectez le caméscope à Internet à l’aide 
du module USB LAN sans fil IFU-WLM3 
(fourni), à l’adaptateur LAN sans fil CBK-WA02 
(optionnel), ou à un modem (optionnel).

[Remarque]
Le kit d’adaptateur réseau CBK-NA1 (optionnel) est 
requis pour la connexion avec un adaptateur LAN sans fil 
CBK-WA02 (optionnel) ou un modem (optionnel).

Lors de l’utilisation de l’IFU-WLM3 (fourni)

1 Fixez l’IFU-WLM3 au caméscope.
 (page 63)

2 Réglez le mode d’accès LAN sans fil sur le 
mode Wi-Fi Station et connectez à 
Internet.
 (page 69)

Lors de l’utilisation du CBK-WA02 (optionnel)

1 Fixez le CBK-WA02 au caméscope.
 (page 63)

2 Réglez le mode d’accès LAN sans fil sur le 
mode Wi-Fi Station et connectez à 
Internet.
 (page 69)

Utilisation d’un modem

1 Fixez l’adaptateur d’extension USB du 
CBK-NA1 (optionnel).
 (page 67)

2 Connectez le modem.
 (page 68)

Aperçu de la fonction réseau

Transfert de fichiers enregistrés sur le 
caméscope vers un serveur sur Internet

Vous pouvez transférer des fichiers proxy 
enregistrés sur une carte SD et des fichiers 
originaux enregistrés sur des cartes mémoire 
SxS vers un serveur sur Internet lorsque vous 
êtes connecté à Internet par l’intermédiaire 
d’un réseau 3G/4G/LTE, d’un point d’accès ou 
d’un routeur LAN sans fil.
 (page 71)

Diffusion de contenus vidéo et audio en 
lecture en transit

Vous pouvez diffuser la vidéo ou l’audio 
enregistré avec le caméscope via Internet ou 
le réseau local.

Lecture en transit en utilisant les réglages de 
lecture en transit du caméscope
 (page 75)

Lecture en transit haute qualité à l’aide de 
Connection Control Manager (CCM) d’une 
station réseau RX Sony (en option) ou de C3 
Portal
 (page 76)

Utilisation de la commande à distance 
Wi-Fi

Vous pouvez accéder à la commande à 

distance Wi-Fi intégrée dans le caméscope à 
partir d’un smartphone, d’une tablette ou de 
tout autre dispositif par l’intermédiaire d’une 
connexion LAN sans fil.
 (page 78)

Configuration depuis le menu Web

Le menu Web du caméscope s’affiche quand 
le caméscope est commandé à partir d’un 
navigateur sur un dispositif connecté à l’aide 
d’une connexion LAN sans fil.
 (page 80)

Fonctions de réseau prises en charge et 
restrictions de fonctionnement

 (page 86)
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Connexion de dispositifs à l’aide du LAN sans fil
Le caméscope peut se connecter à des 
smartphones, tablettes et autres dispositifs 
à l’aide d’une connexion LAN sans fil en 
raccordant le module USB LAN sans fil IFU-
WLM3 (fourni) ou l’adaptateur LAN sans fil 
CBK-WA02 (optionnel).
Les opérations suivantes peuvent être 
effectuées entre le caméscope et les 
dispositifs connectés à l’aide d’un LAN sans fil.

[Remarque]
Les modules/adaptateurs USB LAN sans fil autres que 
le modèle IFU-WLM3 ou CBK-WA02 ne peuvent pas être 
utilisés.

Commande à distance par LAN sans fil
Le caméscope peut être commandé à distance 
à partir d’un smartphone, d’une tablette ou 
d’un ordinateur connecté à l’aide d’un LAN 
sans fil.

Transfert de fichiers par l’intermédiaire d’un 
LAN sans fil
Les fichiers proxy (fichiers à basse résolution) 
stockés sur la carte SD du caméscope et les 
fichiers originaux (fichiers à haute résolution) 
enregistrés sur le caméscope peuvent être 
transférés vers un serveur par l’intermédiaire 
d’un LAN sans fil.

Surveillance vidéo par LAN sans fil
Vous pouvez créer un flux de lecture en transit 
(H.264) de l’image de caméra ou de l’image 
de lecture du caméscope pour la surveillance 
à partir d’un dispositif connecté par LAN sans 
fil à l’aide de l’application « Content Browser 
Mobile ».

« Content Browser Mobile » est une 
application qui peut faire fonctionner le 
caméscope à distance sur l’écran du dispositif, 
tout en visionnant du contenu en lecture en 
transit et qui peut être utilisée pour configurer 
le caméscope.

Vous pouvez également transférer une partie 
sélectionnée d’un fichier en définissant les 
repères de début et de fin dans le fichier proxy 
(page 72).
Vérifiez toujours que vous avez la dernière 
version de l’application « Content Browser 
Mobile ».

Pour de plus amples informations concernant l’application 
« Content Browser Mobile », contactez un représentant ou 
un technicien Sony.

[Remarques]
ˎˎ Les fichiers proxy (fichiers à basse résolution) 

enregistrés sur la carte SD dans le caméscope 
peuvent être lus en transit via un LAN sans fil.
ˎˎ Les obstacles et interférences électromagnétiques 

entre le caméscope et le terminal ou le point 
d’accès LAN sans fil, ainsi que l’environnement 
ambiant (matériaux des murs, par exemple) peuvent 
réduire la portée de communication ou empêcher 
l’établissement des connexions. Si vous êtes 
confronté à ce type de problème, vérifiez l’état de 
la connexion/communication après avoir déplacé 
le caméscope dans un autre endroit ou après avoir 
rapproché le caméscope et le point d’accès/terminal.

Dispositifs compatibles

Vous pouvez utiliser un smartphone, une 
tablette ou un ordinateur pour configurer et 
utiliser le caméscope. Les dispositifs, le système 
d’exploitation et les navigateurs pris en charge 
sont affichés dans le tableau suivant.

Dispositif Système 
d’exploitation

Navigateur

Smartphone Android 11/12 Chrome

iOS 15.x Safari

Tablette Android 10/11 Chrome

iPadOS 15.x Safari

Ordinateur Microsoft 
Windows 10/11

Chrome

macOS 12.x Safari

[Remarques]
ˎˎ L’image peut ne pas s’afficher correctement, selon la 

version de votre navigateur.  
Le fonctionnement a été vérifié dans les versions de 
navigateur suivantes.  
Safari : 15 
Chrome : 103
ˎˎ Il est possible que la lecture ne soit pas prise en 

charge, en fonction du système d’exploitation 
du dispositif terminal utilisé et de la version du 
navigateur. Si cela se produit, utilisez « Content 
Browser Mobile ».

Fixation de l’IFU-WLM3

1 Ouvrez le cache du connecteur de module 
USB LAN sans fil.

Garde protectrice (fourni)

2 Fixez le cache de protection sur l’IFU-
WLM3.

3 Branchez l’IFU-WLM3 sur le connecteur.

[Remarque]
Mettez toujours le caméscope hors tension avant 
connecter ou de retirer l’IFU-WLM3.

Si vous n’utilisez pas l’IFU-WLM3

Dévissez les deux vis, retirez la garde 
protectrice et fermez le cache du connecteur.

Fixation du CBK-WA02

1 Fixez le support de fixation à la poignée 
dans la position illustrée dans l’image 
ci-dessous.
Pour la fixation du support de fixation 
(référence Nº A-2092-367-), contactez un 
technicien Sony.

Support de fixation
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2 Fixez l’adaptateur d’extension USB fourni 
avec le CBK-WA02 (optionnel) au support 
de fixation.

3 Serrez la vis de fixation dans le sens des 
aiguilles d’une montre pour fixer 
l’adaptateur d’extension USB.

Vis de fixation

Adaptateur d’extension USB

Vous pouvez ajuster la position de 
l’adaptateur d’extension USB en le glissant 
tel qu’indiqué dans l’image ci-dessous.

4 Fixez le cache de protection (fourni) au 
connecteur USB de l’adaptateur 
d’extension USB.

5 Ouvrez le cache du connecteur de module 
USB LAN sans fil.

Garde protectrice (fourni)

6 Branchez le connecteur USB de 
l’adaptateur d’extension USB dans le 
connecteur de module USB LAN sans fil.

7 Branchez le CBK-WA02 dans le connecteur 
USB de l’adaptateur d’extension USB.

8 Réglez le canal LAN sans fil dans 
Maintenance >Network >Channel du 
menu de configuration (page 125).

Pour plus de détails sur l’utilisation du CBK-WA02, 
reportez-vous au mode d’emploi fourni avec le CBK-WA02.

[Remarques]
ˎˎ Mettez toujours le caméscope hors tension avant de 

connecter ou de retirer le CBK-WA02.
ˎˎ Branchez le CBK-WA02 et sélectionnez Wi-Fi Station 

dans Maintenance >Network >Wi-Fi Mode du menu 
de configuration pour permettre une connexion à un 
point d’accès de 5 GHz.
ˎˎ Le réglage de canal « Auto(5GHz) » en mode Wi-Fi 

Access Point peut ne pas être affiché en fonction du 
CBK-WA02 utilisé.
ˎˎ « Auto(5GHz) » n’est pas affiché dans le menu si 

l’utilisation du CBK-WA02 dans la bande 5 GHz est 
interdite pour une utilisation extérieure dans votre 
pays ou votre région. Vérifiez que l’utilisation du CBK-
WA02 est permise dans votre pays ou région. Pour 
plus de détails, reportez-vous au manuel d’utilisation 
du CBK-WA02.

Si vous n’utilisez pas le CBK-WA02

Dévissez les deux vis, retirez la garde 
protectrice et fermez le cache du connecteur.

Connexion à l’aide du point 
d’accès de LAN sans fil (mode 
Wi-Fi Access Point)

Le caméscope peut se connecter aux 
dispositifs qui sont configurés comme points 
d’accès.

Smartphone/
Tablette

Ordinateur

Installez « Content Browser Mobile » sur le 
dispositif à raccorder avant de commencer la 
configuration de la connexion.

[Remarque]
Le mot de passe par défaut de Wi-Fi Access Point ne 
doit pas être utilisé tel quel. Utilisez un mot de passe en 
suivant la procédure suivante.
1 Réglez Maintenance >Network >Setting sur On.
2 Réglez Maintenance >Network >Wi-Fi Mode sur Wi-Fi 

Access Point.
3 Exécutez Maintenance >Network >Regenerate 

Password.
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Connexion une touche à l’aide des 
dispositifs équipés de la technologie 
NFC

Les dispositifs prenant en charge la 
technologie NFC peuvent être connectés par la 
connexion une touche à l’aide de la NFC.

1 Sélectionnez [Settings] sur le dispositif et 
activez la fonction [NFC].

2 Allumez le caméscope et réglez 
Maintenance >Network >Setting sur On.

3 Réglez Maintenance >Network >Wi-Fi 
Mode sur Wi-Fi Access Point.

4 Active la fonction NFC.
Réglez le mode de connexion NFC en 
exécutant Maintenance >Network >NFC 
dans le menu de configuration ou 
appuyez et maintenez enfoncé un 
commutateur attribuable qui a été 
attribué avec la fonction NFC pendant 
trois secondes.
La fonction NFC ne peut être utilisée que 
lorsque  est affiché sur l’écran.

[Remarque]
Cela peut prendre un certain temps (30 secondes à 
90 secondes) avant que  n’apparaisse sur l’écran. 
Attendez jusqu’à ce que l’indicateur de réseau sans 
fil « AP » (point d’accès) du réseau (page 20) 
cesse de clignoter sur l’écran du viseur.

5 Touchez le dispositif sur le caméscope.
Le dispositif se connecte au caméscope et 
« Content Browser Mobile » est lancé.

[Remarques]
ˎˎ Sortez le dispositif de l’hibernation et déverrouillez 

l’écran de verrouillage au préalable.
ˎˎ Continuez à tenir le dispositif contre le caméscope, 

sans le déplacer jusqu’à ce que « Content Browser 
Mobile » soit lancé (1 à 2 secondes).
ˎˎ Si un dispositif avec un SSID identique a déjà été 

enregistré, il est possible que le dispositif ne puisse 
pas être connecté, en fonction de la version du 
système d’exploitation du dispositif. Dans ce cas, vous 
pouvez connecter le dispositif en supprimant le SSID 
enregistré du dispositif.

Connexion à l’aide de dispositifs 
équipés du WPS

Les dispositifs qui prennent en charge le WPS 
peuvent être connectés à l’aide du WPS.

1 Réglez Maintenance >Network >Setting 
sur On.

2 Réglez Maintenance >Network >Wi-Fi 
Mode sur Wi-Fi Access Point.

[Remarque]
Il peut falloir un certain temps (30 secondes à 90 
secondes) pour activer le mode de point d’accès. 
Attendez jusqu’à ce que l’indicateur « AP » (point 
d’accès) du réseau (page 20) cesse de clignoter 
sur le moniteur LCD ou dans le viseur.

3 Sélectionnez Maintenance >Network 
>WPS dans le menu de configuration.

4 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

5 Ouvrez les réglages réseau ou les 
réglages Wi-Fi du dispositif et activez la 
Wi-Fi.

6 Sélectionnez le SSID du caméscope à 
partir de la liste SSID du réseau Wi-Fi, 
affichez Option, puis sélectionnez le 
bouton poussoir WPS.

[Remarque]
Les étapes varient en fonction du dispositif utilisé.

Connexion à l’aide d’un SSID et d’un 
mot de passe sur le dispositif

Connectez-vous en saisissant le SSID et le mot 
de passe sur le dispositif.

1 Réglez Maintenance >Network >Setting 
sur On.

2 Réglez Maintenance >Network >Wi-Fi 
Mode sur Wi-Fi Access Point.

[Remarque]
Il peut falloir un certain temps (30 secondes à 90 
secondes) pour activer le mode de point d’accès. 
Attendez jusqu’à ce que l’indicateur « AP » (point 
d’accès) du réseau (page 20) cesse de clignoter 
sur le moniteur LCD ou dans le viseur.

3 Ouvrez les réglages réseau ou les 
réglages Wi-Fi du dispositif et activez la 
Wi-Fi.

4 Sélectionnez le SSID du caméscope à 
partir de la liste de SSID du réseau Wi-Fi, 
puis saisissez un mot de passe pour vous 
connecter.
Pour le SSID et le mot de passe du 
caméscope, reportez-vous à Maintenance 
>Network >SSID & Password (page 125) 
dans le menu de configuration.

[Remarque]
Les étapes varient en fonction du dispositif utilisé.

Connexion à l’aide du mode 
Wireless LAN Station (mode Wi-Fi 
Station)

Le caméscope peut se connecter à un point 
d’accès de LAN sans fil existant en tant que 
client.
Le dispositif se connecte par l’intermédiaire du 
point d’accès.
La connexion peut être établie à l’aide du 
menu de configuration ou du menu Web. 
Cette section décrit la méthode utilisant la 
fonction WPS dans le menu de configuration.
Pour de plus amples informations sur la 
connexion par le biais du menu Web, reportez-
vous à « Connexion à un point d’accès en 
mode station sans utiliser la fonction WPS » 
(page 82).
Pour de plus amples informations sur la 
connexion à l’aide de la fonction de détection 
automatique de réseau ou par saisie 
manuelle, consultez « Connexion à un point 
d’accès à l’aide du menu de configuration » 
(page 69).
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Smartphone/
Tablette

Ordinateur

Point 
d’accès

Connexion à un point d’accès à l’aide de 
la fonction WPS

Si un point d’accès prend en charge la fonction 
WPS, vous pouvez vous connecter à l’aide 
d’un réglage de base.

1 Mettez le point d’accès en marche.

2 Mettez le caméscope sous tension.

3 Réglez Maintenance >Network >Setting 
sur On.

4 Réglez Maintenance >Network >Wi-Fi 
Mode sur Wi-Fi Station.

[Remarque]
Il peut falloir un certain temps (30 secondes à 1 
minute) pour activer le mode station. Attendez 
jusqu’à ce que l’icône de puissance de signal 
(page 20) de l’indicateur du réseau cesse de 
clignoter sur le moniteur LCD ou dans le viseur.

5 Sélectionnez Maintenance >Network 
>WPS dans le menu de configuration.

6 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

7 Appuyez sur la touche WPS du point 
d’accès.
Pour de plus amples informations 
concernant le fonctionnement de la 
touche WPS, reportez-vous au mode 
d’emploi du point d’accès.
Quand la connexion est réussie, l’icône de 
puissance de signal (page 20) de 
l’indicateur du réseau affiche une 
puissance de 1 ou plus sur le moniteur 
LCD ou dans le viseur.

[Remarque]
Si la connexion échoue, exécutez de nouveau la 
procédure de l’étape 1.

8 Connectez le dispositif au point d’accès.
Pour de plus amples informations sur la 
façon de se connecter, reportez-vous au 
mode d’emploi de chaque dispositif.
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Connexion à Internet
Vous pouvez vous connecter à Internet avec 
un LAN filaire ou un LAN sans fil.
Pour le LAN filaire, raccordez un câble LAN 
(non fourni) au connecteur du réseau sur le 
caméscope et connectez à Internet via un 
routeur.
Pour le LAN sans fil, effectuez la connexion à 
Internet à l’aide du module USB LAN sans fil 
IFU-WLM3 (fourni), de l’adaptateur LAN sans 
fil CBK-WA02 (optionnel), ou d’un modem 
(optionnel).

Dispositif requis pour la connexion au 
réseau

Connexion LAN sans fil
L’un des périphériques suivants est requis.
ˎˎ Module USB LAN sans fil IFU-WLM3 (fourni)
ˎˎ Adaptateur LAN sans fil CBK-WA02 
(optionnel) + Adaptateur d’extension USB 
CBK-NA1E fourni avec le kit d’adaptateur 
réseau CBK-NA1 (optionnel)
ˎˎ Modem (optionnel) + Adaptateur 
d’extension USB CBK-NA1E fourni avec le kit 
d’adaptateur réseau CBK-NA1 (optionnel)

Connexion LAN filaire
ˎˎ Câble LAN (non fourni)

[Remarques]
ˎˎ Il est possible que le module LAN sans fil ne soit pas 

disponible dans certains pays/régions.
ˎˎ La gamme de fréquences du module LAN sans fil 

est partagée par différents périphériques. Selon 
l’environnement d’utilisation, il est possible que la 
vitesse de transmission et la distance diminuent ou 
que la communication se déconnecte, si vous utilisez 
d’autres dispositifs.
ˎˎ Pour utiliser les services 3G/4G/LTE, vous devez 

souscrire un contrat auprès d’un opérateur de 
téléphonie mobile.
ˎˎ Pour plus de détails sur le périphérique compatible 

requis pour la connexion réseau, contactez votre 
revendeur Sony ou un technicien Sony.

Restrictions de l’usage simultané de la 
fonction de connexion au réseau

Le caméscope peut se connecter à un réseau 
au moyen de méthodes incluant le LAN sans 
fil ou le LAN filaire.
Cependant, l’usage simultané de ces fonctions 
de connexion comporte des restrictions.
Pour les détails, consultez « Restrictions de 
l’usage simultané des fonctions réseau » 
(page 86).

Connexion avec un câble LAN 
(connexion LAN filaire)

Vous pouvez vous connecter à Internet avec 
une connexion LAN filaire via un routeur 
raccordé au connecteur du réseau situé sur le 
caméscope.

[Remarques]
ˎˎ Par mesure de sécurité, ne raccordez pas le 

connecteur pour le câblage de périphériques pouvant 
avoir une tension excessive à ce port. Suivez les 
instructions pour ce port.
ˎˎ Lors de la connexion du câble LAN de l’appareil au 

périphérique, utilisez un câble blindé afin d’empêcher 
tout dysfonctionnement dû au bruit de rayonnement.

Internet

Routeur

Ordinateur

1 Raccordez le connecteur du réseau du 
caméscope à un routeur à l’aide d’un 
câble LAN.

2 Réglez Maintenance >Network >Setting 
sur On.

3 Réglez Maintenance >Network >Wired 
LAN sur Enable.
Une adresse IP est automatiquement 
attribuée au caméscope.

[Remarques]
ˎˎ Il peut falloir un certain temps (30 secondes à 

1 minute) pour activer la connexion LAN filaire. 
Attendez jusqu’à ce que l’icône LAN (page 20) de 
l’indicateur d’état du réseau cesse de clignoter sur 
l’écran LCD ou dans le viseur.
ˎˎ Pour transférer les fichiers d’origine/proxy enregistrés 

sur le caméscope, utilisez la commande à distance 
Wi-Fi, ouvrez le menu Web ou la sortie moniteur en 
utilisant l’application « Content Browser Mobile », 
réglez Maintenance >Network >Wired LAN Remote du 
menu de configuration sur On (page 126).
ˎˎ Lorsqu’une connexion réseau a été effectuée par 

l’intermédiaire d’un câble LAN qui ne sera pas utilisé 
pour une connexion Internet, il est recommandé de 
régler Wired LAN Remote sur On pour empêcher un 
accès non autorisé depuis Internet. Lorsque vous vous 
connectez à Internet, assurez-vous que la connexion 
réseau se fait via un réseau sécurisé avant utilisation.
ˎˎ Une connexion LAN filaire est impossible si un 

modem (optionnel) est raccordé au connecteur du 
module USB LAN sans fil. Pour établir une connexion 
LAN filaire, retirez d’abord le modem (optionnel).
ˎˎ Lorsque vous êtes connecté à Internet grâce au mode 

Wi-Fi Station et que le LAN filaire n’est pas connecté 
à Internet, il est possible qu’une erreur réseau se 
produise et que les fonctions liées à Internet ne 
fonctionnent pas. Dans ce cas, réglez Wired LAN sur 
Disable et connectez-vous à Internet grâce au mode 
Wi-Fi Station uniquement.

Préparation à la connexion 
Internet avec un modem

Vous pouvez connecter le caméscope à 
Internet via un réseau 3G/4G en connectant 
un modem en option à l’appareil.
Vous pouvez connecter l’adaptateur 
d’extension USB CBK-NA1E, fourni avec le kit 
d’adaptateur réseau CBK-NA1 (en option), au 
connecteur USB du module LAN sans fil sur le 
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caméscope pour la préparation à la connexion 
à l’aide de la procédure suivante.
Vous pouvez également vous connecter à 
Internet à l’aide d’un réseau smartphone en 
raccordant un câble USB au connecteur USB 
du module LAN sans fil de l’appareil et en 
connectant un smartphone.

1 Fixez le support de fixation à la poignée 
dans la position illustrée dans l’image 
ci-dessous.
Pour la fixation du support de fixation 
(référence Nº A-2092-367-), contactez un 
technicien Sony.

Support de fixation

2 Raccordez l’adaptateur d’extension USB 
au support de fixation.

3 Serrez la vis de fixation dans le sens des 
aiguilles d’une montre pour fixer 
l’adaptateur d’extension USB.

Vis de fixation

Adaptateur d’extension USB

Vous pouvez ajuster la position de 
l’adaptateur d’extension USB en le glissant 
tel qu’indiqué dans l’image ci-dessous.

4 Fixez le cache de protection (fourni) au 
connecteur USB de l’adaptateur 
d’extension USB.

5 Ouvrez le cache du connecteur de module 
USB LAN sans fil.

Garde protectrice 
(fourni)

6 Branchez le connecteur USB de 
l’adaptateur d’extension USB dans le 
connecteur de module USB LAN sans fil.

Connexion par l’intermédiaire 
d’un modem

Vous pouvez connecter le caméscope à 
Internet par l’intermédiaire d’un réseau 
3G/4G en fixant un modem (optionnel) au 
caméscope en utilisant un kit d’adaptateur 
réseau CBK-NA1 (optionnel).

Internet

CBK-NA1
+
Modem

Connexion

1 Branchez le modem (option) dans le 
connecteur USB de l’adaptateur 
d’extension USB CBK-NA1E.

Pour plus de détails concernant le raccordement 
d’un modem, reportez-vous au mode d’emploi 
fourni avec le modem.

2 Réglez Maintenance >Network >Setting 
sur On.

3 Réglez Maintenance >Network >Modem 
sur On.

[Remarques]
ˎˎ Mettez toujours le caméscope hors tension avant de 

connecter ou de retirer le CBK-NA1 et le modem.
ˎˎ Il peut falloir un certain temps (30 secondes à 1 

minute) pour activer le mode modem. Attendez 
jusqu’à ce que l’indicateur d’état des réglages/de la 
connexion du modem 3G/4G (page 19) cesse de 
clignoter sur l’écran LCD ou dans le viseur.

Connexion à l’aide d’un outil 
d’aide à la configuration du réseau

En utilisant l’outil d’aide à la configuration 
du réseau, vous pouvez créer un code QR 
contenant les informations requises pour 
accéder au caméscope via une connexion 
C3 Portal. Charger le code QR créé dans le 
smartphone vous permet de vous connecter 
rapidement au caméscope via une connexion 
C3 Portal.
Pour utiliser cette fonction, installez d’abord 
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l’application dédiée à C3 Portal sur votre 
smartphone.

1 Branchez le câble USB connecté à un 
smartphone au connecteur de module 
USB LAN sans fil.

2 Mettez le caméscope sous tension.

3 Sélectionnez Maintenance >Setup for 
Mobile App >Setup dans le menu.
Un écran apparaît, affichant les réglages 
qui seront changés automatiquement 
pour activer la connexion avec C3 Portal.

[Remarque]
La configuration ne peut pas être exécutée lorsque 
Maintenance >Network Client Mode est réglé sur 
On dans le menu et que la lecture en transit est en 
cours.

4 Vérifiez les réglages et sélectionnez OK.
La configuration démarre. Un message 
« Processing » apparaît pendant la 
configuration.
Lorsque la configuration est terminée, les 
informations requises et un code QR pour 
accéder à l’appareil s’affichent.

[Remarques]
ˎˎ Veillez à ce que le mot de passe ne puisse pas 

être visualisé et que l’image du code QR ne 
puisse pas être copiée par d’autres personnes.
ˎˎ L’écran du code QR apparaît sur le moniteur LCD, 

mais ne s’affiche pas lorsque le moniteur LCD 
est réglé sur le mode « Vidéo sans informations 
superposées (MONI) » ou « Affichage d’état 
(STATUS) ». Passez au mode « Vidéo avec 
informations superposées (CHAR) » à l’aide de la 
touche DISP SEL (page 9).

5 Lancez l’application dédiée à C3 Portal 
installée sur votre smartphone et scannez 
le code QR en utilisant la caméra du 
smartphone.
Pour plus de détails sur l’utilisation de 
l’application dédiée, reportez-vous au 
Manuel d’aide de l’application dédiée.

Les informations requises pour accéder au 
caméscope sont chargées dans le 
smartphone.

Pour plus de détails sur l’application 
dédiée, visitez le site C3 Portal.
https://www.c3p.sony.net

Connexion à l’aide du mode 
Wireless LAN Station (mode Wi-Fi 
Station)

Vous pouvez vous connecter à Internet à 
l’aide du mode station Wi-Fi en raccordant le 
module USB LAN sans fil IFU-WLM3 (fourni) ou 
l’adaptateur LAN sans fil CBK-WA02 (optionnel) 
au caméscope et en utilisant un point d’accès 
compatible 3G/4G/LTE (optionnel) ou à l’aide 
d’une fonction modem.
Pour plus de détails concernant le 
raccordement des dispositifs, consultez 

« Fixation de l’IFU-WLM3 » (page 63) et 
« Fixation du CBK-WA02 » (page 63).

Internet

Internet

Point 
d’accès

Smartphone/
Tablette

Smartphone/
Tablette

Ordinateur

Connexion par l’intermédiaire 
d’un appareil

Si le point d’accès et le dispositif prennent 
en charge le WPS, connectez-vous à l’aide 
de la procédure indiquée sous « Connexion 

à un point d’accès à l’aide de la fonction 
WPS » (page 66). Si le WPS n’est pas pris 
en charge, connectez-vous à l’aide de la 
procédure indiquée sous « Connexion à un 
point d’accès en mode station sans utiliser la 
fonction WPS » (page 82).
D’abord, mettez le point d’accès et le dispositif 
en marche, puis configurez la fonction modem 
du dispositif si vous envisagez d’utiliser la 
fonction modem.

Connexion à un point d’accès à 
l’aide du menu de configuration

Vous pouvez vous connecter à un point 
d’accès à l’aide du menu de configuration.
Cette connexion peut être établie à l’aide de la 
fonction de détection automatique de réseau 
ou par saisie manuelle.

Connexion à l’aide de la fonction de 
détection automatique de réseau

1 Effectuez les étapes 1 à 4 de « Connexion 
à un point d’accès à l’aide de la fonction 
WPS » (page 66).

2 Sélectionnez Maintenance >Network 
>Wi-Fi Station Detail Settings >Scan 
Networks dans le menu de configuration, 
puis sélectionnez [Execute].
Le caméscope lance la détection des 
destinations réseau. Les destinations 
détectées pour la connexion s’affichent 
dans la liste de résultats Scan Networks.

 [Remarque]
Fermez d’abord l’affichage de la liste si vous 
souhaitez éteindre le caméscope.

https://www.c3p.sony.net
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3 Tournez le bouton MENU pour 
sélectionner une destination à laquelle 
vous connecter, puis appuyez sur le 
bouton.
Lorsque la connexion est établie, l’écran 
de saisie de mot de passe s’affiche.

4 Réglez le mot de passe sur l’écran de 
saisie Password.
Après avoir réglé le mot de passe, vous 
revenez à l’écran Wi-Fi Station Detail 
Settings.
Si des informations sur une destination 
précédemment connectée sont 
enregistrées dans l’historique du 
dispositif, sélectionner le SSID pour cette 
destination permet d’afficher l’écran Wi-Fi 
Station Detail Settings.

5 Configurez les réglages de connexion 
suivants sur l’écran Wi-Fi Station Detail 
Settings.

Elément Description

DHCP Permet d’activer/
désactiver le DHCP.
Lorsque cette fonction est 
réglée sur On, une adresse 
IP est automatiquement 
attribuée au caméscope.
Pour saisir manuellement 
l’adresse IP du caméscope, 
réglez cette fonction sur 
Off.

IP Address Permet de saisir l’adresse 
IP du caméscope.
Activé uniquement lorsque 
DHCP est [Off].

Subnet mask Permet de saisir le masque 
de sous-réseau du 
caméscope.
Activé uniquement lorsque 
DHCP est [Off].

Elément Description

Gateway Permet de saisir la 
passerelle pour le point 
d’accès.
Activé uniquement lorsque 
DHCP est [Off].

DNS Auto Obtient automatiquement 
l’adresse DNS.
Lorsque le réglage est sur 
On, l’adresse du serveur 
DNS est obtenue 
automatiquement.

Primary DNS 
Server

Saisissez le serveur DNS 
primaire pour le point 
d’accès.
Activé uniquement lorsque 
DNS Auto est [Off].

Secondary 
DNS Server

Saisissez le serveur DNS 
secondaire pour le point 
d’accès.
Activé uniquement lorsque 
DNS Auto est [Off].

6 Lorsque vous avez terminé, sélectionnez 
Set >Execute pour appliquer les réglages.

[Remarques]
ˎˎ Si vous modifiez les réglages de connexion, 

sélectionnez toujours Set >Execute. Si vous ne 
sélectionnez pas Execute, les réglages configurés ne 
sont pas appliqués.
ˎˎ Il peut falloir un certain temps (30 secondes à 1 

minute) pour activer le mode station. Attendez 
jusqu’à ce que l’icône de puissance de signal 
(page 20) de l’indicateur du réseau cesse de 
clignoter sur le moniteur LCD ou dans le viseur.
ˎˎ Les informations de configuration de la station 

de connexion sont enregistrées dans l’historique. 
L’historique peut être effacé à l’aide de ALL Reset et 
Network Reset.

Connexion par saisie manuelle

1 Effectuez les étapes 1 à 4 de « Connexion 
à un point d’accès à l’aide de la fonction 
WPS » (page 66).

2 Configurez les réglages de connexion 
suivants dans Maintenance >Network 
>Wi-Fi Station Detail Settings dans le 
menu de configuration.

Elément Description

SSID Saisissez le SSID pour la 
destination à laquelle 
vous souhaitez vous 
connecter.

Password Saisissez le mot de passe 
du point d’accès pour la 
connexion.
Le mot de passe saisi est 
affiché sous forme 
d’astérisques. Les 
caractères saisis sont 
visibles lorsque vous 
appuyez sur la touche 
SHIFT.

DHCP Permet d’activer/
désactiver le DHCP.
Lorsque cette fonction est 
réglée sur On, une adresse 
IP est automatiquement 
attribuée au caméscope.
Pour saisir manuellement 
l’adresse IP du 
caméscope, réglez cette 
fonction sur Off.

IP Address Permet de saisir l’adresse 
IP du caméscope.
Activé uniquement 
lorsque DHCP est [Off].

Subnet mask Permet de saisir le 
masque de sous-réseau 
du caméscope.
Activé uniquement 
lorsque DHCP est [Off].

Gateway Permet de saisir la 
passerelle pour le point 
d’accès.
Activé uniquement 
lorsque DHCP est [Off].

Elément Description

DNS Auto Obtient automatiquement 
l’adresse DNS.
Lorsque le réglage est sur 
On, l’adresse du serveur 
DNS est obtenue 
automatiquement.

Primary DNS 
Server

Saisissez le serveur DNS 
primaire pour le point 
d’accès.
Activé uniquement 
lorsque DNS Auto est 
[Off].

Secondary DNS 
Server

Saisissez le serveur DNS 
secondaire pour le point 
d’accès.
Activé uniquement 
lorsque DNS Auto est 
[Off].

3 Lorsque vous avez terminé, sélectionnez 
Set >Execute pour appliquer les réglages.

[Remarques]
ˎˎ Si vous modifiez les réglages de connexion, 

sélectionnez toujours Set >Execute. Si vous ne 
sélectionnez pas Execute, les réglages configurés ne 
sont pas appliqués.
ˎˎ Il peut falloir un certain temps (30 secondes à 1 

minute) pour activer le mode station. Attendez 
jusqu’à ce que l’icône de puissance de signal 
(page 20) de l’indicateur du réseau cesse de 
clignoter sur le moniteur LCD ou dans le viseur.
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Transfert de fichiers
Vous pouvez transférer des fichiers proxy 
enregistrés sur une carte SD et des fichiers 
originaux enregistrés sur des cartes mémoire 
SxS vers un serveur sur Internet lorsque vous 
êtes connecté à Internet par l’intermédiaire 
d’un réseau 3G/4G/LTE, d’un point d’accès ou 
d’un routeur LAN filaire.

Réglage de la destination de 
transfert

1 Connectez le caméscope à Internet à 
l’aide des procédures indiquées sous 
« Connexion de dispositifs à l’aide du LAN 
sans fil » (page 63) et « Connexion à 
Internet » (page 67).

2 Vous devez d’abord enregistrer un serveur 
vers lequel vous voulez transférer des 
fichiers.
Pour de plus amples informations sur 
l’enregistrement d’un serveur, reportez-
vous à « Pour enregistrer un serveur de 
destination » (page 84).

Configuration de la destination de 
transfert à l’aide de l’application 
dédiée (connexion au 
smartphone)

Vous pouvez envoyer les réglages requis pour 
le transfert de fichier d’un smartphone vers le 
caméscope lorsqu’il est connecté à C3 Portal à 
l’aide d’un smartphone (page 68).

1 Envoyez les informations de transfert de 
fichier au caméscope en utilisant 
l’application dédiée sur un smartphone.
Pour plus de détails sur l’utilisation de 
l’application dédiée, reportez-vous au 
Manuel d’aide de l’application dédiée.
Si le caméscope reçoit les informations de 
transfert de fichier avec succès, le 
message suivant apparaît.

2 Sélectionnez OK.
Les informations de configuration 
commencent à charger.
Lorsque la configuration est chargée avec 
succès, un message « Network File 
loaded. » apparaît.
Éléments configurés automatiquement
Pour les éléments configurés 
automatiquement, consultez « Pour 
enregistrer un serveur de destination » 
(page 84).

[Remarque]
Service, Show Password et Load Certification 
ne sont pas inclus dans les éléments qui sont 
configurés automatiquement.

Pour plus de détails sur l’application dédiée, 
visitez le site C3 Portal.
https://www.c3p.sony.net

Transfert des fichiers proxy à l’aide 
du menu Web

Vous pouvez télécharger les fichiers proxy 
enregistrés sur une carte SD sur un serveur à 
l’aide du menu Web.

1 Connectez le caméscope et le dispositif à 
l’aide d’une connexion LAN, puis lancez 
un navigateur sur le dispositif pour 
accéder au caméscope .

2 Affichez un écran de liste de fichiers pour 
sélectionner des fichiers.

3 Tapez sur  et sélectionnez [Media Info], 
puis tapez sur [SD Card].
L’écran SD Card s’affiche.

En utilisant la version 2.0 ou ultérieure de 
l’application « Content Browser Mobile », 
vous pouvez rapidement afficher une 
miniature correspondant à un fichier 
proxy sur une carte SD en utilisant l’image 
fixe de la première image.

4 Sélectionnez les fichiers que vous 
souhaitez transférer.
Tapez sur un fichier pour le sélectionner. 
Tapez sur un fichier une deuxième fois 
pour le désélectionner. Vous pouvez taper 
deux fois sur un fichier pour le lire et 
vérifier son contenu.

5 Tapez sur [Transfer].
Le serveur de destination par défaut 
spécifié sous [Default Setting] s’affiche 
(reportez-vous à « Pour enregistrer un 
serveur de destination » (page 84)).
Pour changer le serveur de destination, 
tapez sur le serveur de destination pour 
afficher une liste, puis sélectionnez un 
autre serveur. Saisissez le répertoire sur le 

serveur de destination, le cas échéant.
Vous pouvez sélectionner une destination 
de transfert en utilisant Maintenance >File 
Transfer >Default Upload Server dans le 
menu de configuration.

6 Tapez sur [Transfer].
Le transfert des fichiers sélectionnés 
commence. Pour annuler le transfert de 
fichiers, tapez sur [Cancel].

Transfert des fichiers proxy à l’aide 
de l’écran de miniatures

Vous pouvez télécharger les fichiers proxy 
enregistrés sur une carte SD sur un serveur à 
l’aide de l’écran de miniatures du caméscope.

Transfert d’un fichier proxy spécifique

1 Sélectionnez une destination de transfert 
précédemment enregistrée dans le menu 
Web.
Vous pouvez sélectionner une destination 
de transfert à l’aide du menu Web ou 
Maintenance >File Transfer >Default 
Upload Server dans le menu de 
configuration.

2 Appuyez sur la touche THUMBNAIL pour 
afficher l’écran de miniatures.

https://www.c3p.sony.net
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3 Sélectionnez Thumbnail >Transfer 
Clip(Proxy) >Select Clip dans le menu de 
configuration.
Un écran de sélection de transfert de 
fichiers apparaît.

4 Tournez le bouton MENU pour déplacer le 
curseur sur un fichier (plan) à transférer 
puis appuyez sur le bouton.
Une coche est ajoutée au plan 
sélectionné.
Pour décocher la case d’un plan 
sélectionné, appuyez de nouveau sur le 
bouton MENU.

5 Appuyez et maintenez enfoncée la touche 
SHIFT et appuyez sur la touche SET.
Une boîte de dialogue de confirmation 
apparaît.

6 Tournez le bouton MENU pour 
sélectionner [Execute] sur l’écran du 
message de confirmation, puis appuyez 
sur le bouton.
Le fichier sélectionné est enregistré dans 
la liste des tâches et un message 
d’enregistrement terminé s’affiche.

Transfert de tous les fichiers proxy

Vous pouvez transférer tous les fichiers proxy 
enregistrés sur une carte SD, en même temps.

[Remarques]
ˎˎ Les fichiers proxy pour lesquels il n’y a pas de fichiers 

originaux, ne peuvent pas être sélectionnés pour le 
transfert sur l’écran de miniatures.
ˎˎ Les fichiers proxy qui ne sont pas affichés sur l’écran 

de sélection de transfert de fichiers ne peuvent pas 
être transférés.

1 Sélectionnez Thumbnail >Transfer 
Clip(Proxy) >All Clips dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Tous les fichiers sont enregistrés dans la 
liste des tâches et un message 
d’enregistrement terminé s’affiche.
Le transfert de fichiers commence dans 
l’ordre dans lequel les fichiers ont été 
enregistrés dans la liste des tâches.
Vous pouvez vérifier les fichiers 
enregistrés en affichant la liste des tâches 
de transfert en utilisant Maintenance >File 
Transfer >View Job List dans le menu de 
configuration.

Transfert automatique une fois 
l’enregistrement terminé

Si Maintenance >File Transfer >Auto 
Upload(Proxy) dans le menu de configuration 
est réglé sur On au préalable, le fichier est 
automatiquement transféré vers le serveur 
spécifié lorsque l’enregistrement proxy est 
terminé.
Si un fichier proxy d’une durée identique à celle 
du fichier original, héritant des informations du 
fichier original, est enregistré sur la base des 
métadonnées de planification, un dossier est 
créé sur la destination de transfert avec un nom 
défini par le contenu de la balise <Title> du 
fichier des métadonnées de planification, et le 
fichier proxy est transféré vers ce dossier.
Lors du transfert, l’ID du support 
d’enregistrement est automatiquement ajouté 
au nom de fichier du fichier de métadonnées 
de planification.

Transfert de parties de fichiers proxy

En utilisant la version 2.0 ou ultérieure de 
l’application « Content Browser Mobile », vous 
pouvez définir des repères de début et de fin 
dans des fichiers proxy et transférer les parties 
sélectionnées.
Vous pouvez également transférer les parties 
sélectionnées de plusieurs fichiers à l’aide du 
Storyboard.

[Remarques]
ˎˎ Des marges pouvant aller jusqu’à 15 images sont 

ajoutées avant et après la partie sélectionnée dans le 
fichier créé.
ˎˎ Les fichiers créés à partir de parties sélectionnées 

de fichiers proxy enregistrés à l’aide du logiciel 
de fonctions de mise en réseau (version 1.25 ou 
antérieure) peuvent ne pas être importés dans des 
systèmes de montage non-linéaires.
ˎˎ En cas de transfert partiel par l’intermédiaire du 

Storyboard, le fichier pour l’envoi des informations du 
Storyboard vers un système de montage non linéaire 
s’affiche dans la liste de tâches.
ˎˎ Lors du transfert, un dossier General/Sony/tmp est 

automatiquement créé sur la carte SD. Le fichier 
est stocké temporairement dans ce dossier et est 
automatiquement supprimé une fois le transfert de 
fichiers terminé.
ˎˎ Les fichiers ne peuvent pas être transférés dans les 

conditions suivantes.
 ‒ Lorsque Maintenance >Network >Wi-Fi Mode est 

réglé sur Wi-Fi Access Point et Wired LAN est réglé 
sur Disable dans le menu de configuration

 ‒ Lorsque la fonction de lecture en transit est activée 
(Maintenance >Streaming >Setting est réglé sur On)

 ‒ Lorsque le mode client réseau est activé et la 
lecture en transit haute qualité est en cours (lecture 
en transit lorsque Maintenance >Network Client 
Mode >Setting est réglé sur On)

Transfert des fichiers originaux à 
l’aide du menu Web

Vous pouvez télécharger les fichiers originaux 
enregistrés sur une carte mémoire SxS sur un 
serveur à l’aide du menu Web.

1 Connectez le caméscope et le dispositif à 
l’aide d’une connexion LAN, puis lancez 
un navigateur sur le dispositif pour vous 
connecter au caméscope « Connexion de 
dispositifs à l’aide du LAN sans fil » 
(page 63).

2 Sélectionnez Maintenance >File Transfer 
>File Transfer dans le menu de 
configuration.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton. 
Le mode de transfert des fichiers 
originaux est lancé.

4 Affichez un écran de liste de fichiers pour 
sélectionnez des fichiers dans le 
navigateur du dispositif.

5 Tapez sur  et sélectionnez [Media Info], 
puis tapez sur Slot A (pour des fichiers 
enregistrés sur un support présent dans la 
fente A) ou Slot B (pour des fichiers 
enregistrés sur un support présent dans la 
fente B).
L’écran Slot A ou Slot B s’affiche.
Exemple : écran Slot A

6 Sélectionnez les fichiers que vous 
souhaitez transférer.
Tapez sur un fichier pour le sélectionner. 
Tapez sur un fichier une deuxième fois 
pour le désélectionner.
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7 Tapez sur [Transfer].
Le serveur de destination par défaut 
spécifié sous [Default Setting] s’affiche 
(reportez-vous à « Pour enregistrer un 
serveur de destination » (page 84)).
Pour changer le serveur de destination, 
tapez sur le serveur de destination pour 
afficher une liste, puis sélectionnez un 
autre serveur.
Saisissez le répertoire sur le serveur de 
destination sous [Directory].
Vous pouvez sélectionner une destination 
de transfert en utilisant Maintenance >File 
Transfer >Default Upload Server dans le 
menu de configuration.

8 Tapez sur [Transfer].
Le transfert des fichiers sélectionnés 
commence. Pour annuler le transfert de 
fichiers, tapez sur [Cancel].
Lorsque le transfert de tous les fichiers est 
terminé, le mode de transfert est 
automatiquement quitté, et l’affichage 
revient à l’écran de prise de vue de la 
caméra.

Transfert des fichiers originaux à 
l’aide de l’écran de miniatures

Vous pouvez télécharger les fichiers originaux 
enregistrés sur une carte mémoire SxS vers un 
serveur à l’aide de l’écran de miniatures.

Transfert de fichiers originaux

1 Sélectionnez une destination de transfert 
précédemment enregistrée dans le menu 
Web.
Vous pouvez sélectionner une destination 
de transfert à l’aide du menu Web ou 
Maintenance >File Transfer >Default 
Upload Server dans le menu de 
configuration.

2 Appuyez sur la touche THUMBNAIL pour 
afficher l’écran de miniatures.

3 Sélectionnez Thumbnail >Transfer Clip 
>Select Clip dans le menu de 
configuration.
Un écran de sélection de transfert de 
fichiers apparaît.

4 Tournez le bouton MENU pour déplacer le 
curseur sur un fichier (plan) à transférer 
puis appuyez sur le bouton.
Une coche est ajoutée au plan 
sélectionné.
Pour décocher la case d’un plan 
sélectionné, appuyez de nouveau sur le 
bouton MENU.

5 Appuyez et maintenez enfoncée la touche 
SHIFT et appuyez sur la touche SET.
Une boîte de dialogue de confirmation 
apparaît.

6 Tournez le bouton MENU pour 
sélectionner [Execute] sur l’écran du 
message de confirmation, puis appuyez 
sur le bouton.
Le fichier sélectionné est enregistré dans 
la liste des tâches et un message 
d’enregistrement terminé s’affiche.

Transfert de tous les fichiers originaux

Vous pouvez transférer tous les fichiers 
originaux enregistrés sur une carte mémoire 
SxS, en même temps.

1 Sélectionnez Thumbnail >Transfer Clip >All 
Clips dans le menu de configuration.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Tous les fichiers sont enregistrés dans la 
liste des tâches et un message 
d’enregistrement terminé s’affiche.
Le transfert de fichiers commence dans 
l’ordre dans lequel les fichiers ont été 
enregistrés dans la liste des tâches.
Vous pouvez vérifier les fichiers 
enregistrés en affichant la liste des tâches 
de transfert en utilisant Maintenance >File 
Transfer >View Job List dans le menu de 
configuration.

Si Maintenance >File Transfer >Remote File 
Transfer dans le menu de configuration 
est réglé sur Enable au préalable, le mode 
de transfert de fichiers originaux est 
automatiquement lancé sans réglage du 
mode de transfert de fichiers.

[Remarque]
Les fichiers ne peuvent pas être transférés dans les 
conditions suivantes.
ˎˎ Pendant l’enregistrement, la lecture ou lors de 

l’affichage de l’écran de miniatures
ˎˎ Lorsque les deux Maintenance >Network >Wireless 

Network est réglé sur Wi-Fi Access Point et Wired 
LAN >Disable est réglé sur Disable dans le menu de 
configuration

ˎˎ Lorsque la fonction de lecture en transit est activée 
(Maintenance >Streaming >Setting est réglé sur On)
ˎˎ Lorsque le mode client réseau est activé et la lecture 

en transit haute qualité est en cours (lecture en transit 
lorsque Maintenance >Network Client Mode >Setting 
est réglé sur On)

Transfert de parties de fichiers originaux

En utilisant la version 2.0 ou ultérieure de 
l’application « Content Browser Mobile », vous 
pouvez définir des repères de début et de fin 
dans des fichiers originaux enregistrés par le 
caméscope pour les couper et transférer les 
parties sélectionnées.
Vous pouvez également transférer les parties 
sélectionnées de plusieurs fichiers à l’aide du 
Storyboard.
Les formats suivants de fichiers originaux sont 
pris en charge.
ˎˎ XAVC-I
ˎˎ XAVC-L
ˎˎ HD422 (exFAT/UDF)
ˎˎ HD420HQ (exFAT/UDF)

[Remarque]
Pour transférer une partie d’un fichier original à l’aide de 
« Content Browser Mobile », un fichier proxy du même 
nom de fichier que le fichier original est nécessaire.
Activez la création de fichiers proxy avant de commencer 
à enregistrer.
Les réglages pertinents sont indiqués ci-dessous.
ˎˎ Réglez Operation >XAVC Proxy Rec Mode >Setting 

dans le menu de configuration sur On.
ˎˎ Lorsque le mode client réseau est activé, réglez 

Maintenance >Network Client Mode >Preset 1, Preset 
2 ou Preset 3 >NCM with Proxy sur Enable dans le 
menu de configuration.
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Vérification de l’état du transfert 
de fichiers

Surveillance à l’aide du menu Web

Tapez sur [Job List] sur l’écran SD Card, Slot 
A ou Slot B pour afficher l’écran Job List 
pour vérifier l’état du transfert de fichiers 
(page 84).

Surveillance à l’aide du menu 
configuration

Sélectionnez Maintenance >File Transfer >View 
Job List dans le menu de configuration afin 
d’afficher l’écran Job List.
Vous pouvez vérifier l’état du transfert de 
fichiers depuis l’écran Job List.

Élément Description

Src. Indicateur du support de source 
de transfert des plans
A : support de logement A
B : support de logement B
P : support de logement pour 

cartes PROXY SD

Clip Name Nom du transfert de plans

Destination Serveur de destination de 
transfert de plans

Élément Description

Status État du transfert
Completed : transfert terminé
Transferring : transfert en cours
Aborted : transfert interrompu
Waiting : transfert en attente
Server Cap. Over : capacité du 

serveur de destination de 
transfert dépassée (« E03-
006 » s’affiche dans Job List 
(page 84) dans le menu 
Web)

Upload Error : erreur de 
téléchargement du serveur 
de destination de transfert 
(« E03-003 » s’affiche dans 
Job List (page 84) dans le 
menu Web)

Dest. Auth. Failed : erreur 
d’authentification du serveur 
de destination de transfert 
(« E03-005 » s’affiche dans 
Job List (page 84) dans le 
menu Web)

Dest. Cert. Err. : erreur de 
certification de la 
destination de transfert 
(« E03-008 » s’affiche dans 
Job List (page 84) dans le 
menu Web)

Suppression des fichiers de 
transfert sur l’écran Job List du 
caméscope

Vous pouvez sélectionner et supprimer 
n’importe quel fichiers de transfert enregistré 
sur l’écran Job List.

[Remarque]
Supprimez les fichiers un par un. Il est impossible de 
supprimer plusieurs fichiers à la fois.

1 Sur l’écran Job List, tournez le bouton 
MENU pour déplacer le curseur sur le 
fichier que vous souhaitez supprimer.

2 Appuyez sur le bouton MENU.
Un message de confirmation s’affiche 
pour vous demander si vous souhaitez le 
supprimer.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Un message d’achèvement de 
suppression apparaît.

Suppression de tous les fichiers de 
transfert enregistrés

Appuyez sur [Clear All jobs] sur l’écran Job List.

Suppression de toutes les tâches de 
transfert terminées

Appuyez sur [Clear Completed jobs] sur l’écran 
Job List.
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Diffusion de contenus vidéo et audio en lecture en transit
Vous pouvez diffuser la vidéo ou l’audio 
enregistré avec le caméscope via Internet ou 
le réseau local.

Préparation de la transmission de 
lecture en transit

1 Connectez le caméscope à Internet à 
l’aide des procédures indiquées sous 
« Connexion de dispositifs à l’aide du LAN 
sans fil » (page 63) et « Connexion à 
Internet » (page 67).

2 Sélectionnez Preset1 (ou Preset2, Preset3) 
dans Maintenance >Streaming du menu 
de configuration.
L’écran de configuration de la destination 
de connexion de lecture en transit 
s’affiche.

3 Définissez Size, Bit Rate, Type et les 
éléments en fonction de Type à l’écran.
Pour les détails et les limites concernant 
les réglages, consultez « Réglages de 
lecture en transit » (page 81).

4 Sélectionnez Preset1 (ou Preset2, Preset3) 
défini aux étapes 1 et 2 dans Maintenance 
>Streaming >Preset Select du menu de 
configuration.

Début de la lecture en transit

1 Réglez Maintenance >Streaming >Setting 
du menu de configuration sur On.
La lecture en transit démarre en fonction 
des réglages.
Vous pouvez attribuer Streaming à un 
commutateur personnalisable. Pour les 
détails sur l’attribution, consultez 
« Attribution de fonctions aux 
commutateurs personnalisables » 
(page 133).

[Remarques]
ˎˎ La lecture en transit ne peut pas démarrer avec les 

réglages de menu suivants.
 ‒ Lorsque Maintenance >Network >Setting dans le 

menu de configuration est réglé sur Off
 ‒ Lorsque Maintenance >Network Client Mode 

>Setting dans le menu de configuration est réglé 
sur On

 ‒ Lorsque Maintenance >Network >Setting dans 
le menu de configuration est réglé sur On, mais 
Maintenance >Network >Wi-Fi Mode est réglé sur 
Off et Maintenance >Network >Wired LAN est réglé 
sur Disable

ˎˎ Au démarrage, le transfert du contenu vidéo ou audio 
actuel peut prendre plusieurs dizaines de secondes.
ˎˎ Vous ne pouvez pas démarrer de lecture en transit 

lorsque vous lisez un plan en format SD.
ˎˎ Si la destination de diffusion de lecture en transit 

n’est pas correctement réglée ou si le caméscope 
n’est pas connecté au réseau, le symbole « × » 
s’affiche sur l’écran comme indicateur de l’état de la 
lecture en transit.
ˎˎ La lecture en transit en mode client réseau 

(page 76), la surveillance, l’enregistrement proxy et 
le transfert de fichiers ne sont pas disponibles après 
avoir activé le mode de lecture en transit.
ˎˎ Le démarrage de la lecture en transit pendant 

la surveillance, l’enregistrement proxy et le 
transfert de fichiers provoque l’arrêt de la fonction 
correspondante.

Arrêt de la lecture en transit

Réglez Maintenance >Streaming >Setting sur 
Off pour arrêter la lecture en transit.
Lorsque Streaming est activé (On), la lecture 
en transit peut également être arrêtée en 
appuyant sur le commutateur personnalisable 
auquel cette fonction a été attribuée.

Lorsque le caméscope est connecté à un 
dispositif via un LAN sans fil (page 63) ou à 
Internet par l’intermédiaire du mode Wireless 
LAN Station (page 65), vous pouvez 
également régler la destination de diffusion 
de lecture en transit et démarrer/arrêter 
la lecture en transit à partir du menu Web 
(page 80).



5. Configuration du réseau76

Lecture en transit de vidéos de haute qualité
La lecture en transit haute qualité à l’aide de 
la technologie Sony QoS est prise en charge 
en activant le mode client réseau et en se 
connectant au Connection Control Manager 
(CCM) d’une station réseau RX Sony (en 
option) ou de C3 Portal. Une lecture en transit 
stable, de meilleure qualité peut être réalisée 
à l’aide de réseaux multiples.

[Remarques]
ˎˎ Utilisez la version 1.18.2 ou ultérieure pour la station 

réseau RX.
ˎˎ Pour une lecture en transit stable à l’aide de réseaux 

multiples, utilisez une ligne porteuse différente pour 
chaque réseau.
ˎˎ Lors de l’utilisation de réseaux multiples, le débit 

binaire cible peut être dépassé selon la scène en 
cours de prise de vue.
ˎˎ C3 Portal est un service Cloud fourni par Sony.  

Une inscription est requise pour utiliser ce service.  
C3 Portal n’est pas fourni dans certaines régions. Pour 
plus de détails sur les zones dans lesquelles le service 
est fourni, rendez-vous sur le site suivant.  
https://www.c3p.sony.net 
En outre, consultez les sites suivants pour connaître la 
politique de confidentialité de C3 Portal.

 ‒ Modalités de service 
https://www.c3p.sony.net/site/tos_eu.html

 ‒ Politique de confidentialité de C3 Portal 
https://www.c3p.sony.net/site/c3p_privacy_policy.
html

 ‒ Politique de confidentialité de Professional ID 
https://www.pro-id.sony.net/#/privacyPolicy

ˎˎ Pour plus de détails, contactez un représentant 
commercial Sony Professional.

1 Connectez le caméscope au réseau.
Pour les détails, consultez « Connexion de 
dispositifs à l’aide du LAN sans fil » 
(page 63) et « Connexion à Internet » 
(page 67).

2 Configurez les réglages réseau de la 
destination à laquelle vous souhaitez vous 
connecter dans Maintenance >Network 
Client Mode >Preset 1, Preset 2 ou Preset 3 
dans le menu de configuration.
Vous pouvez enregistrer les réglages 
réseau d’une destination à laquelle vous 
connecter en tant que réglage prédéfini 

sous Preset 1, Preset 2 et Preset 3.

Elément Description

CCM Address Saisissez l’adresse du CCM 
pour effectuer la 
connexion. (Nom de l’hôte 
ou adresse IP)

CCM Port Saisissez le numéro de 
port du CCM pour 
effectuer la connexion.

User Name Saisissez le nom 
d’utilisateur.

Password Saisissez le mot de passe.
Le mot de passe saisi est 
affiché sous forme 
d’astérisques. Les 
caractères saisis sont 
visibles lorsque vous 
appuyez sur la touche 
SHIFT.

NCM with 
Proxy

Permet d’activer/
désactiver 
l’enregistrement proxy 
lors de la connexion avec 
un CCM.

Camera Control Permet d’activer/
désactiver le contrôle de la 
caméra lors de la 
connexion avec un CCM.

Camera Setting Permet d’activer/
désactiver la manipulation 
du fichier ALL lors de la 
connexion avec un CCM.

[Remarques]
ˎˎ Pour régler le mode client réseau, des valeurs 

doivent être saisies pour tous les éléments.
ˎˎ Régler Maintenance >Network Client Mode 

>Preset 1, Preset 2 ou Preset 3 >NCM with Proxy 
sur Enable dans le menu de configuration 
permet d’activer l’enregistrement proxy même 
lorsque le mode client réseau est activé. Pour 
activer le réglage NCM with Proxy, réglez 
Operation >XAVC Proxy Rec Mode >Setting sur 
On dans le menu de configuration.
ˎˎ Si Maintenance >Network Client Mode 

>Preset 1, Preset 2 ou Preset 3 >NCM with 

Proxy est réglé sur Disable dans le menu de 
configuration, l’enregistrement proxy s’arrête si 
le mode client réseau est réglé sur On pendant 
l’enregistrement.  
Si l’enregistrement du fichier original est 
continu, réglez les deux sur Off pour redémarrer 
l’enregistrement proxy.
ˎˎ Si Operation >XAVC Proxy Rec Mode >Proxy File 

>Size dans le menu de configuration est réglé 
sur HD Auto(9Mbps) ou HD Auto(6Mbps), NCM 
with Proxy ne peut pas être activé.  
Si HD Auto(9Mbps) ou HD Auto(6Mbps) est réglé 
après avoir réglé NCM with Proxy sur Enable, 
le réglage est conservé, mais l’enregistrement 
proxy n’est pas effectué.

3 Sélectionnez un des noms de réglages 
prédéfinis, celui choisi en étape 1 dans 
Maintenance >Network Client Mode 
>Preset Select dans le menu de 
configuration.

4 Réglez Maintenance >Network Client 
Mode >Setting dans le menu de 
configuration sur On.
Le mode client réseau est activé, et le 
caméscope se connecte à la station 
réseau RX ou à C3 Portal.
La lecture en transit démarre en réponse 
au fonctionnement de la station réseau 
RX. Un fichier ALL peut également être 
enregistré/chargé à l’aide de la 
télécommande de l’unité avec la station 
réseau RX.
Pour les détails sur le fonctionnement, 
reportez-vous au mode d’emploi de la 
station réseau RX ou au Manuel d’aide de 
C3 Portal.
Vous pouvez attribuer le réglage du mode 
client réseau (On/Off) à un commutateur 
personnalisable. Pour les détails sur 
l’attribution, consultez « Attribution de 
fonctions aux commutateurs 
personnalisables » (page 133).

[Remarques]
ˎˎ Il est impossible de passer en mode client réseau 

pendant la lecture en transit normale (page 75).

ˎˎ Après le passage au mode client réseau, la lecture en 
transit normale (page 75) et la surveillance sont 
disponibles.
ˎˎ Le passage au mode client réseau pendant la 

surveillance arrêtera la surveillance.
ˎˎ Le transfert de fichiers n’est pas pris en charge 

pendant la lecture en transit en mode client réseau. 
Le transfert de fichiers est pris en charge après l’arrêt 
de la lecture en transit.
ˎˎ Si la lecture en transit en mode client réseau est 

lancée pendant le transfert de fichiers, le transfert 
de fichiers s’arrête. Le transfert de fichiers redémarre 
après l’arrêt de la lecture en transit.
ˎˎ Les débits binaires de lecture en transit disponibles 

qui peuvent être configurés avec la station réseau RX 
sont limités aux indications suivantes, en fonction du 
format d’enregistrement proxy.

 ‒ Si le format d’enregistrement proxy est de 
1280×720 9Mbps/6Mbps, le débit binaire de lecture 
en transit est réglé sur 1 Mbps ou inférieur.

 ‒ Si le format d’enregistrement proxy est de 640×360 
3Mbps, le débit binaire de lecture en transit est 
réglé sur 3 Mbps ou inférieur.

ˎˎ Le format proxy ne peut pas être modifié en mode 
client réseau. Pour modifier le format, réglez d’abord 
Network Client Mode sur Off.
ˎˎ Le mode client réseau ne peut pas être réglé sur On 

lorsque Maintenance >Network >Modem Remote est 
réglé sur On dans le menu.

Transfert de fichiers en mode client 
réseau

Vous pouvez transférer des fichiers vers un 
serveur défini par un CCM en connectant le 
caméscope en mode client réseau au CCM 
d’une station réseau RX ou de C3 Portal.

1 Sélectionnez les fichiers que vous 
souhaitez transférer.
ˎˎ Pour transférer un enregistrement 
proxy : 
Suivez les étapes 1 à 5 dans « Transfert 
des fichiers proxy à l’aide du menu 
Web » (page 71).
ˎˎ Pour transférer des fichiers originaux : 
Suivez les étapes 1 à 6 dans « Transfert 
des fichiers proxy à l’aide du menu 
Web » (page 71).

https://www.c3p.sony.net
https://www.c3p.sony.net/site/tos_eu.html
https://www.c3p.sony.net/site/c3p_privacy_policy.html
https://www.c3p.sony.net/site/c3p_privacy_policy.html
https://www.pro-id.sony.net/#/privacyPolicy
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2 Tapez sur [Transfer].
« NCM: RX Server » s’affiche comme 
destination.
Définissez « NCM: RX Server » comme 
destination.

3 Tapez sur [Transfer].
Transférez les fichiers sélectionnés vers le 
serveur spécifié au démarrage de CCM.

[Remarque]
La destination peut également être réglée sur « NCM: RX 
Server » si le mode client réseau n’est pas activé.  
Dans ce cas, le transfert est mis en attente puis le 
transfert vers le serveur spécifié sur le CCM démarre 
après la connexion au CCM en mode client réseau.
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Utilisation de la commande à distance Wi-Fi
Vous pouvez accéder à la commande à 
distance Wi-Fi intégrée dans le caméscope à 
partir d’un smartphone, d’une tablette ou de 
tout autre dispositif par l’intermédiaire d’une 
connexion LAN sans fil.
L’utilisation de la commande à distance Wi-Fi 
vous permet de commander le caméscope à 
distance. Ceci vous permet de lancer/arrêter 
l’enregistrement ou de configurer les réglages 
à distance et est également utile dans des 
circonstances dans lesquelles le caméscope 
est positionné à distance ou monté sur une 
grue, par exemple.

Affichage de la commande à 
distance Wi-Fi

L’écran Wi-Fi remote est automatiquement 
redimensionné pour s’adapter à la taille de 
l’écran du dispositif connecté.

1 Connectez le caméscope à Internet à 
l’aide des procédures indiquées sous 
« Connexion de dispositifs à l’aide du LAN 
sans fil » (page 63) et « Connexion à 
Internet » (page 67).

2 Lancez un navigateur sur le dispositif et 
saisissez « http://<IP_address>/rm.html » 
dans la barre d’URL, où « <IP_address> » 
est l’adresse IP du caméscope 
(Maintenance >Network >IP 
Address(Wireless) dans le menu de 
configuration).
Par exemple, si l’adresse IP est 192.168.1.1, 
saisissez « http://192.168.1.1/rm.html » 
dans la barre d’URL.

3 Saisissez le nom d’utilisateur et le mot de 
passe (Maintenance >Access 
Authentication (page 124) dans le menu 
de configuration) sur l’écran du 
navigateur.
Quand la connexion est réussie, l’écran 
Wi-Fi Remote s’affiche sur le dispositif.
Vous utilisez l’écran Wi-Fi Remote pour 
commander le caméscope.
Vous pouvez désactiver le 
fonctionnement de la touche REC en 
faisant glisser le bouton Lock vers la 
droite sur l’écran.
Vous pouvez également afficher la 
commande à distance Wi-Fi à l’aide de 
[Cam Remote Control] (page 80) du 
menu Web.

[Remarques]
ˎˎ Pour afficher la page pour un smartphone, remplacez 

« rm.html » par « rms.html » dans l’URL. Pour afficher 
la page pour une tablette, remplacez « rm.html » par 
« rmt.html » dans l’URL. Quand « rm.html » est saisi, 
la page s’affiche automatiquement sur le dispositif 
correspondant. Cependant, la page appropriée peut 
ne pas être affichée, en fonction du dispositif.
ˎˎ L’écran Wi-Fi Remote peut ne pas correspondre 

aux réglages du caméscope dans les circonstances 
suivantes. Si ceci se produit, rechargez la fenêtre du 
navigateur.

 ‒ Si le caméscope est remis en marche alors qu’il est 
connecté

 ‒ Si le caméscope est utilisé directement alors qu’il 
est connecté

 ‒ Si le dispositif a été reconnecté
 ‒ Si les touches avance/recul du navigateur ont été 

utilisées
ˎˎ La commande à distance Wi-Fi peut ne pas 

fonctionner si la force du signal sans fil devient faible.

Ecran Wi-Fi Remote (smartphones)

Ecran Main

ˎˎ Affichage de l’état
ˎˎ Réglages de prise de vue 

Iris, Focus, Zoom, S&Q FPS, 
Shutter, White, Gamma, Auto 
Iris, Gain, ATW, Color Bars, 
Auto Black, Auto White

Ecran Playback

ˎˎ Affichage de l’état
ˎˎ Touches de commande de 

lecture 
F Rev, Play/Pause, F Fwd, 
Prev, Stop, Next

Ecran Cursor

ˎˎ Indicateurs d’état
ˎˎ Touches de commande 

de curseur, affichage de 
menu/d’état 
Haut, gauche, Set, droite, 
bas, Cancel/Back, Menu, 
Status, Thumbnail, Option 
(SHIFT + SET)

Ecran Assign

ˎˎ Affichage de l’état
ˎˎ Commutateurs 

personnalisables 
Commutateur 
personnalisable 0, 1, 3, 4, 5
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Ecran Wi-Fi Remote (tablettes)

Ecran Main

ˎˎ Affichage de l’état
ˎˎ Commutateurs personnalisables 

Commutateur personnalisable 0, 1, 3, 4, 5
ˎˎ Réglages de prise de vue 

S&Q FPS, Shutter, White, Gamma, Auto Iris, Gain, ATW, 
Color Bars, Auto Black, Auto White

Ecran Playback

ˎˎ Affichage de l’état
ˎˎ Touches de commande de lecture 

F Rev, Play/Pause, F Fwd, Prev, Stop, Next

Ecran Cursor

ˎˎ Affichage de l’état
ˎˎ Touches de commande de curseur, affichage de 

menu/d’état 
Haut, gauche, Set, droite, bas, Cancel/Back, Menu, 
Status, Thumbnail, Option (SHIFT + SET)

Ecran Assign

ˎˎ Commutateurs personnalisables 
Commutateur personnalisable 0, 1, 3, 4, 5
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Configuration depuis le menu Web
Le menu Web du caméscope s’affiche quand 
le caméscope est commandé à partir d’un 
navigateur sur un dispositif connecté à l’aide 
d’une connexion LAN sans fil. A l’aide du menu 
Web, vous pouvez configurer des réglages liés 
aux fonctions sans fil, transférer des fichiers et 
effectuer d’autres actions.

Affichage du menu Web

1 Connectez le caméscope à Internet à 
l’aide des procédures indiquées sous 
« Connexion de dispositifs à l’aide du LAN 
sans fil » (page 63) et « Connexion à 
Internet » (page 67).

2 Lancez un navigateur sur le dispositif et 
saisissez « http://192.168.1.1:8080/index.
html » dans la barre d’URL.
L’écran de saisie de nom d’utilisateur et 
de mot de passe s’affiche.

3 Saisissez un nom d’utilisateur et un mot 
de passe, puis sélectionnez [OK].
Pour le nom d’utilisateur et le mot de 
passe pour l’authentification d’accès, 
reportez-vous à Maintenance >Access 
Authentication (page 124) dans le menu 
de configuration.

Menu de configuration

Lancez un navigateur sur le dispositif et 
saisissez « http://<IP_address>:8080 » dans la 
barre d’URL, où « <IP_address> » est l’adresse 
IP du caméscope (Maintenance >Network 
>IP Address dans le menu de configuration) 

pour afficher l’écran Media Info >SD Card du 
caméscope.
Tapez sur  en haut à gauche de l’écran 
de menu Web pour afficher les menus de 
configuration. Tapez sur l’élément que vous 
souhaitez configurer.
Le menu possède les éléments suivants : 
Settings, Media Info, Job List et Cam Remote 
Control.

Settings

Utilisé pour configurer le caméscope. Cet 
écran dispose des commandes suivantes.

Elément Description Consultez

Wireless 
Module 
>Streaming 
Format

Réglages du 
format de 
lecture en 
transit

Réglages du 
format de lecture 
en transit 
(page 80)

Wireless 
Module 
>Proxy Format

Réglages de 
format de 
proxy

Réglages de 
format de proxy 
(page 81)

Wireless 
Module 
>System 
Settings

Charge le 
certificat 
Network 
Client Mode 
Settings 
(exécuté en 
utilisant la 
touche Load 
de Load 
Certification)

Réglages du 
système 
(page 82)

Wireless LAN 
>Station 
Settings

Réglages de 
LAN sans fil

Réglages 
Wireless LAN 
Station 
(page 82)

Wireless LAN 
>Status

Etat des 
réglages LAN 
sans fil

Vérification des 
réglages de LAN 
sans fil 
(page 82)

Wired LAN 
>Wired LAN 
Settings

Réglages de 
LAN filaire

Réglages de LAN 
filaire 
(page 83)

Elément Description Consultez

Wired LAN 
>Status

Etat des 
réglages de 
LAN filaire

Vérification des 
réglages de LAN 
filaire 
(page 83)

Upload 
Settings

Réglages de 
transfert

Réglages de 
transfert 
(Upload) 
(page 83)

Media Info

Permet d’afficher les informations relatives 
au support et est utilisé pour sélectionner 
des fichiers à transférer à partir d’un support 
particulier.
ˎˎ SD Card : support inséré dans le logement 
pour carte PROXY SD du caméscope. 
Double-cliquer sur un fichier permet de 
commencer la lecture du fichier sélectionné.

 [Remarque]
Il est possible que la lecture ne soit pas prise en 
charge, en fonction du système d’exploitation 
du dispositif terminal utilisé et de la version du 
navigateur. Si cela se produit, utilisez « Content 
Browser Mobile ».

ˎˎ Slot A : support inséré dans le logement de 
carte A du caméscope
ˎˎ Slot B : support inséré dans le logement de 
carte B du caméscope

Job List

Permet d’afficher l’écran Job List pour la 
gestion des transferts de fichiers (page 84).

Cam Remote Control

Permet d’afficher l’écran Wi-Fi remote control 
(page 78).

OSS Information

Permet d’afficher les informations des droits 
d’auteur.

Réglages du format de lecture en 
transit

Vous pouvez configurer la lecture en transit 
pour la surveillance par des dispositifs, et 
régler le format et la destination de diffusion 
de la lecture en transit pour une lecture en 
transit via Internet ou le réseau local.

Video

ˎˎ AVC/H.264 Main Profile, 4:2:0 Long GOP
ˎˎ La taille est sélectionnée dans les réglages 
suivants.

Audio

ˎˎ Compression AAC-LC
ˎˎ Fréquence d’échantillonnage : 48 kHz
ˎˎ Débit binaire : 128 kbps pour le stéréo

Réglages de surveillance

Vous pouvez faire le réglage par dispositif du 
format pour la surveillance.
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Elément Description Réglage

Monitoring 
Size

Permet de régler 
la taille de la 
vidéo et le débit 
binaire pour la 
surveillance.

480×270(1Mbps)/ 
480×270(0.5Mbps)

Monitoring 
Frame Rate

Affiche la 
fréquence 
d’images vidéo 
pour la 
surveillance.

23.98fps/25fps/ 
29.97fps/50fps/ 
59.94fps

Monitoring 
Bit Rate

Affiche le débit 
binaire vidéo pour 
la surveillance.

1Mbps(VBR)/ 
0.5Mbps(VBR)

[Remarques]
ˎˎ Le débit binaire est une valeur moyenne qui peut 

parfois être dépassée.
ˎˎ Une fréquence d’images vidéo de 24 fps n’est pas 

prise en charge.
ˎˎ 640×360 (3 Mbps (VBR)) n’est pas pris en charge pour 

Monitoring Size.

Réglages de lecture en transit

Vous pouvez régler le format et la destination 
de diffusion pour la lecture en transit. Vous 
pouvez prédéfinir jusqu’à trois réglages.

Elément Description Réglage

On/Off Active/désactive 
la diffusion de 
lecture en transit.

On/Off

Preset Sélectionne le 
préréglage de 
Preset 1 à Preset 3. 
Vous pouvez 
modifier un 
préréglage en 
sélectionnant Edit.

Preset1/
Preset2/Preset3

Elément Description Réglage

Type Sélectionne le 
type de vidéo 
pour la lecture en 
transit.

MPEG-2 TS/
UDP/ 
MPEG-2 TS/ 
RTP

Size Règle la taille de 
vidéo pour la 
lecture en transit.
Lorsque HD Auto 
est sélectionné, la 
taille est réglée 
sur 1920×1080 ou 
1280×720, en 
fonction du 
réglage du format 
d’enregistrement 
enregistré sur la 
carte mémoire 
SxS ou du format 
du plan à lire.

HD Auto/ 
1280×720/ 
640×360/ 
480×270/ 
320×180

Bit Rate Règle le débit 
binaire de vidéo 
pour la lecture en 
transit.
Le débit binaire à 
sélectionner varie 
en fonction du 
réglage de Size.

9Mbps/6Mbps/ 
3Mbps/2Mbps/ 
1Mbps/0.5Mbps/ 
0.3Mbps(Mono L)/
0.3Mbps(Mono R)/
0.2Mbps(Mono L)/
0.2Mbps(Mono R)

Destination 
Address

Saisissez l’adresse 
du serveur de 
destination de la 
diffusion pour les 
données de 
lecture en transit.

Nom de l’hôte 
ou adresse IP

Destination 
Port

Saisissez le 
numéro de port 
du serveur de 
destination de la 
diffusion utilisé 
pour la lecture en 
transit.

1 à 65535

Audio 
Channel 
Select

Sélectionne les 
canaux audio 
pour la sortie de 
lecture en transit.

Ch-1 & Ch-2/ 
Ch-3 & Ch-4

[Remarques]
ˎˎ Lorsque Streaming est réglé sur On, la fonction de 

surveillance ne peut pas être utilisée.
ˎˎ Les données audio/vidéo sont transmises en l’état via 

Internet.  
De ce fait, les données peuvent éventuellement être 
exposées à des tiers.  
Vérifiez toujours que la destination de diffusion peut 
recevoir les données de lecture en transit.  
Les données peuvent être non intentionnellement 
envoyées au mauvais destinataire si l’adresse 
ou d’autres réglages ne sont pas correctement 
configurés.
ˎˎ Il se peut que certains plans ne soient pas lus, selon 

l’état du réseau.
ˎˎ La qualité de l’image peut être altérée lors de scènes 

comprenant des mouvements excessifs.
ˎˎ Il se peut que tous les plans ne soient pas lus lorsque 

la taille de lecture en transit est grande et que le débit 
binaire est faible.  
Pour y remédier, sélectionnez une taille plus petite 
pour le réglage Size.
ˎˎ Si un réseau avec une bande passante de moins de 

500 Kbps est utilisé, la taille et le débit binaire sont 
définis comme suit.

 ‒ Lorsque Size est de 480×270, Bit Rate est 
réglé sur 0.3Mbps(Mono L), 0.3Mbps(Mono R), 
0.2Mbps(Mono L) ou 0.2Mbps(Mono R).

 ‒ Lorsque Size est de 320×180, Bit Rate est réglé sur 
0.2Mbps(Mono L) ou 0.2Mbps(Mono R).

Lorsque cela se produit, la vidéo est réglée sur une 
fréquence d’images de 10 fps, et l’audio est réglé sur 
une fréquence d’échantillonnage de 48 kHz et un 
débit binaire de 56 Kbps.
ˎˎ Lorsque Bit Rate est de 0.3Mbps(Mono L) ou 

0.2Mbps(Mono L), Audio Channel Select >Ch-1 & Ch-2 
est réglé sur Ch-1 ou Ch-3 & Ch-4 est réglé sur Ch-3.  
Lorsque Bit Rate est de 0.3Mbps(Mono R) ou 
0.2Mbps(Mono R), Audio Channel Select >Ch-1 & Ch-2 
est réglé sur Ch-2 ou Ch-3 & Ch-4 est réglé sur Ch-4.

Réglages de format de proxy

Vous pouvez régler le format du fichier proxy 
enregistré sur la carte SD du caméscope.

Video

ˎˎ Proxy XAVC (AVC/H.264 Main Profile, 4:2:0 
Long GOP)
ˎˎ La taille est sélectionnée dans les réglages 
suivants.

Audio

ˎˎ Compression AAC-LC
ˎˎ Fréquence d’échantillonnage : 48 kHz
ˎˎ Débit binaire : 128 kbps pour le stéréo

Elément Description Réglage

Proxy File 
recording 
>Size

Permet de régler 
la taille de la 
vidéo et le débit 
binaire pour les 
fichiers proxy.

HD Auto(9Mbps)/ 
HD Auto(6Mbps)/ 
1280×720(9Mbps)/ 
1280×720(6Mbps)/ 
640×360(3Mbps)/ 
480×270(1Mbps)/ 
480×270(0.5Mbps)

Proxy File 
recording 
>Frame 
Rate

Affiche la 
fréquence 
d’images vidéo 
pour les fichiers 
proxy.

23.98fps/ 
25fps/ 
29.97fps/ 
50fps/ 
59.94fps

Proxy File 
recording 
>Bit Rate

Affiche le débit 
binaire de la vidéo 
pour les fichiers 
proxy.

9Mbps(VBR)/ 
6Mbps(VBR)/ 
3Mbps(VBR)/ 
1Mbps(VBR)/ 
0.5Mbps(VBR)

Proxy File 
recording 
>Audio 
Channel 
Select

Définit le canal 
audio à 
enregistrer pour 
les données proxy.

Ch-1 & Ch-2/ 
Ch-3 & Ch-4
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[Remarques]
ˎˎ Le débit binaire est une valeur moyenne qui peut 

parfois être dépassée.
ˎˎ Une fréquence de 24 fps n’est pas prise en charge.
ˎˎ Lorsque HD Auto est sélectionné pour Size dans les 

réglages du format proxy, le format proxy est défini 
en fonction du réglage du format d’enregistrement 
enregistré sur la carte mémoire SxS ou du format du 
plan à lire.
ˎˎ Les fichiers proxy enregistrés avec Size réglé sur HD 

Auto dans les réglages du format proxy peuvent ne 
pas être lus dans un navigateur ou Content Browser 
Mobile. Insérez les cartes SD pour l’enregistrement de 
fichiers proxy directement dans un ordinateur pour 
lire les fichiers.

Réglages du système

Utilisé pour charger le certificat Network Client 
Mode Settings.

Réglages du mode client réseau

ˎˎ Load Certification : touche Load 
Saisissez le certificat CCM « CCM_
certification.pem » à charger dans le 
répertoire racine de la carte SD au préalable. 
Pour plus de détails concernant les 
certificats CCM, contactez un représentant 
commercial Sony Professional.

Réglages Wireless LAN Station

Utilisez cet écran pour réaliser les réglages de 
connexion du caméscope à un LAN sans fil.

Elément Description

Host Name Nom du caméscope (peut 
être modifié)

SSID Permet d’afficher le SSID 
sélectionné sous [Access 
Point].

Elément Description

Key Saisissez le mot de passe 
pour le point d’accès.

Show Key Lorsque réglé sur On, les 
caractères saisis sont affichés.

DHCP Permet d’activer/désactiver le 
DHCP.
Lorsque cette fonction est 
réglée sur [On], une adresse 
IP est automatiquement 
attribuée au caméscope.
Pour saisir manuellement 
l’adresse IP du caméscope, 
réglez cette fonction sur [Off].

IP Address Permet de saisir l’adresse IP 
du caméscope. Activé 
uniquement lorsque DHCP 
est [Off].

Subnet mask Permet de saisir le masque 
de sous-réseau du 
caméscope.
Activé uniquement lorsque 
DHCP est [Off].

Gateway Permet de saisir la passerelle 
pour le point d’accès.
Activé uniquement lorsque 
DHCP est [Off].

DNS Auto Obtient automatiquement 
l’adresse DNS.
Lorsque le réglage est sur On, 
l’adresse du serveur DNS est 
obtenue automatiquement.

Primary DNS 
Server

Saisissez le serveur DNS 
primaire pour le point 
d’accès.
Activé uniquement lorsque 
DNS Auto est [Off].

Secondary DNS 
Server

Saisissez le serveur DNS 
secondaire pour le point 
d’accès.
Activé uniquement lorsque 
DNS Auto est [Off].

Submit Permet d’appliquer les 
réglages LAN sans fil.

Connexion à un point d’accès en mode 
station sans utiliser la fonction WPS

1 Connectez le caméscope et le dispositif à 
l’aide du mode de point d’accès 
(page 64).

2 Configurez les réglages sur l’écran Station 
Settings.
Configurez les réglages pour qu’ils 
correspondent aux réglages de la 
connexion de point d’accès.

Pour de plus amples informations concernant les 
réglages de point d’accès, reportez-vous au mode 
d’emploi du point d’accès.

3 Tapez sur [Submit].
Les réglages spécifiés sont appliqués.

4 Sélectionnez Maintenance >Network 
>Wi-Fi Mode dans le menu de 
configuration.

5 Tournez le bouton MENU pour 
sélectionner [Wi-Fi Station], puis appuyez 
sur le bouton.
Cette étape permet de connecter le 
caméscope au point d’accès en mode 
station. Passez à l’étape 9 sous 
« Connexion à un point d’accès à l’aide de 
la fonction WPS » (page 66) pour 
accéder au caméscope à partir du 
dispositif.

Vérification des réglages de LAN sans fil

Utilisez l’onglet Wireless LAN >Status pour 
surveiller l’état du LAN sans fil.
Les réglages affichés varient en fonction du 
mode LAN sans fil du caméscope.
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Mode Access Point

Mode Station

Réglages de LAN filaire

Utilisez cet écran pour réaliser les réglages de 
connexion du caméscope à un LAN filaire.

Elément Description

DHCP Permet d’activer/désactiver le 
DHCP.
Lorsque cette fonction est 
réglée sur [On], une adresse 
IP est automatiquement 
attribuée au caméscope.
Pour saisir manuellement 
l’adresse IP du caméscope, 
réglez cette fonction sur [Off].

IP Address Permet de saisir l’adresse IP 
du caméscope.
Activé lorsque DHCP est [Off].

Subnet mask Permet de saisir le masque 
de sous-réseau du 
caméscope. Activé lorsque 
DHCP est [Off].

Gateway Permet de saisir la passerelle 
pour le point d’accès.
Activé lorsque DHCP est [Off].

DNS Auto Obtient automatiquement 
l’adresse DNS.
Lorsque le réglage est sur On, 
l’adresse du serveur DNS est 
obtenue automatiquement.

Primary DNS 
Server

Saisissez le serveur DNS 
primaire du routeur.
Activé lorsque DNS Auto est 
[Off].

Secondary DNS 
Server

Saisissez le serveur DNS 
secondaire du routeur.
Activé lorsque DNS Auto est 
[Off].

Web/Cam 
Remote

Active/désactive l’accès au 
menu Web du caméscope et 
à la commande à distance 
Wi-Fi.
Lorsque le réglage est sur On, 
l’accès est autorisé.

Submit Configure les réglages du 
LAN filaire.

[Remarque]
Afin d’empêcher tout accès non autorisé depuis Internet, 
il est recommandé de régler Web/Cam Remote sur 
On uniquement quand le réseau LAN filaire n’est pas 
connecté à Internet. Lorsque vous vous connectez à 
Internet, assurez-vous que la connexion réseau se fait 
via un réseau sécurisé avant utilisation.

Vérification des réglages de LAN filaire

Utilisez l’onglet Wired LAN >Status pour 
surveiller l’état du LAN filaire.

Réglages de transfert (Upload)

Vous pouvez enregistrer et configurer des 
serveurs pour transférer des fichiers proxy 
ou des fichiers originaux enregistrés sur le 
caméscope.

Transfert automatique ON/OFF

Si [Auto upload] est [On] et qu’une connexion 
Internet existe, les fichiers proxy sont 
automatiquement transférés vers le serveur 

par défaut spécifié sur l’onglet Upload Settings 
à la fin de l’enregistrement.
« Sony Ci », « NCM: RX Server », « Server 
Settings1 », « Server Settings2 » et « Server 
Settings3 » sont enregistrés comme serveurs 
de destination de transfert. La valeur par 
défaut est « Sony Ci ».
« Sony Ci » est le service de Media Cloud 
Services fourni par Sony. Vous pouvez 
transférer des fichiers vers le service de cloud 
« Sony Ci ».

[Remarques]
ˎˎ Il est possible que le service ne soit pas disponible 

dans certaines régions.
ˎˎ Un abonnement est nécessaire afin d’utiliser le 

service de cloud « Sony Ci ». Pour plus de détails, 
consultez www.SonyMCS.com/wireless. 
Pour plus de détails sur la politique de confidentialité 
de Sony Ci, visitez les sites suivants.

 ‒ Modalités de service 
https://www.sonymcs.com/terms/

 ‒ Politique d’utilisation 
https://www.sonymcs.com/use/

 ‒ Politique de confidentialité 
https://www.sonymcs.com/privacy/

ˎˎ Le nom du dossier de destination du transfert est 
spécifié dans [Destination Directory]. S’il n’est pas 
spécifié, un nom de dossier où figure la date actuelle 
est utilisé. Pour modifier le réglage, reportez-vous 
à « Pour enregistrer un serveur de destination » 
(page 84).

Utilisez la procédure suivante pour vous 
enregistrer auprès de « Sony Ci ».
Pour plus de détails sur l’enregistrement, 
consultez www.SonyMCS.com/wireless.

1 Vérifiez que « Sony Ci » est affiché sur 
l’onglet [Upload Settings], puis cliquez sur 
[Edit].
L’écran de configuration « Sony Ci » 
s’affiche.

https://www.sonymcs.com/terms/
https://www.sonymcs.com/use/
https://www.sonymcs.com/privacy/
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2 Saisissez un nom d’utilisateur dans User, 
et un mot de passe dans Password.
Les caractères saisis sont visibles lorsque 
Show Password est On.

Load Certification : touche Load
Saisissez le certificat Ci « Ci_certification.
pem » à charger dans le répertoire racine 
de la carte SD au préalable. Pour plus de 
détails sur les certificats Ci, contactez un 
représentant commercial Sony 
Professional.

3 Tapez sur [Link].
Un message d’achèvement apparaît au 
bout d’un instant.
[Link] associe l’utilisateur au caméscope. 
Une connexion Internet est nécessaire 
pour utiliser [Link].

4 Tapez sur [OK].
Après que vous vous êtes enregistré 
auprès de « Sony Ci », [Unlink] s’affiche sur 
l’écran Settings. Tapez sur [Unlink] pour 
libérer le compte utilisateur et permettre à 
d’autres comptes d’utilisateur de se 
connecter au caméscope.

Pour enregistrer un serveur de 
destination

Vous pouvez sélectionner « Server Settings1 », 
« Server Settings2 » ou « Server Settings3 » 

(enregistrés dans Upload Server) comme 
serveur de destination.
Sélectionnez les réglages du serveur, appuyez 
sur Edit et configurez les informations du 
serveur sur l’écran d’affichage (ci-dessous).

Après avoir spécifié les réglages, tapez sur 
[OK] pour appliquer les réglages. Tapez sur 
[Cancel] pour supprimer les réglages.

Élément Description

Default Server Réglez ce mode sur [On] 
pour régler le serveur de 
destination de fichiers par 
défaut. (Affiché en haut de 
la liste de serveurs pour les 
transferts de fichiers.)

Display Name Saisissez le nom du serveur 
à afficher dans la liste.

Service Permet d’afficher le type de 
serveur.
FTP : serveur FTP

Host Name Saisissez l’adresse du 
serveur.

[Remarque]
Si un autre numéro de port que 
le numéro de port par défaut 
21 est utilisé, ajoutez un signe 
deux-points et le numéro de 
port à la fin de l’adresse (par 
exemple, « :123 »).

User Saisissez le nom 
d’utilisateur.

Password Saisissez le mot de passe.

Élément Description

Show Password Lorsque réglé sur On, les 
caractères saisis sont 
affichés.

PASV Mode Activez/désactivez le mode 
PASV.

Destination 
Directory

Spécifiez le répertoire de 
destination.

[Remarque]
Si un caractère non valide est 
saisi dans le nom du répertoire, 
le répertoire n’est pas créé et 
les fichiers sont transférés au 
niveau supérieur du répertoire 
de destination de transfert par 
défaut.

Using Secure 
Protocol

Permet d’établir l’utilisation 
ou non d’un FTP sécurisé.

Load Certification Permet de charger un 
certificat CA intermédiaire.
Affiché lorsque Using 
Secure Protocol est réglé sur 
On.

[Remarques]
ˎˎ La communication via FTP 

n’est pas cryptée. L’utilisation 
du FTPS est recommandée.
ˎˎ Un certificat CA intermédiaire 

contenant un certificat racine 
est requis.
ˎˎ Le certificat à charger doit 

être au format PEM et doit 
être enregistré dans le 
répertoire racine de la carte 
SD avec « certification.pem » 
comme nom de fichier.

[Remarque]
La communication via FTP n’est pas cryptée. L’utilisation 
du FTPS est recommandée.

Pour changer les réglages enregistrés 
de serveur

Sélectionnez le serveur dont vous souhaitez 
modifier les réglages sur l’écran Upload 
Settings, puis tapez sur [Edit]. Changez le 

réglage sur l’écran de configuration affiché.
Pour de plus amples informations concernant 
les éléments, reportez-vous à « Pour 
enregistrer un serveur de destination ».

Surveillance du transfert de 
fichiers (Job List)

Vous pouvez surveiller l’état du transfert 
de fichiers, gérer les fichiers dans la liste 
de fichiers à transférer et lancer/arrêter les 
transferts de fichiers.
Le caméscope prend en charge la fonction FTP 
resume (pour reprendre le transfert de fichiers 
si celui-ci s’interrompt).

Élément Description

Total Etat d’avancement du 
transfert de tous les fichiers

Status Etat d’avancement du 
fichier en cours de transfert

Remain time Temps de transfert restant 
prévu

Transfer data rate Débit de transfert
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Pour arrêter/relancer le transfert de 
fichiers ou supprimer un fichier de la 
liste de transfert

1 Sélectionnez un fichier.

2 Tapez sur  en haut à droite de l’écran.
Sélectionnez un élément de menu.
ˎˎ Abort selected : permet d’arrêter le 
transfert de fichiers.
ˎˎ Delete from list : permet de supprimer 
le fichier de la liste de transfert.
ˎˎ Start selected : permet de lancer le 
transfert de fichiers.
ˎˎ Select All : permet de sélectionner tous 
les fichiers de la liste.
ˎˎ Clear completed : permet de supprimer 
tous les fichiers qui ont été transférés à 
partir de la liste.

Dépannage lors du chargement 
du certificat

Symptôme Solution

« Invalid 
certification file. » 
apparaît.

Le certificat chargé n’est 
pas valide.
Vérifiez le certificat.

« Certification file 
not found. » 
apparaît.

Vérifiez que le nom de 
fichier du certificat est 
correct.
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Fonctions de réseau prises en charge et restrictions de fonctionnement

Fonctions réseau et réglages de connexion réseau

Les fonctions réseau et les réglages de connexion réseau correspondants pris en charge 
(réglages Maintenance >Network >Wi-Fi Mode, Modem, et Wired LAN) sont indiqués ci-dessous.
Pour activer les fonctions réseau, réglez Maintenance >Network >Setting dans le menu de 
configuration sur On.

Fonction réseau Maintenance >Network >Wireless 
Network dans le menu de 
configuration

Maintenance 
>Network >Modem

Maintenance >Network 
>Wired LAN

Wi-Fi Access 
Point

Wi-Fi 
Station

Off On Off Enable Disable

Enregistrement 
proxy 1)

(page 56)

Oui Oui Oui Oui Oui Oui Oui

Lecture proxy
(page 80)

Oui 2) Oui 2) Non Non Non Oui 2) Non

Transfert de fichiers
(page 71)

Non Oui 2) Non Oui 2) Non Oui 2) Non

Transmission de 
lecture en transit
(page 75)

Non Oui Non Oui Non Oui Non

Surveillance
(page 80)

Oui 2) Oui 2) Non Non Non Oui 2) Non

Mode client réseau
(page 76)

Non Oui Non Oui Non Oui Non

Télécommande du 
caméscope
(page 78)

Oui 2) Oui 2) Non Non Non Oui 2) Non

1) L’enregistrement proxy est activé quand Operation >XAVC Proxy Rec Mode >Setting dans le menu de configuration 
est réglé sur On.

2) Prise en charge des fonctions des dispositifs connectés au réseau et du caméscope.

Restrictions de l’usage simultané des fonctions réseau

Les restrictions suivantes s’appliquent à l’usage simultané des fonctions réseau.

Connexion LAN sans fil Connexion LAN 
filaire

Fonctionnement

Aucun Désactivé Fonction Network arrêtée

Module USB LAN sans fil Désactivé Module USB LAN sans fil en fonctionnement

Modem USB 3G/4G/LTE Désactivé Modem USB 3G/4G/LTE en fonctionnement

Aucun Activé LAN filaire en fonctionnement

Module USB LAN sans fil Activé Module USB LAN sans fil et LAN filaire en 
fonctionnement 1)

1) La lecture en transit et le transfert de fichier fonctionnent en utilisant le LAN filaire. Le module USB LAN sans fil est 
réservé au fonctionnement de la commande à distance Wi-Fi.

[Remarque]
La connexion LAN filaire est impossible lorsque l’adaptateur d’extension USB de l’adaptateur Ethernet CBK-NA1R, 
fourni avec le CBK-NA1 (optionnel), est raccordé au module USB LAN sans fil du caméscope.
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Opérations sur les plans sur l’écran de miniatures
6. Opérations sur les plans

Ecran de miniatures

OK S

1 2 3 4

9 10 11 12 13

65 7 8

Sub

Curseur 
(jaune)

L’écran de miniatures apparaît si vous appuyez 
sur la touche THUMBNAIL en mode de lecture 
ou E-E. Les écrans de miniatures affichent les 
listes des images d’index des plans stockés 
sur des cartes mémoire SxS sous forme de 
miniatures.
Vous pouvez sélectionner n’importe quel plan 
(page 88) dans un écran de miniatures et 
démarrer la lecture de ce plan (page 88).
Vous pouvez également ajouter une balise de 
plan à un des plans de l’écran de miniatures 
pour filtrer les plans selon les balises. Vous 
pouvez également basculer de l’écran de 
miniatures à l’écran de miniatures de repères 
et ajouter des repères (par exemple, des 

repères de prise de vue) à n’importe quelle 
image du plan.

Pour masquer l’écran de miniatures, appuyez 
sur la touche THUMBNAIL.

1. Miniature (image d’index)
Lorsqu’un plan est enregistré, sa première 
image est automatiquement affichée 
comme image d’index. Vous pouvez modifier 
l’image d’index pour n’importe quelle image 
(page 92).

2. Statut du support/icône du support 
sélectionné

Un repère  s’affiche si le support est 
protégé.
Si deux cartes mémoire SxS sont insérées dans 
le caméscope, vous pouvez basculer entre 
elles à l’aide de la touche SLOT SELECT.

3. Numéro de plan / nombre total de plans

4. Etat batterie / tension

5. Indicateur de lecture désactivée

6. État des plans
Affiche l’état des plans à l’aide d’une icône.

Icône Signification

Icônes S, OK, 
NG, KP

Repère ou balise de plan 
associé à un plan

Icône Sub Enregistrement d’un sous-plan 
(1-slot Simul Rec)

Icône de 
verrou

Le plan est verrouillé (protégé)
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7. Case à cocher de sélection de plan
Placez une coche dans la case à cocher pour 
sélectionner un plan (miniature).

8. Informations des miniatures
Affiche les informations des miniatures. Les 
informations affichées varient en fonction du 
réglage Customize View (page 93).

9. Nom de plan / titre
Affiche le nom ou le titre du plan sélectionné.

10. Format d’enregistrement vidéo

11. Informations d’enregistrement spécial
Affiche le mode d’enregistrement si le 
plan a été enregistré à l’aide d’un mode 
d’enregistrement spécial (ralenti et accéléré).
Pour les plans en ralenti et accéléré, 
[Recording frame rate/Playback frame rate] est 
affiché à droite.

12. Durée du plan

13. Date de création

Sélection de plans

Pour sélectionner une miniature de plan, 
effectuez l’une des opérations suivantes pour 
déplacer le curseur jaune sur la miniature que 
vous souhaitez sélectionner.
ˎˎ Appuyez sur les touches , , , .
ˎˎ Tournez le bouton MENU.
ˎˎ Appuyez sur la touche PREV ou NEXT.

Sélection de la première miniature

Tenez la touche F REV enfoncée et appuyez 
sur la touche PREV.

Sélection de la dernière miniature

Tenez la touche F FWD enfoncée et appuyez 
sur la touche NEXT.

Lecture de plans séquentiellement 
en commençant par le plan 
sélectionné

1 Sélectionnez la miniature du plan que 
vous souhaitez lire en premier.

2 Appuyez sur la touche PLAY/PAUSE.
La lecture commence au début du plan 
sélectionné.

Les plans sont lus séquentiellement en 
commençant par le plan sélectionné.
Une fois la lecture du dernier plan terminée, le 
caméscope bascule vers l’image de la caméra 
ou l’état d’entrée externe.
Appuyez sur la touche THUMBNAIL pour 
revenir à l’écran de miniatures.

[Remarques]
ˎˎ Tous les plans ne peuvent pas être lus 

séquentiellement si les plans sur les cartes mémoire 
SxS ont été enregistrés avec différents formats 
d’enregistrement.
ˎˎ Les plans avec une icône indiquant l’indisponibilité 

de la lecture (page 87) affichés sur l’écran des 
miniatures ne sont pas lus. Les plans correspondants 
sont sautés et la lecture séquentielle continue.
ˎˎ Il peut y avoir une interruption temporaire de l’image 

ou une image fixe à la limite située entre les plans. 
Pendant ce temps, les commandes de lecture et la 
touche THUMBNAIL ne peuvent pas être utilisées.
ˎˎ Lorsque vous sélectionnez un plan dans l’écran de 

miniatures et commencez la lecture, il peut y avoir 
une interruption temporaire de l’image au début du 
plan. Pour voir le début du plan sans interruption, 
mettez le caméscope en mode de lecture, mettez la 

lecture en pause, utilisez la touche PREV pour revenir 
au début du plan et redémarrez la lecture.

Pause de la lecture

Appuyez sur la touche PLAY/PAUSE.
L’indicateur PLAY/PAUSE clignote quand la 
lecture est en pause.
Appuyez de nouveau sur la touche pour 
revenir au mode de lecture.

Lecture à vitesse rapide

Appuyez sur la touche F FWD (page 8) ou 
F REV (page 8).
Pour revenir à la lecture normale, appuyez sur 
la touche PLAY/PAUSE.

Retour au début du plan actuel

Appuyez sur la touche PREV.
ˎˎ Pendant la lecture, cela vous permet 
d’accéder au début du plan actuel et de 
démarrer la lecture.
ˎˎ Pendant l’avance rapide (F FWD), cela vous 
permet d’accéder au début du plan actuel et 
de mettre la lecture en pause.
ˎˎ Pendant le retour rapide (F REV) ou en 
pause, cela vous permet d’accéder au début 
du plan actuel et d’afficher une image fixe.
ˎˎ Chaque pression successive de la touche 
vous fait passer au plan précédent.

Lecture à partir du début du 
premier plan

Appuyez simultanément sur les touches PREV 
et F REV. Cela vous permet d’accéder au début 
du premier plan sur la carte mémoire SxS.

Passage au début du plan suivant

Appuyez sur la touche NEXT.
ˎˎ Pendant la lecture, cela vous permet 
d’accéder au début du plan suivant et de 
démarrer la lecture.
ˎˎ Pendant l’avance rapide (F FWD), cela vous 
permet d’accéder au début du plan suivant 
et de mettre la lecture en pause. Pendant 
la lecture du dernier plan, cela vous permet 
d’accéder à la fin du plan et de mettre la 
lecture en pause.
ˎˎ Pendant le retour rapide (F REV) ou en 
pause, cela vous permet d’accéder au début 
du plan suivant et d’afficher une image fixe.
ˎˎ Chaque pression successive de la touche 
vous fait passer au plan suivant.

Accès au dernier plan

Appuyez simultanément sur les touches F 
FWD et NEXT. Cela vous permet d’accéder à la 
dernière image du dernier plan enregistré sur 
la carte mémoire SxS.
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Ajout d’un repère de prise de vue 
pendant la lecture

Vous pouvez ajouter des repères de prise de 
vue aux plans pendant la lecture en utilisant la 
même méthode que pendant l’enregistrement 
(page 50).

[Remarque]
Les repères de prise de vue ne peuvent pas être 
enregistrés lorsque la carte mémoire SxS est protégée 
en écriture.

Arrêt de la lecture

Appuyez sur la touche STOP : la lecture 
s’arrête et le caméscope passe en mode 
E-E.

Appuyez sur la touche THUMBNAIL : la 
lecture s’arrête et l’écran de miniatures 
(page 87) apparaît dans le viseur.

La lecture s’arrête également si vous éjectez 
la carte mémoire. Dans ce cas, l’image de la 
caméra apparaît dans le viseur.

Opérations de base du menu 
Thumbnail

Le menu Thumbnail est utilisé pour protéger/
supprimer des plans, vérifier des propriétés, 
ajouter/supprimer des balises et des repères 
aux images d’un plan et d’autres tâches.

1 Appuyez sur la touche THUMBNAIL.
L’écran de miniatures apparaît.

2 Réglez le commutateur MENU ON/OFF sur 
ON ou appuyez sur la touche MENU.
L’écran de menu apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Thumbnail], puis appuyez 
sur le bouton.
Vous pouvez également appuyer sur la 
touche  ou  pour sélectionner 
[Thumbnail] et appuyer sur la touche SET.

Pour masquer le menu Thumbnail, appuyez de 
nouveau sur la touche MENU.

Pour sélectionner un élément/sous-élément 
de menu, effectuez l’une des opérations 
suivantes.
ˎˎ Tournez le bouton MENU pour sélectionner 
un élément ou un sous-élément puis 
appuyez sur le bouton.
ˎˎ Appuyez sur les touches fléchées (, , , 
) pour sélectionner un élément ou un 
sous-élément puis appuyez sur la touche 
SET.

Selon l’élément ou le sous-élément 
sélectionné, une liste de sélection ou un écran 
de propriétés de plan apparaît (page 91).
Pour revenir à l’écran précédent, poussez le 
commutateur MENU CANCEL/PRST/ESCAPE 
vers la position ESCAPE.

[Remarques]
ˎˎ Lorsqu’une carte mémoire SxS est protégée en 

écriture, il n’est pas possible de copier, de supprimer, 
de modifier des images d’index ou d’ajouter et de 
supprimer des balises de plans et des repères de 
prise de vue.

ˎˎ Certains éléments ne peuvent pas être sélectionnés, 
selon l’état du caméscope lorsque le menu a été 
affiché.

Pour plus de détails sur la structure de l’écran 
de miniatures, consultez « Menu Thumbnail » 
(page 93).

Protection de plans

Vous pouvez protéger un plan spécifique 
ou tous les plans pour empêcher leur 
suppression.

 est ajouté aux miniatures des plans 
protégés.
Les plans peuvent être protégés sur l’écran de 
miniatures ou l’écran de miniatures de plans 
filtrés (page 92).

[Remarques]
ˎˎ Cette fonction n’est pas disponible lorsque le système 

de fichiers est réglé sur FAT.
ˎˎ Pour les plans créés en mode 1-slot Simul Rec, les 

sous-plans sont également protégés.

Protection d’un plan spécifique

1 Sélectionnez Thumbnail >Lock/Unlock Clip 
>Select Clip dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
L’écran de sélection de plan apparaît.

3 Tournez le bouton MENU pour 
sélectionner un plan à protéger, puis 
appuyez sur le bouton.
Une coche est ajoutée au plan 
sélectionné.

4 Appuyez et maintenez enfoncée la touche 
SHIFT et appuyez sur la touche SET.
Une boîte de dialogue de confirmation 
apparaît.

5 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Le plan est protégé et un message 
d’achèvement apparaît.

6 Appuyez sur le bouton MENU pour faire 
disparaître ce message.

Protection de tous les plans

1 Sélectionnez Thumbnail >Lock/Unlock Clip 
>Lock All Clips dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Tous les plans sont protégés et un 
message d’achèvement apparaît.

4 Appuyez sur le bouton MENU pour faire 
disparaître ce message.

Déverrouillage de tous les plans

1 Sélectionnez Thumbnail >Lock/Unlock Clip 
>Unlock All Clips dans le menu de 
configuration.
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2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Tous les plans sont déverrouillés et un 
message d’achèvement apparaît.

4 Appuyez sur le bouton MENU pour faire 
disparaître ce message.

Copie de plans

Vous pouvez copier des plans vers une autre 
carte mémoire SxS.
Les plans sont copiés vers les cartes mémoire 
SxS de destination en conservant les mêmes 
noms que les plans d’origine.

[Remarques]
ˎˎ Si un plan ayant le même nom existe déjà sur la 

carte mémoire SxS de destination de la copie, un 
chiffre unique entre parenthèses est ajouté au nom 
d’origine.  
Le chiffre entre parenthèses est le plus petit numéro 
n’existant pas dans la destination de copie.  
Exemple :  
ABCD0002ABCD0002(1) 
ABCD0002(1)ABCD0002(2) 
ABCD0005(3)ABCD0005(4)
ˎˎ Si les numéros entre parenthèses (1) à (999) existent 

déjà dans la destination de copie parce qu’un plan a 
été copié plus de 1000 fois, il n’est plus possible de 
copier des plans avec le même nom.
ˎˎ Un message s’affiche si l’espace libre restant est 

insuffisant sur la carte mémoire SxS de destination 
de la copie. Remplacez la carte par une carte dont la 
capacité disponible est plus grande.
ˎˎ Lorsque plusieurs plans sont enregistrés sur la carte 

mémoire SxS source, il existe un risque que tous 
les plans ne soient pas copiés même si les cartes 

mémoires source et de destination ont la même 
capacité. Cela dépend des caractéristiques de la 
mémoire et de l’utilisation des cartes mémoire.
ˎˎ Lorsque les plans créés en mode 1-slot Simul Rec sont 

copiés, le plan principal et les sous-plans sont copiés.

Copie d’un plan spécifique

1 Sélectionnez Thumbnail >Copy Clip 
>Select Clip dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
L’écran de sélection de plan apparaît.

3 Tournez le bouton MENU pour 
sélectionner un plan à copier, puis 
appuyez sur le bouton.
Une coche est ajoutée au plan 
sélectionné.

4 Appuyez et maintenez enfoncée la touche 
SHIFT et appuyez sur la touche SET.
Une boîte de dialogue de confirmation 
apparaît.

5 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Le plan est copié et un message 
d’achèvement apparaît.

6 Appuyez sur le bouton MENU pour faire 
disparaître ce message.

Copie de tous les plans

Vous pouvez copier tous les plans stockés sur 
la même carte mémoire SxS en même temps 
sur une autre carte mémoire SxS.

1 Sélectionnez Thumbnail >Copy Clip >All 
Clips dans le menu de configuration.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Tous les plans sont copiés et un message 
d’achèvement apparaît.

4 Appuyez sur le bouton MENU pour faire 
disparaître ce message.

Suppression de plans

Vous pouvez supprimer des plans de cartes 
mémoires SxS. Les plans peuvent être 
supprimés sur l’écran de miniatures ou l’écran 
de miniatures de plans filtrés (page 92).

[Remarque]
Lorsque les plans créés en mode 1-slot Simul Rec sont 
supprimés, le plan principal et les sous-plans sont 
supprimés.

1 Sélectionnez Thumbnail >Delete Clip 
>Select Clip dans le menu de 
configuration.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
L’écran de sélection de plan apparaît.

3 Tournez le bouton MENU pour 
sélectionner un plan à supprimer, puis 
appuyez sur le bouton.
Une coche est ajoutée au plan 
sélectionné.

4 Appuyez et maintenez enfoncée la touche 
SHIFT et appuyez sur la touche SET.
Une boîte de dialogue de confirmation 
apparaît.

5 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Le plan est supprimé et un message 
d’achèvement apparaît.

6 Appuyez sur le bouton MENU pour faire 
disparaître ce message.

Les plans qui se trouvaient en-dessous du 
plan supprimé dans l’écran de miniatures 
remontent d’une position.

Suppression de tous les plans

Vous pouvez supprimer tous les plans stockés 
sur la même carte mémoire SxS en même 
temps.

[Remarques]
ˎˎ Les plans supprimés ne peuvent pas être restaurés.
ˎˎ Si le support ou le plan est protégé, cette fonction est 

désactivée.

1 Sélectionnez Thumbnail >Delete Clip >All 
Clips dans le menu de configuration.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Une boîte de dialogue de confirmation 
apparaît.
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3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Tous les plans sont supprimés et un 
message d’achèvement apparaît.

4 Appuyez sur le bouton MENU pour faire 
disparaître ce message.

Transfert de plans

Les plans (fichiers originaux) enregistrés 
sur les cartes mémoires SxS et les fichiers 
proxy enregistrés sur les cartes SD peuvent 
être téléchargés sur un serveur en utilisant 
Thumbnail >Transfer Clip et Transfer 
Clip(Proxy), respectivement, dans le menu de 
configuration.
Pour la procédure Thumbnail >Transfer Clip, 
consultez « Transfert des fichiers originaux à 
l’aide de l’écran de miniatures » (page 73).
Pour la procédure Thumbnail >Transfer 
Clip(Proxy), consultez « Transfert des fichiers 
originaux à l’aide de l’écran de miniatures » 
(page 73).

[Remarque]
Lorsque les plans créés en mode 1-slot Simul Rec 
sont transférés en utilisant Thumbnail >Transfer Clip, 
uniquement le plan principal est transféré.

Affichage des propriétés de plan

L’écran de propriétés de plan du plan sélectionné apparaît lorsque vous sélectionnez Thumbnail 
>Display Clip Properties dans le menu de configuration.

1

2

3

4

5

6
7

OK S Sub

1. Image du plan actuel
Affiche l’image d’index et l’état du plan 
sélectionné.

2. Affichage de code temporel
TC Index : code temporel de l’image affichée
Start : code temporel du point de démarrage 

de l’enregistrement
End : code temporel du point de fin de 

l’enregistrement
Duration : durée entre les points de début et 

de fin

3. Date de création et date de modification

4. Nom de plan

5. Format d’enregistrement
Video Codec : codec vidéo
Size : taille d’image
FPS : fréquence d’images
Audio Codec : codec audio
Ch/Bit : canal audio d’enregistrement/nombre 

de bits pour l’enregistrement audio

6. Informations d’enregistrement spécial

7. Nom du dispositif d’enregistrement

Pour masquer l’écran des propriétés de plan, 
effectuez l’une des opérations suivantes.
Appuyez sur la touche RESET/RETURN : 

permet de revenir à l’écran du menu 
Thumbnail.

Appuyez sur la touche THUMBNAIL : permet 
de régler le caméscope en mode E-E et 
d’afficher l’image de la caméra.

Appuyez sur la touche PLAY/PAUSE : lance la 
lecture du plan sélectionné.

Ajout de balises sur les plans

Vous pouvez ajouter des balises (repères OK, 
NG ou KP) aux plans pour filtrer l’affichage des 
plans en fonction des balises. Vous effectuez 
cette opération sur l’écran de miniatures 
ou l’écran de miniatures de plans filtrés 
(page 92).

[Remarque]
Cette fonction n’est pas disponible lorsque le système 
de fichiers est réglé sur FAT.

1 Sélectionnez la miniature du plan auquel 
vous voulez ajouter la balise de plan, puis 
sélectionnez Thumbnail >Set Clip Flag 
dans le menu de configuration.

2 Tournez le bouton MENU pour 
sélectionner une balise, puis appuyez sur 
le bouton.

Réglage Balise de plan ajoutée

Add OK OK

Add NG NG

Add KEEP KP

La balise est ajoutée à la miniature du 
plan sélectionné.

Vous pouvez également utiliser un 
commutateur personnalisable auquel la 
fonction Clip Flag est attribuée pour ajouter 
des balises (page 133).

Suppression d’une balise de plan

1 Sélectionnez la miniature du plan duquel 
vous voulez supprimer une balise de plan, 
puis sélectionnez Thumbnail >Set Clip 
Flag >Delete Clip Flag dans le menu de 
configuration.
La balise de plan est supprimée.
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Filtrage de plans affichés à l’aide 
de l’écran des plans filtrés

[Remarque]
Cette fonction n’est pas disponible lorsque le système 
de fichiers est réglé sur FAT.

1 Sélectionnez Thumbnail >Filter Clips dans 
le menu de configuration.

2 Tournez le bouton MENU pour 
sélectionner une balise utilisée pour filtrer 
les plans, puis appuyez sur le bouton.

Réglage Balise de plan de filtre

OK OK

NG NG

KEEP KP

None (Les plans ne sont pas filtrés)

L’écran de plans apparaît en affichant les 
plans filtrés selon la balise sélectionnée. 
Cet écran est appelé l’écran de plans 
filtrés.

Pour annuler le filtrage, réalisez l’une des 
actions suivantes.
ˎˎ Appuyez sur la touche RESET/RETURN.
ˎˎ Sélectionnez Thumbnail >Thumbnail View 
>All dans le menu de configuration.

Ajout/suppression de repères 
dans les plans

Vous pouvez ajouter (et supprimer) des 
repères (repères de prise de vue, repères 
de début d’enregistrement) à n’importe 
quelle image dans un plan. Vous pouvez 

ajouter/supprimer des repères sur l’écran de 
miniatures de repères.

[Remarque]
Cette fonction n’est pas disponible lorsque le système 
de fichiers est réglé sur FAT.

Ajout d’un repère de prise de vue

1 Sélectionnez Thumbnail > Thumbnail View 
> Essence Mark Thumbnail dans le menu 
de configuration.

2 Tournez le bouton MENU pour 
sélectionner [All] puis appuyez sur le 
bouton.

3 Sélectionnez la miniature de l’image à 
laquelle vous voulez ajouter le repère 
dans l’écran de miniatures de repères, 
puis sélectionnez Thumbnail >Set Shot 
Mark dans le menu de configuration.

4 Tournez le bouton MENU pour 
sélectionner un des réglages suivants, 
puis appuyez sur le bouton.

Réglage Fonctionnement

Add Shot Mark1 Ajoute le repère de 
prise de vue 1

Add Shot Mark2 Ajoute le repère de 
prise de vue 2

Le repère de prise de vue est ajouté à 
l’image sélectionnée.

Suppression d’un repère de prise de vue

1 Sélectionnez Thumbnail > Thumbnail View 
> Essence Mark Thumbnail dans le menu 
de configuration.

2 Sélectionnez le type de repère de prise de 
vue à supprimer.

3 Sélectionnez la miniature de l’image de 
laquelle vous voulez supprimer le repère 
dans l’écran de miniatures de repères, 
puis sélectionnez Thumbnail >Set Shot 
Mark dans le menu de configuration.

4 Tournez le bouton MENU pour 
sélectionner un des réglages suivants, 
puis appuyez sur le bouton.

Réglage Fonctionnement

Delete Shot Mark1 Supprime le repère de 
prise de vue 1

Delete Shot Mark2 Supprime le repère de 
prise de vue 2

Le repère de prise de vue est supprimé de 
l’image sélectionnée.

Filtrage des plans (images) à l’aide 
de l’écran de miniatures de 
repères

L’écran de miniatures de repères affiche 
uniquement les images d’un plan dans 
lesquelles un repère a été enregistré en 
affichage de miniatures. Affichez l’écran 
de miniatures, puis appuyez sur la touche 
ESSENCE MARK (page 10) ou utilisez la 
procédure suivante pour afficher l’écran de 
miniatures de repères.

[Remarque]
Cette fonction n’est pas disponible lorsque le système 
de fichiers est réglé sur FAT.

1 Sélectionnez Thumbnail >Thumbnail View 
>Essence Mark Thumbnail dans le menu 
de configuration.

2 Tournez le bouton MENU pour 
sélectionner un repère utilisé pour filtrer 
les images, puis appuyez sur le bouton.

Réglage Description

All Toutes les images 
contenant des repères

Rec Start Les images marquées d’un 
repère de début 
d’enregistrement et la 
première image des plans 
qui ne sont pas marqués 
d’un repère de début 
d’enregistrement

Shot Mark0 à 
Shot Mark9

Les images avec chaque 
repère de prise de vue

L’écran de miniatures de repères apparaît, 
filtré selon le repère sélectionné.

Si un plan est enregistré en utilisant des 
métadonnées de planification qui définissent 
des noms pour Shot Mark 0 à Shot Mark 9, les 
options de sélection dans la liste s’affichent en 
fonction des noms définis.

Changement de l’image d’index 
d’un plan

Vous pouvez définir l’image sélectionnée 
sur l’écran de miniatures de repères comme 
image d’index pour le plan.
Sélectionnez la miniature de l’image que vous 
souhaitez définir comme image d’index pour 
le plan, puis sélectionnez Thumbnail >Set 
Index Picture dans le menu de configuration.



6. Opérations sur les plans93

Menu Thumbnail
Les valeurs par défaut sont soulignées et le texte est en gras.

Elément Réglage de sous-éléments Description

Display Clip Properties – Affiche les propriétés de plan (page 91).

Set Index Picture – Définit/change l’image d’index d’un plan 
(page 92).

Thumbnail View
Change l’écran de 
miniatures affiché.

Essence Mark Thumbnail
All/Rec Start/Shot Mark1/
Shot Mark2/Shot Mark3/
Shot Mark4/Shot Mark5/
Shot Mark6/Shot Mark7/Shot 
Mark8/Shot Mark9/Shot 
Mark0

Affiche l’écran de miniatures de repères avec 
des plans filtrés par repère (page 92).

Clip Thumbnail Affiche l’écran de miniatures (écran de 
miniature de plans) (page 87).

Set Shot Mark
Ajoute/supprime les 
repères de prise de vue.

Add Shot Mark1 Ajoute le repère de prise de vue 1 à une 
image (page 92).

Delete Shot Mark1 Supprime le repère de prise de vue 1 
(page 92).

Add Shot Mark2 Ajoute le repère de prise de vue 2 à une 
image (page 92).

Delete Shot Mark2 Supprime le repère de prise de vue 2 
(page 92).

Set Clip Flag
Ajoute/supprime les 
balises de plan.

Add OK Ajoute une balise OK à un plan (page 91).

Add NG Ajoute une balise NG à un plan (page 91).

Add KEEP Ajoute une balise KP (Keep) à un plan 
(page 91).

Delete Clip Flag Supprime une balise de plan (page 91).

Lock/Unlock Clip
Protège/déverrouille un 
plan.

Select Clip Sélectionne le plan à protéger (page 89).

Lock All Clips Protège tous les plans sur le support 
(page 89).

Unlock All Clips Déverrouille tous les plans sur le support 
(page 89).

Copy Clip
Copie des plans.

Select Clip Sélectionne le plan à copier (page 90).

All Clips Copie tous les plans sur le support 
(page 90).

Copy Sub Clip 
Copie les sous-plans sur 
d’autres supports en 
tant que plans 
principaux.

All Clips Sélectionne tous les sous-plans à copier 
(page 55).

Elément Réglage de sous-éléments Description

Delete Clip
Supprime les plans.

Select Clip Sélectionne le plan à supprimer 
(page 90).

All Clips Supprime tous les plans sur le support 
(page 90).

Transfer Clip
Enregistre les fichiers 
originaux à transférer 
dans la liste des tâches.

Select Clip Sélectionne le fichier original à transférer 
(page 73).

All Clips Sélectionne tous les fichiers originaux sur le 
support à transférer (page 73).

Transfer Clip(Proxy)
Enregistre les fichiers 
proxy à transférer dans 
la liste des tâches.

Select Clip Sélectionne le fichier proxy à transférer 
correspondant au fichier original sélectionné 
(page 71).

All Clips Sélectionne tous les fichiers proxy sur le 
support à transférer correspondant au fichier 
original (page 72).

Filter Clips
Filtre l’affichage des 
plans par balise.

OK Filtre l’affichage des plans en fonction de 
balises OK (page 92).

NG Filtre l’affichage des plans en fonction de 
balises NG (page 92).

KEEP Filtre l’affichage des plans en fonction de la 
balise KP (Keep) (page 92).

None Les plans ne sont pas filtrés (page 92).

Customize View Thumbnail Caption
Date Time/Time Code/
Duration/Sequential 
Number

Sélectionne les informations affichées sous 
les miniatures de plans.
Date Time : affiche la date et l’heure.
Time Code : affiche le code temporel.
Duration : affiche la durée du plan.
Sequential Number : affiche un numéro 

séquentiel de chaque plan.
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Organisation du menu de configuration
Sur ce caméscope, les réglages de prise de 
vue et de lecture sont effectués dans le menu 
de configuration, qui apparaît dans le viseur.
Le menu de configuration peut également 
être affiché sur un moniteur vidéo externe 
(page 148).

Structure du menu

Menu User
Menu utilisé pour arranger les éléments 
du menu de configuration dans un ordre 
choisi (page 99).

Menu Operation
Menu utilisé pour réaliser les réglages 
relatifs au tournage (réglages relatifs à la 
qualité d’image non compris).

Menu Paint
Menu utilisé pour réaliser les réglages 
relatifs à la qualité d’image.

Menu Thumbnail
Menu utilisé pour réaliser les réglages 
relatifs aux miniatures de plans 
(page 93).

[Remarque]
Le menu Thumbnail peut être utilisé uniquement 
lorsqu’un écran de miniatures (page 87) 
est affiché. Il est désactivé lorsque l’écran de 
miniatures n’est pas affiché.

Menu Maintenance
Menu utilisé pour réaliser les réglages 
relatifs à la maintenance du caméscope et 
à la gestion du système.

Menu File
Menu utilisé pour effectuer des 
opérations sur les fichiers.

Eléments du menu

Menu Operation

Elément Description Page

Format Réglages de système 102

Base Setting Réglages de mode de 
plage dynamique

102

HDR Setting Réglages HDR 102

Format Media Réglages de format 
du support

103

Input/Output Réglages du signal 
d’entrée/de sortie

103

Super Impose Réglages de 
superposition

103

LCD Réglages du 
moniteur LCD

104

Rec Function Réglages du mode 
d’enregistrement 
spécial

104

XAVC Proxy 
Rec Mode

Réglages de données 
proxy

105

Assignable 
Switch

Attribue des 
fonctions aux 
commutateurs 
personnalisables

105

VF Setting Réglages du viseur 105

Marker Réglages du repère 105

Gain Switch Réglages de valeur 
de gain

106

Auto Iris Réglages du 
diaphragme 
automatique

106

Zebra Réglages du motif de 
zébrures

107

Display On/Off Réglages des 
éléments d’affichage 
du viseur

107

“!” LED Réglages “!” du viseur 108

Elément Description Page

White Setting Réglages de 
l’équilibre des blancs

108

Offset White Réglages de 
décalage des blancs

109

Shutter Réglages 
d’obturation

109

Slow Shutter Réglages 
d’obturateur lent

109

Time Zone Réglages d’heure 110

Clip Réglages de plan 110

Update Media Mise à jour des 
informations de 
gestion du support

110

GPS Réglages 
d’informations de 
lieu (GPS)

110

Planning 
Metadata

Réglages des 
métadonnées de 
planification

110

USB Copie vers les 
paramètres du 
support USB 

111

Menu Paint

Elément Description Page

Switch Status Réglages 
d’activation/
désactivation du 
signal de test et des 
fonctions de 
correction

112

HDR Paint 
Setting

Réglages HDR 112

White Réglages de 
température de 
couleur

112

Black Réglages du niveau 
de noir

112
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Elément Description Page

Flare Réglages de 
correction de lumière 
parasite

113

Gamma(HDR) Réglages de gamma 
HDR

113

Gamma Réglages de 
correction gamma

113

Black Gamma Réglages de 
correction gamma du 
noir

114

Knee Réglages de 
correction de courbe

114

White Clip Réglages d’écrêtage 
du blanc

114

Detail(QFHD) Réglages des détails 114

Detail(HD) Réglages des détails 114

Aperture Réglages de 
correction 
d’ouverture

115

Skin Detail Réglages de 
correction des détails 
du teint

115

Matrix Réglages de 
correction de matrice

115

Multi Matrix Réglages de 
correction de matrice 
multiple

116

V Modulation Réglages de 
correction d’ombrage 
de modulation V

116

Low Key 
Saturation

Réglages de 
correction de 
saturation de clair-
obscur

116

Saturation 
Mode

Réglages de 
correction de 
saturation

116

Noise 
Suppression

Réglages de 
suppression de bruit

117

Menu Maintenance

Elément Description Page

White Shading Réglages de 
correction d’ombrage 
blanc

118

Black Shading Réglages de 
correction d’ombrage 
noir

118

Battery Réglages de la 
batterie

118

DC Voltage 
Alarm

Réglages de l’alarme 
de tension de la 
source DC externe

118

Audio Réglages audio 118

WRR Setting Réglages de tuner 
sans fil

120

Time Code Réglages du code 
temporel

121

Essence Mark Réglages de repère 121

Camera Config Réglages d’opération 
du caméscope

122

Preset White Réglages de blanc 
prédéfini

123

White Filter Réglages du filtre 123

DCC Adjust Réglages DCC 123

Flicker Reduce Réglages de 
correction du 
scintillement

124

Genlock Réglages du 
verrouillage de la 
synchronisation

124

Auto Shading Réglages de 
correction d’ombrage 
noir automatique

124

APR Réglages APR 124

Setup for 
Mobile App

Réglages de connexion 
à l’aide de l’outil d’aide 
à la configuration du 
réseau

124

Elément Description Page

Access 
Authentication

Réglages de 
l’authentification 
d’accès

124

Network Réglages de 
connexion réseau

125

Network Client 
Mode

Réglages du mode 
client réseau

126

File Transfer Réglages de transfert 
Wi-Fi

127

Streaming Réglages de lecture 
en transit

128

Clock Set Réglages de l’horloge 
interne

128

Language Réglages de la 
langue d’affichage

128

Hours Meter Réglages du 
compteur temporel 
numérique

128

Network Reset Réinitialisation du 
réseau

129

Fan Control Réglages de 
commande du 
ventilateur

129

VF Display 
Setting

Réglages d’affichage 
du viseur

129

Version Réglages de version 129

Menu File

Elément Description Page

User File Réglages du fichier 
utilisateur

130

All File Réglages du fichier 
ALL

130

Scene File Réglages du fichier 
de scène

130

Reference File Réglages du fichier 
de référence

131

Lens File Réglages du fichier 
d’objectif

131

Elément Description Page

User Gamma Réglages du fichier 
de gamma

132
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Opérations de base du menu de configuration

Affichage du menu de 
configuration

Réglez le commutateur MENU ON/OFF sur ON 
ou appuyez sur la touche MENU.
Le caméscope passe en mode menu et la liste 
des menus apparaît à l’écran.

L’exemple suivant montre le curseur 
positionné sur le menu Operation

Liste des menus

Zone de sélection des éléments de menu

[Remarque]
Le menu de configuration ne peut pas être utilisé 
lorsque le caméscope est en mode de grossissement 
de la mise au point. Quittez le mode de grossissement 
de la mise au point en appuyant sur le commutateur 
personnalisable auquel la fonction Focus Mag a été 
attribuée.

Effectuer des réglages de menu

1 Tournez le bouton MENU ou appuyez sur 
la touche  ou  pour placer le curseur 
sur le menu souhaité.
Une liste des éléments de menu 
sélectionnables apparaît dans la zone de 
sélection des éléments de menu à droite 
de la liste des menus.

2 Appuyez sur le bouton MENU ou la touche 
SET.
L’écran de sélection d’élément de menu 
apparaît.  
Vous pouvez également afficher l’écran 
de sélection des éléments de menu en 
appuyant sur la touche .
ˎˎ La zone de sélection des éléments 
de menu affiche un maximum de 
sept lignes. Vous pouvez faire défiler 
les menus de plus de sept lignes en 
déplaçant le curseur vers le haut et vers 
le bas.

Zone de sélection des éléments de menu
ˎˎ Si l’élément sélectionné possède des 
sous-éléments, ils apparaissent sur la 
droite.
ˎˎ S’il n’y a pas de sous-éléments, le 
réglage actuel apparaît sur la droite.
ˎˎ Sélectionnez [Back] pour revenir au 
niveau précédent.

Affiché lorsqu’il y a 
plusieurs éléments de menu 
ci-dessous.

3 Tournez le bouton MENU ou appuyez sur 
la touche  ou  pour placer le curseur 
sur l’élément de menu que vous souhaitez 
régler, puis confirmez en appuyant sur le 
bouton MENU ou la touche SET.
La zone des sous-éléments apparaît à 
droite de la zone de sélection des 
éléments de menu et le curseur se place 
sur le premier sous-élément.

Zone des réglages
ˎˎ Affiche les sous-éléments et leurs 
réglages actuels
ˎˎ Pour revenir au niveau précédent, 
sélectionnez [Back], appuyez sur la 
touche , ou poussez le commutateur 
MENU CANCEL/PRST/ESCAPE sur la 
position ESCAPE.

4 Tournez le bouton MENU ou appuyez sur 
la touche  ou  pour placer le curseur 
sur le sous-élément de menu que vous 
souhaitez régler, puis confirmez en 
appuyant sur le bouton MENU ou la 
touche SET.
Les réglages du sous-élément sélectionné 
apparaissent et le curseur se place sur la 
valeur actuellement sélectionnée.

Zone des réglages

ˎˎ La zone des réglages affiche un 
maximum de neuf lignes. Vous pouvez 
faire défiler les menus de plus de neuf 
sous-éléments en déplaçant le curseur 
vers le haut et vers le bas.
ˎˎ Pour les sous-éléments avec une 
grande plage de réglage (par exemple 
–99 à +99), la zone des réglages n’est 
pas affichée. Le paramètre actuel est 
mis en surbrillance pour indiquer que la 
valeur peut être changée.

5 Tournez le bouton MENU ou appuyez sur 
la touche  ou  pour sélectionner la 
valeur à régler puis confirmez en 
appuyant sur le bouton MENU ou la 
touche SET.
Le réglage est modifié et l’affichage est 
mis à jour pour indiquer le nouveau 
réglage.
Si vous sélectionnez [Execute] pour un 
élément exécutable, la fonction 
correspondante est exécutée.

Si un élément nécessite une confirmation 
avant l’exécution, sélectionner l’élément à 
l’étape 3 masque le menu et un message de 
confirmation apparaît. Suivez les instructions 
dans le message pour exécuter ou annuler 
l’opération.

Saisie de texte

Lorsque vous sélectionnez un élément, 
comme un nom de fichier, qui nécessite une 
saisie de caractères, l’écran de saisie de texte 
apparaît.

1

2 3

1 Appuyez sur le bouton MENU pour 
sélectionner le type de caractère à saisir, 
puis appuyez sur le bouton MENU ou sur 
la touche SET.



7. Affichage et réglages de menu : Opérations de base du menu de configuration97

ABC : caractères alphabétiques 
majuscules

abc : caractères alphabétiques minuscules
123 : caractères numériques
!#$ : caractères spéciaux

2 Sélectionnez un caractère dans le type de 
caractère sélectionné, puis appuyez sur le 
bouton.
Le curseur se place sur le champ suivant.
Space : insère un caractère d’espace à la 

position du curseur.
/ : déplace la position du curseur.
BS : supprime le caractère à la gauche du 

curseur (retour arrière).

3 Une fois terminé, sélectionnez [Done] et 
appuyez sur la molette.
La chaîne de caractères est confirmée et 
l’écran de saisie de texte disparaît.

Annulation de modifications 
apportées aux réglages

1 Poussez le commutateur MENU CANCEL/
PRST/ESCAPE sur la position ESCAPE.

Sortie du menu

1 Réglez le commutateur MENU ON/OFF sur 
OFF ou appuyez sur la touche MENU.
L’image normale de la caméra réapparaît.

Verrouillage/Déverrouillage du 
menu

Vous pouvez verrouiller le menu de 
configuration de sorte que seul le menu User 
s’affiche.

Verrouillage du menu

1 Appuyez et maintenez enfoncé le bouton 
MENU et positionnez le commutateur 
MENU ON/OFF vers le bas pour afficher le 
menu de configuration.

2 Affichez Maintenance >Camera Config 
>User Menu with Lock dans le menu de 
configuration.

[Remarques]
ˎˎ Lorsque vous appuyez et maintenez enfoncé le 

bouton MENU et positionnez le commutateur 
MENU ON/OFF vers le bas, Camera Config >User 
Menu Only passe à User Menu with Lock.
ˎˎ Si vous positionnez le commutateur MENU ON/

OFF vers le bas sans appuyer sur le bouton 
MENU ou si vous appuyez sur le bouton MENU 
pour afficher le menu, Camera Config >User 
Menu with Lock ne s’affiche pas.

3 Sélectionnez « On », puis appuyez sur le 
bouton MENU.
L’affichage de l’écran du viseur bascule 
sur l’écran de saisie du numéro de code.

4 Saisissez un numéro de code arbitraire.
La plage de saisie valide est comprise 
entre 0000 et 9999. La valeur par défaut 
est 0000.
Saisissez un numéro et appuyez sur le 
bouton MENU pour déplacer le curseur sur 
le chiffre suivant.
Une fois tous les chiffres saisis, déplacez 
le curseur sur [Set].

5 Une fois [Set] sélectionné, appuyez sur le 
bouton MENU.
La saisie s’applique.
Un message de confirmation apparaît. 
Ensuite, seul le menu User s’affichera.

[Remarques]
ˎˎ Si le menu est verrouillé sans avoir enregistré les 

éléments du menu de configuration suivant dans le 
menu User, l’attribution de la fonction de menu à un 
commutateur personnalisable n’est pas possible.
ˎˎ Si certains des éléments du menu de configuration 

suivant sont attribués à un commutateur 
personnalisable lorsque le menu est verrouillé, 
le réglage pour les fonctions attribuées aux 
commutateurs personnalisables est réglé de force sur 
Off si le menu est verrouillé.

Menu de configuration Fonctions qui 
peuvent être 
attribuée aux 
commutateurs 
personnalisables

Operation >Rec Function 
>Picture Cache Rec

Picture Cache Rec

Operation >Rec Function 
>Clip Continuous Rec

Clip Continuous 
Rec

Operation >Rec Function 
>Slow & Quick Motion

Slow & Quick 
Motion

Operation >Display On/Off 
>Video Signal Monitor

Video Signal 
Monitor

Operation >Display On/Off 
>Lens Info

Lens Info

Operation >Auto Iris 
>Mode

Spotlight

Backlight

Operation >Marker 
>Setting

Marker

Maintenance >Audio 
>Front MIC Select

Front MIC

Maintenance >Network 
Client Mode >Setting

Network Client 
Mode

Maintenance >File Transfer 
>Auto Upload(Proxy)

Auto Upload(Proxy)

Déverrouillage du menu

1 Appuyez et maintenez enfoncé le bouton 
MENU et positionnez le commutateur 
MENU ON/OFF vers le bas pour afficher le 
menu de configuration.

2 Affichez User >Camera Config >User Menu 
with Lock dans le menu de configuration.

[Remarques]
ˎˎ Lorsque vous appuyez et maintenez enfoncé le 

bouton MENU et positionnez le commutateur 
MENU ON/OFF vers le bas, Camera Config >User 
Menu Only passe à User Menu with Lock.
ˎˎ Si vous positionnez le commutateur MENU ON/

OFF vers le bas sans appuyer sur le bouton 
MENU ou si vous appuyez sur le bouton MENU 
pour afficher le menu, Camera Config >User 
Menu with Lock ne s’affiche pas.

3 Sélectionnez « Off », puis appuyez sur le 
bouton MENU.
L’affichage de l’écran du viseur bascule 
sur l’écran de saisie du numéro de code.

4 Saisissez le numéro de code utilisé pour 
verrouiller le menu.
La plage de saisie valide est comprise 
entre 0000 et 9999.
Saisissez un numéro et appuyez sur le 
bouton MENU pour déplacer le curseur sur 
le chiffre suivant.
Une fois tous les chiffres saisis, déplacez 
le curseur sur [Set].

5 Une fois [Set] sélectionné, appuyez sur le 
bouton MENU.
La saisie s’applique.
Si le numéro de code saisi correspond au 
numéro de code utilisé pour verrouiller le 
menu, un message de confirmation 
apparaît et l’affichage de tous les menus 
est activé.
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[Remarques]
ˎˎ Si le numéro de code saisi ne correspond pas au 

numéro de code utilisé pour verrouiller le menu, 
le menu n’est pas déverrouillé.
ˎˎ Il est recommandé de prendre note du numéro 

de code et le laisser à proximité, au cas où vous 
l’oublieriez. Si vous oubliez votre numéro de 
code, contactez votre technicien Sony.
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Edition du menu User
Vous pouvez éditer le menu User, par exemple 
ajouter des éléments, supprimer des éléments 
et réarranger des éléments, pour rendre le 
menu User plus utile à l’aide d’Edit User Menu.
Vous pouvez sélectionner des éléments dans 
le menu Operation, le menu Paint, le menu 
Maintenance et certains éléments dans le 
menu File, et vous pouvez les ajouter au menu 
User.
Vous pouvez enregistrer jusqu’à 20 éléments 
dans le menu User. Il y a six éléments 
enregistrés dans le menu User par défaut, 
l’un d’eux doit toujours être présent, vous 
permettant ainsi d’ajouter 19 nouveaux 
éléments.

[Remarque]
Le montage n’est pas disponible lorsque le menu est 
verrouillé.

Affichage de l’écran Edit User 
Menu

Vous modifiez le menu User sur l’écran Edit 
User Menu.

1 Tournez le bouton MENU pour 
sélectionner User >Edit User Menu, puis 
appuyez sur le bouton.

L’écran Edit User Menu apparaît.

Ajout d’éléments et de sous-
éléments

1 Tournez le bouton MENU pour 
sélectionner Edit User Menu >Add Item, 
puis appuyez sur le bouton.
Les éléments qui peuvent être ajoutés 
s’affichent.

2 Tournez le bouton MENU pour 
sélectionner un élément, puis appuyez sur 
le bouton.
Un écran de sélection des sous-éléments 
à ajouter apparaît.

3 Tournez le bouton MENU pour 
sélectionner un sous-élément, puis 
appuyez sur le bouton.
Placez une coche dans la case à cocher All 
pour ajouter tous les sous-éléments.
Placez une coche dans les cases à cocher 
individuelles pour indiquer quels sous-
éléments ajouter.

4 Tournez le bouton MENU pour 
sélectionner [OK], puis appuyez sur le 
bouton.
Le ou les élément(s)/sous-élément(s) est/
sont ajouté(s).

[Remarque]
Le même élément ou sous-élément ne peut pas être 
enregistré deux fois. De même, le nom de l’élément ou 
du sous-élément ne peut pas être modifié.

Edition des sous-éléments

Vous pouvez spécifier les sous-éléments à 
afficher.

1 Affichez l’écran Edit User Menu.

2 Tournez le bouton MENU pour 
sélectionner un élément à éditer, puis 
appuyez sur le bouton.
La liste des fonctions d’édition apparaît.

3 Tournez le bouton MENU pour 
sélectionner Edit Sub Item dans la liste 
des fonctions d’édition, puis appuyez sur 
le bouton.

L’écran Edit Sub Item apparaît.

Tous les sous-éléments sont cochés lors 
de la première apparition de l’écran 
(fonction pour afficher tous les sous-
éléments).
Retirez les coches pour les sous-éléments 
que vous ne voulez pas afficher dans le 
menu User.

4 Tournez le bouton MENU pour 
sélectionner [OK], puis appuyez sur le 
bouton.
L’édition est terminée.

Suppression d’éléments

1 Affichez l’écran Edit User Menu.

2 Tournez le bouton MENU pour 
sélectionner un élément à éditer, puis 
appuyez sur le bouton.
La liste des fonctions d’édition apparaît.

3 Tournez le bouton MENU pour 
sélectionner Delete dans la liste des 
fonctions d’édition, puis appuyez sur le 
bouton.

L’élément est supprimé.
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Déplacement des éléments

1 Affichez l’écran Edit User Menu.

2 Tournez le bouton MENU pour 
sélectionner un élément à déplacer, puis 
appuyez sur le bouton.
La liste des fonctions d’édition apparaît.

3 Tournez le bouton MENU pour 
sélectionner Move dans la liste des 
fonctions d’édition, puis appuyez sur le 
bouton.

L’élément à déplacer est surligné, et une 
marque triangulaire et une ligne indiquent 
la position de destination.

Marque triangulaire et ligne indiquant 
la destination du déplacement

4 Tournez le bouton MENU pour déplacer le 
triangle et la ligne à la destination 
souhaitée, puis appuyez sur le bouton.
L’élément est déplacé.

Restauration de l’état d’usine par 
défaut du menu User

1 Tournez le bouton MENU pour 
sélectionner Edit User Menu >Customize 
Reset, puis appuyez sur le bouton.
L’écran Customize Reset apparaît.

2 Tournez le bouton MENU pour 
sélectionner [Reset], puis appuyez sur le 
bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Le menu User est restauré à l’état d’usine 
par défaut.
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Menu User (configuration d’usine par défaut)
Le menu User se compose des éléments suivants avec les réglages d’usine par défaut.
ˎˎ Format Media (page 103)
ˎˎ Rec Function (page 104)
ˎˎ Input/Output (page 103)
ˎˎ Clip (page 110)
ˎˎ Assignable Switch 1) (page 105)
ˎˎ Camera Config 2) (page 122)

1) Mis à part le sous-élément 0
2) Contient User Menu Only pour seul sous-élément

Pour de plus amples informations sur la modification du menu User, reportez-vous à « Edition du 
menu User » (page 99).
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Menu Operation
Les valeurs par défaut sont soulignées et le texte est en gras.

Operation >Format
Définit la fréquence de système, le système de fichiers, le format d’enregistrement et le rapport 
de format d’enregistrement.

Elément Réglage Description

Frequency 59.94/50/29.97/25/23.98 Sélectionne la fréquence de système 
(exécutez en sélectionnant Execute).

[Remarque]
La commutation de la fréquence de système 
passe également le réglage Rec Format à la valeur 
configurée précédemment à cette fréquence.

File System exFAT/UDF/FAT Permet de changer de système de fichiers 
(exécutez en sélectionnant Execute).

Rec Format Les réglages varient selon le 
réglage de fréquence de 
système.

Sélectionne le format d’enregistrement 
(exécutez en sélectionnant Execute).

XAVC-I 3840×2160P
XAVC-I 1920×1080P
XAVC-I 1920×1080i
XAVC-L200 2160P
XAVC-L 3840×2160P
XAVC-L 50 1920×1080P
XAVC-L 50 1920×1080i
XAVC-L 35 1080P
XAVC-L 35 1080i
XAVC-L 25 1080i
HD422 50 1080i
HD422 50 720P
HQ 1920×1080i
HQ 1440×1080i
HQ 1280×720P

Lorsque le système de fichier est exFAT et le 
système de fréquence est 59.94 ou 50.

XAVC-I 3840×2160P
XAVC-I 1920×1080P
XAVC-L 3840×2160P
XAVC-L 50 1920×1080P
XAVC-L 35 1080P
HD422 50 1080P
HD422 50 720P
HQ 1920×1080P

Lorsque le système de fichier est exFAT et le 
système de fréquence est 29.97, 25 ou 23.98.

HD422 50 1080i
HD422 50 720P
HQ 1920×1080i
HQ 1440×1080i
HQ 1280×720P

Lorsque le système de fichier est UDF et le 
système de fréquence est 59.94 ou 50.

Operation >Format
Définit la fréquence de système, le système de fichiers, le format d’enregistrement et le rapport 
de format d’enregistrement.

Elément Réglage Description

Rec Format HD422 50 1080P
HD422 50 720P
HQ 1920×1080P

Lorsque le système de fichier est UDF et le 
système de fréquence est 29.97, 25 ou 23.98.

HQ 1920×1080i
HQ 1440×1080i 
HQ 1280×720P 
SP 1440×1080i

Lorsque le système de fichier est FAT et que le 
système de fréquence est 59.94 ou 50.

HQ 1920×1080P Lorsque le système de fichier est FAT et que le 
système de fréquence est 29.97, 25 ou 23.98.

Operation >Base Setting
Définit la plage dynamique pour l’imagerie.

Elément Réglage Description

Shooting Mode SDR/HDR SDR : définit le mode de plage dynamique 
standard conventionnel.

HDR : définit le mode High Dynamic Range.

High Sensitivity 
Mode

Off/On On : augmente la sensibilité d’environ 4 dB 
comparé au mode normal.

Operation >HDR Setting
Règle l’enregistrement 4K(QFHD) et HD et le système de sortie utilisé durant l’opération HDR. 
L’espace de couleurs est ITU-R BT.2020 pour HDR(HLG). L’espace de couleurs peut être réglé sur 
ITU-R BT.2020 ou S-Gamut3/S-Gamut3.Cine pour HDR(S-Log3).

Elément Réglage Description

4K(QFHD) Rec/Out HDR(HLG)/HDR(S-Log3) HDR(HLG) : définit HLG pour la sortie et 
l’enregistrement 4K (QFHD).

HDR(S-Log3) : définit S-Log3 pour la sortie et 
l’enregistrement 4K (QFHD).

HD Rec/Out HDR(HLG)/HDR(S-Log3)/SDR Activé lorsque vous réglez 4K(QFHD) Rec/Out 
sur HDR(HLG) ou HDR(S-Log3).
HDR(HLG) : définit HLG pour l’enregistrement 

et la sortie HD.
HDR(S-Log3) : définit HDR(S-Log3) pour 

l’enregistrement et la sortie HD.
SDR : définit SDR pour l’enregistrement et la 

sortie HD.

[Remarques]
ˎˎ Lorsque 4K(QFHD) Rec/Out est réglé sur HDR(S-

Log3), HDR(HLG) ne peut pas être sélectionné.
ˎˎ Lorsque 4K(QFHD) Rec/Out est réglé sur 

HDR(HLG), HDR(S-Log3) ne peut pas être 
sélectionné.
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Operation >HDR Setting
Règle l’enregistrement 4K(QFHD) et HD et le système de sortie utilisé durant l’opération HDR. 
L’espace de couleurs est ITU-R BT.2020 pour HDR(HLG). L’espace de couleurs peut être réglé sur 
ITU-R BT.2020 ou S-Gamut3/S-Gamut3.Cine pour HDR(S-Log3).

Elément Réglage Description

SDR Gain 0dB à –6dB à –15dB Ajuste le gain SDR par rapport à la valeur HDR 
lorsque HD Rec/Out est réglé sur SDR.

4K(QFHD) Color 
Space

BT.2020/
S-Gamut3(3200K)/
S-Gamut3(4300K)/
S-Gamut3(5500K)/
S-Gamut3.Cine(3200K)/
S-Gamut3.Cine(4300K)/
S-Gamut3.Cine(5500K)/
BT.709

Règle l’espace de couleurs de la sortie 4K.
S-Gamut3 : espace de couleurs large qui 

couvre l’espace de couleurs ITU-R BT.2020 
de Sony.

S-Gamut3.Cine : espace de couleurs ajustable 
pour l’espace de couleurs du cinéma 
numérique (DCI-P3).

Les réglages recommandés basés sur la 
température de couleur de l’équilibre des 
blancs sont les suivants.
3700K ou inférieur : S-Gamut3(3200K) ou 

S-Gamut3.Cine(3200K)
3700K à 4700K : S-Gamut3(4300K) ou 

S-Gamut3.Cine(4300K)
4700K ou supérieur : S-Gamut3(5500K) ou 

S-Gamut3.Cine(5500K)

[Remarque]
Lorsque S-Gamut3 ou S-Gamut3.Cine est utilisé, 
sélectionnez un réglage en fonction de la 
température de couleur de l’environnement de prise 
de vue.

HD Color Space BT.2020/
S-Gamut3(3200K)/
S-Gamut3(4300K)/
S-Gamut3(5500K)/
S-Gamut3.Cine(3200K)/
S-Gamut3.Cine(4300K)/
S-Gamut3.Cine(5500K)/
BT.709

Espace de couleurs de la sortie HD (affichage 
uniquement).
S-Gamut3 : espace de couleurs large qui 

couvre l’espace de couleurs ITU-R BT.2020 
de Sony.

S-Gamut3.Cine : espace de couleurs ajustable 
pour l’espace de couleurs du cinéma 
numérique (DCI-P3).

Operation >Format Media
Formate le support.

Elément Réglage Description

Media(A) Execute/Cancel Initialise la carte mémoire SxS dans le 
logement A (exécutez en sélectionnant 
Execute).

Operation >Format Media
Formate le support.

Elément Réglage Description

Media(B) Execute/Cancel Initialise la carte mémoire SxS dans le 
logement B (exécutez en sélectionnant 
Execute).

SD Card(Utility) Execute/Cancel Initialise la carte SD dans le logement de carte 
UTILITY SD (exécutez en sélectionnant 
Execute).

SD Card(Proxy) Execute/Cancel Initialise la carte SD dans le logement de carte 
PROXY SD (exécutez en sélectionnant 
Execute).

Operation >Input/Output
Définit les signaux d’entrée/de sortie.

Elément Réglage Description

Output Format Les réglages varient selon le 
réglage de fréquence de 
système.

Sélectionne le format de sortie (exécutez en 
sélectionnant Execute).
Les réglages varient selon le réglage du 
format d’enregistrement (page 35).

Source Select Camera/External Sélectionne le signal d’entrée d’image de 
caméra (Caméra) ou de connecteur SDI IN 
pour la source d’entrée vidéo.

SDI Out1 Output On/Off Active/désactive le signal de sortie du 
connecteur SDI OUT1.

SDI Out2 Output On/Off Active/désactive le signal de sortie du 
connecteur SDI OUT2.

HDMI Output On/Off Active/désactive le signal de sortie du 
connecteur HDMI.

SDI Out/HDMI Super Off/On Active/désactive les informations textuelles 
(superposées) des connecteurs SDI OUT 1/2 et 
HDMI. Toutefois, lorsque le format du signal 
est HD, la sortie des informations textuelles 
du connecteur SDI OUT1 est désactivée quel 
que soit son réglage.

Operation >Super Impose
Définit les informations textuelles/repères à superposer.

Elément Réglage Description

Super(VF Display) On/Off Lorsque Input/Output >SDI Out/HDMI Super 
est réglé sur On, la superposition des 
informations de caractères de la sortie des 
connecteurs SDI OUT est activée/désactivée.

Super(Menu) On/Off
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Operation >Super Impose
Définit les informations textuelles/repères à superposer.

Elément Réglage Description

Super(Marker) On/Off Lorsque Input/Output >SDI Out/HDMI Super 
est réglé sur On, la superposition des repères 
de la sortie des connecteurs SDI OUT est 
activée/désactivée.

Operation >LCD
Règle le moniteur LCD.

Elément Réglage Description

LCD Color –99 à ±0 à +99 Permet d’ajuster la profondeur de couleur du 
moniteur LCD.

LCD Marker&Zebra On/Off Active/désactive l’affichage de repère et de 
motif de zébrures sur le moniteur LCD.

Operation >Rec Function
Définit le mode d’enregistrement spécial.

Elément Réglage Description

Slow & Quick Motion On/Off Active/désactive le mode ralenti et accéléré. 
(Lorsque le réglage est sur On, les réglages 
pour les autres modes d’enregistrement 
spéciaux sont définis sur Off.)

Frame Rate Les réglages varient selon le 
réglage du format 
d’enregistrement.

Lorsque Slow & Quick Motion est réglé sur On, 
cela sélectionne la fréquence d’images pour 
la prise de vue au ralenti et accéléré.

72, 75, 90, 96, 100, 120 Lorsque le système de fichiers est exFAT, et le 
format d’enregistrement est XAVC Intra 
(1920×1080) ou XAVC Long (1920×1080).

1 à 60 Lorsque le système de fichiers est exFAT, et le 
format d’enregistrement est XAVC Intra ou 
XAVC Long.

1 à 50 Lorsque le système de fichiers est UDF, et le 
format d’enregistrement est MPEG HD 422 
50M (1280×720), 50P/25P.

1 à 30 Lorsque le système de fichiers est exFAT ou 
UDF, et le format d’enregistrement est MPEG 
HD 422 50M (1920×1080), 29.97P/23.98P.

1 à 25 Lorsque le système de fichiers est exFAT ou 
UDF, et le format d’enregistrement MPEG HD 
422 50M (1920×1080), 25P.

Operation >Rec Function
Définit le mode d’enregistrement spécial.

Elément Réglage Description

Clip Continuous Rec On/Off Active/désactive le mode d’enregistrement 
continu de plan. (Lorsque le réglage est sur 
On, les réglages pour les autres modes 
d’enregistrement spéciaux sont définis sur 
Off.)

Picture Cache Rec On/Off Active/désactive le mode Picture Cache Rec. 
(Lorsque le réglage est sur On, les réglages 
pour les autres modes d’enregistrement 
spéciaux, à l’exception de certaines fonctions, 
sont définis sur Off.)

Cache Rec Time Les réglages varient selon le 
réglage du format 
d’enregistrement.

Règle le temps pour l’accumulation d’images 
dans la mémoire du cache d’images (temps 
d’enregistrement du cache d’images).

Pour de plus amples informations, consultez 
« Réglages du mode Picture Cache Rec » (page 177) 
en annexe.

Interval Rec On/Off Active/désactive le mode d’enregistrement 
par intervalles. (Lorsque le réglage est sur On, 
les réglages pour les autres modes 
d’enregistrement spéciaux sont définis sur 
Off.)

Number of Frames Les réglages disponibles 
varient en fonction du réglage 
Format >Frequency.

Lorsque l’enregistrement par intervalles est 
réglé sur On, ce réglage définit le nombre 
d’images à filmer en une prise de 
l’enregistrement par intervalles.

2frames/6frames/12frames Lorsque la fréquence d’images du format 
enregistrement est de 50P ou 59.94P.

1frame/3frames/6frames/ 
9frames

Lorsque la fréquence d’images du format 
enregistrement est de 23.98P, 25P, 29.97P, 50i, 
ou 59.94i.

Interval Time 1/2/3/4/5/6/7/8/9/10/15/ 
20/30/40/50 (sec) 
1/2/3/4/5/6/7/8/9/10/15/ 
20/30/40/50/ (min) 
1/2/3/4/6/12/24 (hour)

Lorsque l’enregistrement par intervalles est 
réglé sur On, ce réglage définit l’intervalle 
pour une prise de vue en enregistrement par 
intervalles.

Pre-Lighting Off/2sec/5sec/10sec Définit la durée en secondes pendant laquelle 
la lampe vidéo est allumée avant le 
démarrage de l’enregistrement par intervalles. 
Pour désactiver la fonction de pré-allumage, 
sélectionnez Off.
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Operation >Rec Function
Définit le mode d’enregistrement spécial.

Elément Réglage Description

Simul Rec On/Off Active/désactive l’enregistrement simultané à 
2 logements sur les logements A et B.

4K & HD (Sub) Rec On/Off Active/désactive l’enregistrement simultané 
sur 1 logement.

HD (Sub) Rec Format Lorsque la fréquence de 
système est 59.94 ou 50 :
XAVC-L50 1920×1080P/HD422 
50 1080i

Règle le format d’enregistrement HD (Sub) 
pour le mode 1-slot Simul Rec.

Lorsque la fréquence de 
système est 29.97, 25 ou 
23.98 :
XAVC-L50 1920×1080P/HD422 
50 1080P

HD (Sub) Playback 
Mode

On/Off Active/désactive la fonction de lecture pour 
les sous-plans enregistrés en mode 1-slot 
Simul Rec.

Operation >XAVC Proxy Rec Mode
Définit l’enregistrement proxy.

Elément Réglage Description

Setting On/Off Active/désactive l’enregistrement proxy.

Size HD Auto(9Mbps)/
HD Auto(6Mbps)/
1280×720(9Mbps)/ 
1280×720(6Mbps)/ 
640×360(3Mbps)/ 
480×270(1Mbps)/ 
480×270(0.5Mbps)

Sélectionne la taille du format 
d’enregistrement proxy.

Frame Rate 23.98fps/25fps/29.97fps/ 
50fps/59.94fps

Sélectionne la fréquence d’image du format 
d’enregistrement proxy.

Bit Rate 9Mbps/6Mbps/3Mbps/1Mbps/ 
0.5Mbps

Sélectionne le débit binaire du format 
d’enregistrement proxy.

Audio Channel CH1/CH2/CH3/CH4 Sélectionne le canal audio à enregistrer pour 
les données proxy.

Operation >Assignable Switch
Attribue des fonctions aux commutateurs personnalisables.

Pour plus de détails sur l’attribution de fonctions, consultez « Attribution de fonctions aux commutateurs 
personnalisables » (page 133).

Elément Réglage Description

<0> page 133 Attribue une fonction au commutateur 
ASSIGN. 0.

<1> page 134 Attribue une fonction au commutateur 
ASSIGN. 1.

<2> page 133 Attribue une fonction au commutateur 
ASSIGN. 2.

<3> page 134 Attribue une fonction au commutateur 
ASSIGN. 3.

<4> page 134 Attribue une fonction au commutateur 
ASSIGNABLE 4.

<5> page 134 Attribue une fonction au commutateur 
ASSIGNABLE 5.

Lens RET page 135 Attribue une fonction à la touche RET de 
l’objectif.

Online page 134 Attribue une fonction à la touche ONLINE.

Zoom Speed 0 à 20 à 99 Lorsque Zoom a été attribué au commutateur 
ASSIGNABLE 4 ou 5, cela définit la vitesse de 
zoom.

Operation >VF Setting
Règle l’écran du viseur.

Elément Réglage Description

Color –99 à ±0 à +99 Permet d’ajuster la profondeur de l’image du 
viseur.

VF Detail Level –99 à ±0 à +99 Définit le niveau de détail (réglé sur le 
caméscope) du viseur (lors de l’utilisation 
HDVF-20A).

Operation >Marker
Définit l’affichage des repères dans le viseur.

Elément Réglage Description

Setting On/Off Active/désactive l’affichage de tous les 
repères.

[Remarque]
Lorsque la fonction Marker est attribuée au 
commutateur ASSIGN. 2, ce réglage est désactivé.

Color White/Yellow/Cyan/Green/
Magenta/Red/Blue

Sélectionne la couleur d’affichage de repères.



7. Affichage et réglages de menu : Menu Operation106

Operation >Marker
Définit l’affichage des repères dans le viseur.

Elément Réglage Description

Center Marker 1/2/3/4/Off Lorsque le repère central est affiché, 
sélectionne le type. Sélectionnez Off si vous 
ne souhaitez pas afficher le repère.

Safety Zone On/Off Active/désactive l’indicateur de la zone de 
sécurité.

Safety Area 80%/90%/92.5%/95% Sélectionne la plage de la zone de sécurité.

Aspect Marker Line/Mask/Off Lorsqu’un repère de format doit être affiché, 
sélectionne la méthode d’affichage. 
Sélectionnez Off si vous ne souhaitez pas 
afficher le repère.
Line : affichage en tant que lignes blanches.
Mask : affiche un niveau de signal vidéo plus 

faible pour les zones en dehors de la 
plage du repère.

Aspect Select 15:9/14:9/13:9/4:3/1.66:1/ 
1.85:1/2.35:1/2.4:1

Sélectionne le rapport de format du repère.

Aspect Mask 0% à 12% à 15% Lorsqu’Aspect Marker est réglé sur Mask, cela 
définit le niveau de signal vidéo des zones en 
dehors de la zone du repère en tant que 
pourcentage par rapport au niveau de signal 
vidéo des zones à l’intérieur de la zone du 
repère.

Aspect Safety Zone On/Off Active/désactive le repère de la zone de 
sécurité.

Aspect Safety Area 80%/90%/92.5%/95% Sélectionne la taille du repère de la zone de 
sécurité (sous forme pourcentage de la taille 
totale de l’écran).

100% Marker On/Off Active/désactive l’indicateur de repère de la 
zone de sécurité à 100%.

User Box On/Off Active/désactive l’affichage du curseur.

User Box Width 40 à 500 à 999 Règle la largeur du curseur (distance du 
centre aux bords gauche et droit).

User Box Height 70 à 500 à 999 Règle la hauteur du curseur (distance du 
centre aux bords haut et bas).

User Box H Position –479 à 0 à 479 Règle la position horizontale du centre du 
curseur.

User Box V Position –464 à 0 à 464 Règle la position verticale du centre du 
curseur.

Operation >Gain Switch
Définit le réglage du commutateur de la valeur de gain.

Elément Réglage Description

Gain<L> –3dB/0dB/3dB/6dB/9dB/12dB/ 
18dB/24dB/30dB/36dB/42dB

Sélectionne la valeur du gain pour la position 
L du commutateur GAIN.

Gain<M> –3dB/0dB/3dB/6dB/9dB/12dB/ 
18dB/24dB/30dB/36dB/42dB

Sélectionne la valeur du gain pour la position 
M du commutateur GAIN.

Gain<H> –3dB/0dB/3dB/6dB/9dB/12dB/ 
18dB/24dB/30dB/36dB/42dB

Sélectionne la valeur du gain pour la position 
H du commutateur GAIN.

Gain <Turbo> –3dB/0dB/3dB/6dB/9dB/12dB/ 
18dB/24dB/30dB/36dB/42dB

Sélectionne la valeur du gain lorsque la 
fonction Turbo Gain est attribuée à un 
commutateur personnalisable.

Shockless Gain On/Off Active/désactive le gain sans chocs (une 
fonction permettant une commutation fluide 
du gain).

Operation >Auto Iris
Règle le diaphragme automatique.

Elément Réglage Description

Iris Override On/Off Active/désactive le changement de la valeur 
du diaphragme (ce réglage ouvre ou ferme le 
diaphragme plus que la normale).

Mode Backlight/Standard/Spotlight Sélectionne le mode de commande du 
diaphragme automatique.
Backlight : mode rétroéclairage (mode qui 

atténue l’obscurité d’un sujet lorsque le 
sujet est rétroéclairé)

Standard : mode standard (ne peut pas être 
sélectionné lors de l’utilisation de la 
connexion de commande à distance en 
option)

Spotlight : mode spot (mode qui atténue les 
rehauts accentués d’un sujet lorsque le 
sujet est éclairé par la lumière d’un spot)

Level –99 à ±0 à +99 Définit le niveau cible de convergence (des 
valeurs plus grandes augmente la luminosité).

Speed –99 à ±0 à +99 Règle la vitesse de commande (vitesse de 
réponse aux modifications dans la vidéo). 
(Des valeurs plus grandes correspondent à 
des réactions plus rapides.)

Clip High light On/Off Active/désactive la fonction qui ignore les 
zones les lumineuses pour fournir une plus 
plate à une luminance élevée.
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Operation >Auto Iris
Règle le diaphragme automatique.

Elément Réglage Description

Detect Window 1/2/3/4/5/6/Var Sélectionne le type de fenêtre de détection 
de diaphragme automatique.
Var : variable

Detect Window 
Indication

On/Off Active/désactive la fonction permettant 
d’afficher une image pour la fenêtre de 
détection de diaphragme automatique à 
l’aide d’un repère.

Iris APL Ratio –99 à ±0 à +99 Si le réglage Mode pour Auto Iris est réglé sur 
Standard, cela définit le rapport de mélange 
de crête à la valeur moyenne de détection de 
diaphragme automatique.

Iris Var Width 40 à 500 à 999 Définit la largeur de la fenêtre lorsque la 
fenêtre Iris est réglée sur Var.

Iris Var Height 70 à 500 à 999 Définit la hauteur de la fenêtre lorsque la 
fenêtre Iris est réglée sur Var.

Iris Var H Position –479 à 0 à 479 Définit la position horizontale de la fenêtre 
lorsque la fenêtre Iris est réglée sur Var.

Iris Var V Position –464 à 0 à 464 Définit la position verticale de la fenêtre 
lorsque la fenêtre Iris est réglée sur Var.

Operation >Zebra
Règle l’affichage des zébrures pour les vidéos affichées sur le viseur.

[Remarque]
L’effet d’aide pour l’affichage gamma ne s’applique pas.

Elément Réglage Description

Zebra Select 1/2/Both Sélectionne le type de motif de zébrures 
(Zebra 1, Zebra 2, Both).

Zebra1 Level 0% à 70% à 107% Définit le niveau d’affichage de Zebra 1.

Zebra1 Aperture 
Level

1% à 10% à 20% Définit le niveau d’ouverture de Zebra 1.

Zebra2 Level 1% à 100% à 109% Définit le niveau d’affichage de Zebra 2.

Operation >Display On/Off
Sélectionne les éléments à afficher dans le viseur.

Elément Réglage Description

Video Level Warning On/Off Active/désactive les avertissements qui 
apparaissent lorsque le niveau vidéo est trop 
clair ou trop sombre.

Shutter Setting On/Off Active/désactive les indicateurs du mode 
d’obturation et de la vitesse d’obturation.

Operation >Display On/Off
Sélectionne les éléments à afficher dans le viseur.

Elément Réglage Description

ND Filter Position On/Off Active/désactive l’indicateur du réglage des 
filtres ND.

Gain Setting On/Off Active/désactive l’indicateur du réglage du 
gain.

Rec/Play Status On/Off Active/désactive les indicateurs 
d’enregistrement et de lecture.

Color Temp. On/Off Active/désactive l’indicateur de température 
de couleur.

Frame Rate/Interval On/Off Active/désactive l’indicateur de mode 
d’enregistrement spécial.

Battery Remain Auto/Voltage/Off Règle le mode de capacité restante de la 
batterie et les indicateurs de tension d’entrée.
Auto : affiche la capacité restante selon le 

type de batterie.
Voltage : affiche la tension d’entrée quel que 

soit le type de batterie.
Off : pas d’affichage.

Timecode On/Off Active/désactive l’affichage des données 
temporelles (code temporel, bits d’utilisateur, 
compteur, durée).

Audio Level Meter On/Off Active/désactive l’affichage des vumètres 
audio.

Media Status On/Off Active/désactive l’indicateur de l’état du 
support.

SD Card(Utility) On/Off Active/désactive l’indicateur de carte SD 
(Utility).

Focus Position Meter/Feet/Off Active/désactive l’indicateur de position de 
mise au point de l’objectif et sélectionne les 
unités d’affichage.

Iris Position On/Off Active/désactive l’indicateur de position du 
diaphragme de l’objectif.

Zoom Position On/Off Active/désactive l’indicateur de position du 
zoom de l’objectif.

Extender On/Off Active/désactive l’indicateur du dispositif 
d’extension et d’objectif.

ALAC On/Off Active/désactive l’indicateur de correction 
d’aberration de l’objectif.

AE Mode On/Off Active/désactive l’indicateur du réglage du 
niveau AE et du mode AE.
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Operation >Display On/Off
Sélectionne les éléments à afficher dans le viseur.

Elément Réglage Description

Focus Mode On/Off Active/désactive l’indicateur du mode de 
mise au point.

White Balance Mode On/Off Active/désactive l’indicateur du mode 
d’équilibre des blancs.

CC5600K On/Off Active/désactive l’indicateur CC5600K.

Rec Format On/Off Active/désactive l’indicateur du format 
d’enregistrement.

Gamma On/Off Active/désactive l’indicateur du type de 
gamma sélectionné.

Timecode Lock On/Off Active/désactive l’indicateur de code 
temporel.

Network Condition On/Off Active/désactive l’indicateur de l’état de la 
connexion réseau.

Proxy Status On/Off Active/désactive l’indicateur de l’état du 
proxy.

NW Client Mode 
Status

On/Off Active/désactive l’indicateur du mode client 
réseau.

Streaming Status On/Off Active/désactive la lecture en transit.

GPS On/Off Active/désactive l’indicateur de l’état de 
réception GPS.

Video Signal Monitor Off/Waveform/Vector/
Histogram

Active/désactive l’indicateur d’état du signal 
de sortie vidéo, puis sélectionne le type de 
signal vidéo à afficher (page 20).

[Remarque]
Non affiché dans les circonstances suivantes.
Lorsque Operation >Input/Output >SDI Out1 Select 
et SDI Out2 Select dans le menu de configuration 
sont tous les deux réglés sur Off.

Clip Name On/Off Active/désactive l’affichage du nom du plan.

Focus Assist Indicator On/Off Active/désactive l’indicateur d’aide à la mise 
au point.

Focus Area Marker On/Off Active/désactive l’indicateur du repère de 
zone.

Lens Info Meter/Feet/Off Sélectionne l’affichage ou non de la 
profondeur de champ et les unités à afficher.

WRR RF Level On/Off Active/désactive l’indicateur de l’état de 
réception du tuner sans fil.

Clip Number On/Off Active/désactive l’affichage des informations 
du plan.

Operation >"!"LED
Définit l’indicateur “!” dans le viseur. (Activé lors de l’utilisation de HDVF-20A.)

Elément Réglage Description

Gain <!> On/Off Active/désactive la fonction d’allumage de 
l’indicateur ! quand le gain est réglé sur un 
paramètre autre que 0 dB.

Shutter <!> On/Off Active/désactive la fonction d’allumage de 
l’indicateur ! quand le commutateur SHUTTER 
est réglé sur ON.

White Preset <!> On/Off Active/désactive la fonction d’allumage de 
l’indicateur ! quand le commutateur WHITE 
BAL est réglé sur PRST.

ATW Run <!> On/Off Active/désactive la fonction d’allumage de 
l’indicateur ! quand ATW est utilisé.

Extender <!> On/Off Active/désactive la fonction d’allumage de 
l’indicateur ! quand le dispositif d’extension 
de l’objectif est utilisé.

Filter <!> On/Off Active/désactive la fonction d’allumage de 
l’indicateur ! quand le filtre ND est réglé sur 
un paramètre autre que 1.

Iris Override <!> On/Off Active/désactive la fonction d’allumage de 
l’indicateur ! quand le changement de valeur 
du diaphragme automatique n’est pas réglé 
sur Standard.

Operation >White Setting
Configure les réglages relatifs à l’ajustement d’équilibre des blancs.

Elément Réglage Description

White Switch<B> Memory/ATW Définit le mode de fonctionnement 
sélectionné par la position B du commutateur 
WHITE BAL.
Memory : équilibre des blancs automatique
ATW : équilibre des blancs à suivi 

automatique

Shockless White Off/1/2/3 Sélectionne la durée de transition lorsque le 
réglage du commutateur WHITE BAL est 
modifié (1 est la plus rapide).

ATW Speed 1/2/3/4/5 Sélectionne la vitesse de transition d’ATW 
(équilibre de blancs à suivi automatique) (1 
est la plus rapide).
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Operation >White Setting
Configure les réglages relatifs à l’ajustement d’équilibre des blancs.

Elément Réglage Description

ATW Mode Natural/Pure Règle le mode ATW (balance des blancs à 
suivi automatique).
Natural : ajuste automatiquement ATW pour 

obtenir une ambiance naturelle selon 
l’éclairage de la scène.

Pure : ajuste automatiquement ATW pour 
obtenir un résultat proche des couleurs 
primaires sans couleur bleuâtre ou 
rougeâtre résiduelle.

AWB Fixed Area On/Off Exécute AWB (équilibre des blancs 
automatique) pour le centre de l’écran.

Filter White Memory On/Off Définit la zone de mémoire d’équilibre des 
blancs pour chaque numéro de position du 
bouton FILTER lorsque White Balance est 
réglé sur Preset ou ATW.
ˎˎ Lorsqu’Electrical CC est attribué À un 
commutateur personnalisable, cela définit 
les zones de mémoire d’équilibre des 
blancs indépendantes pour les réglages 
Electrical CC A, B, C et D.
ˎˎ Lorsqu’Electrical CC n’est pas attribué à un 
commutateur personnalisable, cela définit 
les zones de mémoire d’équilibre des 
blancs pour chaque numéro de position du 
bouton FILTER.

Operation >Offset White
Configure les réglages relatifs aux valeurs de décalage de l’équilibre des blancs.

Elément Réglage Description

Offset White<A> On/Off Choisit d’ajouter (On) ou non (Off) une valeur 
de décalage à l’équilibre des blancs dans la 
mémoire A.

Warm Cool <A> Affichage de la température 
de couleur approximative
(Environ 1600K à 3200K à 
16000K)

Lorsque Offset White<A> est réglé sur On, 
cela indique le décalage (en tant que 
température de couleur) à ajouter à l’équilibre 
des blancs dans la mémoire A. (Notez que 
l’erreur augmente pour les décalages de 
températures de couleur élevés. Effectuez 
l’ajustement en regardant l’image.)

Operation >Offset White
Configure les réglages relatifs aux valeurs de décalage de l’équilibre des blancs.

Elément Réglage Description

Warm Cool 
Balance<A>

–99 à ±0 à +99 Indique une température de couleur plus 
précise, à utiliser lorsqu’il n’est pas possible 
d’obtenir une image satisfaisante avec le 
réglage Warm Cool <A>.

Offset White <B> On/Off Lorsque cet élément est réglé sur On, le 
décalage ajusté ici est ajouté à l’équilibre des 
blancs du canal B.

Warm Cool <B> Affichage de la température 
de couleur approximative
(Environ 1600K à 3200K à 
16000K)

Lorsque Offset White<B> est réglé sur On, cela 
indique le décalage (en tant que température 
de couleur) à ajouter à l’équilibre des blancs 
dans la mémoire A. (Notez que l’erreur 
augmente pour les décalages de 
températures de couleur élevés. Effectuez 
l’ajustement en regardant l’image.)

Warm Cool 
Balance<B>

–99 à ±0 à +99 Indique une température de couleur plus 
précise, à utiliser lorsqu’il n’est pas possible 
d’obtenir une image satisfaisante avec le 
réglage Warm Cool <B>.

Operation >Shutter
Définit le mode de fonctionnement de l’obturateur.

Elément Réglage Description

Mode Speed/Angle Sélectionne le mode de fonctionnement de 
l’obturateur électronique.
Speed : définit la vitesse d’obturation comme 

une durée (unités : secondes).
Angle : définit la vitesse d’obturation comme 

un angle (unités : degrés).

Operation >Slow Shutter
Règle l’obturateur lent.

Elément Réglage Description

Setting On/Off Active/désactive la fonction d’obturateur lent.

Number of Frames 2/3/4/5/6/7/8/16 Définit le nombre d’images accumulées pour 
la fonction d’obturateur lent.
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Operation >Time Zone
Définit le fuseau horaire.

Elément Réglage Description

Time Zone UTC +14:00 à UTC Greenwich 
à UTC –12:00

Sélectionne la différence horaire par rapport 
au temps universel coordonné (temps moyen 
de Greenwich) par unités de 30 minutes.

Operation >Clip
Configure les réglages relatifs à la gestion et au nom de plan.

[Remarque]
N’attribuez pas de noms de plan qui commencent par le symbole « . » (point). Les plans avec des noms dans 
lesquels le premier caractère est « . » ne peuvent pas être visualisés dans le logiciel d’application sur un 
ordinateur.

Elément Réglage Description

Clip Naming Title/Plan Sélectionne le format du nom du plan.
Title : nom spécifié par Title Prefix.
Plan : nom spécifié dans les métadonnées de 

planification (si aucun nom n’est spécifié 
dans les métadonnées de planification, le 
nom spécifié par Title Prefix est utilisé.)

Title Prefix Saisie de texte Règle la partie de titre (4 à 46 caractères 
alphanumériques) des titres de plans à l’aide 
d’un écran de saisie de chaîne de caractères 
(page 96).

Number Set Les réglages varient selon le 
réglage Clip Naming.

Définit la portion numérique du nom de plan.
Lorsque Clip Naming est réglé sur Title : 0001 

à 9999
Lorsque Clip Naming est réglé sur Plan, et 

qu’un fichier de métadonnées de 
planification est chargé : 00001 à 99999

Operation >Update Media
Met à jour le fichier de gestion du support.

[Remarque]
Cette fonction n’est pas disponible lorsque le système de fichiers est réglé sur FAT.

Elément Réglage Description

Media(A) Execute/Cancel Met à jour les informations de gestion de la 
carte mémoire SxS dans le logement A 
(exécutez en sélectionnant Execute).

Media(B) Execute/Cancel Met à jour les informations de gestion de la 
carte mémoire SxS dans le logement B 
(exécutez en sélectionnant Execute).

Operation >GPS
Active/désactive les informations d’emplacement (GPS).

Elément Réglage Description

GPS On/Off Active/désactive la fonction GPS.

Operation >Planning Metadata
Configure les réglages relatifs aux opérations des métadonnées de planification.

Elément Réglage Description

Load from Media(A) Execute/Cancel Charge les métadonnées de planification de 
la carte mémoire SxS située dans le logement 
A.
Utilisez Execute pour afficher une liste des 
fichiers de métadonnées de planification 
stockés sur la carte mémoire SxS du logement 
A. Sélectionnez un fichier pour afficher l’écran 
de propriétés.

[Remarque]
Cet élément ne s’affiche pas lorsque le système de 
fichiers est défini sur FAT.

Load from Media(B) Execute/Cancel Charge les métadonnées de planification de 
la carte mémoire SxS située dans le logement 
B.
Utilisez Execute pour afficher une liste des 
fichiers de métadonnées de planification 
stockés sur la carte mémoire SxS du logement 
B. Sélectionnez un fichier pour afficher l’écran 
de propriétés.

[Remarque]
Cet élément ne s’affiche pas lorsque le système de 
fichiers est défini sur FAT.

Properties Execute/Cancel Affiche le contenu des métadonnées de 
planification chargé dans le caméscope 
(exécutez en sélectionnant Execute).

Clear Memory Execute/Cancel Efface les métadonnées de planification 
chargées dans le caméscope (exécutez en 
sélectionnant Execute).

Clip Name Disp Title1(ASCII)/Title2(UTF-8) Sélectionne le format d’affichage si le nom de 
plan est spécifié dans les métadonnées de 
planification (page 58).
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Operation >Planning Metadata
Configure les réglages relatifs aux opérations des métadonnées de planification.

Elément Réglage Description

Sort by Date/Time (0-9)/ 
Date/Time (9-0)

Date/Time (0-9) : permet de trier la liste de 
fichiers en ordre croissant dans la colonne 
Date/Time (date de création la plus 
ancienne en haut).

Date/Time (9-0) : permet de trier la liste de 
fichiers en ordre décroissant dans la 
colonne Date/Time (date de création la 
plus récente en haut).

Operation >USB
Configure les réglages relatifs à la copie de plans du support d’enregistrement inséré dans un 
logement pour carte SxS du caméscope vers un support USB.

Elément Réglage Description

Select Folder Sélectionne un dossier sur le support USB.
Crée un nouveau dossier sur le support USB.

View Clip List Affiche une liste des plans sur le support USB.

Rename Folder Renomme un dossier sur le support USB.

Error Check On/Off Sélectionne d’effectuer ou non une 
vérification d’erreur lors de la copie de plans 
du support d’enregistrement inséré dans un 
logement pour carte SxS du caméscope vers 
un support USB.

Format USB Execute/Cancel Formate le support USB (exécutez en 
sélectionnant Execute).

Copy to USB Media(A) to USB/  
Media(B) to USB/  
Media(A)(B) to USB

Sélectionne le logement cible lors de la copie 
de tous les plans à partir d’un logement pour 
carte SxS.
Media(A) to USB : copier tous les plans à partir 

du support d’enregistrement inséré dans 
le logement A.

Media(B) to USB : copier tous les plans à partir 
du support d’enregistrement inséré dans 
le logement B.

Media(A)(B) to USB : copier tous les plans à 
partir du support d’enregistrement inséré 
dans le logement A et le logement B.

Media Remain (Espace libre : affichage 
numérique et affichage de 
barre)

Affiche l’espace libre restant sur le support 
USB.
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Menu Paint
Les valeurs par défaut sont soulignées et le texte est en gras.

Paint >Switch Status
Active/désactive différentes fonctions de correction et un signal de test.

Elément Réglage Description

Gamma On/Off Active/désactive la fonction de gamma.

Black Gamma On/Off Active/désactive la fonction de gamma du 
noir.

Matrix On/Off Active/désactive la fonction de matrice.

Knee On/Off Active/désactive la fonction de courbe.

White Clip On/Off Active/désactive la fonction d’écrêtage du 
blanc.

[Remarque]
Si Off est défini, le réglage est réinitialisé sur On lors 
de la mise sous tension suivante.

Detail(QFHD) On/Off Active/désactive la fonction de détails.

Detail(HD) On/Off

Aperture On/Off Active/désactive la fonction d’ouverture.

Flare On/Off Active/désactive la fonction de correction de 
lumière parasite.

Test Saw On/Off Active/désactive le signal test.

Paint >HDR Paint Setting
Règle les réglages HDR lorsque Shooting Mode est réglé sur HDR.

Elément Réglage Description

HLG Look Natural/Mild/Live Règle le HLG Type en mode HDR.
Natural : caractéristique conforme à ITU-R 

BT.2100(HLG).
Mild : caractéristique conforme à ITU-R 

BT.2100(HLG) qui délivre une qualité 
d’image globalement plus douce que Live 
Look.

Live : caractéristique conforme à ITU-R 
BT.2100(HLG) qui délivre des 
performances HDR améliorées.

HDR Black Offset –95 à ±0 à +103 Règle le décalage noir pour HDR en fonction 
du réglage SDR (Master Black) en mode HDR.

HDR Knee On/Off Active/désactive la fonction de correction de 
courbe du signal HDR en mode HDR.

HDR Knee Point –99 à ±0 à +99 Définit le point de courbe pour les signaux 
HDR lorsque HDR Knee est réglé sur On.

HDR Knee Slope –99 à ±0 à +99 Définit la pente de courbe pour les signaux 
HDR lorsque HDR Knee est réglé sur On.

Paint >HDR Paint Setting
Règle les réglages HDR lorsque Shooting Mode est réglé sur HDR.

Elément Réglage Description

HDR Black 
Compression

On/Off Active/désactive la fonction de compression 
du niveau de noir de la vidéo HDR pour qu’il 
corresponde à celui de la vidéo SDR.

Paint >White
Règle la température de couleur et ajuste l’équilibre des blancs manuellement.

Elément Réglage Description

Color Temp <A> 1500K à 3200K à 50000K Affiche la température de couleur de 
l’équilibre des blancs stockée dans la 
mémoire A.

Color Temp Balance 
<A>

–99 à ±0 à +99 Règle la valeur de gain de l’équilibre des 
blancs stockée dans la mémoire A (gain R et 
gain B associés).

R Gain <A> –99 à ±0 à +99 Règle la valeur de gain R de l’équilibre des 
blancs stockée dans la mémoire A.

B Gain <A> –99 à ±0 à +99 Règle la valeur de gain B de l’équilibre des 
blancs stockée dans la mémoire A.

Color Temp <B> 1500K à 3200K à 50000K Affiche la température de couleur de 
l’équilibre des blancs stockée dans la 
mémoire B.

Color Temp Balance 
<B>

–99 à ±0 à +99 Règle les valeurs de gain de l’équilibre des 
blancs stockées dans la mémoire B (gain R et 
gain B associés).

R Gain <B> –99 à ±0 à +99 Règle la valeur de gain R de l’équilibre des 
blancs stockée dans la mémoire B.

B Gain <B> –99 à ±0 à +99 Règle la valeur de gain B de l’équilibre des 
blancs stockée dans la mémoire B.

Paint >Black
Définit le niveau de noir (niveau d’image sans lumière).
Vous pouvez obtenir l’effet souhaité en ajustant le niveau de noir pour les noirs plus et moins 
profonds.

Elément Réglage Description

Master Black –99 à ±0 à +99 Règle le niveau de noir maître.

R Black –99 à ±0 à +99 Règle le niveau de noir R.

B Black –99 à ±0 à +99 Règle le niveau de noir B.
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Paint >Flare
Configure les réglages relatifs à la correction de la lumière parasite.
La lumière parasite est un phénomène où le niveau de vidéo augmente sur l’image entière à 
cause des effets des zones lumineuses dans l’image, ce qui augmente la luminosité des zones 
plus sombres et réduit le contraste. Elle est causée par la lumière reflétée à l’intérieur de l’objectif.

Elément Réglage Description

Setting On/Off Active/désactive la fonction de correction de 
lumière parasite.

Master Flare –99 à ±0 à +99 Règle le niveau de correction de lumière 
parasite maître.

R Flare –99 à ±0 à +99 Règle le niveau de correction de lumière 
parasite R.

G Flare –99 à ±0 à +99 Règle le niveau de correction de lumière 
parasite V.

B Flare –99 à ±0 à +99 Règle le niveau de correction de lumière 
parasite B.

Paint >Gamma(HDR)
Affiche les réglages de gamma HDR.

Elément Réglage Description

Gamma Select S-Log3
HLG(Natural)
HLG(Mild)
---

Réglages gamma HDR (affichage 
uniquement)

Paint >Gamma
Configure les réglages relatifs à la correction gamma.
La correction gamma vous permet d’ajuster le contraste de l’image pour modifier façon 
significative l’impression donnée par une image.

Elément Réglage Description

Setting On/Off Active/désactive la fonction de correction 
gamma.

Step Gamma 0.35 à 0.45 à 0.90
(0,05 pas)

Définit une valeur de correction gamma par 
incréments de 0,05.

Master Gamma –99 à ±0 à +99 Définit le niveau gamma maître.

R Gamma –99 à ±0 à +99 Définit le niveau gamma R.

G Gamma –99 à ±0 à +99 Définit le niveau gamma V.

B Gamma –99 à ±0 à +99 Règle le niveau gamma B.

Paint >Gamma
Configure les réglages relatifs à la correction gamma.
La correction gamma vous permet d’ajuster le contraste de l’image pour modifier façon 
significative l’impression donnée par une image.

Elément Réglage Description

Gamma Category STD/HG/User/--- Sélectionne la catégorie de gamma.
STD : courbe gamma standard pour les 

signaux vidéo
HG : courbe gamma qui imite la gradation et 

la reproduction de couleurs du tournage 
avec le film

User : courbe gamma définie par l’utilisateur 
créée grâce à CvpFileEditorTM V4.2

--- : pas de sortie SDR

Gamma Select Les réglages varient selon le 
réglage Gamma Category.

Sélectionne le tableau gamma utilisé pour la 
correction gamma.

Lorsque Gamma Category est réglé sur STD
STD1 DVW : équivalent à un caméscope DVW
STD2 x4.5 : gain ×4,5
STD3 x3.5 : gain ×3,5
STD4 240M : équivalent à SMPTE-240M
STD5 R709 : équivalent à ITU-R709
STD6 x5.0 : gain ×5,0

Lorsque Gamma Category est réglé sur HG
HG1 3250G36 : compresse l’entrée vidéo 325 % en sortie vidéo 100 %.
HG2 4600G30 : compresse l’entrée vidéo 460 % en sortie vidéo 100 %.
HG3 3259G40 : compresse l’entrée vidéo 325 % en sortie vidéo 109 %.
HG4 4609G33 : compresse l’entrée vidéo 460 % en sortie vidéo 109 %.

Lorsque Gamma Category est réglé sur User
User 1 : tableau gamma enregistré dans User1
User 2 : tableau gamma enregistré dans User2
User 3 : tableau gamma enregistré dans User3
User 4 : tableau gamma enregistré dans User4
User 5 : tableau gamma enregistré dans User5

Lorsqu’il n’y a pas de sortie SDR
---
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Paint >Black Gamma
Configure les réglages relatifs à la correction gamma du noir.
La correction gamma du noir vous permet de reproduire des gradations et des couleurs dans les 
parties noires ou presque noires (sombres) de l’image.

Elément Réglage Description

Setting On/Off Active/désactive la fonction de correction 
gamma du noir.

[Remarque]
Pour activer la fonction de gamma noir, réglez 
Saturation Mode sur Low Key.

Range Low/L.Mid/H.Mid Sélectionne la plage effective de la correction 
gamma du noir.
Low : 0 à 3,6 %
L.Mid : 0 à 7,2 %
H.Mid : 0 à 14,4 %

Master Black Gamma –99 à ±0 à +99 Règle le niveau de gamma du noir maître.

Paint >Knee
Configure les réglages relatifs à la correction de courbe.
La correction de courbe est un traitement qui empêche les rehauts accentués en comprimant les 
parties lumineuses de l’image en réponse à la limite supérieure pour la plage dynamique de 
l’image enregistrée/de sortie. Le niveau de signal où commence le traitement de courbe est 
appelé « point de courbe » et la pente de la compression de courbe est appelée « pente de 
courbe ».

Elément Réglage Description

Setting On/Off Active/désactive la fonction de correction de 
courbe.

Point 75% à 95% à 109% Règle le point de courbe lorsque la fonction 
DCC est désactivée.

Slope –99 à ±0 à +99 Règle la pente de courbe lorsque la fonction 
DCC est désactivée.

Knee Saturation On/Off Active/désactive la fonction de saturation de 
la courbe.

[Remarque]
Pour activer la fonction de saturation de la courbe, 
réglez Saturation Mode sur Knee.

Knee Saturation Level –99 à ±0 à +99 Règle le niveau de saturation de la courbe.

Paint >White Clip
Configure les réglages relatifs à l’ajustement d’écrêtage du blanc.
Le traitement du plan limite le niveau maximum des signaux de sortie vidéo. La valeur du signal 
de sortie vidéo maximum est appelée « niveau d’écrêtage du blanc ».

Elément Réglage Description

Setting On/Off Active/désactive la fonction d’ajustement 
d’écrêtage du blanc.

Level 90.0% à 108.0% à 109.0% Règle le niveau d’écrêtage du blanc.
Le réglage par défaut est 108.0% lorsque la 
fréquence de système est 59.94, 29.97, 24 ou 
23.98. Le réglage par défaut est 105.0% 
lorsque la fréquence de système est 50.25.

Paint >Detail(QFHD)/Detail(HD)
Configure les réglages relatifs aux ajustements de détail en mode 4K/HD.
Le traitement d’ajustement de détail améliore la clarté des images en ajoutant des signaux de 
détail au contour du sujet.

[Remarque]
Pendant la sortie QFHD/HD simultanée, ces réglages ne sont pas appliqués à la sortie HD.

Elément Réglage Description

Setting On/Off Active/désactive la fonction d’ajustement de 
détail.

Level –99 à ±0 à +99 Règle le niveau de détail.

H/V Ratio –99 à ±0 à +99 Règle le rapport de mélange entre le niveau 
de détail H et le niveau de détail V.

Crispening –99 à ±0 à +99 Règle le niveau de netteté.

Level Depend On/Off Active/désactive la fonction d’ajustement de 
dépendance du niveau.

Level Depend Level –99 à ±0 à +99 Règle le niveau de dépendance du niveau.

Frequency –99 à ±0 à +99 Règle la fréquence centrale du signal de détail 
H (des valeurs plus grandes donnent des 
détails plus précis).

Knee Aperture On/Off Active/désactive la fonction de correction 
d’ouverture de courbe.

Knee Aperture Level –99 à ±0 à +99 Règle le niveau d’ouverture de courbe.

Limit –99 à ±0 à +99 Règle les limites de détail pour les côtés blanc 
et noir.

White Limit –99 à ±0 à +99 Règle la limite de détail pour le côté blanc.

Black Limit –99 à ±0 à +99 Règle la limite de détail pour le côté noir.

V Black Limit –99 à ±0 à +99 Règle la limite de détail V pour le côté noir.
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Paint >Detail(QFHD)/Detail(HD)
Configure les réglages relatifs aux ajustements de détail en mode 4K/HD.
Le traitement d’ajustement de détail améliore la clarté des images en ajoutant des signaux de 
détail au contour du sujet.

[Remarque]
Pendant la sortie QFHD/HD simultanée, ces réglages ne sont pas appliqués à la sortie HD.

Elément Réglage Description

V Detail Creation NAM/Y/G/G+R Sélectionne le signal source utilisé pour 
générer le signal de détail V.
NAM : un signal de détail V créé à partir du 

signal R, un signal de détail V créé à partir 
du signal V ou un signal de détail V créé à 
partir du signal B, selon le signal ayant le 
niveau le plus élevé

Y : signal Y
G : signal V
G+R : signal mélangé comprenant le signal V 

et le signal R à un rapport 1:1

Paint >Aperture
Configure les réglages relatifs à la correction d’ouverture.
Le traitement de correction d’ouverture améliore la résolution en ajoutant des signaux 
d’ouverture haute fréquence au signal vidéo, ce qui corrige la détérioration due aux 
caractéristiques de haute fréquence.

Elément Réglage Description

Setting On/Off Active/désactive la fonction de correction 
d’ouverture.

Level –99 à ±0 à +99 Règle le niveau d’ouverture.

Paint >Skin Detail
Configure les réglages relatifs à la correction des détails du teint.
La correction des détails du teint est un traitement qui augmente ou diminue le niveau de détail 
d’une plage de couleur indiquée, afin d’obtenir une belle reproduction des tons du teint.

Elément Réglage Description

Setting On/Off Active/désactive la fonction de correction des 
détails du teint.

Area Detection Execute/Cancel Affiche un écran de détection de couleur afin 
de détecter les couleurs pour la correction des 
détails de teint (exécutez en sélectionnant 
Execute).

Area Indication On/Off Active/désactive l’affichage d’un motif de 
zébrures dans les zones cibles pour la 
correction des détails du teint.

Level –99 à ±0 à +99 Règle le niveau des détails du teint.

Paint >Skin Detail
Configure les réglages relatifs à la correction des détails du teint.
La correction des détails du teint est un traitement qui augmente ou diminue le niveau de détail 
d’une plage de couleur indiquée, afin d’obtenir une belle reproduction des tons du teint.

Elément Réglage Description

Saturation –99 à ±0 à +99 Règle la saturation de la couleur cible pour la 
correction des détails du teint.

Hue 0 à 359 Règle la teinte de la couleur cible pour la 
correction des détails du teint.

Width 0 à 40 à 90 Règle la plage de la teinte de la couleur cible 
de la correction des détails du teint.

Paint >Matrix
Configure les réglages relatifs à la correction de matrice.
Règle la teinte et l’éclat de l’image en utilisant la correction de matrice.
Vous pouvez sélectionner une matrice pour obtenir un résultat spécifique depuis une série de 
paramètres prédéfinis dans « Preset Matrix ». Vous pouvez également définir vous-même des 
paramètres arbitraires dans « User Matrix ». La fonction « Adaptive Matrix » ajuste la matrice pour 
contrôler la reproduction de la couleur.

Elément Réglage Description

Setting On/Off Active/désactive la fonction de correction de 
matrice.

Adaptive Matrix On/Off Active/désactive la fonction de matrice 
d’adaptation.

Preset Matrix On/Off Active/désactive la fonction de matrice 
prédéfinie.

Preset Select 1 : SMPTE240M
2 : ITU-709
3 : SMPTE Wide
4 : NTSC
5 : EBU
6 : PAL

Sélectionne une matrice prédéfinie.
1 : SMPTE240M : équivalent à SMPTE-240M
2 : ITU-709 : équivalent à ITU-709
3 : SMPTE Wide : équivalent à SMPTE WIDE
4 : NTSC : équivalent à NTSC
5 : EBU : équivalent à EBU
6 : PAL : équivalent à PAL

User Matrix On/Off Active/désactive la fonction de correction de 
matrice utilisateur.

Level –99 à ±0 à +99 Règle la saturation de la couleur de l’image 
entière.

Phase –99 à ±0 à +99 Règle la nuance de couleur (phase) de l’image 
entière.

User Matrix R-G –99 à ±0 à +99 Règle une matrice utilisateur R-V définie par 
l’utilisateur.

User Matrix R-B –99 à ±0 à +99 Règle une matrice utilisateur R-B définie par 
l’utilisateur.
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Paint >Matrix
Configure les réglages relatifs à la correction de matrice.
Règle la teinte et l’éclat de l’image en utilisant la correction de matrice.
Vous pouvez sélectionner une matrice pour obtenir un résultat spécifique depuis une série de 
paramètres prédéfinis dans « Preset Matrix ». Vous pouvez également définir vous-même des 
paramètres arbitraires dans « User Matrix ». La fonction « Adaptive Matrix » ajuste la matrice pour 
contrôler la reproduction de la couleur.

Elément Réglage Description

User Matrix G-R –99 à ±0 à +99 Règle une matrice utilisateur V-R définie par 
l’utilisateur.

User Matrix G-B –99 à ±0 à +99 Règle une matrice utilisateur V-B définie par 
l’utilisateur.

User Matrix B-R –99 à ±0 à +99 Règle une matrice utilisateur B-R définie par 
l’utilisateur.

User Matrix B-G –99 à ±0 à +99 Règle une matrice utilisateur B-V définie par 
l’utilisateur.

Paint >Multi Matrix
Configure les réglages relatifs à la correction de matrice multiple.
La correction de matrice multiple règle la saturation à l’aide d’un espace de teinte à 16 axes.

Elément Réglage Description

Setting On/Off Active/désactive la fonction de correction de 
matrice multiple.

Area Indication On/Off Active/désactive l’affichage d’un motif de 
zébrures dans la zone de couleur cible pour la 
correction de matrice multiple.

Color Detection Execute/Cancel Affiche un écran de détection de couleur afin 
de détecter les couleurs pour la correction de 
la matrice multiple (exécutez en sélectionnant 
Execute).

Reset Execute/Cancel Règle toutes les teintes et la saturation sur 
chaque axe aux valeurs par défaut (exécutez 
en sélectionnant Execute).

Axis B/B+/MG–/MG/MG+/R/R+/
YL–/YL/YL+/G–/G/G+/CY/
CY+/B–

Règle la couleur cible pour la correction de 
matrice multiple (mode 16 axes).

Hue –99 à ±0 à +99 Règle la teinte de la couleur cible pour la 
correction de matrice multiple pour chaque 
mode 16 axes.

Saturation –99 à ±0 à +99 Règle la saturation de la couleur cible pour la 
correction de matrice multiple pour chaque 
mode 16 axes.

Paint >V Modulation
Configure les réglages relatifs à la correction de l’ombrage de modulation V.
L’ombrage de modulation V corrige la pente verticale de sensibilité dus à la relation entre 
l’objectif et un prisme.

Elément Réglage Description

Setting On/Off Active/désactive la fonction de correction de 
l’ombrage à modulation V.

Master V Modulation –99 à ±0 à +99 Règle le niveau de modulation V maître.

R V Modulation –99 à ±0 à +99 Règle le niveau de modulation V du signal R.

G V Modulation –99 à ±0 à +99 Règle le niveau de modulation V du signal V.

B V Modulation –99 à ±0 à +99 Règle le niveau de modulation V du signal B.

Paint >Low Key Saturation
Configure les réglages relatifs à la correction de saturation de clair-obscur.
Corrige la saturation des couleurs dans les parties sombres de l’image.

Elément Réglage Description

Setting On/Off Active/désactive la fonction de correction de 
saturation de clair-obscur.

[Remarque]
Pour activer la fonction de saturation clair obscur, 
réglez Saturation Mode sur Low Key.

Level –99 à ±0 à +99 Règle la saturation des couleurs dans les 
zones à faible luminance.

Range Low/L.Mid/H.Mid Sélectionne le niveau de luminance auquel la 
saturation de clair-obscur est activée.

Paint >Saturation Mode
Configure les réglages relatifs à la correction de saturation.

Elément Réglage Description

Saturation Mode Knee/Low Key Choisit ou non que la fonction de saturation 
fonctionne à des niveaux élevés (Knee) ou 
des niveaux faibles (Low Key).

Knee Saturation On/Off Active/désactive la fonction de saturation de 
la courbe.

Black Gamma On/Off Active/désactive la fonction de correction 
gamma du noir.

Low Key Saturation On/Off Active/désactive la fonction de saturation de 
clair-obscur.
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Paint >Noise Suppression
Configure les réglages relatifs à la suppression de bruit (compression de bruit).
Cela vous permet de supprimer efficacement les composants de bruit tout en préservant les 
composants de contour précis du sujet.

Elément Réglage Description

Setting On/Off Active/désactive la fonction de suppression 
de bruit.

Level Low/Mid/High/Super Sélectionne le niveau de suppression de bruit.

Gain Link On/Off Détermine si le niveau de suppression du 
bruit est lié au gain.

–3dB Off/Low/Mid/High/Super Définit le niveau de suppression de bruit sur 
–3 dB lorsque vous réglez Gain Link sur On.

0dB Off/Low/Mid/High/Super Définit le niveau de suppression de bruit sur 
0 dB lorsque vous réglez Gain Link sur On.

3dB Off/Low/Mid/High/Super Définit le niveau de suppression de bruit sur 
3 dB lorsque vous réglez Gain Link sur On.

6dB Off/Low/Mid/High/Super Définit le niveau de suppression de bruit sur 
6 dB lorsque vous réglez Gain Link sur On.

9dB Off/Low/Mid/High/Super Définit le niveau de suppression de bruit sur 
9 dB lorsque vous réglez Gain Link sur On.

12dB Off/Low/Mid/High/Super Définit le niveau de suppression de bruit sur 
12 dB lorsque vous réglez Gain Link sur On.

18dB Off/Low/Mid/High/Super Définit le niveau de suppression de bruit sur 
18 dB lorsque vous réglez Gain Link sur On.

24dB Off/Low/Mid/High/Super Définit le niveau de suppression de bruit sur 
24 dB lorsque vous réglez Gain Link sur On.

30dB Off/Low/Mid/High/Super Définit le niveau de suppression de bruit sur 
30 dB lorsque vous réglez Gain Link sur On.

36dB Off/Low/Mid/High/Super Définit le niveau de suppression de bruit sur 
36 dB lorsque vous réglez Gain Link sur On.

42dB Off/Low/Mid/High/Super Définit le niveau de suppression de bruit sur 
42 dB lorsque vous réglez Gain Link sur On.
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Menu Maintenance
Les valeurs par défaut sont soulignées et le texte est en gras.

Maintenance >White Shading
Configure les réglages relatifs à la correction de l’ombrage blanc.
L’ombrage blanc est requis pour chaque objectif différent afin de corriger les irrégularités de 
couleur et de luminance dans les zones lumineuses dues aux caractéristiques de l’objectif.

Elément Réglage Description

Channel Select Red/Green/Blue Sélectionne la cible pour la correction 
d’ombrage blanc.

White H Saw –99 à ±0 à +99 Règle la valeur de correction d’ombrage blanc 
en dent de scie pour le sens horizontal.

White H Para –99 à ±0 à +99 Règle la valeur de correction d’ombrage blanc 
parabolique pour le sens horizontal.

White V Saw –99 à ±0 à +99 Règle la valeur de correction d’ombrage blanc 
en dent de scie pour le sens vertical.

White V Para –99 à ±0 à +99 Règle la valeur de correction d’ombrage blanc 
parabolique pour le sens vertical.

White Saw/Para On/Off Active/désactive la fonction de correction 
d’ombrage blanc en dent de scie/
parabolique.

Maintenance >Black Shading
Configure les réglages relatifs à la correction d’ombrage noir.

Elément Réglage Description

Channel Select Red/Green/Blue Sélectionne la cible pour la correction 
d’ombrage noir.

Black H Saw –99 à ±0 à +99 Règle la valeur de correction d’ombrage noir 
en dent de scie pour le sens horizontal.

Black H Para –99 à ±0 à +99 Règle la valeur de correction d’ombrage noir 
parabolique pour le sens horizontal.

Black V Saw –99 à ±0 à +99 Règle la valeur de correction d’ombrage noir 
en dent de scie pour le sens vertical.

Black V Para –99 à ±0 à +99 Règle la valeur de correction d’ombrage noir 
parabolique pour le sens vertical.

Black Saw/Para On/Off Active/désactive la fonction de correction 
d’ombrage noir en dent de scie/parabolique.

Master Black –99 à ±0 à +99 Règle le niveau de noir maître.

Master Gain (TMP) –3dB/0dB/3dB/6dB/9dB/12dB/ 
18dB/24dB/30dB/36dB/42dB

Règle une valeur de gain maître temporaire.

Maintenance >Battery
Configure les réglages relatifs aux batteries.

Elément Réglage Description

Near End:Info Battery 5%/10%/15%...95%/100% Règle la valeur seuil pour l’affichage d’un 
avertissement « Battery Near End » lors de 
l’utilisation d’un pack batterie BP-GL95B.

End:Info Battery 0%/1%/2%/3%/4%/5% Règle la valeur seuil pour l’affichage d’un 
avertissement « Battery End » lors de 
l’utilisation d’un pack batterie BP-GL95B.

Near End:Sony 
Battery

11.5V à 17V 
(par incréments de 0.1V)

Règle la valeur seuil pour l’affichage d’un 
« Battery Near End » lors de l’utilisation d’un 
pack batterie BP-L60S/L80S.

End:Sony Battery 11.0V à 12.5V 
(par incréments de 0.1V)

Règle la valeur seuil pour l’affichage d’un 
« Battery End » lors de l’utilisation d’un pack 
batterie BP-L60S/L80S.

Near End:Other 
Battery

11.5V à 11.8V à 17.0V 
(par incréments de 0.1V)

Règle la valeur seuil pour l’affichage d’un 
« Battery Near End » lors de l’utilisation d’un 
pack batterie d’un autre fabricant que Sony.

End: Other Battery 11.0V à 14.0V 
(par incréments de 0.1V)

Règle la valeur seuil pour l’affichage d’un 
« Battery End » lors de l’utilisation d’un pack 
batterie d’un autre fabricant que Sony.

Detected Battery Sony Info Battery/ 
Sony Battery/ 
Other Battery/DC IN

Affiche le résultat de la détection 
automatique du type de pack batterie.

Maintenance >DC Voltage Alarm
Règle les alarmes relatives à la tension d’alimentation DC externe.

Elément Réglage Description

DC Low Voltage1 11.5V à 17V 
(par incréments de 0.1V)

Règle la valeur seuil pour l’affichage d’un 
avertissement « Battery Near End » lors de 
l’utilisation d’une source d’alimentation 
externe raccordée au connecteur DC IN.

DC Low Voltage2 11.0V à 14.0V 
(par incréments de 0.1V)

Règle la valeur seuil pour l’affichage d’un 
avertissement « Battery End » lors de 
l’utilisation d’une source d’alimentation 
externe raccordée au connecteur DC IN.

Maintenance >Audio
Configure les réglages relatifs à l’audio.

Elément Réglage Description

Front MIC Select Mono/Stereo Sélectionne le mode du microphone avant : 
monaural (Mono) ou stéréo (Stereo).
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Maintenance >Audio
Configure les réglages relatifs à l’audio.

Elément Réglage Description

Rear XLR Auto On/Off Active/désactive la fonction de détection 
automatique pour la connexion des câbles 
aux connecteurs AUDIO IN CH-1/CH-2 sur le 
panneau arrière.

Front MIC CH1 Ref –70dB/–60dB/–50dB/ 
–40dB/–30dB

Sélectionne le niveau de référence du 
microphone avant pour le canal 1.

Front MIC CH2 Ref –70dB/–60dB/–50dB/ 
–40dB/–30dB

Sélectionne le niveau de référence du 
microphone avant pour le canal 2.

Rear MIC CH1 Ref –70dB/–60dB/–50dB/ 
–40dB/–30dB

Sélectionne le niveau d’entrée de référence 
lorsque le commutateur AUDIO IN CH1 est 
réglé sur MIC.

Rear MIC CH2 Ref –70dB/–60dB/–50dB/ 
–40dB/–30dB

Sélectionne le niveau d’entrée de référence 
lorsque le commutateur AUDIO IN CH2 est 
réglé sur MIC.

Line Input Ref +4dB/0dB/–3dB/EBUL Sélectionne le niveau d’entrée de référence 
lorsque les commutateurs AUDIO IN CH1 et 
AUDIO IN CH2 sont réglés sur LINE.

Min Alarm Volume Off/Set Sélectionne le volume lorsque le bouton 
ALARM est au minimum.
Off : inaudible
Set : audible

Speaker Attenuate Off/3dB/6dB/9dB/12dB Sélectionne le volume des haut-parleurs du 
moniteur (n’affecte pas le volume des 
écouteurs).

Headphone Out Mono/Stereo Sélectionne le mode des écouteurs : 
monaural (Mono) ou stéréo (Stereo).

Reference Level –20dB/–18dB/–16dB/ 
–12dB/EBUL

Définit le niveau d’entrée de référence. Cela 
règle également le niveau de sortie du signal 
de test de 1 kHz.

Reference Out +4dB/0dB/–3dB/EBUL règle le niveau de sortie relatif au niveau 
d’entrée de référence.

CH1&2 AGC Mode Mono/Stereo Ajuste automatiquement du niveau d’entrée 
des signaux audio analogiques enregistrés 
sur les canaux 1 et 2, et choisit d’effectuer les 
ajustements séparément pour chaque canal 
(Mono) ou en mode stéréo (Stereo).

Maintenance >Audio
Configure les réglages relatifs à l’audio.

Elément Réglage Description

CH3&4 AGC Mode Mono/Stereo Ajuste automatiquement du niveau d’entrée 
des signaux audio analogiques enregistrés 
sur les canaux 3 et 4, et choisit d’effectuer les 
ajustements séparément pour chaque canal 
(Mono) ou en mode stéréo (Stereo).

AGC Spec –6dB/–9dB/–12dB/ 
–15dB/–17dB

Sélectionne la caractéristique AGC (niveau de 
saturation).

Limiter Mode Off/–6dB/–9dB/–12dB/ 
–15dB/–17dB

Sélectionne la caractéristique du limiteur 
(niveau de saturation) pour des forts signaux 
d’entrée lorsque le niveau d’entrée audio est 
ajouté manuellement. Sélectionnez Off si 
vous n’utilisez pas le limiteur.

Output Limiter On/Off Active/désactive le limiteur de sortie audio.

CH1 Wind Filter On/Off Active/désactive le filtre de réduction anti-
bruit du vent du canal 1.

CH2 Wind Filter On/Off Active/désactive le filtre de réduction anti-
bruit du vent du canal 2.

CH3 Wind Filter On/Off Active/désactive le filtre de réduction anti-
bruit du vent du canal 3.

CH4 Wind Filter On/Off Active/désactive le filtre de réduction anti-
bruit du vent du canal 4.

1kHz Tone on Color 
Bars

On/Off/Auto Règle d’émettre (On) ou non (Off) un signal 
de test 1 kHz en mode de barres de couleur.
Auto : émet un signal de test uniquement 

quand le commutateur AUDIO SELECT CH1 
est réglé sur AUTO.

MIC CH1 Level Side1/Front/Front+Side1 Sélectionne le bouton servant à ajuster le 
niveau audio lors de l’enregistrement audio 
d’entrée du microphone avant sur le canal 1.
Side1 : bouton LEVEL (gauche) sur le panneau 

latéral
Front : bouton MIC LEVEL sur le panneau 

avant
Front+Side1 : bouton LEVEL (gauche) et 

bouton MIC LEVEL (commande associée)



7. Affichage et réglages de menu : Menu Maintenance120

Maintenance >Audio
Configure les réglages relatifs à l’audio.

Elément Réglage Description

MIC CH2 Level Side2/Front/Front+Side2 Sélectionne le bouton servant à ajuster le 
niveau audio lors de l’enregistrement audio 
d’entrée du microphone avant sur le canal 2.
Side2 : bouton LEVEL (droite) sur le panneau 

latéral
Front : bouton MIC LEVEL sur le panneau 

avant
Front+Side2 : bouton LEVEL (droite) et bouton 

MIC LEVEL (commande associée)

Rear1/WRR Level Side1/Front/Front+Side1 Sélectionne le bouton permettant d’ajuster le 
niveau audio d’un microphone sans fil ou 
d’un dispositif raccordé au connecteur AUDIO 
IN CH-1 du panneau arrière.
Side1 : bouton LEVEL (gauche) sur le panneau 

latéral
Front : bouton MIC LEVEL sur le panneau 

avant
Front+Side1 : bouton LEVEL (gauche) et 

bouton MIC LEVEL (commande associée)

Rear2/WRR Level Side2/Front/Front+Side2 Sélectionne le bouton permettant d’ajuster le 
niveau audio d’un microphone sans fil ou 
d’un dispositif raccordé au connecteur AUDIO 
IN CH-2 du panneau arrière.
Side2 : bouton LEVEL (droite) sur le panneau 

latéral
Front : bouton MIC LEVEL sur le panneau 

avant
Front+Side2 : bouton LEVEL (droite) et bouton 

MIC LEVEL (commande associée)

Audio CH3 Level Side3/Front/Front+Side3 Sélectionne le bouton permettant 
l’ajustement du niveau audio enregistré sur le 
canal 3.
Side3 : bouton LEVEL sur le panneau latéral
Front : bouton MIC LEVEL sur le panneau 

avant
Front+Side3 : bouton LEVEL et bouton MIC 

LEVEL (commande associée)

Maintenance >Audio
Configure les réglages relatifs à l’audio.

Elément Réglage Description

Audio CH4 Level Side4/Front/Front+Side4 Sélectionne le bouton permettant 
l’ajustement du niveau audio enregistré sur le 
canal 4.
Side4 : bouton LEVEL sur le panneau latéral
Front : bouton MIC LEVEL sur le panneau 

avant
Front+Side4 : bouton LEVEL et bouton MIC 

LEVEL (commande associée)

Maintenance >WRR Setting
Configure les réglages relatifs au tuner sans fil.

Elément Réglage Description

WRR Valid CH Sel All/CH1 Sélectionne d’activer les canaux 1 et 2 du 
tuner sans fil (All) ou le canal 1 uniquement 
(CH1).

WRR CH Select TX1/TX2 Sélectionne le canal de réception à afficher 
dans le menu.
TX1 : affiche le canal 1.
TX2 : affiche le canal 2.

WRR Delay Comp On/Off Permet de choisir d’activer (On) ou de 
désactiver (Off) la fonction de compensation 
de délai pour l’audio d’entrée sans fil. 
(Lorsque On est sélectionné, tout l’audio de 
sortie E-E est retardé d’environ 8 ms.)

TX --- Affiche le nom de l’émetteur dont les signaux 
sont reçus sur le canal sélectionné par WRR 
CH Select.

TX Audio Peak ---/Peak Indique si le niveau AF de l’émetteur dont les 
signaux sont reçus sur le canal sélectionné 
par WRR CH Select dépasse la crête.

TX Input Level ---/Mic/Line Indique si le niveau d’entrée de l’émetteur 
dont les signaux sont reçus sur le canal 
sélectionné par WRR CH Select est réglé sur 
microphone (Mic) ou ligne (Line).

TX ATT Level --- Règle le niveau ATT de l’émetteur dont les 
signaux sont reçus sur le canal sélectionné 
par WRR CH Select. (La plage de réglage varie 
selon l’émetteur.)
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Maintenance >WRR Setting
Configure les réglages relatifs au tuner sans fil.

Elément Réglage Description

TX LCF Frequency --- Règle la fréquence du filtre passe-bas de 
l’émetteur dont les signaux sont reçus sur le 
canal sélectionné par WRR CH Select. (La 
plage de réglage varie selon l’émetteur.)

TX System Delay Auto/0.0ms à 8.0ms Règle la quantité de délai audio.
Auto : corrige automatiquement la quantité 

de délai de manière à ce que le délai de 
l’audio du tuner sans fil soit égal à zéro.

0.0ms à 8.0ms : règle la quantité de délai 
sans fil estimé, pour les cas où plusieurs 
systèmes sans fil sont utilisés via un 
dispositif tel qu’une table de mixage 
audio.

TX RF Power High (Valeur de puissance) 
mW/ 
Mid (Valeur de puissance) 
mW/ 
Low (Valeur de puissance) mW

Règle le niveau de puissance RF de l’émetteur 
en communication sur le canal sélectionné 
dans WRR CH Select. (La plage de réglage 
varie selon l’émetteur.)

TX Power Save Active/Sleep Règle le mode d’économie d’énergie de 
l’émetteur dont les signaux sont reçus sur le 
canal sélectionné par WRR CH Select.
Active : Règle l’émetteur sur le mode de 

démarrage.
Sleep : Règle l’émetteur sur le mode 

d’économie d’énergie.

TX-Cam Power Sync Off/On Définit si l’état d’économie d’énergie de 
l’émetteur change également en fonction de 
l’état de l’interrupteur d’alimentation (POWER) 
du caméscope.

Maintenance >Time Code
Configure les réglages relatifs au code temporel.

Elément Réglage Description

TC Out Auto/Generator Sélectionne la sortie du code temporel.
Auto : émet la valeur du générateur de code 

temporel pendant l’enregistrement, et la 
valeur du lecteur de code temporel 
pendant la lecture.

Generator : émet la valeur du générateur de 
code temporel pendant l’enregistrement 
et la lecture.

Maintenance >Time Code
Configure les réglages relatifs au code temporel.

Elément Réglage Description

DF/NDF DF/NDF Sélectionne le mode temps réel (DF) ou le 
mode temps non réel (NDF).

LTC UBIT Fix/Time Règle les données enregistrées dans les bits 
d’utilisateur LTC.
Fix : enregistre les données indiquées par 

l’utilisateur.
Time : enregistre l’heure actuelle.

Counter Display Counter/Duration Sélectionne la méthode utilisée pour 
réinitialiser la valeur du compteur affichée sur 
l’écran du viseur.
Counter : continue à augmenter jusqu’à ce 

que la touche RESET soit enfoncée.
Duration : est réinitialisé à chaque démarrage 

de l’enregistrement.

HDMI TC Out On/Off Règle s’il faut envoyer le code temporel vers 
des dispositifs à d’autres fins à l’aide de la 
sortie HDMI.

Maintenance >Essence Mark
Configure les réglages relatifs aux repères.

Elément Réglage Description

Find Mode Clip/Rec Start Règle l’opération lorsque la touche NEXT/
PREV est enfoncée.
Rec Start : passe à la marque de début 

d’enregistrement suivante ou précédente, 
respectivement.

Clip : passe au début du plan suivant lorsque 
la touche NEXT est enfoncée. Passe au 
début du plan actuel lorsque la touche 
PREV est enfoncée (ou passe au début du 
plan précédent si la touche PREV est 
enfoncée au début du plan).
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Maintenance >Camera Config
Configure les réglages relatifs à différentes opérations du caméscope.

Elément Réglage Description

HD SDI Remote I/F Off/Characters/
Green Tally/Red Tally

Règle l’activation ou non de la fonction du 
commande d’enregistrement pour un 
dispositif externe connecté au connecteur SDI 
OUT 1/2 (sortie HD SDI) du caméscope. Si elle 
est activée, elle sélectionne l’indicateur utilisé 
pour afficher l’état d’enregistrement du 
dispositif externe.
Off : la fonction de commande 

d’enregistrement est désactivée.
Chara : affiché à l’aide de l’indicateur de 

commande de dispositif externe sur 
l’écran d’état du viseur.

G-Tally : affiché à l’aide de l’indicateur TALLY 
(de signalisation vert) dans le viseur.

R-Tally : affiché à l’aide de l’indicateur REC 
(signalisation d’enregistrement rouge) 
dans le viseur.

Color Bars Select ARIB/100%/75%/SMPTE Sélectionne le type de barres de couleur.

User Menu Only On/Off Sélectionne d’afficher le menu User 
uniquement (On) ou d’afficher la liste des 
menus (Off) lorsque le caméscope affiche le 
menu.

User Menu with Lock On/Off Sélectionne de verrouiller ou non l’affichage 
du menu en ne montrant que le menu User.
On : Permet de saisir un numéro de code 

arbitraire pour verrouiller l’affichage du 
menu. (Seul le menu User s’affichera.)

Off : Permet de saisir un numéro de code saisi 
quand « On » a été sélectionné pour 
déverrouiller l’affichage du menu. (En cas 
de déverrouillage, la liste de menus 
normale s’affiche.)

[Remarque]
En cas d’affichage normal du menu, cet élément ne 
s’affiche pas.
Pour les détails sur l’affichage de menu, consultez 
page 97.

RM Common 
Memory

On/Off Sélectionne de partager (On) ou non (Off) les 
réglages entre l’utilisation d’une 
télécommande raccordée et les moments où 
le caméscope est actionné localement.

Maintenance >Camera Config
Configure les réglages relatifs à différentes opérations du caméscope.

Elément Réglage Description

RM Rec Start RM/Camera/PARA Sélectionne laquelle des touches de 
démarrage/d’arrêt d’enregistrement sont 
activées lorsqu’une télécommande est 
raccordée.
RM : télécommande
Camera : caméscope
PARA : les deux

Detail Control(RM/
RCP)

HD/QFHD Règle le format du signal pour un contrôle 
détaillé par RM/RCP au format 
d’enregistrement QFHD sur HD ou QFHD.

SET Key on 
Thumbnail

Pause/Play Sélectionne l’opération lorsque le bouton 
MENU est enfoncé et qu’une seule miniature 
est sélectionnée.

ALAC Auto/Off Règle si exécuter automatiquement ou non 
ALAC (correction automatique d’aberrations 
d’objectif).
Auto : exécute automatiquement ALAC 

lorsqu’un objectif compatible ALAC est 
fixé et ALAC est activé.

Off : pas d’exécution.

[Remarque]
En fonction de l’objectif de correction d’aberration, 
la fonction de correction d’aberration risque de ne 
pas être activée immédiatement (« ALAC » n’apparaît 
pas sur l’écran du viseur) lors de la mise sous 
tension, même lorsque ce réglage est réglé sur Auto. 
Si cela se produit, tournez complètement la bague 
de l’objectif zoom et la bague de mise au point puis 
effectuez cette opération en sens inverse, et vérifiez 
que l’indicateur « ALAC » apparaît sur l’écran du 
viseur.

Contactez un revendeur Sony pour obtenir plus 
d’informations sur les objectifs de correction 
d’aberration.

SD HDMI On/Off Active/désactive la fonction de conversion du 
signal de sortie HDMI vers le format SD.
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Maintenance >Camera Config
Configure les réglages relatifs à différentes opérations du caméscope.

Elément Réglage Description

HD Modulation High/Normal Définit la résolution vidéo du signal de sortie 
HD converti à la baisse à partir du signal 
QFHD.
High : caractéristique de haute résolution qui 

utilise le suréchantillonnage QFHD pour 
mettre en évidence les détails.

Normal : caractéristique relativement proche 
des caméras HD existantes (telles que la 
PDW-750).

Maintenance >Preset White
Configure les réglages relatifs aux valeurs prédéfinies de l’équilibre des blancs.

Elément Réglage Description

Color Temp <P> 1500K à 3200K à 50000K Règle la valeur prédéfinie de l’équilibre des 
blancs.

Color Temp Balance 
<P>

–99 à ±0 à +99 Définit des réglages de température de 
couleur plus précis, à utiliser lorsqu’il n’est 
pas possible d’obtenir une image satisfaisante 
à l’aide du réglage Color Temp <P>.

R Gain <P> –99 à ±0 à +99 Règle la valeur prédéfinie de gain R.

B Gain <P> –99 à ±0 à +99 Règle la valeur prédéfinie de gain B.

AWB Enable <P> On/Off Active/désactive l’exécution de la fonction 
AWB (équilibre des blancs automatique) 
lorsque le commutateur WHITE BAL est réglé 
sur PRST.

Maintenance >White Filter
Configure les réglages relatifs aux filtres.

Elément Réglage Description

ND Filter C.Temp On/Off Active/désactive la fonction permettant 
d’attribuer des filtres CC électriques aux filtres 
ND.

ND FLT C.Temp<1> 3200K/4300K/5600K/6300K Sélectionne la température de couleur lorsque 
des filtres CC électriques sont attribués aux 
filtres ND (filtre 1).

ND FLT C.Temp<2-4> 3200K/4300K/5600K/6300K Sélectionne la température de couleur lorsque 
des filtres CC électriques sont attribués aux 
filtres ND (filtres 2 à 4).

Maintenance >White Filter
Configure les réglages relatifs aux filtres.

Elément Réglage Description

Electrical CC<A> 3200K/4300K/5600K/6300K Sélectionne la température de couleur lorsque 
la fonction de basculement des filtres CC 
électriques est attribuée à un commutateur 
personnalisable.

Electrical CC<B> 3200K/4300K/5600K/6300K Sélectionne la température de couleur lorsque 
la fonction de basculement des filtres CC 
électriques est attribuée à un commutateur 
personnalisable.

Electrical CC<C> 3200K/4300K/5600K/6300K/ 
---

Sélectionne la température de couleur lorsque 
la fonction de basculement des filtres CC 
électriques est attribuée à un commutateur 
personnalisable. Sélectionnez « ---- » si vous 
n’utilisez pas C.

Electrical CC<D> 3200K/4300K/5600K/6300K/ 
---

Sélectionne la température de couleur lorsque 
la fonction de basculement des filtres CC 
électriques est attribuée à un commutateur 
personnalisable. Sélectionnez « ---- » si vous 
n’utilisez pas D.

Maintenance >DCC Adjust
Configure les réglages relatifs à la fonction DCC (commande de contraste dynamique).

Elément Réglage Description

DCC Function Select DCC/Fix Sélectionne la méthode de réglage pour le 
point de courbe lorsque le commutateur 
OUTPUT/DCC est réglé sur CAM avec DCC 
réglé sur ON.
DCC : ajuste automatiquement le point de la 

courbe en s’adaptant à la luminosité du 
sujet.

Fix : règle le point de la courbe sur une valeur 
fixe.

DCC D Range 400%/450%/500%/550%/600% Règle la plage dynamique lorsque le 
commutateur OUTPUT/DCC est réglé sur CAM 
avec DCC réglé sur ON.

DCC Point –99 à ±0 à +99 Règle le point de courbe minimum de la 
fonction DCC.

DCC Gain –99 à ±0 à +99 Règle le gain relatif à la valeur DCC détectée.

DCC Delay Time –99 à ±0 à +99 Règle la vitesse de commande DCC (vitesse 
de réponse aux modifications dans la vidéo).

DCC Peak Filter –99 à ±0 à +99 Ajuste la sensibilité de réponse relative aux 
crêtes dans les valeurs DCC détectées.
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Maintenance >Flicker Reduce
Configure les réglages relatifs à la fonction de correction du scintillement.
Vous pouvez corriger le scintillement créé lors de la prise de vue d’un sujet avec une lumière dont 
la luminosité varie régulièrement, par exemple l’éclairage fluorescent, en raison de la relation 
entre la fréquence et la fréquence d’images d’enregistrement.

Elément Réglage Description

Mode Auto/On/Off Règle le fonctionnement de la fonction de 
correction du scintillement.
On : fonctionnement en continu.
Auto : fonctionne quand un scintillement est 

détecté.
Off : ne fonctionne pas.

Frequency 60Hz/50Hz Se synchronise avec la fréquence de 
l’alimentation de l’éclairage causant le 
scintillement.
Le réglage d’usine est 60Hz lorsque System 
Frequency est réglé sur 59.94, 29.97, ou 23.98.
Le réglage d’usine est 50Hz lorsque System 
Frequency est réglé sur 50 ou 25.

Maintenance >Genlock
Configure les réglages relatifs au verrouillage de la synchronisation.

Elément Réglage Description

Genlock On/Off Active/désactive la fonction de verrouillage 
de la synchronisation.

Reference Internal/External(HD)/
External(SD)/SDI IN/CA

Affiche le type de signal de référence utilisé 
par le caméscope.

Maintenance >Auto Shading
Exécute la correction d’ombrage noir automatique.

Elément Réglage Description

Auto Black Shading Execute/Cancel Exécute la correction d’ombrage noir 
automatique (exécutez en sélectionnant 
Execute).

Reset Black Shading Execute/Cancel Efface la valeur de correction d’ombrage noir 
(exécutez en sélectionnant Execute).

Master Gain (TMP) –3dB/0dB/3dB/6dB/9dB/12dB/ 
18dB/24dB/30dB/36dB/42dB

Règle une valeur de gain maître temporaire. 
(La valeur est identique à celle sélectionnée 
par le commutateur GAIN.)

Maintenance >APR
Configure les réglages relatifs à la réduction automatique du bruit de pixel.

Elément Réglage Description

APR Execute/Cancel Exécute la fonction de réduction automatique 
de bruit de pixel pour supprimer les 
mouchetures blanches en mode SLS 
(exécutez en sélectionnant Execute).

Reset Execute/Cancel Supprime les données des mouchetures 
blanches qui ont été ajoutées par l’exécution 
de la commande APR et les fonctions 
d’ajustement automatique de l’équilibre des 
noirs (exécutez en sélectionnant Execute).

Maintenance >Setup for Mobile App
Configure les réglages de connexion à l’aide de l’outil d’aide à la configuration du réseau.

Élément Réglage Description

Setup Démarre la configuration des réglages de 
connexion à l’aide de l’outil d’aide à la 
configuration du réseau.

Maintenance >Access Authentication
Définit les réglages liés à l’authentification d’accès.

Élément Réglage Description

User Name (Affiche le nom d’utilisateur 
actuel.)

Règle le nom d’utilisateur (nom arbitraire 
pour l’authentification d’accès). Réglé sur 
« admin » par défaut.

Password ******* Règle le mot de passe pour l’authentification 
d’accès.
Les mots de passe valides doivent contenir 8 
caractères ou plus, au moins un caractère 
alphanumérique et au moins un caractère 
numérique.
Le mot de passe saisi est affiché sous forme 
d’astérisques. Les caractères saisis sont 
visibles lorsque vous appuyez sur la touche 
SHIFT.

[Remarque]
Le réglage du mot de passe est réinitialisé lors 
de la mise à jour du micrologiciel de l’appareil 
d’une version inférieure à 2.0 à une version 2.0 ou 
supérieure, ou d’une version inférieure à 3.1 à une 
version 3.1 ou supérieure. Dans ce cas, réglez de 
nouveau le mot de passe.

Generate Password Execute/Cancel Génère automatiquement un mot de passe 
pour l’authentification d’accès.
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Maintenance >Access Authentication
Définit les réglages liés à l’authentification d’accès.

Élément Réglage Description

Show Settings Affiche le nom d’utilisateur et le mot de passe 
à utiliser pour l’authentification d’accès.

Maintenance >Network
Configure les réglages relatifs aux connexions réseau.

Elément Réglage Description

Setting On/Off Active/désactive la fonction réseau.

Wi-Fi Mode Wi-Fi Access Point/ 
Wi-Fi Station/Off

Règle le mode de fonctionnement pour les 
connexions LAN sans fil.

NFC Execute/Cancel Lance la connexion une touche à l’aide de la 
NFC (exécuté en sélectionnant Execute).

WPS Execute/Cancel Démarre le WPS (Configuration protégée 
Wi-Fi) (exécutez en sélectionnant Execute).

Channel Auto(5GHz)/Auto/CH1/CH2/
CH3/CH4/CH5/CH6/CH7/CH8/
CH9/CH10/CH11

Règle le canal LAN sans fil.

[Remarque]
« Auto(5GHz) » peut ne pas être affiché en fonction 
du module LAN sans fil utilisé.

SSID & Password (Affichage SSID)
(Affichage du mot de passe)

Affiche le SSID et le mot de passe.

SSID (Affichage SSID) Affiche le SSID du point d’accès de la 
destination à laquelle se connecter en mode 
Wi-Fi Station.

Wi-Fi Station Remote On/Off Active/désactive l’opération depuis une 
télécommande Wi-Fi, un menu Web, et 
l’application « Content Browser Mobile » lors 
d’une connexion réseau effectuée à l’aide du 
mode Wi-Fi Station.

Wi-Fi Station Detail 
Settings

Scan Networks (Execute/
Cancel)

Lance la détection automatique des 
destinations réseau pour la connexion 
(exécutez en sélectionnant Exécuter).

SSID (SSID du point d’accès) Saisissez le SSID du point d’accès de la 
destination à laquelle se connecter en mode 
Wi-Fi Station.
Les caractères suivants sont valides.
Alphabétiques (majuscules) : A à Z
Alphabétiques (minuscules) : a à z
Numériques :0 à 9
Symboles : !”#$%&’*+,/:;<=>?[\]^`{|}~

Maintenance >Network
Configure les réglages relatifs aux connexions réseau.

Elément Réglage Description

Wi-Fi Station Detail 
Settings

Password (mot de passe du 
point d’accès)

Saisissez le mot de passe du point d’accès de 
la destination à laquelle se connecter en 
mode Wi-Fi Station.
Le mot de passe saisi est affiché sous forme 
d’astérisques. Les caractères saisis sont 
visibles lorsque vous appuyez sur la touche 
SHIFT.
Les caractères suivants sont valides.
Alphabétiques (majuscules) : A à Z
Alphabétiques (minuscules) : a à z
Numériques :0 à 9
Symboles : !”#$%&’*+,/:;<=>?[\]^`{|}~

DHCP (On/Off) Règle DHCP en mode Wi-Fi Station.
Lorsque cette fonction est réglée sur On, une 
adresse IP est automatiquement attribuée au 
caméscope. Pour saisir manuellement 
l’adresse IP du caméscope, réglez cette 
fonction sur Off.

IP Address (DHCP/On : obtenir 
automatiquement, DHCP/
Off : 192.168.1.50)

Permet de saisir l’adresse IP du caméscope.
Activé uniquement lorsque DHCP est sur Off.

Subnet Mask (DHCP/On : 
obtenir automatiquement, 
DHCP/Off : 255.255.255.0)

Permet de saisir le masque de sous-réseau du 
caméscope.
Activé uniquement lorsque DHCP est sur Off.

Gateway (DHCP/On : obtenir 
automatiquement, DHCP/
Off : 0.0.0.0)

Permet de saisir la passerelle pour le point 
d’accès.
Activé uniquement lorsque DHCP est sur Off.

DNS Auto (On/Off) Active/désactive le DNS automatique.
Lorsque le réglage est sur On, l’adresse du 
serveur DNS est obtenue automatiquement.

Primary DNS Server (DNS Auto/
On : obtenir 
automatiquement, DNS Auto/
Off : 0.0.0.0)

Permet de saisir le serveur DNS principal pour 
le routeur.
Activé uniquement lorsque DNS Auto est sur 
Off.

Secondary DNS Server (DNS 
Auto/On : obtenir 
automatiquement, DNS Auto/
Off : 0.0.0.0)

Permet de saisir le serveur DNS secondaire 
pour le routeur.
Activé uniquement lorsque DNS Auto est sur 
Off.

Device Name (Wi-Fi) Affiche le nom du périphérique réseau installé 
sur le connecteur du module USB LAN sans fil
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Maintenance >Network
Configure les réglages relatifs aux connexions réseau.

Elément Réglage Description

IP Address (Wi-Fi) Affiche l’adresse IP lors de la connexion à un 
LAN sans fil.

Subnet Mask (Wi-Fi) Affiche le masque de sous-réseau lors de la 
connexion à un LAN sans fil.

MAC Address (Wi-Fi) Affiche l’adresse MAC du module USB LAN 
sans fil installé sur le caméscope.

Regenerate Password Execute/Cancel Génère un nouveau mot de passe (exécutez 
en sélectionnant Execute).

Modem On/Off Active/désactive la connexion réseau à l’aide 
d’un modem 3G/4G ou d’un raccordement 
modem USB.

Modem Remote On/Off Active/désactive l’interface Web UI, la 
télécommande Wi-Fi et la télécommande 
CBM lorsqu’un modem est connecté.

[Remarque]
Les fonctions sont désactivées quel que soit ce 
réglage lorsqu’un modem 3G/4G est connecté.

Public Key Creation Execute/Cancel Génère une clé publique/privée.

[Remarque]
La clé publique/privée générée sera supprimée 
lorsque Maintenance >Network Reset est exécuté.

Public Key Clear Execute/Cancel Efface une clé publique/privée.

Create Key Date Affiche la date de création de la clé publique/
privée.

Wired LAN Enable/Disable Active/désactive la connexion LAN filaire.

Wired LAN Remote On/Off Active/désactive l’opération depuis une 
télécommande Wi-Fi, un menu Web, et 
l’application « Content Browser Mobile » lors 
d’une connexion réseau effectuée à l’aide 
d’un câble LAN.

Maintenance >Network
Configure les réglages relatifs aux connexions réseau.

Elément Réglage Description

Wired LAN Detail 
Settings

DHCP (On/Off) Permet d’activer/désactiver le DHCP.
Lorsque cette fonction est réglée sur On, une 
adresse IP est automatiquement attribuée au 
caméscope.
Pour saisir manuellement l’adresse IP du 
caméscope, réglez cette fonction sur Off.

IP Address (DHCP/On : obtenir 
automatiquement, DHCP/
Off : 192.168.2.50)

Permet de saisir l’adresse IP du caméscope.
Activé uniquement lorsque DHCP est sur Off.

Subnet Mask (DHCP/On : 
obtenir automatiquement, 
DHCP/Off : 255.255.255.0)

Permet de saisir le masque de sous-réseau du 
caméscope.
Activé uniquement lorsque DHCP est sur Off.

Gateway (DHCP/On : obtenir 
automatiquement, DHCP/
Off : 0.0.0.0)

Permet de saisir la passerelle pour le point 
d’accès.
Activé uniquement lorsque DHCP est sur Off.

DNS Auto (On/Off) Active/désactive le DNS automatique.
Lorsque le réglage est sur On, l’adresse du 
serveur DNS est obtenue automatiquement.

Primary DNS Server (DNS 
Auto/On : obtenir 
automatiquement, DNS Auto/
Off : 0.0.0.0)

Permet de saisir le serveur DNS principal pour 
le routeur.
Activé uniquement lorsque DNS Auto est sur 
Off.

Secondary DNS Server (DNS 
Auto/On : obtenir 
automatiquement, DNS Auto/
Off : 0.0.0.0)

Permet de saisir le serveur DNS secondaire 
pour le routeur.
Activé uniquement lorsque DNS Auto est sur 
Off.

Maintenance >Network Client Mode
Configure les réglages relatifs au mode client réseau pour la connexion à C3 Portal air ou une 
station réseau RX Sony.

[Remarque]
Pour régler le mode client réseau, des valeurs doivent être saisies pour tous les éléments.

Elément Réglage Description

Setting On/Off Active/désactive le mode client réseau.

[Remarque]
Si cette fonction est réglée sur On, la version du 
micrologiciel ne peut pas être mise à jour.

Preset Select Preset 1/Preset 2/Preset 3 Sélectionne les réglages prédéfinis (Preset 1/
Preset 2/Preset 3), dont les réglages de 
connexion en mode client réseau configurés 
au préalable.
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Maintenance >Network Client Mode
Configure les réglages relatifs au mode client réseau pour la connexion à C3 Portal air ou une 
station réseau RX Sony.

[Remarque]
Pour régler le mode client réseau, des valeurs doivent être saisies pour tous les éléments.

Elément Réglage Description

Preset 1 (Affichage du nom de valeur 
prédéfinie)

Saisissez le nom de valeur prédéfinie.

CCM Address Règle l’adresse du CCM pour la connexion.
Nom de l’hôte ou adresse IP

CCM Port (1 à 65535 (8443)) Règle le numéro de port du CCM pour la 
connexion.

User Name Règle le nom d’utilisateur pour 
l’authentification du CCM pour la connexion.

Password Règle le mot de passe du CCM pour la 
connexion.
Le mot de passe saisi est affiché sous forme 
d’astérisques. Les caractères saisis sont 
visibles lorsque vous appuyez sur la touche 
SHIFT.

NCM with Proxy (Enable/
Disable)

Enable : Permet d’activer l’enregistrement 
proxy lors de la connexion avec un CCM.

Disable : Permet de désactiver 
l’enregistrement proxy lors de la 
connexion avec un CCM.

Camera Control (Enable/
Disable)

Active/Désactive les opérations de contrôle 
de la caméra lors d’une connexion avec un 
CCM.

Camera Setting (Always/
Onetime/Off)

Active/Désactive les opérations du fichier ALL 
lors d’une connexion avec un CCM.
Always : active les opérations du fichier ALL 

tout le temps.
Onetime : active les opérations du fichier ALL 

une seule fois.
Off : désactive les opérations du fichier ALL.

Preset 2 Identique à Preset 1 Identique à Preset 1

Preset 3 Identique à Preset 1 Identique à Preset 1

Maintenance >File Transfer
Configure les réglages relatifs aux transferts de fichiers en réseaux.

Elément Réglage Description

File Transfer Execute/Cancel Bascule en mode transfert (exécutez en 
sélectionnant Execute).

Remote File Transfer Enable/Disable Permet de définir l’activation/la désactivation 
du passage en mode de transfert pour 
transférer des fichiers originaux enregistrés 
sur le caméscope par une opération à 
distance sur un réseau.
Enable : activer le passage en mode de 

transfert par une opération à distance sur 
un réseau.  
Il n’est pas nécessaire d’exécuter un 
transfert à l’aide de Maintenance >File 
Transfer.

Disable : désactiver le passage en mode de 
transfert par une opération à distance sur 
un réseau.  
Il est nécessaire d’exécuter un transfert à 
l’aide de Maintenance >File Transfer.

Auto Upload (Proxy) Off/On Active/Désactive le transfert automatique de 
fichiers proxy.

Default Upload 
Server

Sony Ci/NCM RX Server/
Server Settings1/Server 
Settings2/Server Settings3

Sélectionne le serveur de destination pour le 
téléchargement des fichiers originaux et 
fichiers proxy.
Pour les Server Settings1 à 3, les noms des 
serveurs saisis dans Display Name sur la page 
Upload Settings du menu Web sont affichés. 
Pour les détails, consultez « Pour enregistrer 
un serveur de destination » (page 84).

Clear Completed Jobs Execute/Cancel Efface les tâches de transfert terminées de la 
liste des tâches.

Clear All Jobs Execute/Cancel Efface toutes les tâches enregistrées dans la 
liste des tâches.

View Job List Affiche la liste des tâches de transfert.
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Maintenance >Streaming
Configure les réglages relatifs à la lecture en transit.

Elément Réglage Description

Setting On/Off Active/désactive la lecture en transit.

[Remarques]
ˎˎ Ce réglage est réglé sur Off lorsque vous remettez 

le caméscope sous tension.
ˎˎ Lorsque réglée sur On, la fonction de surveillance 

de Content Browser Mobile n’est pas disponible.

Preset Select Preset 1/Preset 2/Preset 3 Sélectionne un préréglage de lecture en 
transit.
Les réglages sont communs pour Preset 1/
Preset 2/Preset 3. Voir ci-après pour la 
description des réglages pour un élément 
prédéfini.

Size HD Auto/ 
1280×720/ 
640×360/ 
480×270/ 
320×180

Règle la taille de vidéo pour la lecture en 
transit.
Lorsque « HD Auto » est sélectionné, la taille 
est réglée sur 1920×1080 ou 1280×720, en 
fonction du réglage du format 
d’enregistrement enregistré sur la carte 
mémoire SxS ou du format du plan à lire.

Bit Rate 9Mbps/ 
6Mbps/ 
3Mbps/ 
2Mbps/ 
1Mbps/ 
0.5Mbps/ 
0.3Mbps(Mono L)/ 
0.3Mbps(Mono R)/ 
0.2Mbps(Mono L)/ 
0.2Mbps(Mono R)

Règle le débit binaire de vidéo pour la lecture 
en transit.
Le débit binaire à sélectionner varie en 
fonction du réglage de Size.

[Remarques]
ˎˎ Les données audio/vidéo sont transmises en 

l’état via Internet. De ce fait, les données peuvent 
éventuellement être exposées à des tiers. Vérifiez 
toujours que la destination de diffusion peut 
recevoir les données de lecture en transit.
ˎˎ Les données peuvent être non intentionnellement 

envoyées au mauvais destinataire si l’adresse 
ou d’autres réglages ne sont pas correctement 
configurés.
ˎˎ Il se peut que certains plans ne soient pas lus, 

selon l’état du réseau.
ˎˎ La qualité de l’image peut être altérée lors de 

scènes comprenant des mouvements excessifs.
ˎˎ Il se peut que tous les plans ne soient pas lus 

lorsque la taille de lecture en transit est grande 
et que le débit binaire est faible. Pour y remédier, 
sélectionnez une taille plus petite pour le réglage 
Size.

Type MPEG-2 TS/UDP/ 
MPEG-2 TS/RTP

Sélectionne le type de vidéo pour la lecture 
en transit.

Maintenance >Streaming
Configure les réglages relatifs à la lecture en transit.

Elément Réglage Description

Destination Address Chaîne de caractères (0.0.0.0) Saisissez l’adresse du serveur de destination 
de la diffusion pour les données de lecture en 
transit.

Destination Port 1 à 65545 (1234) Saisissez le numéro de port du serveur de 
destination de la diffusion utilisé pour la 
lecture en transit.

Audio Channel CH1/CH2/CH3/CH4 Sélectionne le canal audio pour la sortie de 
lecture en transit.

Maintenance >Clock Set
Règle l’horloge interne.

Elément Réglage Description

Date Mode YYMMDD/MMDDYY/
DDMMYY

Sélectionne le format d’affichage pour les 
dates.

12H/24H 12H/24H Sélectionne le format d’affichage de l’horloge.

Date Affiche l’écran de réglage de la date.

Time Affiche l’écran de réglage de l’heure.

Maintenance >Language
Sélectionne la langue d’affichage des messages.

Elément Réglage Description

Select English/  /
Espanol/ Русский 

Sélectionne la langue d’affichage des 
messages.

Maintenance >Hours Meter
Configure les réglages relatifs au compteur horaire numérique.

Elément Réglage Description

Hours (System) xxxxH
(xxxx heures)

Affiche les heures d’utilisation cumulées (ne 
peut pas être réinitialisé).

Hours (Reset) xxxxH
(xxxx heures)

Affiche les heures d’utilisation cumulées (peut 
être réinitialisé).

Reset Execute/Cancel Réinitialise l’affichage Hours (Reset) à 0 
(exécutez en sélectionnant Execute).
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Maintenance >Network Reset
Ramène les réglages relatifs au réseau à leur état par défaut.

Elément Réglage Description

Reset Execute/Cancel Réinitialise les réglages relatifs au réseau 
(exécutez en sélectionnant Execute).

[Remarque]
La clé publique/privée générée à l’aide de 
Maintenance >Network >Public Key Creation sera 
supprimée lorsque cet élément est exécuté.

Maintenance >Fan Control
Définit le mode de commande du ventilateur.

Elément Réglage Description

Setting Auto/Minimum/Off in Rec Sélectionne le mode de commande du 
ventilateur.

Maintenance >VF Display Setting
Configure les réglages relatifs à l’affichage du viseur.

Elément Réglage Description

Chara/Marker 
Brightness

5/4/3/2/1 Règle la luminosité des chaînes de caractères, 
des icônes, et des repères superposés dans 
l’image du viseur.

Maintenance >Version
Affiche la version du caméscope et met à jour le caméscope.

Elément Réglage Description

Number Affiche la version du logiciel du caméscope 
(Vx.xx).

Version Up Execute/Cancel Met à jour la version du logiciel du caméscope 
à l’aide d’une carte dans le logement pour 
carte UTILITY SD (exécutez en sélectionnant 
Execute).
Les cartes SD suivantes sont prises en charge.
ˎˎ Cartes mémoire SDHC (classe de vitesse : 4 ou 

plus, non UHS, capacité : 4 Go à 32 Go)

[Remarque]
Ne peut pas être sélectionné lorsque la carte SD 
de mise à jour de version n’est pas insérée ou 
lorsque Network Client Mode >Setting dans le menu 
Maintenance est sur On.

Maintenance >Version
Affiche la version du caméscope et met à jour le caméscope.

Elément Réglage Description

Net-Func Version 
Number

Affiche la version du micrologiciel de la 
fonction de connexion LAN sans fil du 
caméscope (Vx.xx).

[Remarque]
Ne s’affiche pas lorsque XAVC Proxy Rec Mode 
>Setting dans le menu Operation est réglé sur Off 
et Network >Setting dans le menu Maintenance est 
sur Off.

Net-Func Ver.Up Execute/Cancel Met à jour le logiciel pour la fonction de 
connexion LAN sans fil du caméscope à l’aide 
d’une carte dans le logement pour carte 
PROXY SD (exécutez en sélectionnant 
Execute).
Les cartes SD suivantes sont prises en charge.
ˎˎ Cartes mémoire SDHC (classe de vitesse : 4 ou 

plus, non UHS, capacité : 4 Go à 32 Go)
ˎˎ Cartes mémoire SDXC (classe de vitesse : 4 ou 

plus, non UHS, capacité : 64 Go à 256 Go)

[Remarque]
Ne peut pas être sélectionné lorsque Network Client 
Mode >Setting dans le menu Maintenance est sur 
On.
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Menu File
Les valeurs par défaut sont soulignées et le texte est en gras.

File >User File
Configure les réglages relatifs aux opérations sur les fichiers utilisateur.

Elément Réglage Description

Load SD Card Affiche un écran pour le transfert des réglages 
du fichier utilisateur d’une carte SD.

Save SD Card Affiche un écran pour la sauvegarde des 
réglages du fichier utilisateur sur une carte 
SD.

File ID Affiche un écran pour l’affichage/l’édition du 
fichier ID des fichiers utilisateur.

Recall User Preset Execute/Cancel Renvoie la valeur des éléments de menu 
enregistrés dans le menu User à leurs valeurs 
prédéfinies (exécutez en sélectionnant 
[Execute]).

Store User Preset Execute/Cancel Enregistre la valeur des éléments de menu 
enregistrés dans les éléments de menu User 
en tant que valeurs prédéfinies (exécutez en 
sélectionnant [Execute]).

Clear User Preset Execute/Cancel Renvoie les réglages actuels et les valeurs 
prédéfinies des éléments de menu 
enregistrés dans le menu User à leurs valeurs 
d’usine par défaut (exécutez en sélectionnant 
[Execute]).

Load Customize Data On/Off Définit le chargement ou non des 
informations personnalisées du menu User 
lorsque [Load SD Card] est exécuté.

Load White Data On/Off Définit le chargement ou non des 
informations de balance des blancs lorsque 
[Load SD Card] est exécuté.

File >All File
Configure les réglages relatifs aux opérations sur les fichiers ALL.

Elément Réglage Description

Load SD Card Affiche un écran pour transférer les réglages 
All File d’une carte SD.

Save SD Card Affiche un écran pour la sauvegarde des 
réglages All File sur une carte SD.

File ID Affiche un écran pour l’affichage/l’édition du 
fichier ID de All Files.

All Preset Execute/Cancel Renvoie tous les éléments à leurs valeurs 
prédéfinies (exécutez en sélectionnant 
Execute).

File >All File
Configure les réglages relatifs aux opérations sur les fichiers ALL.

Elément Réglage Description

Store All Preset Execute/Cancel Enregistre les réglages actuels de tous les 
éléments en tant que valeurs prédéfinies 
(exécutez en sélectionnant [Execute]).

Clear All Preset Execute/Cancel Ramène les réglages actuels et les 
préréglages des éléments du menu All File (à 
l’exception de certains) à leurs valeurs d’usine 
par défaut (exécutez en sélectionnant 
Execute).
Pour les détails, consultez « Éléments 
sauvegardés dans les données utilisateur » 
(page 166).

3Sec Clear Preset On/Off Active/désactive la fonction qui efface les 
réglages actuels et les préréglages de chaque 
élément, lorsque le commutateur MENU 
CANCEL/PRST/ESCAPE est actionné vers le 
haut et maintenu pendant trois secondes en 
position CANCEL/PRST.

File >Scene File
Configure les réglages relatifs aux opérations sur les fichiers de scène.

Elément Réglage Description

Recall Internal 
Memory

Affiche un écran pour le rappel des fichiers de 
scène depuis la mémoire interne.

Store Internal 
Memory

Affiche un écran pour le stockage des fichiers 
de scène dans la mémoire interne.

Load SD Card Affiche un écran pour le transfert des fichiers 
de scène depuis une carte SD.

Save SD Card Affiche un écran pour le stockage des fichiers 
de scène sur une carte SD.

File ID Affiche un écran pour l’affichage/l’édition du 
fichier ID des fichiers de scène.

Scene White Data On/Off Règle s’il faut refléter les données d’équilibre 
des blancs des fichiers de scène lors du 
rappel des fichiers de scène.
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File >Reference File
Configure les réglages relatifs aux opérations sur les fichiers de référence.

Elément Réglage Description

Store Reference Execute/Cancel Enregistre les réglages actuels des éléments 
du menu cible des fichiers de référence en 
tant que valeurs prédéfinies (exécutez en 
sélectionnant [Execute]).

Clear Reference Execute/Cancel Ramène les réglages actuels et les valeurs 
prédéfinies des éléments du menu cible des 
fichiers de référence à leurs valeurs d’usine 
par défaut (exécutez en sélectionnant 
[Execute]).

Load Reference(SD 
Card)

Execute/Cancel Charge les réglages de fichier de référence 
depuis une carte SD et règle les valeurs 
prédéfinies (exécutez en sélectionnant 
[Execute]).

Save Reference(SD 
Card)

Execute/Cancel Enregistre les valeurs prédéfinies des 
éléments du menu cible des fichiers de 
référence sur une carte SD (exécutez en 
sélectionnant [Execute]).

File ID Affiche un écran pour l’affichage/l’édition du 
fichier ID des fichiers de référence.

File >Lens File
Configure les réglages relatifs aux opérations sur les fichiers d’objectif.

Elément Réglage Description

Display Mode Model Name/Lens ID Sélectionne les éléments à afficher dans la 
liste déroulante qui apparaît lors de la 
sauvegarde ou du chargement d’un fichier.

Recall Internal 
Memory

Affiche un écran pour le rappel des fichiers 
d’objectif depuis la mémoire interne.

Store Internal 
Memory

Affiche un écran pour le stockage des fichiers 
d’objectif dans la mémoire interne.

Load SD Card Affiche un écran pour le transfert des fichiers 
d’objectif depuis une carte SD.

Save SD Card Affiche un écran pour le stockage des fichiers 
d’objectif sur une carte SD.

File ID Affiche un écran pour l’affichage/l’édition du 
fichier ID des fichiers d’objectif.

File Source Affiche le numéro du fichier sélectionné.

Clear Lens Offset Execute/Cancel Efface le fichier d’objectif (exécutez en 
sélectionnant Execute).

File >Lens File
Configure les réglages relatifs aux opérations sur les fichiers d’objectif.

Elément Réglage Description

Lens Auto Recall Off/On(Lens Name)/ 
On(Serial Number)

Choisit de rappeler automatiquement un 
fichier d’objectif ou non lorsqu’un objectif 
prend en charge une communication en série 
est installé.

Lens Serial Number Affiche le numéro de série de l’objectif installé 
(objectifs prenant en charge la 
communication de numéros de série 
uniquement).

Lens Name Affiche le nom du modèle de l’objectif installé 
(objectifs prenant en charge la 
communication de numéros de série 
uniquement).

Lens Manufacturer Affiche le nom du fabricant de l’objectif 
installé (pour les objectifs prenant en charge 
la communication de numéros de série 
uniquement).

Master V Modulation –99 à ±0 à +99 Règle la valeur de correction d’ombrage en 
dent de scie dans le sens vertical dans le 
fichier d’objectif.

Lens Center H –40 à ±0 à +40 Règle la position horizontale du repère central 
dans le fichier d’objectif.

Lens Center V –40 à ±0 à +40 Règle la position verticale du repère central 
dans le fichier d’objectif.

R Flare –99 à ±0 à +99 Règle le niveau de lumière parasite R dans le 
fichier d’objectif.

G Flare –99 à ±0 à +99 Règle le niveau de lumière parasite V dans le 
fichier d’objectif.

B Flare –99 à ±0 à +99 Règle le niveau de lumière parasite B dans le 
fichier d’objectif.

White Offset R –99 à ±0 à +99 Règle la valeur de correction du canal R de 
décalage d’équilibre des blancs dans le fichier 
d’objectif.

White Offset B –99 à ±0 à +99 Règle la valeur de correction du canal B de 
décalage d’équilibre des blancs dans le fichier 
d’objectif.

Shading Ch Select Red/Green/Blue Sélectionne la cible pour la correction 
d’ombrage blanc.

Shading H SAW –99 à ±0 à +99 Règle la valeur de correction d’ombrage blanc 
en dent de scie dans le sens horizontal dans 
le fichier d’objectif.
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File >Lens File
Configure les réglages relatifs aux opérations sur les fichiers d’objectif.

Elément Réglage Description

Shading H PARA –99 à ±0 à +99 Règle la valeur de correction d’ombrage blanc 
parabolique dans le sens horizontal dans le 
fichier d’objectif.

Shading V SAW –99 à ±0 à +99 Règle la valeur de correction d’ombrage blanc 
en dent de scie dans le sens vertical dans le 
fichier d’objectif.

Shading V PARA –99 à ±0 à +99 Règle la valeur de correction d’ombrage blanc 
parabolique dans le sens vertical dans le 
fichier d’objectif.

File >User Gamma
Configure les réglages relatifs au gamma utilisateur.

Elément Réglage Description

Current Settings Affiche un écran de liste des réglages du 
fichier gamma utilisateur actuel (noms de 
fichier).

Load SD Card Affiche un écran pour le transfert des réglages 
User Gamma d’une carte SD.

Reset 1/2/3/4/5/All Réinitialise les réglages dans le fichier de 
gamma utilisateur sélectionné (exécutez en 
sélectionnant Execute).
Sélectionnez All pour réinitialiser tous les 
fichiers de gamma utilisateur.



7. Affichage et réglages de menu133

Attribution de fonctions aux commutateurs personnalisables
A l’aide de l’élément Assignable Switch du menu Operation, vous pouvez attribuer des fonctions 
indiquées par l’utilisateur aux commutateurs ASSIGN. 0 à 3, aux commutateurs ASSIGNABLE 4 et 
5, à la touche ONLINE et à la touche RET de l’objectif.
Les tableaux suivants énumèrent les fonctions attribuées lorsque le caméscope quitte l’usine.

Commutateur ou touche Fonction Réglage du commutateur 
personnalisable

Commutateur ASSIGN. 0 Pas d’attribution Off

Commutateur ASSIGN. 1 Pas d’attribution Off

Commutateur ASSIGN. 2 Pas d’attribution Off

Commutateur ASSIGN. 3 Pas d’attribution Off

Commutateur 
ASSIGNABLE 4

Pas d’attribution Off

Commutateur 
ASSIGNABLE 5

Pas d’attribution Off

Touche RET Rec Review (si la lecture est permise) Lens RET

Touche ONLINE Transfert automatique de plan proxy Network Client Mode

Fonctions pouvant être attribuées au commutateur ASSIGN. 0

Réglage du 
commutateur 
personnalisable

Fonction Etat lors de la mise sous 
tension suivante du 
caméscope

Off Pas d’attribution –

Marker Active/désactive l’affichage de tous les 
repères.

Réglage conservé

ATW Hold Fige le réglage de l’équilibre des blancs en 
mode ATW (équilibre des blancs à suivi 
automatique)

–

Picture Cache Rec Active/désactive le mode Picture Cache Rec. Réglage conservé

Focus Magnifier Active/désactive la fonction de grossissement 
de la mise au point.

Réglage non conservé

Zebra Active/désactive l’affichage des zébrures. Réglage non conservé

Shot Mark1 Insère un repère Shot Mark1. –

Shot Mark2 Insère un repère Shot Mark2. –

Clip Flag OK Ajoute/efface un repère OK dans le/du plan 
en cours d’enregistrement ou de lecture.

Réglage non conservé

Clip Flag NG Ajoute/efface un repère NG dans le/du plan 
en cours d’enregistrement ou de lecture.

Réglage non conservé

Réglage du 
commutateur 
personnalisable

Fonction Etat lors de la mise sous 
tension suivante du 
caméscope

Clip Flag Keep Ajoute/efface un repère KP (Keep) dans le/du 
plan en cours d’enregistrement ou de lecture.

Réglage non conservé

Fonctions pouvant être attribuées au commutateur ASSIGN. 2

[Remarque]
Immédiatement après avoir attribué une fonction au commutateur ASSIGN. 2 ou basculé le format d’enregistrement, 
le réglage du commutateur à ce point peut ne pas correspondre à l’état interne du caméscope. Après avoir attribué 
une fonction, faites basculer le commutateur ASSIGN. 2 ou mettez le caméscope hors tension puis de nouveau sous 
tension.

Réglage du 
commutateur 
personnalisable

Fonction

Off Pas d’attribution

Front Mic Bascule entre stéréo et monaural lorsqu’un microphone stéréo est 
raccordé.

Marker Active/désactive l’affichage de tous les repères.

Picture Cache Rec 1) Active/désactive le mode Picture Cache Rec.

Zebra Active/désactive l’affichage des zébrures.

Clip Continuous Rec Active/désactive le mode d’enregistrement continu de plan.

Rec Source Basculez les signaux à enregistrer entre l’image de la caméra et l’entrée 
externe. (Si le caméscope est en cours d’enregistrement ou de lecture, le 
basculement prend effet une fois que l’enregistrement ou la lecture est 
terminé.)

TX Power Save Change le mode d’économie d’énergie de l’émetteur sans fil.

1) Lorsque Picture Cache Rec est attribué, Operation >Rec Function est désactivé (grisé) et ne peut pas être défini.
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Fonctions pouvant être attribuées aux commutateurs ASSIGN. 1 et 3, aux 
commutateurs ASSIGNABLE 4 et 5 et à la touche ONLINE

Réglage du 
commutateur 
personnalisable

Fonction Etat lors de la mise sous 
tension suivante du 
caméscope

Off Pas d’attribution –

Front Mic Bascule entre stéréo (On) et monaural (Off) 
lorsqu’un microphone stéréo est raccordé.

Réglage conservé

Marker Active/désactive l’affichage de tous les 
repères.

Réglage conservé

Last Clip Delete Supprime le dernier plan enregistré. –

ATW Active/désactive le mode ATW (équilibre des 
blancs à suivi automatique).

Réglage non conservé

ATW Hold Fige le réglage de l’équilibre des blancs en 
mode ATW.

–

Turbo Gain Exécute Turbo Gain selon le réglage 
Operation >Gain Switch >Gain <Turbo>.

Réglage non conservé

Rec Review Effectue un passage en revue de 
l’enregistrement.

–

Rec Démarre ou arrête l’enregistrement. –

NFC Exécute la fonction NFC. –

Network Client Mode Active/désactive le mode client réseau. Réglage conservé

Streaming Active/désactive la lecture en transit. Réglage non conservé

Auto Upload(Proxy) Active/Désactive le transfert automatique de 
fichiers proxy.

Réglage conservé

Picture Cache Rec Active/désactive le mode Picture Cache Rec. Réglage conservé

Spotlight Active/désactive la fonction spot en mode de 
diaphragme automatique.

Réglage conservé

Backlight Active/désactive la fonction rétroéclairage en 
mode de diaphragme automatique.

Réglage conservé

Video Signal Monitor Bascule la fonction d’affichage du suivi de 
signal vidéo.

Réglage conservé

Lens Info Bascule l’indication de profondeur de champ 
entre la désactivation, l’affichage en mètres et 
l’affichage en pieds.

Réglage conservé

Réglage du 
commutateur 
personnalisable

Fonction Etat lors de la mise sous 
tension suivante du 
caméscope

Zoom Tele/Wide Lorsqu’un objectif prenant en charge la 
communication de numéros de série est 
installé, attribue la fonction Zoom Tele à 
ASSIGNABLE 4 et la fonction Zoom Wide à 
ASSIGNABLE 5 (s’affiche uniquement lorsque 
<4> et <5> sont réglés).

[Remarque]
Ne modifiez pas l’attribution durant l’enregistrement 
proxy indépendant.

–

Zoom Wide/Tele Lorsqu’un objectif prenant en charge la 
communication de numéros de série est 
installé, attribue la fonction Zoom Wide à 
ASSIGNABLE 4 et la fonction Zoom Tele à 
ASSIGNABLE 5 (s’affiche uniquement lorsque 
<4> et <5> sont réglés).

[Remarque]
Ne modifiez pas l’attribution durant l’enregistrement 
proxy indépendant.

–

Manual Focus Assist Active ou désactive la fonction d’aide à la 
mise au point manuelle.

Réglage conservé

Focus Magnifier Active/désactive la fonction de grossissement 
de la mise au point.

Réglage non conservé

Zebra Active/désactive l’affichage des zébrures. Réglage non conservé

Lens RET Rec Review (si la lecture est permise) –

Shot Mark1 Insère un repère Shot Mark1. –

Shot Mark2 Insère un repère Shot Mark2. –

Clip Flag OK Ajoute/efface un repère OK dans le/du plan 
en cours d’enregistrement ou de lecture.

Réglage non conservé

Clip Flag NG Ajoute/efface un repère NG dans le/du plan 
en cours d’enregistrement ou de lecture.

Réglage non conservé

Clip Flag Keep Ajoute/efface un repère KP (Keep) dans le/du 
plan en cours d’enregistrement ou de lecture.

Réglage non conservé

Color Temp SW 3200K Ajuste la balance des blancs en utilisant une 
valeur prédéfinie de 3200K.

Réglage conservé

Color Temp SW 4300K Ajuste la balance des blancs en utilisant une 
valeur prédéfinie de 4300K.

Réglage conservé

Color Temp SW 5600K Ajuste la balance des blancs en utilisant une 
valeur prédéfinie de 5600K.

Réglage conservé

Color Temp SW 6300K Ajuste la balance des blancs en utilisant une 
valeur prédéfinie de 6300K.

Réglage conservé
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Réglage du 
commutateur 
personnalisable

Fonction Etat lors de la mise sous 
tension suivante du 
caméscope

Electrical CC Fonction qui bascule les filtres CC électriques 
(3200K/4300K/5600K/6300K) appliqués aux 
valeurs d’ajustement de l’équilibre des blancs.
Séquence obtenue à chaque pression du 
commutateur/de la touche :
3200K  4300K  5600K  6300K
Peut être modifiée en utilisant les réglages de 
menu (Electrical CC <A> <B> <C> <D>).

[Remarque]
Cette fonction n’est pas disponible lorsque 
Maintenance >White Filter >ND Filter C.Temp dans le 
menu de configuration est réglé sur On.
Si vous réglez ND Filter C.Temp sur On après avoir 
attribué la fonction, le commutateur personnalisable 
cesse de fonctionner.

Réglage conservé

CC5600K Applique un filtre CC électrique de 5600K aux 
valeurs d’ajustement de l’équilibre des blancs.

Réglage conservé

Clip Continuous Rec Active/désactive le mode d’enregistrement 
continu de plan.

Réglage non conservé

Slow & Quick Motion Active/désactive le mode ralenti et accéléré. Réglage conservé

Slot Select Lorsque le support d’enregistrement est 
chargé dans les deux logements A et B, 
sélectionne la carte que vous souhaitez 
utiliser.

–

TX Power Save Change le mode d’économie d’énergie de 
l’émetteur sans fil.

Réglage non conservé

XAVC Proxy Rec Mode Active/désactive la fonction d’enregistrement 
des données de proxy.

Réglage conservé

XAVC Proxy Rec Start Démarre/arrête l’enregistrement proxy. Réglage non conservé

Gamma Display Assist Règle l’affichage du moniteur LCD et du viseur 
au contraste approprié pour HLG lorsque HLG 
est configuré, ou pour S-Log3 lorsque S-Log3 
est configuré.

[Remarque]
Pas disponible en mode SDR ou pendant la lecture.

Réglage non conservé

HD (Sub) P/B Mode Active/désactive le mode de lecture de 
sous-plan.

Réglage conservé

Fonctions pouvant être attribuées à la touche RET sur l’objectif

Réglage du 
commutateur 
personnalisable

Fonction Etat lors de la mise sous 
tension suivante du 
caméscope

Off Pas d’attribution –

Lens RET Rec Review (si la lecture est permise) –

Rec Review Effectue un passage en revue de 
l’enregistrement.

–

Shot Mark1 Insère un repère Shot Mark1. –

Shot Mark2 Insère un repère Shot Mark2. –

Clip Flag OK Ajoute/efface un repère OK dans le/du plan 
en cours d’enregistrement ou de lecture.

Réglage non conservé

Clip Flag NG Ajoute/efface un repère NG dans le/du plan 
en cours d’enregistrement ou de lecture.

Réglage non conservé

Clip Flag Keep Ajoute/efface un repère KP (Keep) dans le/du 
plan en cours d’enregistrement ou de lecture.

Réglage non conservé

Focus Magnifier Active/désactive la fonction de grossissement 
de la mise au point.

Réglage non conservé

XAVC Proxy Rec Start Démarre/arrête l’enregistrement proxy. Réglage non conservé

Gamma Display Assist Règle l’affichage du moniteur LCD et du viseur 
au contraste approprié pour HLG lorsque HLG 
est configuré, ou pour S-Log3 lorsque S-Log3 
est configuré.

[Remarque]
Pas disponible en mode SDR ou pendant la lecture.

Réglage non conservé
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Données de configuration utilisateur
8. Sauvegarde et chargement des données de configuration utilisateur

Vous pouvez sauvegarder les réglages du 
menu de configuration dans la mémoire 
interne du caméscope et sur des cartes SD. 
Cela vous permet de rappeler rapidement un 
ensemble de réglages de menu approprié à la 
situation actuelle.
Pour sauvegarder les données de 
configuration sur une carte SD, insérez une 
carte SD inscriptible (page 33) dans le 
logement pour carte UTILITY SD avant de 
lancer la procédure.
Pour les détails sur les réglages sauvegardés 
dans chaque fichier, consultez « Éléments 
sauvegardés dans les données utilisateur » 
(page 166).

Insertion d’une carte SD (pour la 
sauvegarde de données de 
configuration)

1 Ouvrez le cache du commutateur.

2 Insérez la carte SD (pour l’enregistrement 
des données de configuration) dans le 
logement de carte UTILITY SD.

3 Refermez le cache du commutateur.

Ejection d’une carte SD (pour la 
sauvegarde de données de 
configuration)

1 Ouvrez le cache du commutateur.

2 Enfoncez la carte SD légèrement, puis 
enlevez la carte.

[Remarques]
ˎˎ Si le caméscope est arrêté ou la carte SD enlevée 

pendant que le système accède à la carte SD, 
l’intégrité des données sur la carte ne peut pas être 
garantie. Toutes les données enregistrées sur la carte 
peuvent être supprimées. Assurez-vous toujours 

que l’indicateur ACCESS est éteint avant d’arrêter le 
caméscope ou d’enlever la carte SD.
ˎˎ Prenez des précautions pour éviter que la carte SD ne 

soit expulsée lors de l’insertion/éjection de la carte.

Les données d’utilisateur suivantes sont prises 
en charge.

Fichiers utilisateur

Les fichiers utilisateur enregistrent les 
éléments de réglage et les données du 
menu User personnalisable. Vous pouvez 
sauvegarder jusqu’à 64 fichiers sur une carte 
SD. En chargeant ce fichier dans la mémoire 
du caméscope, vous pouvez personnaliser la 
configuration du menu User.

Fichiers ALL

Les fichiers ALL sauvegardent les données de 
configuration de tous les menus. Vous pouvez 
sauvegarder jusqu’à 64 fichiers sur une carte 
SD.

[Remarque]
Les données spécifiques à un dispositif (ombrage, 
niveaux de sortie et autres données nécessitant un 
ajustement pour le dispositif spécifique) ne sont pas 
sauvegardées.

Fichiers de scène

Les fichiers de scène sauvegardent les 
ajustements des éléments du menu Paint 
pour la prise de vue d’une scène particulière. 
Vous pouvez sauvegarder jusqu’à cinq fichiers 
dans la mémoire interne du caméscope et 
jusqu’à 64 fichiers sur une carte SD.
Les fichiers de scène vous permettent de 
sauvegarder les types de données suivants.
ˎˎ Valeurs réglées dans le menu Paint
ˎˎ Vitesses d’obturation réglées en mode 
standard ou ECS
ˎˎ Données d’équilibre des blancs 
Les données sauvegardées et chargées 
dépendent du réglage File >Scene File 
>Scene White Data dans le menu de 
configuration.

Les fichiers de scène peuvent être stockés sur 
la mémoire interne du caméscope ou sur une 
carte SD.
Les fichiers de scène peuvent également être 
chargés dans le caméscope.

Fichiers référence

Les fichiers référence enregistrent les 
réglages standard de fichier de scène (lorsque 
l’identifiant de fichier est Standard). Vous 
pouvez enregistrer un fichier dans la mémoire 
interne du caméscope et un fichier sur une 
carte SD.

Fichiers d’objectif

Vous pouvez configurer les données suivantes 
pour corriger les caractéristiques d’objectif 
et vous pouvez sauvegarder les données 
sous forme de fichier d’objectif. Vous pouvez 
sauvegarder jusqu’à 32 fichiers d’objectif dans 
la mémoire interne du caméscope et jusqu’à 
64 fichiers d’objectif sur une carte SD.

Données de configuration Sous-éléments

Valeurs de correction 
d’ombrage de 
modulation V

M V Modulation

Position du repère central Lens Center H
Lens Center V

Niveau de lumière 
parasite

R Flare
G Flare
B Flare

Valeur de correction de 
l’équilibre des blancs

White Offset R
White Offset B

Valeur de correction 
d’ombrage blanc

Shading Ch Select
Shading H SAW
Shading H PARA
Shading V SAW
Shading V PARA

Fichiers Gamma

Vous pouvez sauvegarder jusqu’à cinq fichiers 
de données de tableaux Gamma définis par 
l’utilisateur (fichier de données User Gamma) 
dans la mémoire interne.
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Fichiers utilisateur

Sauvegarde d’un fichier utilisateur

1 Sélectionnez File >User File >Save SD Card 
dans le menu de configuration.
Un écran pour la sélection de la 
destination de sauvegarde du fichier 
utilisateur apparaît.

2 Tournez le bouton MENU pour 
sélectionner une destination, puis 
appuyez sur le bouton.
Vous pouvez sauvegarder des fichiers sur 
plusieurs rangées avec un File ID défini 
sur « No File ». Si vous sélectionnez une 
rangée affichant un nom File ID, le fichier 
sélectionné sera écrasé.
Le File ID est généré automatiquement, 
mais vous pouvez le modifier.

3 Tournez le bouton MENU pour 
sélectionner [Execute] sur l’écran du 
message de confirmation, puis appuyez 
sur le bouton.

Changement du File ID

1 Sélectionnez File >User File >File ID dans 
le menu de configuration.
Un écran pour modifier le File ID apparaît.

2 Sélectionnez les caractères et saisissez le 
File ID.

3 Tournez le bouton MENU pour 
sélectionner [Done], puis appuyez sur le 
bouton.
Le File ID est mis à jour.

Chargement d’un fichier 
utilisateur

1 Sélectionnez File >User File >Load SD Card 
dans le menu de configuration.
Un écran de liste de fichiers utilisateur 
s’affiche.

2 Tournez le bouton MENU pour 
sélectionner un fichier à charger, puis 
appuyez sur le bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

[Remarque]
Le caméscope redémarrera automatiquement après 
avoir chargé les données de configuration.
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Fichiers ALL

Sauvegarde de données de 
configuration en tant que fichier 
ALL

1 Sélectionnez File >All File >Save SD Card 
dans le menu de configuration.
Un écran pour la sélection de la 
destination de sauvegarde du fichier ALL 
apparaît.

2 Tournez le bouton MENU pour 
sélectionner une destination, puis 
appuyez sur le bouton.
Vous pouvez sauvegarder des fichiers sur 
plusieurs rangées avec un File ID défini 
sur « No File ». Si vous sélectionnez une 
rangée affichant un nom File ID, le fichier 
sélectionné sera écrasé.
Le File ID est généré automatiquement, 
mais vous pouvez le modifier.

3 Tournez le bouton MENU pour 
sélectionner [Execute] sur l’écran du 
message de confirmation, puis appuyez 
sur le bouton.

[Remarque]
Les valeurs actuelles et les valeurs prédéfinies sont 
stockées dans un fichier ALL.

Si un message d’erreur apparaît

L’un des messages d’erreur suivants peut 
apparaître pendant l’exécution de la 
sauvegarde, ou quand vous sélectionnez 
[Execute]. Dans ce cas, le fichier n’est pas 
sauvegardé.

Message 
d’erreur

Problème Solution

File Access 
NG

Aucun support 
enregistrable 
n’est inséré.

Insérez un 
support 
enregistrable.

Changement du File ID

1 Sélectionnez File >All File >File ID dans le 
menu de configuration.
Un écran pour modifier le File ID apparaît.

2 Sélectionnez les caractères et saisissez le 
File ID.

3 Tournez le bouton MENU pour 
sélectionner [Done], puis appuyez sur le 
bouton.
Le File ID est mis à jour.

Chargement de données de 
configuration

1 Sélectionnez File >All File >Load SD Card 
dans le menu de configuration.
Un écran avec la liste des fichiers ALL 
apparaît.

2 Tournez le bouton MENU pour 
sélectionner un fichier à charger, puis 
appuyez sur le bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

[Remarques]
ˎˎ Lorsque vous chargez un fichier depuis une carte 

SD, les valeurs actuelles et les valeurs prédéfinies 
sauvegardées dans la mémoire interne du caméscope 
sont écrasées.
ˎˎ Ne rappelez pas un fichier sur un dispositif plus 

ancien que le dispositif sur lequel le fichier 
a été enregistré. Cela pourrait provoquer un 
dysfonctionnement.
ˎˎ Le caméscope redémarrera automatiquement après 

avoir chargé les données de configuration.

Si un message d’erreur apparaît

L’un des messages d’erreur suivants 
peut apparaître pendant l’exécution du 
chargement, ou quand vous sélectionnez 
[Execute]. Dans ce cas, le fichier n’est pas 
chargé.

Message 
d’erreur

Problème Solution

File Access 
NG

Il n’y a pas de 
support lisible
Le fichier 
déterminé 
n’existe pas sur 
le support

Insérez le 
support qui 
contient le 
fichier souhaité.

Restauration de tous les réglages 
actuels sur les valeurs prédéfinies

Dans ce document, les réglages du menu de 
configuration initial configurés/sauvegardés 
par l’utilisateur sont appelés « valeurs 
prédéfinies ».
Même après avoir chargé les fichiers pour 
configurer le caméscope, et après avoir écrasé 
les fichiers originaux avec les nouveaux 

réglages, vous pouvez réinitialiser les 
contenus des fichiers en récupérant les valeurs 
prédéfinies.

1 Sélectionnez File >All File >All Preset dans 
le menu de configuration.
Une boîte de dialogue de confirmation 
apparaît.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

Sauvegarde de tous les réglages 
actuels en tant que valeurs 
prédéfinies

1 Sélectionnez File >All File >Store All Preset 
dans le menu de configuration.
Une boîte de dialogue de confirmation 
apparaît.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

[Remarque]
Le caméscope redémarrera automatiquement après 

l’exécution.
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Réinitialisation des réglages 
actuels et des valeurs prédéfinies 
sur les réglages d’usine par défaut

1 Sélectionnez File >All File >Clear All Preset 
dans le menu de configuration.
Une boîte de dialogue de confirmation 
apparaît.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

[Remarque]
Le caméscope redémarrera automatiquement après 
l’exécution.
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Fichiers de scène

Sauvegarde d’un fichier de scène 
dans la mémoire interne

1 Sélectionnez File >Scene File >Store 
Internal Memory dans le menu de 
configuration.
Un écran avec la liste des fichiers de scène 
apparaît.
Si File ID est réglé sur la destination 
« Standard », les réglages préconfigurés 
standard sont sauvegardés.

2 Tournez le bouton MENU pour 
sélectionner une destination, puis 
appuyez sur le bouton.
Le fichier de scène est sauvegardé, et 
écrase tout fichier existant, dans le fichier 
de destination sélectionné.

3 Tournez le bouton MENU pour 
sélectionner [Execute] sur l’écran du 
message de confirmation, puis appuyez 
sur le bouton.

Sauvegarde d’un fichier de scène 
sur une carte SD

1 Sélectionnez File >Scene File >Save SD 
Card dans le menu de configuration.
Un écran de destination de sauvegarde de 
fichiers de scène apparaît.

2 Tournez le bouton MENU pour 
sélectionner une destination, puis 
appuyez sur le bouton.
Vous pouvez sauvegarder des fichiers sur 
plusieurs rangées avec un File ID défini 

sur « No File ». Si vous sélectionnez une 
rangée affichant un nom File ID, le fichier 
sélectionné sera écrasé.
Le File ID est généré automatiquement, 
mais vous pouvez le modifier.

3 Tournez le bouton MENU pour 
sélectionner [Execute] sur l’écran du 
message de confirmation, puis appuyez 
sur le bouton.

Changement du File ID

1 Sélectionnez File >Scene File >File ID dans 
le menu de configuration.
Un écran pour modifier le File ID apparaît.

2 Sélectionnez les caractères et saisissez le 
File ID.

3 Tournez le bouton MENU pour 
sélectionner [Done], puis appuyez sur le 
bouton.
Le File ID est mis à jour.

Chargement d’un fichier de scène 
depuis la mémoire interne

1 Sélectionnez File >Scene File >Recall 
Internal Memory dans le menu de 
configuration.
Un écran avec la liste des fichiers de scène 
apparaît.

2 Tournez le bouton MENU pour 
sélectionner un fichier à charger, puis 
appuyez sur le bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

Charger un fichier de scène depuis 
une carte SD

1 Sélectionnez File >Scene File >Load SD 
Card dans le menu de configuration.
Un écran avec la liste des fichiers de scène 
apparaît.

2 Tournez le bouton MENU pour 
sélectionner un fichier à charger, puis 
appuyez sur le bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
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Fichiers référence

Sauvegarde des réglages actuels 
en tant que valeurs prédéfinies

1 Sélectionnez File >Reference File >Store 
Reference dans le menu de configuration.
Une boîte de dialogue de confirmation 
apparaît.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

Sauvegarde des réglages actuels 
en tant que valeurs prédéfinies 
sur une carte SD

1 Sélectionnez File >Reference File >Save 
Reference(SD Card) dans le menu de 
configuration.
Une boîte de dialogue de confirmation 
apparaît.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

Changement du File ID

1 Sélectionnez File >Reference File >File ID 
dans le menu de configuration.
Un écran pour modifier le File ID apparaît.

2 Sélectionnez les caractères et saisissez le 
File ID.

3 Tournez le bouton MENU pour 
sélectionner [Done], puis appuyez sur le 
bouton.
Le File ID est mis à jour.

Chargement d’un fichier de 
référence depuis une carte SD

1 Sélectionnez File >Reference File >Load 
Reference(SD Card) dans le menu de 
configuration.
Une boîte de dialogue de confirmation 
apparaît.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

Réinitialisation des réglages 
actuels et des valeurs prédéfinies 
sur les réglages d’usine par défaut

1 Sélectionnez File >Reference File >Clear 
Reference dans le menu de configuration.
Une boîte de dialogue de confirmation 
apparaît.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
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Fichiers d’objectif

Sauvegarde d’un fichier d’objectif 
dans la mémoire interne

1 Sélectionnez File >Lens File >Store Internal 
Memory dans le menu de configuration.
Un écran avec la liste des fichiers 
d’objectif apparaît.

2 Tournez le bouton MENU pour 
sélectionner une destination, puis 
appuyez sur le bouton.
Vous pouvez enregistrer des fichiers sur 
plusieurs rangées avec un File ID défini 
sur « No offset ». Si vous sélectionnez une 
rangée affichant un nom File ID, le fichier 
sélectionné sera écrasé.
Le File ID est généré automatiquement, 
mais vous pouvez le modifier.

3 Tournez le bouton MENU pour 
sélectionner [Execute] sur l’écran du 
message de confirmation, puis appuyez 
sur le bouton.

Sauvegarde d’un fichier d’objectif 
sur une carte SD

1 Sélectionnez File >Lens File >Save SD Card 
dans le menu de configuration.
Un écran de destination de sauvegarde de 
fichiers d’objectif apparaît.

2 Tournez le bouton MENU pour 
sélectionner une destination, puis 
appuyez sur le bouton.
Vous pouvez sauvegarder des fichiers sur 
plusieurs rangées avec un File ID défini 

sur « No File ». Si vous sélectionnez une 
rangée affichant un nom File ID, le fichier 
sélectionné sera écrasé.
Le File ID est généré automatiquement, 
mais vous pouvez le modifier.

3 Tournez le bouton MENU pour 
sélectionner [Execute] sur l’écran du 
message de confirmation, puis appuyez 
sur le bouton.

Changement du File ID

1 Sélectionnez File >Lens File >File ID dans 
le menu de configuration.
Un écran pour modifier le File ID apparaît.

2 Sélectionnez les caractères et saisissez le 
File ID.

3 Tournez le bouton MENU pour 
sélectionner [Done], puis appuyez sur le 
bouton.
Le File ID est mis à jour.

Chargement d’un fichier d’objectif 
depuis la mémoire interne

1 Sélectionnez File >Lens File >Recall 
Internal Memory dans le menu de 
configuration.
Un écran avec la liste des fichiers 
d’objectif apparaît.

2 Tournez le bouton MENU pour 
sélectionner un fichier à charger, puis 
appuyez sur le bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

Chargement d’un fichier d’objectif 
depuis une carte SD

1 Sélectionnez File >Lens File >Load SD Card 
dans le menu de configuration.
Un écran avec la liste des fichiers 
d’objectif apparaît.

2 Tournez le bouton MENU pour 
sélectionner un fichier à charger, puis 
appuyez sur le bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

Chargement automatique d’un 
fichier d’objectif

Lorsque vous utilisez un objectif prenant en 
charge la communication de numéros de 
série, vous pouvez configurer le caméscope 
en chargeant automatiquement le fichier 
d’objectif correspondant aux réglages de 

l’objectif (fonction Lens Auto Recall).
Pour utiliser la fonction Lens Auto Recall, 
réglez File >Lens File >Lens Auto Recall dans le 
menu de configuration sur l’un des éléments 
suivants.
Off : n’utilise pas la fonction Lens Auto Recall.
On (Lens Name) : charge le fichier d’objectif 

correspondant au nom de modèle 
d’objectif.

On (Serial Number) : charge le fichier 
d’objectif correspondant au nom de 
modèle et au numéro de série de l’objectif 
(lorsque l’objectif prend en charge la 
communication du numéro de série).

Si l’objectif ne prend pas en charge la 
communication du numéro de série, même 
avec le réglage On (Serial Number) activé, 
chargez le fichier d’objectif correspondant au 
nom de modèle d’objectif.
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Fichiers Gamma

Vérification des réglages de 
fichiers Gamma actuels (Noms de 
fichier)

Sélectionnez File >User Gamma >Current 
Settings dans le menu de configuration 
pour afficher une liste des fichiers Gamma 
d’utilisateur actuellement configurés.

Chargement d’un fichier User 
Gamma depuis une carte SD

1 Sélectionnez File >User Gamma >Load SD 
Card dans le menu de configuration.
Un écran avec la liste des fichiers User 
Gamma apparaît.

2 Tournez le bouton MENU pour 
sélectionner un fichier à charger, puis 
appuyez sur le bouton.
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.

Utilisation de fichiers User Gamma 
créés à l’aide de CvpFileEditorTM 
V4.3

Sauvegardez les fichiers Gamma d’utilisateur 
à charger dans le répertoire « PRIVATE/SONY/
PRO/CAMERA/HD_CAM » de la carte SD.

Réinitialisation d’un fichier User 
Gamma à son état initial

1 Sélectionnez File >User Gamma >Reset 
dans le menu de configuration.
Un écran de réinitialisation du nombre de 
fichiers Gamma apparaît.

2 Tournez le bouton MENU pour 
sélectionner le nombre de fichiers Gamma 
à réinitialiser (1 à 5).
Pour réinitialiser tous les fichiers Gamma, 
sélectionnez [All].
Une boîte de dialogue de confirmation 
apparaît.

3 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
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Raccordement d’une télécommande
Lorsqu’une télécommande RM-B170, un 
panneau de télécommande RCP-1001/1501 ou 
un autre appareil de commande est raccordé, 
certaines fonctions du caméscope peuvent 
être contrôlées depuis ces appareils.

Raccordement d’une 
télécommande

A l’aide d’un câble de télécommande, 
raccordez le connecteur REMOTE (8 broches) 
du caméscope et le connecteur de caméra de 
la télécommande.
Lorsque vous mettez sous tension le 
caméscope après le raccordement, le 
caméscope entre en mode commande à 
distance, activant ainsi les opérations du menu 
et les opérations de prise de vue.

[Remarques]
ˎˎ L’utilisation de la télécommande n’est pas prise en 

charge si la connexion USB au caméscope est activée.
ˎˎ Si une connexion USB au caméscope est activée 

pendant la commande à distance, le mode de 
commande à distance est libéré.
ˎˎ Ne connectez et ne déconnectez pas la 

télécommande lorsque le caméscope est sous 
tension.
ˎˎ Aucun câble de télécommande n’est fourni avec le 

panneau de télécommande RCP-1001/1501.
ˎˎ Si Detail est réglé à l’aide de RM-B170, seul Detail HD 

change.
ˎˎ Effectuez des ajustements de Detail QFHD à l’aide de 

Detail(QFHD) dans le menu Paint.

Les commutateurs suivants du caméscope 
sont désactivés lorsqu’une télécommande est 
connectée.
ˎˎ Commutateur GAIN
ˎˎ Commutateur WHITE BAL
ˎˎ Commutateur AUTO W/B BAL
ˎˎ Commutateur SHUTTER
ˎˎ Commutateur OUTPUT/DCC
ˎˎ Commutateur ASSIGN. 1/3, Commutateurs 

ASSIGNABLE 4/5 et touche ONLINE à 
laquelle la fonction Turbo Gain ou ATW est 
attribuée

Libération du mode de commande 
à distance

Mettez le caméscope hors tension et 
déconnectez la télécommande.
Les réglages du commutateur sur le 
caméscope sont activés.

Ajustements de la qualité d’image 
lorsque la télécommande RM-
B170 est raccordée

Lorsque la télécommande RM-B170 est 
raccordée, les paramètres pour les éléments 
d’ajustement de la qualité d’image de la 
caméra (données paint) sont réglés sur les 
paramètres qui étaient indiqués la dernière 
fois que la RM-B170 était connectée.

Fonction des touches de 
démarrage/d’arrêt 
d’enregistrement lorsque la RM-
B170 est raccordée

Réglez la fonction des touches à l’aide de 
Maintenance >Camera Config >RM Rec Start 
dans le menu de configuration.

Les fonctions des touches pour les réglages 
de RM Rec Start sont indiquées ci-dessous.

Touche Réglage RM Rec Start

RM Camera PARA

Touche REC 
START du 
caméscope

Désactivé Activé Activé

Touche VTR de 
l’objectif

Désactivé Activé Activé

Commutateur 
ASSIGN. 1/3, 
commutateurs 
ASSIGNABLE 4/5 
et touche 
ONLINE à 
laquelle la 
fonction de 
démarrage/
d’arrêt de 
l’enregistrement 
est attribuée

Désactivé Activé Activé

Touche MEDIA 
START de la 
RM-B170

Activé Désactivé Activé

Structure de données des 
données d’ajustement de la 
qualité d’image

La mémoire non-volatile du caméscope utilisé 
pour le stockage des données d’ajustement de 
qualité d’image de la caméra (données paint) 
se compose de deux zones tel qu’indiqué ci-
dessous : un « bloc données principales » qui 
est utilisé lorsque la télécommande n’est pas 
raccordée et un « bloc données de commande 
à distance » qui est utilisé lorsqu’une 
télécommande est raccordée. Les données 
d’ajustement paint sont automatiquement 

sélectionnées et émises à la section de 
caméra selon qu’une télécommande, comme 
la RM-B170, est raccordée ou non.

Menu de configuration du caméscope

Bloc données 
principales

Bloc données de 
commande à distance

Matériel de caméra

RM-B170 raccordée

RM-B170 non raccordée

RM-B170

Mémoire non-volatile du caméscope

Lorsqu’une télécommande est raccordée, le 
« bloc données de commande à distance » 
est sélectionné comme le bloc données paint 
actuel, et les paramètres d’ajustement paint 
qui étaient en vigueur la dernière fois que la 
télécommande était utilisée sont chargés.
Cependant, lorsque les réglages de 
commandes de valeur absolue 1) et les 
commutateurs de valeur absolue 2) sont 
réglés sur la télécommande, les réglages de 
la télécommande écrasent les réglages du 
caméscope.
Lorsque la télécommande est déconnectée 
du caméscope, le « bloc données principales » 
est réactivé et le caméscope revient aux 
réglages qui étaient en vigueur avant que la 
télécommande soit connectée.
1) Commandes de valeur absolue : les données 

correspondant à la position angulaire de la 
commande sont émises. On appelle commandes de 
valeur relative les commandes pour lesquelles les 
données correspondant à la quantité de rotation sont 
émises.
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2) Commutateurs de valeur absolue : on appelle 
commutateurs de valeur absolue les commutateurs 
(ou boutons), comme les commutateurs de 
basculement ou les commutateurs à glissement 
(à l’exception de la plupart des commutateurs 
temporaires), dont les positions coïncident avec leurs 
fonctions.

Lorsque Maintenance >Camera Config >RM 
Common Memory est réglé sur [On] dans le 
menu de configuration, vous pouvez utiliser 
les réglages des données d’ajustement 
paint stockées dans le bloc données 
principales même si vous connectez la 
télécommande. Dans ce cas, les réglages 
stockés dans le bloc données principales 
seront mis à jour lorsque vous modifiez les 
réglages sur la télécommande. Ainsi, les 
réglages des données paint effectués avec la 
télécommande seront retenus même après 
le retrait de la télécommande. Cependant, 
si la position du commutateur sur la 
télécommande diffère de celle du caméscope, 
la position du commutateur sur le caméscope 
prévaut.
De même, il est possible de conserver les 
réglages qui sont en vigueur avant que vous 
ne connectiez la télécommande. Dans ce cas, 
vous devez régler les boutons de commande 
en mode valeur relative sur la télécommande.

Pour plus de détails, reportez-vous au manuel d’utilisation 
fourni avec la télécommande.

Utilisation du menu depuis la 
RM-B170

1 Appuyez sur la touche CHARACTER de la 
RM-B170 pour l’allumer, puis appuyez sur 
la touche MENU.
Le menu s’affiche sur le moniteur raccordé 
au connecteur MONITOR de la RM-B170.

2 Sélectionnez et réglez les éléments du 
menu à l’aide du bouton de réglage et de 
la touche CANCEL/ENTER.

3 Une fois terminé, réglez la touche MENU 
sur OFF pour quitter le menu.

Pour de plus amples informations concernant le 
fonctionnement de la RM-B170, reportez-vous au mode 
d’emploi de la RM-B170.
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Fonctions majeures prises en charge par la RCP-1001/1501 et la RM-B170

Légende du tableau
La prise en charge du signal est indiquée par ce qui suit. 
Oui : disponible
– : non disponible

Élément Sous-option Réglages Fonction RCP-1001 RCP-1501 RM-B170

Panel Active Panel Active On/Off Active/désactive les opérations du panneau. Oui Oui Oui

Bars Bars On/Off Active/désactive l’émission de barres de couleur. Oui Oui Oui

Call Call On/Off Appelle le caméscope depuis la RCP/RM. Oui Oui Oui 1)

Standard Standard On/Off Active/désactive le mode standard. Oui Oui Oui 1)

ND Filter ND Filter 1/2/3/4 Affiche le filtre ND sélectionné. Oui Oui Oui

CC Filter CC Filter A/B/C/D Affiche le filtre CC sélectionné. – – –

Gain Step Gain –3/0/3/6/9/12/18/24/30/36/42dB Réglage du gain maître Oui Oui Oui

White Balance AWB Start/Stop Démarre la balance des blancs automatique.
Pendant l’exécution, cela arrête la balance des blancs 
automatique.

Oui Oui Oui

White Memory A/B/PRESET Change la mémoire prédéfinie de la balance des blancs. Oui Oui Oui

ATW On/Off Active/Désactive l’ATW. Oui 1) Oui Oui 1)

5600K On/Off Active/désactive la conversion de température de couleur 
électrique.

Oui Oui Oui 1)

Black ABB Start/Stop Démarre l’ajustement automatique de la balance des noirs.
Pendant l’exécution, cela arrête la balance des noirs.

Oui Oui Oui

Knee Point 75% à 90% à 109% Règle le point de courbe. – Oui Oui 1)

Detail Level –99 à ±0 à +99 Règle le niveau de détail QFHD ou HD. Oui 3) Oui 3) Oui 3)

Shutter Shutter Setting On/Off Active/désactive l’obturateur. – Oui Oui

Shutter Speed – Règle la vitesse d’obturation. – Oui Oui

ECS Setting On/Off Active/désactive le mode ECS. – Oui Oui

ECS Frequency – Règle la fréquence de mode ECS. – Oui Oui

SLS Setting On/Off Active/désactive le mode SLS. – Oui Oui

SLS Speed – Règle la vitesse de mode SLS (nombre d’images) – Oui Oui

Iris Iris Mode Auto/Manual Règle le mode de diaphragme. Oui Oui Oui

Iris Level –99 à ±0 à +99 Ajuste le niveau cible du diaphragme automatique. Oui Oui Oui

Close On/Off Active/désactive la fermeture du contrôle de diaphragme. Oui Oui –
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Élément Sous-option Réglages Fonction RCP-1001 RCP-1501 RM-B170

Switch Status Gamma On/Off Active/désactive la fonction de correction gamma. – Oui Oui 1)

Black Gamma On/Off Active/désactive la fonction de correction gamma du noir. Oui 1) Oui Oui 1)

Matrix On/Off Active/désactive la fonction de matrice. – Oui Oui 2)

Knee On/Off Active/désactive la fonction de correction de courbe. – Oui Oui 1)

White Clip On/Off Active/désactive la fonction d’ajustement d’écrêtage du 
blanc.

– Oui Oui 2)

Detail(QFHD) On/Off Active/désactive la fonction d’ajustement de détail QFHD. – Oui Oui

Detail(HD) On/Off Active/désactive la fonction d’ajustement de détail HD. – Oui Oui

Flare On/Off Active/désactive la fonction de correction de lumière 
parasite.

– Oui Oui 1)

Test Saw On/Off Active/désactive le signal test. – Oui Oui 1)

White R Gain –99 à ±0 à +99 Règle la valeur de gain R de la balance des blancs. Oui Oui Oui

B Gain –99 à ±0 à +99 Règle la valeur de gain B de la balance des blancs. Oui Oui Oui

Black Master Black –99 à ±0 à +99 Règle le niveau de noir maître. Oui Oui Oui

R Black –99 à ±0 à +99 Règle le niveau de noir du canal R. Oui Oui Oui

B Black –99 à ±0 à +99 Règle le niveau de noir du canal B. Oui Oui Oui

Camcorder Menu Menu On/Off Affiche le menu du caméscope. – – Oui

Cancel/Preset Cancel/Preset – – Oui

Select/Set Select(Up/Down)/Set – – Oui

Media Rec Start/Stop Démarre/arrête l’enregistrement. – – Oui

Play Play/Pause Démarre la lecture. – – Oui

FREV – Lecture rapide en arrière – – Oui

FFWD – Lecture rapide en avant – – Oui

STOP – Arrête la lecture. – – Oui

Rec Review – Démarre un passage en revue de l’enregistrement. – – Oui

PREV – Passe au début du plan actuel. – – Oui

NEXT – Passe au début du plan suivant. – – Oui

Shot Mark Shot Mark1 – Règle la prise de vue 1. – – Oui

Shot Mark2 – Règle la prise de vue 2. – – Oui 1)

ZOOM – – Opération de zoom (avec un objectif compatible) – – Oui 1)

FOCUS – – Opération de mise au point (avec un objectif compatible) – – Oui 1)

1) L’opération est prise en charge lorsque la fonction est attribuée à un commutateur attribuable sur la RCP/RM.
2) L’opération du menu du caméscope est prise en charge depuis la RM.
3) Vous pouvez contrôler les détails QFHD ou HD, selon le réglage Maintenance >Camera Config >Detail Control(RM/RCP) dans le menu de configuration.
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Raccordement d’un moniteur externe
Sélectionnez le signal de sortie et utilisez un câble approprié pour le moniteur à raccorder.

Câble BNC (non fourni)

Câble HDMI haute vitesse (non 
fourni)

Que le signal soit un signal 4K ou HD, les 
mêmes menus et informations d’état que ceux 
affichés sur l’écran du viseur peuvent être 
affichés sur le moniteur externe.

Connecteur SDI OUT (de type BNC)

Le connecteur SDI OUT peut être utilisé pour 
raccorder un dispositif prenant en charge 
le SDI. Le type de dispositif peut être un 
moniteur, un aiguilleur, un magnétoscope ou 
autre dispositif d’enregistrement.
Le signal émis par ce connecteur peut être 
activé et désactivé avec Operation >Input/
Output >SDI Out1 Output/SDI Out2 Output 
dans le menu de configuration (page 103).

Pour le raccordement, utilisez un câble BNC 
(non fourni).

Connecteur HDMI OUT (connecteur 
de type A)

Vous pouvez activer/désactiver le signal de 
sortie du caméscope à l’aide de Operation 
>Input/Output >HDMI Output dans le menu 
de configuration.
Le format de signal de sortie est réglé à l’aide 
de Operation >Input/Output >Output Format 
dans le menu de configuration.
Pour la connexion, utilisez un câble HDMI 
haute vitesse disponible dans le commerce.
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Gestion/montage des plans avec un ordinateur
Les plans enregistrés sur des cartes mémoire 
SxS avec ce caméscope peuvent être 
commandés sur un ordinateur ou montés à 
l’aide du logiciel de montage non linéaire en 
option.
Vous pouvez copier des plans de cartes 
mémoire SxS sur un périphérique de 
stockage portable ou un autre support USB 
si le périphérique de stockage portable/le 
support USB est raccordé au connecteur de 
raccordement de dispositif externe.

[Remarque]
La copie n’est pas prise en charge lorsque le système de 
fichiers est réglé sur UDF.

Connexion USB à un ordinateur

Quand vous connectez le caméscope à un 
ordinateur en utilisant un câble USB (non 
fourni), la carte mémoire dans le logement 
est reconnue comme lecteur étendu par 
l’ordinateur.
Lorsque deux cartes mémoire sont insérées 
dans le caméscope, elles sont reconnues par 
l’ordinateur comme deux lecteurs étendus.

Câble USB  
(non fourni)

[Remarques]
ˎˎ Allumez le caméscope et attendez que l’image et 

les informations soient affichées sur l’écran, puis 
raccordez le câble USB au caméscope.
ˎˎ Lors du raccordement du câble USB à l’ordinateur, 

prenez soin de vérifier la forme et le sens du 
connecteur USB.
ˎˎ Le caméscope ne fonctionne pas sur l’alimentation du 

bus de l’ordinateur.

Pour démarrer la connexion USB

Lorsque vous raccordez un ordinateur au 
connecteur PC à l’aide d’un câble USB (non 
fourni), le message « Connect USB Now? » 
s’affiche vous demandant de confirmer que 
vous souhaitez activer la connexion USB.
Si vous sélectionnez « Cancel » ou poussez 
le commutateur MENU CANCEL/PRST/
ESCAPE vers la position ESCAPE, ou encore 
si vous débranchez le câble USB, le message 
« Connect USB Now? » disparaît.
Si vous sélectionnez « Execute » et appuyez 
sur le bouton MENU, la connexion USB est 
activée et le caméscope est reconnu comme 
un lecteur étendu.
Si la connexion USB est activée pendant 
une opération d’enregistrement/de lecture, 
l’opération est interrompue et le message 
« USB Connecting » apparaît sur l’écran du 
viseur.
A ce moment-là, le signal de sortie des 
connecteurs SDI OUT 1/2 passe à un signal 
noir.

[Remarques]
ˎˎ Le caméscope ne peut pas être utilisé pour 

l’enregistrement, la lecture, etc. tant que le message 
« USB Connecting » est affiché.
ˎˎ Lorsque l’ordinateur accède au support chargé 

dans le caméscope, n’essayez pas d’effectuer les 
opérations suivantes.

 ‒ Utiliser le caméscope (le mettre sous/hors tension, 
basculer le mode de fonctionnement, etc.)

 ‒ Retirer ou charger un support d’un logement actif 
(en cours d’accès depuis l’ordinateur)

 ‒ Retirer ou raccorder le câble USB

Désactiver la connexion USB

Pour désactiver la connexion USB, suivez la 
même procédure que lorsque vous retirez un 
périphérique de l’ordinateur.
Pour réactiver la connexion USB, débranchez 
d’abord le câble USB puis raccordez-le de 
nouveau. Le message « Connect USB Now? » 
réapparaît.

Pour retirer une carte mémoire SxS

Sur Windows

1 Cliquez sur l’icône « Retirer le 
périphérique en toute sécurité » dans la 
barre des tâches de l’ordinateur.

2 Sélectionnez « Retirer la carte mémoire 
SxS - Lecteur(X:) en toute sécurité » dans 
le menu affiché.

3 Vérifiez que le message « Le matériel peut 
être retiré en toute sécurité » apparaît puis 
retirez la carte.

Sur Macintosh
Glissez l’icône de la carte mémoire SxS dans la 
Corbeille sur le bureau.
Si l’icône de la carte mémoire SxS s’affiche 
dans le Finder, cliquez sur l’icône d’éjection.

Pour utiliser le logiciel d’application

Pour copier les plans vers le disque local 
de votre ordinateur, le logiciel d’application 
dédié doit être téléchargé et installé sur 
votre ordinateur. Pour plus de détails sur 
le téléchargement du logiciel, consultez 
« Téléchargements de logiciels » (page 184).
Bien que les données concernant les plans 
enregistrés soient mémorisées sur des fichiers 
et dossiers multiples, vous pouvez facilement 

gérer les plans sans vous préoccuper des 
données et de l’arborescence des répertoires 
en utilisant le logiciel dédié.

[Remarque]
Si vous effectuez des opérations sur les plans, par 
exemple si vous les copiez sur la carte mémoire SxS 
en utilisant l’Explorateur (Windows) ou le Finder 
(Macintosh), il est possible que les données secondaires 
contenues dans les plans ne soient pas conservées.

Pour utiliser un système de montage 
non linéaire

Dans un système de montage non linéaire, 
un logiciel de montage (en option) qui prend 
en charge les formats enregistrés par le 
caméscope est nécessaire.
Stockez les plans à monter sur le disque dur 
de votre ordinateur à l’avance, à l’aide du 
logiciel d’application fourni.
Il est possible que certains logiciels de 
montage ne fonctionnent pas correctement. 
Veuillez vous assurer avant l’utilisation 
que le logiciel est conforme aux formats 
d’enregistrement utilisés avec ce caméscope.

Raccordement d’un périphérique 
de stockage portable/d’un 
support USB

Lorsqu’un périphérique de stockage 
portable, un disque dur externe USB ou un 
support similaire est raccordé au connecteur 
de raccordement de dispositif externe, 
vous pouvez copier des plans du support 
d’enregistrement inséré dans un logement 
pour carte SxS du caméscope vers un support 
USB.
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1 Spécifiez le dossier de destination pour la 
copie des plans dans Operation >USB 
>Select Folder du menu de configuration.
Vous pouvez également sélectionner 
[New] sur l’écran pour créer un nouveau 
dossier.

[Remarque]
Si aucun dossier n’est spécifié, un dossier est 
automatiquement créé, avec pour non la date de 
création du premier plan à copier, et les plans sont 
copiés dans ce dossier.

2 Sélectionnez Operation >USB >Copy to 
USB dans le menu de configuration.

3 Sélectionnez le logement dans lequel le 
support d’enregistrement cible est inséré.
Media(A) to USB : copier tous les plans à 

partir du support d’enregistrement 
inséré dans le logement A.

Media(B) to USB : copier tous les plans à 
partir du support d’enregistrement 
inséré dans le logement B.

Media(A)(B) to USB : copier tous les plans 
à partir du support d’enregistrement 
inséré dans le logement A et le 
logement B.

[Remarque]
Lorsqu’un dossier de destination de copie est 
spécifié à l’étape 1 et que Media(A)(B) to USB est 
sélectionné, les plans du logement A sont copiés 
dans le dossier de destination spécifié. Les plans 
du logement B sont copiés dans un dossier qui est 
automatiquement créé, avec pour non la date de 
création du premier plan.

4 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
Tous les plans se trouvant sur le support 
d’enregistrement cible sont copiés sur le 
support USB.

[Remarque]
Si un plan portant le même non de fichier que 
le plan à copier existe déjà dans le dossier de 
destination, le plan n’est pas copié.

Affichage d’une liste des plans présents 
sur un périphérique de stockage 
portable/un support USB

Vous pouvez afficher une liste des plans 
présents sur un périphérique de stockage 
portable/un support USB à l’aide de Operation 
>USB >View Clip List dans le menu de 
configuration.

Renommage d’un dossier sur un 
périphérique de stockage portable/un 
support USB

Vous pouvez renommer un dossier à l’aide de 
Operation >USB >Rename Folder dans le menu 
de configuration.

1 Sélectionnez Operation >USB >Rename 
Folder dans le menu de configuration.

2 Sélectionnez le dossier à renommer et 
appuyez sur la touche SET.
Un écran de saisie du non de fichier 
apparaît.

3 Saisissez un non de dossier et 
sélectionnez [Done] sur l’écran.
Le dossier est renommé.

Vérification de la présence d’erreurs de 
lecture de copie

Vous pouvez vérifier la présence d’erreurs de 
lecture après l’écriture de plans en réglant 
Operation >USB >Error Check dans le menu de 
configuration sur On.

Formatage d’un périphérique de 
stockage portable/d’un support USB

Vous pouvez formater un périphérique de 
stockage portable/un support USB au format 
exFAT à l’aide de Operation >USB >Format USB 
dans le menu de configuration.

1 Sélectionnez Operation >USB >Format USB 
dans le menu de configuration.

2 Tournez le bouton MENU pour 
sélectionner [Execute], puis appuyez sur le 
bouton.
L’initialisation (le formatage) commence.

3 Lorsque le formatage est terminé, un 
message s’affiche à l’écran. Sélectionnez 
[OK].

Vérification de l’espace libre sur un 
périphérique de stockage portable/un 
support USB

L’espace libre sur un périphérique de stockage 
portable/un support USB est affiché dans la 
ligne Media Remain de l’écran qui apparaît 
lorsque Operation >USB est sélectionné dans 
le menu de configuration.

À propos de l’alimentation fournie à un 
périphérique de stockage portable/un 
support USB

L’alimentation est automatiquement fournie 
à un périphérique de stockage portable/
un support USB via le connecteur de 
dispositif externe lorsqu’une opération est 
effectuée dans Operation >USB du menu de 
configuration.  
Cependant, l’alimentation ne démarre 
pas dans les conditions suivantes, même 
lorsqu’une opération est effectuée dans 

Operation >USB du menu de configuration. 
Pour démarrer l’alimentation, appliquez la 
solution indiquée dans le tableau.

État Solution

Pendant l’enregistrement 
de plans, la lecture, 
l’affichage des miniatures, 
l’enregistrement proxy, la 
lecture en transit, le 
transfert proxy ou le mode 
de transfert en direct

Terminez 
l’opération 
précédente.

Network Client Mode est 
réglé sur On

Réglez Network 
Client Mode sur 
Off.

L’adaptateur de caméra est 
raccordé a)

Démontez la 
connexion de 
l’adaptateur de 
caméra.

a) La connexion d’un adaptateur de caméra est prise en 
charge sur le modèle japonais uniquement.

[Remarques]
ˎˎ Les plans présents sur un périphérique de stockage 

portable ou un autre support USB ne peuvent pas être 
copiés sur un support d’enregistrement inséré dans 
un logement pour carte SxS.
ˎˎ Les plans ne peuvent pas être enregistrés lorsque 

l’alimentation est fournie au connecteur de dispositif 
externe. Pour démarrer l’enregistrement de plans, 
terminez l’opération Operation >USB du menu de 
configuration.
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Configuration d’un système de prise de vue et d’enregistrement
Vous pouvez monter un adaptateur de caméra HD CA-FB70/TX70 HD a) sur le caméscope et 
raccorder une unité de contrôle de caméra (CCU).
Cela vous permet de configurer un système de prise de vue et d’enregistrement constitué de 
plusieurs caméscopes avec des unités d’extension de caméra raccordés à une télécommande.
a) La connexion d’un adaptateur de caméra est prise en charge sur le modèle japonais uniquement.

Pour plus d’informations sur le CA-FB70 et la CA-TX70, reportez-vous à leurs modes d’emploi respectifs.

[Remarques]
ˎˎ Lors de l’utilisation de ce caméscope avec ce système, ne raccordez pas de lampe vidéo au caméscope.
ˎˎ Pris en charge uniquement pour l’enregistrement en XAVC et MPEG HD.
ˎˎ Non pris en charge pour la fonction d’enregistrement proxy et de connexion LAN sans fil.
ˎˎ Non pris en charge par le caméscope dans l’affichage vidéo de retour.

Indicateurs de signalisation et d’appel

Les indicateurs de signalisation et d’appel d’un système sont les suivants.

Données reçues depuis le système Indicateurs LED HDVF Affichage de texte sur l’écran du 
viseur

Signalisation Signalisation 
en vert

Appel CA Appel 
non CA

REC/
TALLY 
LED

GREEN 
TALLY 
LED

  CALL

OFF OFF OFF OFF Eteint Eteint Pas 
d’affichage

Pas 
d’affichage

Pas 
d’affichage

OFF OFF OFF ON Allumé Eteint  Pas 
d’affichage

CALL

OFF OFF ON OFF Eteint Eteint Pas 
d’affichage

Pas 
d’affichage

CALL

OFF OFF ON ON Allumé Eteint  Pas 
d’affichage

CALL

OFF ON OFF OFF Eteint Allumé Pas 
d’affichage

 Pas 
d’affichage

OFF ON OFF ON Allumé Allumé   CALL

OFF ON ON OFF Eteint Allumé Pas 
d’affichage

 CALL

OFF ON ON ON Allumé Allumé   CALL

ON OFF OFF OFF Allumé Eteint  Pas 
d’affichage

Pas 
d’affichage

ON OFF OFF ON Eteint Eteint Pas 
d’affichage

Pas 
d’affichage

CALL

ON OFF ON OFF Allumé Eteint  Pas 
d’affichage

CALL

ON OFF ON ON Eteint Eteint Pas 
d’affichage

Pas 
d’affichage

CALL

ON ON OFF OFF Allumé Allumé   Pas 
d’affichage

ON ON OFF ON Eteint Allumé Pas 
d’affichage

 CALL

ON ON ON OFF Allumé Allumé   CALL

ON ON ON ON Eteint Allumé Pas 
d’affichage

 CALL

[Remarque]
Les indications d’alarme utilisant l’indicateur de signalisation dans l’affichage d’avertissement ne sont pas affichées 
lorsqu’un adaptateur de caméra CA-FB70/TX70 est connecté.
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Formats pris en charge et limitations des systèmes de prise de vue/
enregistrement

Les formats pris en charge par un système de prise de vue/enregistrement composé d’un 
caméscope, d’un adaptateur de caméra a) et d’une unité de contrôle de caméra sont indiqués 
dans le tableau suivant.
a) La connexion d’un adaptateur de caméra est prise en charge sur le modèle japonais uniquement.

Menu Operation Format de système d’un  
adaptateur de caméra /  
d’une unité de contrôle 
de caméra

Limitation du 
caméscope

Format Input/Output Affichage 
vidéo de 
retour

Frequency Rec Format Output Format

SDI

59.94 XAVC-I 3840×2160P 1920×1080i 1920×1080 59.94i Non

XAVC-L 200 2160P

XAVC-L 3840×2160P

XAVC-I 1920×1080P

XAVC-L 50 1920×1080P

XAVC-L 35 1080P

XAVC-I 1920×1080i 1920×1080i 1920×1080 59.94i Non

XAVC-L 50 1920×1080i

XAVC-L 35 1080i

XAVC-L 25 1080i

HD422 50 1080i

HQ 1920×1080i

HQ 1440×1080i

SP 1440×1080i 

HD 422 50 720P 1280×720P 1280×720 59.94P Non

HQ 1280×720P

29.97 XAVC-I 3840×2160P 1920×1080PsF 1920×1080 29.97PsF a)

1920×1080 59.94i
Non

XAVC-L 3840×2160P

XAVC-I 1920×1080P

XAVC-L 50 1920×1080P

XAVC-L 35 1080P

HD422 50 1080P

HQ 1920×1080P

HD422 50 720P 1280×720P 1280×720 59.94P Non

Menu Operation Format de système d’un  
adaptateur de caméra /  
d’une unité de contrôle 
de caméra

Limitation du 
caméscope

Format Input/Output Affichage 
vidéo de 
retour

Frequency Rec Format Output Format

SDI

23.98 XAVC-I 3840×2160P 1920×1080i  
(2-3PD)

1920×1080 59.94i Non

XAVC-L 3840×2160P

XAVC-I 1920×1080P

XAVC-L 50 1920×1080P

XAVC-L 35 1080P

HD422 50 1080P

HQ 1920×1080P

HD422 50 720P 1280×720P  
(2-3PD)

1280×720 59.94P Non

50 XAVC-I 3840×2160P 1920×1080i 1920×1080 50i Non

XAVC-L 200 2160P

XAVC-L 3840×2160P

XAVC-I 1920×1080P

XAVC-L 50 1920×1080P

XAVC-L 35 1080P

XAVC-I 1920×1080i 1920×1080i 1920×1080 50i Non

XAVC-L 50 1920×1080i

XAVC-L 35 1080i

XAVC-L 25 1080i

HD422 50 1080i

HQ 1920×1080i

HQ 1440×1080i

SP 1440×1080i 

HD 422 50 720P 1280×720P 1280×720 50P Non

HQ 1280×720P
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Menu Operation Format de système d’un  
adaptateur de caméra /  
d’une unité de contrôle 
de caméra

Limitation du 
caméscope

Format Input/Output Affichage 
vidéo de 
retour

Frequency Rec Format Output Format

SDI

25 XAVC-I 3840×2160P 1920×1080PsF 1920×1080 25PsF a)

1920×1080 50i
Non

XAVC-L 3840×2160P

XAVC-I 1920×1080P

XAVC-L 50 1920×1080P

XAVC-L 35 1080P

HD422 50 1080P

HQ 1920×1080P

HD422 50 720P 1280×720P 1280×720 50P Non

a) Un réglage PsF est recommandé lorsqu’un adaptateur de caméra CA-TX70 est connecté. La connexion d’un 
adaptateur de caméra est prise en charge sur le modèle japonais uniquement.

[Remarque]
Dans un système de prise de vue/enregistrement, les modes d’enregistrement spécial, tels que la fonction de 
connexion LAN sans fil ou la fonction de ralenti et d’accéléré, ne peuvent pas être utilisés simultanément.
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Enregistrement de signaux d’entrée externe
Vous pouvez enregistrer un signal SDI depuis des appareils connectés au connecteur SDI IN du 
caméscope.

Vous pouvez émettre et enregistrer des signaux d’entrée au lieu de l’image de caméra ; réglez 
Operation >Input/Output >Source Select dans le menu de configuration sur [External].

[Remarques]
ˎˎ Les signaux d’entrée externes ne peuvent pas être enregistrés en mode ralenti et accéléré. Lorsqu’un mode 

d’enregistrement spécial, comme le mode ralenti et accéléré, est sélectionné, le mode d’enregistrement est annulé 
lorsque vous réglez Operation >Input/Output >Source Select dans le menu de configuration sur [External].
ˎˎ L’exécution des fonctions d’ajustement automatique comme l’équilibre automatique des noirs et les opérations 

comme la lecture, Rec Review et l’affichage des miniatures prennent fin lorsque vous réglez Operation >Input/
Output >Source Select dans le menu de configuration sur [External]. Le caméscope entre en mode d’arrêt, puis 
l’image de caméra bascule sur l’entrée externe.
ˎˎ L’enregistrement peut s’arrêter si le signal d’entrée est perturbé lors de l’enregistrement d’entrée externe. 

L’enregistrement redémarre automatiquement lorsque le signal d’entrée redevient normal.
ˎˎ Non pris en charge pour la fonction d’enregistrement proxy et de connexion LAN sans fil.

Formats de signal d’entrée externe et formats d’enregistrement du 
caméscope pris en charge

HD/SD Operation >Format >Rec 
Format dans le menu de 
configuration

Operation >Format 
>Frequency dans le menu 
de configuration

Formats du signal d’entrée externe 
pris en charge

HD XAVC-I 1920×1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

XAVC-L 50 1920×1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD422 50 1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD422 50 720P 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HQ 1920×1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HQ 1440×1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

SP 1440×1080i 59.94 HD 1920×1080 29.97PsF/59.94i 
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i 
HD 1280×720 50P

HQ 1280×720P 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P
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Maintenance

Nettoyage du viseur

Utilisez un ventilateur pour nettoyer l’écran 
CRT et le miroir à l’intérieur du barillet du 
viseur.
Nettoyez l’objectif et le filtre de protection 
avec un produit de nettoyage disponible dans 
le commerce.

[Remarque]
N’utilisez jamais de produits organiques tels que des 
solvants.

Remarque à propos de la borne 
de batterie

La borne de batterie de cet appareil (le 
connecteur pour les packs batterie et les 
adaptateurs CA) est une pièce consommable.
L’appareil risque de ne pas être alimenté 
correctement si les broches de la borne de 
batterie sont cintrées ou déformées par 
les chocs ou les vibrations, ou si elles sont 
touchées par la corrosion en raison d’une 
utilisation prolongée en extérieur.
Des inspections périodiques sont 
recommandées pour que l’appareil continue à 
fonctionner correctement et pour prolonger la 
durée de son utilisation.
Contactez un vendeur ou un technicien Sony 
pour plus d’informations sur les inspections.

Remplacement de la batterie de 
l’horloge interne

L’horloge interne du caméscope est alimentée 
par une batterie au lithium. Si le message 
« BackUp Battery End » apparaît dans le viseur, 
cette batterie doit être remplacée. Contactez 
un revendeur Sony.
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Système d’erreur/d’avertissement
Si le caméscope détecte un avertissement, une précaution ou une opération qui nécessite une confirmation, un message s’affiche sur le viseur, les indicateurs correspondants commencent à 
clignoter et un avertissement sonore est émis.
Vous pouvez ajuster le volume de l’avertissement sonore à l’aide du bouton ALARM. Si le bouton ALARM est réglé sur la position minimum, l’avertissement sonore ne sera pas audible.

Affichage d’erreur

Le caméscope arrêtera l’opération si l’un des écrans suivants s’affiche.

Message d’erreur Avertissement 
sonore

Indicateur 
WARNING

Indicateur de 
signalisation/REC

Cause et solution

E + code d’erreur Continu – Clignotement rapide Indique une anomalie dans le caméscope.
Mettez le caméscope hors tension, et vérifiez si vous détectez un problème au niveau des dispositifs raccordés, des 
câbles ou du support.
(Si le caméscope ne peut pas être mis hors tension en réglant le commutateur POWER sur OFF, retirez la batterie ou 
débranchez l’alimentation AC.)
Si l’erreur persiste après avoir remis le caméscope sous tension, contactez votre technicien Sony.

Affichage d’avertissement

Suivez les instructions fournies si l’écran suivant s’affiche.

Message d’avertissement Avertissement 
sonore

Indicateur 
WARNING

Indicateur de 
signalisation/REC

Cause et solution

Media Near Full Intermittent Clignotement Clignotement La capacité restante de la carte mémoire SxS est faible.
Remplacez-la dès que possible.

Media Full Continu On Clignotement rapide Les plans n’ont pas pu être enregistrés, copiés ou divisés parce que la capacité de la carte SxS n’est pas suffisante.
Remplacez-la immédiatement.

Battery Near End Intermittent Clignotement Clignotement La capacité restante du pack batterie est faible.
Rechargez-le dès que possible.
(L’indicateur de batterie clignote dans le viseur.)

Battery End Continu On Clignotement rapide Le pack batterie est épuisé.
L’enregistrement est désactivé.
Raccordez une source d’alimentation sur DC IN et laissez le pack batterie se recharger sans essayer de faire 
fonctionner le caméscope.
(L’indicateur de batterie clignote dans le viseur.)

Temperature High Intermittent Clignotement Clignotement La température interne est élevée.
Mettez le caméscope hors tension et laissez-le refroidir avant de le faire fonctionner à nouveau.

Voltage Low Intermittent Clignotement Clignotement La tension DC IN est faible (niveau 1).
Vérifiez la source d’alimentation.
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Message d’avertissement Avertissement 
sonore

Indicateur 
WARNING

Indicateur de 
signalisation/REC

Cause et solution

Insufficient Voltage Continu On Clignotement rapide La tension DC IN est trop faible (niveau 2).
L’enregistrement est désactivé.
Raccordez une source d’alimentation différente.
(L’indicateur de batterie clignote dans le viseur.)

Clips Full Continu On Clignotement rapide Le nombre maximum de plans pouvant être enregistrés sur une carte mémoire SxS est atteint. Il n’est plus possible 
d’enregistrer ou de copier d’autres plans. Remplacez-la immédiatement.

Last Clip Recording Intermittent Clignotement Clignotement Le plan en cours d’enregistrement est le dernier plan à pouvoir être enregistré car le nombre maximum de plans est 
atteint.
Préparez une nouvelle carte mémoire SxS.

Clips Near Full Intermittent Clignotement Clignotement Le nombre maximum de plans supplémentaires pouvant être enregistrés sur une carte mémoire SxS diminue.
Remplacez-la dès que possible.

Media(Proxy) Full Continu On Clignotement rapide Les données proxy ne peuvent pas être enregistrées parce qu’il n’y a plus suffisamment d’espace libre sur la carte SD 
de données proxy. Remplacez-la immédiatement.

Clips(Proxy) Full Continu On Clignotement rapide Le nombre maximum de plans pouvant être enregistrés sur la carte SD de données proxy est atteint. Il n’est plus 
possible d’enregistrer d’autres plans. Remplacez-la immédiatement.

Media(Proxy) Near Full Intermittent Clignotement Clignotement L’espace libre restant sur la carte SD de données proxy diminue.
Remplacez-la dès que possible.

Last Clip(Proxy) Rec Intermittent Clignotement Clignotement Les données proxy en cours d’enregistrement constituent le dernier plan à pouvoir être enregistré car le nombre 
maximum de plans est atteint.
Préparez une nouvelle carte SD de données proxy.

Clips(Proxy) Near Full Intermittent Clignotement Clignotement Le nombre maximum de plans supplémentaires pouvant être enregistrés sur une carte SD de données proxy diminue. 
Remplacez-la dès que possible.

Media(A) 1) Full Continu On Clignotement rapide Lorsque vous utilisez la fonction 2-slot Simul Rec

Media(A) 1) Clips Full Continu On Clignotement rapide Lorsque vous utilisez la fonction 2-slot Simul Rec

Media(A) 1) Near Full Intermittent Clignotement Clignotement Lorsque vous utilisez la fonction 2-slot Simul Rec

Media(A) 1) Last Clip Rec Intermittent Clignotement Clignotement Lorsque vous utilisez la fonction 2-slot Simul Rec

1) « (B) » est affiché pour les cartes dans le logement B.
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Affichage de précaution et de confirmation d’opération

Les messages de précaution et opérations suivants peuvent apparaître au centre de l’écran. 
Suivez les instructions fournies pour résoudre le problème.

Indication d’affichage Cause et solution

Battery Error
Please Change Battery

Une erreur a été détectée au niveau du pack batterie.
Remplacez-le par un pack batterie normal.

Backup Battery End
Please Change

La capacité restante de la batterie de secours est 
insuffisante.
Remplacez la batterie de secours.

Unknown Media(A) 1)

Please Change
ˎˎ Une carte mémoire qui a été divisée en plusieurs parts ou 
une carte mémoire contenant plus de plans que ceux 
permis pour la manipulation du caméscope a été insérée.
ˎˎ Une carte SxS a été insérée alors que le système de 
fichiers est défini sur FAT.
ˎˎ Une carte SDHC a été insérée alors que le système de 
fichiers est défini sur exFAT ou UDF. 

La carte ne peut pas être utilisée dans le caméscope et doit 
être remplacée.

Media Error
Media(A) 1) Needs to be Restored

Une erreur s’est produite avec la carte mémoire et la carte 
doit être restaurée.
Ejectez la carte et insérez-la à nouveau, puis réparez la 
carte.

Media Error
Cannot Record to Media(A) 1)

La carte mémoire peut être endommagée et ne peut plus 
être utilisée pour l’enregistrement.
La lecture est possible, il est donc recommandé d’effectuer 
une copie et de remplacer la carte mémoire.

Media Error
Cannot Use Media(A) 1)

La carte mémoire peut être endommagée et ne peut plus 
être utilisée pour l’enregistrement ou la lecture.
La carte ne peut pas être utilisée dans le caméscope et doit 
être remplacée.

Cannot Use Media(A) 1)

Unsupported File System
Une carte utilisant un système de fichiers différent ou une 
carte non formatée a été insérée.
La carte ne peut pas être utilisée dans le caméscope et doit 
être remplacée ou formatée à l’aide du caméscope.

Media(A) 1) Error
Playback Halted

Impossible de continuer la lecture parce qu’une erreur s’est 
produite pendant la lecture de la carte mémoire.
Si le problème persiste, effectuez une copie et remplacez la 
carte mémoire.

Media(A) 1) Error L’enregistrement s’est arrêté parce qu’une erreur s’est 
produite sur la carte mémoire.
Si le problème persiste, remplacez la carte mémoire.

Indication d’affichage Cause et solution

Different Media is Inserted
Cannot Use Media(A) 1)

Un support différent a été inséré. Éjectez la carte insérée et 
insérez une carte du même type que la carte insérée 
auparavant.

1) « (B) » est affiché pour les cartes dans le logement B.
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Messages affichés pendant les opérations
11. Annexe

Cette section explique les messages qui peuvent s’afficher en réponse à une opération d’une touche, d’un commutateur ou d’un bouton.

[Remarques]
ˎˎ Cette section couvre uniquement les messages affichés relatifs aux causes possibles en réponse à une opération.
ˎˎ Les messages affichés lorsqu’une opération est tentée alors qu’un élément de menu ne peut pas être sélectionné (grisé) ne sont pas décrits.

Opération Message Signification et cause possible

La touche REC a été enfoncée Media not exist Enregistrement impossible parce qu’il n’y a aucun support d’enregistrement dans le logement de carte mémoire 
SxS.

Media(Proxy)
Cannot Record
No Media in Slot(Proxy)

Le mode d’enregistrement des données proxy est activé (On), mais ne peut pas enregistrer les données proxy 
parce que la carte SD proxy n’est pas insérée.

Media(Proxy)
Cannot Record
Media(Proxy) Error

Impossible d’enregistrer les données proxy parce que l’écriture sur la carte SD proxy est impossible en raison d’une 
erreur de support.

Media(Proxy)
Cannot Record
Media(Proxy): Write Protected

Impossible d’enregistrer les données proxy parce que la carte SD proxy est protégée contre l’écriture.

Media(Proxy)
Cannot Record
NG: Preparing

Impossible d’enregistrer les données proxy parce que l’initialisation de la circuiterie de l’enregistrement des 
données proxy n’est pas terminée.

Le commutateur personnalisable auquel la 
fonction XAVC Proxy Rec Start a été 
attribuée a été actionné

Media(Proxy)
Cannot Record
No Media in Slot(Proxy)

Impossible d’enregistrer les données proxy parce que la carte SD proxy n’est pas insérée.

Media(Proxy)
Cannot Record
Media(Proxy) Error

Impossible d’enregistrer les données proxy parce que l’écriture sur la carte SD proxy est impossible en raison d’une 
erreur de support.

Media(Proxy)
Cannot Record
Media(Proxy): Write Protected

Impossible d’enregistrer les données proxy parce que la carte SD proxy est protégée contre l’écriture.

Media(Proxy)
Cannot Record
NG: Preparing

Impossible d’enregistrer les données proxy parce que l’initialisation de la circuiterie de l’enregistrement des 
données proxy n’est pas terminée.

La touche PREV a été enfoncée First Clip Top! Exécution impossible parce que la position de lecture se trouve sur la première image du premier plan.

La touche F REV a été enfoncée First Clip Top! Exécution impossible parce que la position de lecture se trouve sur la première image du premier plan.

Les touches PREV + F REV ont été enfoncées First Clip Top! Exécution impossible parce que la position de lecture se trouve sur la première image du premier plan.

La touche PLAY a été enfoncée Last Clip End! Exécution impossible parce que la position de lecture se trouve sur la dernière image du dernier plan.

La touche NEXT a été enfoncée Last Clip End! Exécution impossible parce que la position de lecture se trouve sur la dernière image du dernier plan.

La touche F FWD a été enfoncée Last Clip End! Exécution impossible parce que la position de lecture se trouve sur la dernière image du dernier plan.

Les touches NEXT + F FWD ont été 
enfoncées

Last Clip End! Exécution impossible parce que la position de lecture se trouve sur la dernière image du dernier plan.

Le logement du support a été modifié Cannot Switch Slots Impossible de modifier les logements pendant la lecture.
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Opération Message Signification et cause possible

Le support d’enregistrement a été retiré Media removed Le support a été retiré du support d’enregistrement pendant la lecture ou lors de l’écriture sur un support 
d’enregistrement (l’indicateur ACCESS est allumé).

Le commutateur GAIN a été actionné Gain: xxdB
(où « xx » représente la valeur de gain)

Le réglage du gain a été modifié.

Le commutateur DCC a été actionné DCC: On DCC a été activé (On).

DCC: Off DCC a été désactivé (Off).

Fixed By Hyper Gamma ! Impossible d’activer (On) DCC parce que Gamma Category est réglé sur HG ou User.

La balance des blancs a été actionnée White: Preset xxxxK
(où « xxxx » représente la valeur de la 
température de couleur)

La balance des blancs a été modifiée sur la valeur prédéfinie.

White: A xxxxK 
(où « xxxx » représente la valeur de la 
température de couleur)

La balance des blancs a été modifiée sur la valeur de la mémoire A.

White: B xxxxK 
(où « xxxx » représente la valeur de la 
température de couleur)

La balance des blancs a été modifiée sur la valeur de la mémoire B.

White: ATW xxxxK 
(où « xxxx » représente la valeur de la 
température de couleur)

Le mode de la balance des blancs a été modifié sur ATW.

Le commutateur SHUTTER a été actionné Shutter: 1/xxxx
(où « xxxx » représente la valeur d’obturation)

La vitesse d’obturation a été modifiée (réglages de mode standard, Speed).

Shutter: xxxx
(où « xxxx » représente la valeur d’obturation)

La vitesse d’obturation a été modifiée (réglages de mode standard, Angle).

ECS: xxxxHz
(où « xxxx » représente la valeur de fréquence)

La vitesse d’obturation a été modifiée (mode ECS).

Le bouton de menu a été tourné ECS: xxxxHz
(où « xxxx » représente la valeur de fréquence)

La vitesse d’obturation a été modifiée (mode ECS).

Iris Override: +x.xx
(où « xxxx » représente la valeur numérique)

Le niveau de changement de valeur du diaphragme a été modifié.

Le commutateur de noir automatique a été 
actionné

Color Bars
Cannot Proceed

Exécution impossible parce qu’un signal de barre de couleur est émis.

Test Saw
Cannot Proceed

Exécution impossible parce qu’un signal de test est émis.

Not Available
Recording

Exécution impossible parce que l’enregistrement est en cours.

Not Available
Playing back

Exécution impossible parce que la lecture est en cours.

Not Available
Displaying Thumbnails

Exécution impossible parce que l’écran de miniatures est affiché.
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Opération Message Signification et cause possible

Le commutateur de blanc automatique a été 
actionné

Color Bars
Cannot Proceed

Exécution impossible parce qu’un signal de barre de couleur est émis.

Not Available
Playing back

Exécution impossible parce que la lecture est en cours.

Not Available
Displaying Thumbnails

Exécution impossible parce que l’écran de miniatures est affiché.

White Balance Preset Exécution impossible parce que la balance des blancs est réglée sur la valeur prédéfinie.

Le commutateur personnalisable auquel la 
fonction ATW Hold a été attribuée a été 
actionné

ATW Hold La fonction ATW Hold a été activée.

ATW Hold Off La fonction ATW Hold a été désactivée.

Le commutateur personnalisable auquel la 
fonction Clip Continuous Rec a été attribuée 
a été actionné

Cannot Proceed
Recording

Exécution impossible parce que l’enregistrement est en cours.

Cannot Proceed Exécution impossible parce qu’un adaptateur de caméra CA-FB70/TX70 a été raccordé à la CCU.

[Remarque]
La connexion d’un adaptateur de caméra est prise en charge sur le modèle japonais uniquement.

Le commutateur personnalisable auquel la 
fonction Picture Cache Rec a été attribuée a 
été actionné

Cannot Proceed
Recording

Exécution impossible parce que l’enregistrement est en cours.

Cannot Proceed Exécution impossible à cause des conditions suivantes.
ˎˎ La lecture est en cours
ˎˎ L’écran de miniatures est affiché
ˎˎ Un adaptateur de caméra CA-FB70/TX70 est raccordé à la CCU.

[Remarque]
La connexion d’un adaptateur de caméra est prise en charge sur le modèle japonais uniquement.

Le commutateur personnalisable auquel la 
fonction Streaming a été attribuée a été 
actionné

Cannot Proceed
Network Client Mode Setting is “On”

Exécution impossible parce que le mode client réseau est activé.

Cannot Proceed
Network Function is Disabled

Exécution impossible parce que le réglage de connexion réseau est désactivé (Off).

Cannot Proceed
Network Client Mode Setting is “On”
Network Function is Disabled

Le mode client réseau est activé (On), mais ne peut pas être exécuté parce que la connexion réseau n’est pas 
disponible.

Cannot Start Streaming
Streaming Disabled Temporarily

Exécution impossible à cause des conditions suivantes.
ˎˎ La lecture des données proxy est en cours
ˎˎ La lecture de plan 1280×720 est en cours avec un format d’enregistrement défini sur 1920×1080
ˎˎ La lecture de plan 1920×1080 est en cours avec un format d’enregistrement défini sur 1280×720

Cannot Start Streaming
Please stop Recording or Playback

Exécution impossible parce que l’enregistrement/la lecture a été lancée pendant l’initialisation de la circuiterie de 
la fonction sans fil (y compris l’affichage des miniatures).
Arrêtez l’enregistrement/la lecture (y compris l’affichage des miniatures) pour permettre l’exécution.
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Opération Message Signification et cause possible

Le commutateur personnalisable auquel la 
fonction Streaming a été attribuée a été 
actionné alors que le mode client réseau est 
activé

Cannot Proceed
Streaming Setting is “On”

Configuration impossible parce que la lecture en transit est en cours.

Cannot Connect to CCM
Network Function is Disabled

Connexion impossible à Connection Control Manager parce que la connexion réseau n’est pas disponible.

Cannot Record Proxy Enregistrement des données proxy impossible si l’enregistrement des données proxy est lancé, car Maintenance 
>Network Client Mode >Preset 1, Preset 2 ou Preset 3 >NCM with Proxy est réglé sur Disable dans le menu de 
configuration.

Proxy Recording will be Stopped L’enregistrement des données proxy sera arrêté, car Maintenance >Network Client Mode >Preset 1, Preset 2 ou 
Preset 3 >NCM with Proxy est réglé sur Disable dans le menu de configuration.

Cannot Connect to CCM
Cannot Record Proxy

ˎˎ Connexion impossible à Connection Control Manager parce que la connexion réseau n’est pas disponible.
ˎˎ Enregistrement des données proxy impossible si l’enregistrement des données proxy est lancé, car Maintenance 
>Network Client Mode >Preset 1, Preset 2 ou Preset 3 >NCM with Proxy est réglé sur Disable dans le menu de 
configuration.

Cannot Connect to CCM
Proxy Recording will be Stopped

ˎˎ Connexion impossible à Connection Control Manager parce que la connexion réseau n’est pas disponible.
ˎˎ L’enregistrement des données proxy sera arrêté, car Maintenance >Network Client Mode >Preset 1, Preset 2 ou 
Preset 3 >NCM with Proxy est réglé sur Disable dans le menu de configuration.

Cannot Connect to CCM
Invalid User Name or Password

Une erreur d’authentification de Connection Control Manager s’est produite.

Cannot Connect to CCM
Invalid Address or Port Number

Connexion impossible à Connection Control Manager parce que le réglage de l’adresse ou du numéro de port de 
Connection Control Manager est incorrect.

Le commutateur personnalisable auquel la 
fonction Auto Upload(Proxy) a été attribuée 
a été actionné

Cannot Proceed
Network Function is Disabled

Exécution impossible parce que l’initialisation de la circuiterie de l’enregistrement des données proxy et de la 
circuiterie de la fonction sans fil n’est pas terminée.

La touche ONLINE a été enfoncée Cannot Proceed Exécution impossible parce que la circuiterie de la fonction sans fil est en mode de commutation ou l’alimentation 
électrique est hors tension.

Le commutateur personnalisable auquel la 
fonction Zebra a été attribuée ou le 
commutateur ZEBRA sur le viseur a été 
modifié

Zebra: On La fonction Zebra a été activée (On).

Zebra: Off La fonction Zebra a été désactivée (Off).

Le commutateur ZEBRA sur le viseur a été 
actionné

Zebra: On La fonction Zebra a été activée (On).

Zebra: Off La fonction Zebra a été désactivée (Off).

Le commutateur personnalisable auquel la 
fonction Master a été attribuée a été 
actionné

Marker: On La fonction Marker a été activée (On).

Marker: Off La fonction Marker a été désactivée (Off).

Le commutateur personnalisable auquel la 
fonction Video Signal Monitor a été 
attribuée a été actionné

Cannot Proceed Exécution impossible parce que Operation >Input/Output >SDI Out1 Select et SDI Out2 Select dans le menu de 
configuration sont tous les deux réglés sur Off.

Le commutateur OUTPUT a été déplacé sur 
la position BARS (affichage des barres de 
couleur)

Not Available
S&Q Motion: On

Exécution impossible parce que le mode d’enregistrement S&Q motion est activé.
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Opération Message Signification et cause possible

Le filtre ND a été modifié 2: 1/4ND  xxxxK
(où « 2: 1/4ND » représente le type de filtre ND 
et « xxxx » représente la valeur de la 
température de couleur)

Le filtre ND a été modifié.

ND:3 CC: x  xxxxK
(où « ND:3 » représente le type de filtre ND 
sélectionné et « CC: x  xxxx » représente le 
filtre CC sélectionné et la valeur de 
température de couleur après la conversion 
de température de couleur électrique)

Le filtre ND a été modifié avec la fonction ND Filter C.Temp désactivée (Off) et la fonction Electrical CC attribuée à 
un commutateur personnalisable.

Le commutateur personnalisable auquel la 
fonction Color Temp SW 3200K a été 
attribuée a été actionné

Color Temp SW 3200K La fonction Color Temp SW 3200K a été activée.

Cannot Proceed
ND Filter C.Temp: On

Modification impossible parce que la fonction ND Filter C.Temp est activée (On).

Le commutateur personnalisable auquel la 
fonction Color Temp SW 4300K a été 
attribuée a été actionné

Color Temp SW 4300K La fonction Color Temp SW 4300K a été activée.

Cannot Proceed
ND Filter C.Temp: On

Modification impossible parce que la fonction ND Filter C.Temp est activée (On).

Le commutateur personnalisable auquel la 
fonction Color Temp SW 5600K a été 
attribuée a été actionné

Color Temp SW 5600K La fonction Color Temp SW 5600K a été activée.

Cannot Proceed
ND Filter C.Temp: On

Modification impossible parce que la fonction ND Filter C.Temp est activée (On).

Le commutateur personnalisable auquel la 
fonction Color Temp SW 6300K a été 
attribuée a été actionné

Color Temp SW 6300K La fonction Color Temp SW 6300K a été activée.

Cannot Proceed
ND Filter C.Temp: On

Modification impossible parce que la fonction ND Filter C.Temp est activée (On).

Le commutateur personnalisable auquel la 
fonction Electrical CC a été attribuée a été 
actionné

ND:3 CC: x  xxxxK
(où « ND:3 » représente le type de filtre ND 
sélectionné et « CC: x  xxxx » représente le 
filtre CC sélectionné et la valeur de 
température de couleur après la conversion 
de température de couleur électrique)

La fonction Electrical CC filter a été modifiée.

Cannot Proceed Modification impossible parce que la fonction ND Filter C.Temp est activée (On).

Le commutateur personnalisable auquel la 
fonction CC5600K a été attribuée a été 
actionné

CC 5600K Le réglage 5600K a été sélecionné.

Cannot Proceed Exécution impossible à cause des conditions suivantes.
ˎˎ La fonction ND Filter C.Temp est activée (On)
ˎˎ La fonction Electrical CC a été attribuée à un commutateur personnalisable, mais le paramètre 5600K n’a pas été 
attribué à Electrical CC.
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Opération Message Signification et cause possible

Le commutateur personnalisable auquel la 
fonction Shot Mark1 a été attribuée a été 
actionné

Shot Mark1
(chaîne de caractères arbitraire lors de la 
définition de la planification des 
métadonnées)

Shot Mark 1 a été ajouté.

Cannot Record Essence Mark
Reached Essence Mark Limit

Ajout impossible parce que le nombre maximum de repères a été atteint.

Cannot Proceed Ajout impossible à cause des conditions suivantes.
ˎˎ Écriture impossible parce que le support sur lequel vous souhaitez enregistrer des plans est protégé contre 
l’écriture
ˎˎ La fonction Picture Cache Rec est activée (On)
ˎˎ L’enregistrement Interval Rec est en cours
ˎˎ Le support est protégé contre l’écriture
ˎˎ Le plan cible est enregistré sur une carte SD

Le commutateur personnalisable auquel la 
fonction Shot Mark2 a été attribuée a été 
actionné

Shot Mark2
(chaîne de caractères arbitraire lors de la 
définition de la planification des 
métadonnées)

Shot Mark 2 a été ajouté.

Cannot Record Essence Mark
Reached Essence Mark Limit

Ajout impossible parce que le nombre maximum de repères a été atteint.

Cannot Proceed Ajout impossible à cause des conditions suivantes.
ˎˎ Écriture impossible parce que le support sur lequel vous souhaitez enregistrer des plans est protégé contre 
l’écriture
ˎˎ La fonction Picture Cache Rec est activée (On)
ˎˎ L’enregistrement Interval Rec est en cours
ˎˎ Le support est protégé contre l’écriture
ˎˎ Le plan cible est enregistré sur une carte SD

Le commutateur personnalisable auquel la 
fonction Clip Flag OK a été attribuée a été 
actionné

OK Clip Flag Le drapeau de plan (repère OK) a été ajouté.

Delete Clip Flag Le drapeau de plan (repère OK) a été supprimé (en appuyant deux fois sur le commutateur).

Cannot Proceed Exécution impossible à cause des conditions suivantes.
ˎˎ Le support est protégé contre l’écriture
ˎˎ Le plan cible est enregistré sur une carte SD

Le commutateur personnalisable auquel la 
fonction Clip Flag NG a été attribuée a été 
actionné

NG Clip Flag Le drapeau de plan (repère NG) a été ajouté.

Delete Clip Flag Le drapeau de plan (repère NG) a été supprimé (en appuyant deux fois sur le commutateur).

Cannot Proceed Exécution impossible à cause des conditions suivantes.
ˎˎ Le support est protégé contre l’écriture
ˎˎ Le plan cible est enregistré sur une carte SD

Le commutateur personnalisable auquel la 
fonction Clip Flag Keep a été attribuée a été 
actionné

KEEP Clip Flag Le drapeau de plan (repère KEEP) a été ajouté.

Delete Clip Flag Le drapeau de plan (repère KEEP) a été supprimé (en appuyant deux fois sur le commutateur).

Cannot Proceed Exécution impossible à cause des conditions suivantes.
ˎˎ Le support est protégé contre l’écriture
ˎˎ Le plan cible est enregistré sur une carte SD

La touche SLOT SELECT a été actionnée Switched Slot Le support d’enregistrement à utiliser a été changé.
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Opération Message Signification et cause possible

Une touche attribuable à laquelle a été 
affecté le mode Slow & Quick Motion a été 
actionnée dans un format d’enregistrement 
qui ne prend pas en charge le mode Slow & 
Quick Motion.

Cannot Proceed
S&Q Unsupported Rec Format

Le mode Slow & Quick Motion ne peut pas être utilisé en raison d’un format non pris en charge.
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Éléments sauvegardés dans les données utilisateur
Légende du tableau
Oui : Sauvegardé
Oui* : Sauvegardé (n’est pas effacé à l’aide de Clear All Preset)
Non : Non sauvegardé
— : Non sauvegardé (réglage temporaire)
Défaut :   Non sauvegardé dans le fichier de référence, mais sauvegardé sous forme de préréglage 

de menu par défaut lorsque File >Reference est exécuté dans le menu de configuration.

Menu User

Élément Sous-option Type de fichier

All Scene Reference Lens

Edit User Menu Oui Non Non Non

Menu Operation

Élément Sous-option Type de fichier

All Scene Reference Lens

Format Frequency Oui* Non Non Non

File System Oui* Non Non Non

Rec Format Oui Non Non Non

Base Setting Shooting Mode Oui Non Non Non

High Sensitivity Mode Oui Oui Non Non

HDR Setting 4K(QFHD) Rec/Out Oui Non Non Non

HD Rec/Out Oui Non Non Non

SDR Gain Oui Non Non Non

4K(QFHD) Color Space Oui Non Non Non

HD Color Space Oui Non Non Non

Format Media Media(A) – – – –

Media(B) – – – –

SD Card(Utility) – – – –

SD Card(Proxy) – – – –

Élément Sous-option Type de fichier

All Scene Reference Lens

Input/Output Output Format Oui Non Non Non

Source Select Oui Non Non Non

SDI Out1 Output Oui Non Non Non

SDI Out2 Output Oui Non Non Non

HDMI Output Oui Non Non Non

SDI Out/HDMI Super Oui Non Non Non

Super Impose Super(VF Display) Oui Non Non Non

Super(Menu) Oui Non Non Non

Super(Marker) Oui Non Non Non

LCD LCD Color Oui Non Non Non

LCD Marker&Zebra Oui Non Non Non

Rec Function Slow & Quick Motion Oui Non Non Non

Frame Rate Oui Non Non Non

Clip Continuous Rec Oui Non Non Non

Picture Cache Rec Oui Non Non Non

Cache Rec Time Oui Non Non Non

Interval Rec Non Non Non Non

Number of Frames Oui Non Non Non

Interval Time Oui Non Non Non

Pre-Lighting Oui Non Non Non

Simul Rec Oui Non Non Non

4K & HD (Sub) Rec Oui Non Non Non

HD (Sub) Rec Format Oui Non Non Non

HD (Sub) Playback Mode Oui Non Non Non

XAVC Proxy Rec 
Mode

Setting Oui* Non Non Non

Size Oui* Non Non Non

Frame Rate – – – –

Bit Rate – – – –

Audio Channel Oui* Non Non Non
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Élément Sous-option Type de fichier

All Scene Reference Lens

Assignable 
Switch

<0> Oui Non Non Non

<1> Oui Non Non Non

<2> Oui Non Non Non

<3> Oui Non Non Non

<4> Oui Non Non Non

<5> Oui Non Non Non

Lens RET Oui Non Non Non

Online Oui Non Non Non

Zoom Speed Oui Non Non Non

VF Setting Color Oui Non Non Non

VF Detail Level Oui Non Non Non

Marker Setting Oui Non Non Non

Color Oui Non Non Non

Center Marker Oui Non Non Non

Safety Zone Oui Non Non Non

Safety Area Oui Non Non Non

Aspect Marker Oui Non Non Non

Aspect Select Oui Non Non Non

Aspect Mask Oui Non Non Non

Aspect Safety Zone Oui Non Non Non

Aspect Safety Area Oui Non Non Non

100% Marker Oui Non Non Non

User Box Oui Non Non Non

User Box Width Oui Non Non Non

User Box Height Oui Non Non Non

User Box H Position Oui Non Non Non

User Box V Position Oui Non Non Non

Gain Switch Gain<L> Oui Non Non Non

Gain<M> Oui Non Non Non

Gain<H> Oui Non Non Non

Gain <Turbo> Oui Non Non Non

Shockless Gain Oui Non Non Non

Élément Sous-option Type de fichier

All Scene Reference Lens

Auto Iris Iris Override Oui Non Non Non

Mode Oui Non Non Non

Level Oui Non Non Non

Speed Oui Non Non Non

Clip High light Oui Non Non Non

Detect Window Oui Non Non Non

Detect Window Indication Non Non Non Non

Iris APL Ratio Oui Non Non Non

Iris Var Width Oui Non Non Non

Iris Var Height Oui Non Non Non

Iris Var H Position Oui Non Non Non

Iris Var V Position Oui Non Non Non

Zebra Zebra Select Oui Non Non Non

Zebra1 Level Oui Non Non Non

Zebra1 Aperture Level Oui Non Non Non

Zebra2 Level Oui Non Non Non
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Élément Sous-option Type de fichier

All Scene Reference Lens

Display On/Off Video Level Warning Oui Non Non Non

Shutter Setting Oui Non Non Non

ND Filter Position Oui Non Non Non

Gain Setting Oui Non Non Non

Rec/Play Status Oui Non Non Non

Color Temp. Oui Non Non Non

Frame Rate/Interval Oui Non Non Non

Battery Remain Oui Non Non Non

Timecode Oui Non Non Non

Audio Level Meter Oui Non Non Non

Media Status Oui Non Non Non

SD Card(Utility) Oui Non Non Non

Focus Position Oui Non Non Non

Iris Position Oui Non Non Non

Zoom Position Oui Non Non Non

Extender Oui Non Non Non

ALAC Oui Non Non Non

AE Mode Oui Non Non Non

Focus Mode Oui Non Non Non

White Balance Mode Oui Non Non Non

CC5600K Oui Non Non Non

Rec Format Oui Non Non Non

Gamma Oui Non Non Non

Timecode Lock Oui Non Non Non

Network Condition Oui Non Non Non

Proxy Status Oui Non Non Non

NW Client Mode Status Oui Non Non Non

Streaming Status Oui Non Non Non

GPS Oui Non Non Non

Video Signal Monitor Oui Non Non Non

Clip Name Oui Non Non Non

Focus Assist Indicator Oui Non Non Non

Focus Area Marker Oui Non Non Non

Lens Info Oui Non Non Non

WRR RF Level Oui Non Non Non

Clip Number Oui Non Non Non

Élément Sous-option Type de fichier

All Scene Reference Lens

“!” LED Gain <!> Oui Non Non Non

Shutter <!> Oui Non Non Non

White Preset <!> Oui Non Non Non

ATW Run <!> Oui Non Non Non

Extender <!> Oui Non Non Non

Filter <!> Oui Non Non Non

Iris Override <!> Oui Non Non Non

White Setting White Switch <B> Oui Non Non Non

Shockless White Oui Non Non Non

ATW Speed Oui Non Non Non

ATW Mode Oui Non Non Non

AWB Fixed Area Oui Non Non Non

Filter White Memory Oui Non Non Non

Offset White Offset White <A> Oui Non Non Non

Warm Cool <A> Oui Non Non Non

Warm Cool Balance<A> Oui Non Non Non

Offset White <B> Oui Non Non Non

Warm Cool <B> Oui Non Non Non

Warm Cool Balance<B> Oui Non Non Non

Shutter Mode Oui Oui Non Non

Slow Shutter Setting Oui Oui Non Non

Number of Frames Oui Oui Non Non

Time Zone Time Zone Oui Non Non Non

Clip Clip Naming Oui Non Non Non

Title Prefix Oui Non Non Non

Number Set Non Non Non Non

Update Media Media(A) – – – –

Media(B) – – – –

GPS GPS Oui Non Non Non

Planning 
Metadata

Load from Media(A) – – – –

Load from Media(B) – – – –

Properties – – – –

Clear Memory – – – –

Clip Name Disp Oui Non Non Non

Sort by Oui Non Non Non
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Élément Sous-option Type de fichier

All Scene Reference Lens

USB Select Folder – – – –

View Clip List – – – –

Rename Folder – – – –

Error Check Oui Non Non Non

Format USB – – – –

Copy to USB – – – –

Media Remain – – – –

Menu Paint

Élément Sous-option Type de fichier

All Scene Reference Lens

Switch Status Gamma Oui Oui Défaut Non

Black Gamma Oui Oui Oui Non

Matrix Oui Oui Oui Non

Knee Oui Oui Oui Non

White Clip Non Oui Non Non

Detail(QFHD) Oui Oui Défaut Non

Detail(HD) Oui Oui Défaut Non

Aperture Oui Oui Défaut Non

Flare Oui Oui Défaut Non

Test Saw Oui Non Non Non

HDR Paint 
Setting

HLG Look Oui Oui Oui Non

HDR Black Offset Oui Oui Oui Non

HDR Knee Oui Oui Oui Non

HDR Knee Point Oui Oui Oui Non

HDR Knee Slope Oui Oui Oui Non

HDR Black Compression Oui Oui Oui Non

Élément Sous-option Type de fichier

All Scene Reference Lens

White Color Temp <A> Oui Oui Oui Non

Color Temp Balance <A> Oui Oui Oui Non

R Gain <A> Oui Oui Oui Non

B Gain <A> Oui Oui Oui Non

Color Temp <B> Oui Oui Oui Non

Color Temp Balance <B> Oui Oui Oui Non

R Gain <B> Oui Oui Oui Non

B Gain <B> Oui Oui Oui Non

Black Master Black Oui Oui Oui Non

R Black Oui Oui Oui Non

B Black Oui Oui Oui Non

Flare Setting Oui Oui Défaut Non

Master Flare Oui Oui Oui Non

R Flare Oui Oui Oui Non

G Flare Oui Oui Oui Non

B Flare Oui Oui Oui Non

Gamma(HDR) Gamma Select Non Non Non Non

Gamma Setting Oui Oui Défaut Non

Step Gamma Oui Oui Oui Non

Master Gamma Oui Oui Oui Non

R Gamma Oui Oui Oui Non

G Gamma Oui Oui Oui Non

B Gamma Oui Oui Oui Non

Gamma Category Oui Oui Oui Non

Gamma Select Oui Oui Oui Non

Black Gamma Setting Oui Oui Oui Non

Range Oui Oui Oui Non

Master Black Gamma Oui Oui Oui Non

Knee Setting Oui Oui Oui Non

Point Oui Oui Oui Non

Slope Oui Oui Oui Non

Knee Saturation Oui Oui Oui Non

Knee Saturation Level Oui Oui Oui Non

White Clip Setting Non Oui Non Non

Level Oui Oui Oui Non



11. Annexe : Éléments sauvegardés dans les données utilisateur170

Élément Sous-option Type de fichier

All Scene Reference Lens

Detail(QFHD) Setting Oui Oui Défaut Non

Level Oui Oui Oui Non

H/V Ratio Oui Oui Oui Non

Crispening Oui Oui Oui Non

Level Depend Oui Oui Oui Non

Level Depend Level Oui Oui Oui Non

Frequency Oui Oui Oui Non

Knee Aperture Oui Oui Oui Non

Knee Aperture Level Oui Oui Oui Non

Limit Oui Oui Oui Non

White Limit Oui Oui Oui Non

Black Limit Oui Oui Oui Non

V Black Limit Oui Oui Oui Non

V Detail Creation Oui Oui Oui Non

Detail(HD) Setting Oui Oui Défaut Non

Level Oui Oui Oui Non

H/V Ratio Oui Oui Oui Non

Crispening Oui Oui Oui Non

Level Depend Oui Oui Oui Non

Level Depend Level Oui Oui Oui Non

Frequency Oui Oui Oui Non

Knee Aperture Oui Oui Oui Non

Knee Aperture Level Oui Oui Oui Non

Limit Oui Oui Oui Non

White Limit Oui Oui Oui Non

Black Limit Oui Oui Oui Non

V Black Limit Oui Oui Oui Non

V Detail Creation Oui Oui Oui Non

Aperture Setting Oui Oui Défaut Non

Level Oui Oui Oui Non

Skin Detail Setting Oui Oui Oui Non

Area Detection – – – –

Area Indication Non Non Non Non

Level Oui Oui Oui Non

Saturation Oui Oui Oui Non

Hue Oui Oui Oui Non

Width Oui Oui Oui Non

Élément Sous-option Type de fichier

All Scene Reference Lens

Matrix Setting Oui Oui Oui Non

Adaptive Matrix Oui Oui Oui Non

Preset Matrix Oui Oui Oui Non

Preset Select Oui Oui Oui Non

User Matrix Oui Oui Oui Non

Level Oui Oui Oui Non

Phase Oui Oui Oui Non

User Matrix R-G Oui Oui Oui Non

User Matrix R-B Oui Oui Oui Non

User Matrix G-R Oui Oui Oui Non

User Matrix G-B Oui Oui Oui Non

User Matrix B-R Oui Oui Oui Non

User Matrix B-G Oui Oui Oui Non

Multi Matrix Setting Oui Oui Oui Non

Area Indication Non Non Non Non

Color Detection – – – –

Reset – – – –

Axis Non Non Non Non

Hue Oui Oui Oui Non

Saturation Oui Oui Oui Non

V Modulation Setting Oui Non Défaut Non

Master V Modulation Oui Oui Défaut Non

R V Modulation Oui Oui Défaut Non

G V Modulation Oui Oui Défaut Non

B V Modulation Oui Oui Défaut Non

Low Key 
Saturation

Setting Oui Oui Oui Non

Level Oui Oui Oui Non

Range Oui Oui Oui Non

Saturation Mode Saturation Mode Oui Oui Oui Non

Knee Saturation Oui Oui Oui Non

Black Gamma Oui Oui Oui Non

Low Key Saturation Oui Oui Oui Non
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Élément Sous-option Type de fichier

All Scene Reference Lens

Noise 
Suppression

Setting Oui Oui Oui Non

Level Oui Oui Oui Non

Gain Link Oui Oui Oui Non

–3dB Oui Oui Oui Non

0dB Oui Oui Oui Non

3dB Oui Oui Oui Non

6dB Oui Oui Oui Non

9dB Oui Oui Oui Non

12dB Oui Oui Oui Non

18dB Oui Oui Oui Non

24dB Oui Oui Oui Non

30dB Oui Oui Oui Non

36dB Oui Oui Oui Non

42dB Oui Oui Oui Non

Menu Thumbnail

Élément Sous-option Type de fichier

All Scene Reference Lens

Display Clip 
Properties

– – – – –

Set Index Picture – – – – –

Thumbnail View Essence Mark Thumbnail – – – –

Clip Thumbnail – – – –

Set Shot Mark Add Shot Mark1 – – – –

Delete Shot Mark1 – – – –

Add Shot Mark2 – – – –

Delete Shot Mark2 – – – –

Set Clip Flag Add OK – – – –

Add NG – – – –

Add KEEP – – – –

Delete Clip Flag – – – –

Lock/Unlock Clip Select Clip – – – –

Lock All Clips – – – –

Unlock All Clips – – – –

Élément Sous-option Type de fichier

All Scene Reference Lens

Copy Clip Select Clip  – – – –

All Clips – – – –

Copy Sub Clip All Clips – – – –

Delete Clip Select Clip – – – –

All Clips – – – –

Transfer Clip Select Clip – – – –

All Clips – – – –

Transfer 
Clip(Proxy)

Select Clip – – – –

All Clips – – – –

Filter Clips OK – – – –

NG – – – –

KEEP – – – –

None – – – –

Customize View Thumbnail Caption Oui* Oui Non Non

Menu Maintenance

Élément Sous-option Type de fichier

All Scene Reference Lens

White Shading Channel Select Oui Non Défaut Non

White H Saw Non Non Non Non

White H Para Non Non Non Non

White V Saw Non Non Non Non

White V Para Non Non Non Non

White Saw/Para Oui Non Défaut Non

Black Shading Channel Select Oui Non Défaut Non

Black H Saw Non Non Non Non

Black H Para Non Non Non Non

Black V Saw Non Non Non Non

Black V Para Non Non Non Non

Black Shading Black Saw/Para Oui Non Défaut Non

Master Black Oui Oui Oui Non

Master Gain (TMP) – – – –
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Élément Sous-option Type de fichier

All Scene Reference Lens

Battery Near End:Info Battery Oui Non Non Non

End:Info Battery Oui Non Non Non

Near End:Sony Battery Oui Non Non Non

End:Sony Battery Oui Non Non Non

Near End:Other Battery Oui Non Non Non

End:Other Battery Oui Non Non Non

Detected Battery – – – –

DC Voltage 
Alarm

DC Low Voltage1 Oui Non Non Non

DC Low Voltage2 Oui Non Non Non

Audio Front MIC Select Oui Non Non Non

Audio CH3/4 Mode Oui Non Non Non

Rear XLR Auto Oui Non Non Non

Front MIC CH1 Ref Oui Non Non Non

Front MIC CH2 Ref Oui Non Non Non

Rear MIC CH1 Ref Oui Non Non Non

Rear MIC CH2 Ref Oui Non Non Non

Line Input Ref Oui Non Non Non

Min Alarm Volume Oui Non Non Non

Speaker Attenuate Oui Non Non Non

Headphone Out Oui Non Non Non

Reference Level Oui Non Non Non

Reference Out Oui Non Non Non

CH1&2 AGC Mode Oui Non Non Non

CH3&4 AGC Mode Oui Non Non Non

AGC Spec Oui Non Non Non

Limiter Mode Oui Non Non Non

Output Limiter Oui Non Non Non

CH1 Wind Filter Oui Non Non Non

CH2 Wind Filter Oui Non Non Non

CH3 Wind Filter Oui Non Non Non

CH4 Wind Filter Oui Non Non Non

1kHz Tone on Color Bars Oui Non Non Non

MIC CH1 Level Oui Non Non Non

MIC CH2 Level Oui Non Non Non

Élément Sous-option Type de fichier

All Scene Reference Lens

Audio Rear1/WRR Level Oui Non Non Non

Rear2/WRR Level Oui Non Non Non

Audio CH3 Level Oui Non Non Non

Audio CH4 Level Oui Non Non Non

WRR Setting WRR Valid CH Sel Oui Non Non Non

WRR CH Select Non Non Non Non

WRR Delay Comp Oui Non Non Non

TX – – – –

TX Audio Peak – – – –

TX Input Level – – – –

TX ATT Level – – – –

TX LCF Frequency – – – –

TX System Delay Oui Non Non Non

TX RF Power – – – –

TX Power Save – – – –

TX-Cam Power Sync Oui Non Non Non

Timecode TC Out Oui Non Non Non

DF/NDF Oui Non Non Non

LTC UBIT Oui Non Non Non

Counter Display Oui Non Non Non

HDMI TC Out Oui Non Non Non

Essence Mark Find Mode Oui Non Non Non

Camera Config HD SDI Remote I/F Oui Non Non Non

Color Bars Select Oui Non Non Non

User Menu Only Oui Non Non Non

User Menu with Lock Non Non Non Non

RM Common Memory Oui Non Non Non

RM Rec Start Oui Non Non Non

Detail Control(RM/RCP) Oui Non Non Non

SET Key on Thumbnail Oui Non Non Non

ALAC Oui Non Non Non

SD HDMI Oui Non Non Non

HD Modulation Oui Non Non Non
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Élément Sous-option Type de fichier

All Scene Reference Lens

Preset White Color Temp <P> Oui Non Non Non

Color Temp Balance <P> Oui Non Non Non

R Gain <P> Oui Non Non Non

B Gain <P> Oui Non Non Non

AWB Enable <P> Non Non Non Non

White Filter ND Filter C.Temp Oui Non Non Non

ND FLT C.Temp<1> Oui Non Non Non

ND FLT C.Temp<2-4> Oui Non Non Non

Electrical CC<A> Oui Non Non Non

Electrical CC<B> Oui Non Non Non

Electrical CC<C> Oui Non Non Non

Electrical CC<D> Oui Non Non Non

DCC Adjust DCC Function Select Oui Non Non Non

DCC D Range Oui Non Non Non

DCC Point Oui Non Non Non

DCC Gain Oui Non Non Non

DCC Delay Time Oui Non Non Non

DCC Peak Filter Oui Non Non Non

Flicker Reduce Mode Oui Non Non Non

Frequency Oui Non Non Non

Genlock Genlock Oui Non Non Non

Reference – – – –

Auto Shading Auto Black Shading – – – –

Reset Black Shading – – – –

Master Gain (TMP) – – – –

APR APR – – – –

Reset – – – –

Setup for Mobile 
App

Setup – – – –

Access 
Authentication

User Name Non Non Non Non

Password Non Non Non Non

Generate Password – – – –

Show Settings – – – –

Network Setting Oui* Non Non Non

Wi-Fi Mode Oui* Non Non Non

NFC – – – –

WPS – – – –

Élément Sous-option Type de fichier

All Scene Reference Lens

Network Channel Oui* Non Non Non

SSID & Password – – – –

SSID – – – –

Wi-Fi Station Remote Oui* Non Non Non

Wi-Fi 
Station 
Detail 
Settings

Scan Networks – – – –

SSID Non Non Non Non

Password Non Non Non Non

DHCP Oui* Non Non Non

IP Address Oui* Non Non Non

Subnet Mask Oui* Non Non Non

Gateway Oui* Non Non Non

DNS Auto Oui* Non Non Non

Primary DNS 
Server

Oui* Non Non Non

Secondary DNS 
Server

Oui* Non Non Non

Device Name (Wi-Fi) – – – –

IP Address (Wi-Fi) – – – –

Subnet Mask (Wi-Fi) – – – –

MAC Address (Wi-Fi) – – – –

Regenerate Password – – – –

Modem Oui* Non Non Non

Modem Remote – – – –

Public Key Creation – – – –

Public Key Clear – – – –

Create Key Date – – – –

Wired LAN Oui* Non Non Non

Wired LAN Remote Oui* Non Non Non

Wired 
LAN 
Detail 
Settings

DHCP Oui* Non Non Non

IP Address Oui* Non Non Non

Subnet Mask Oui* Non Non Non

Gateway Oui* Non Non Non

DNS Auto Oui* Non Non Non

Primary DNS 
Server

Oui* Non Non Non

Secondary DNS 
Server

Oui* Non Non Non
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Élément Sous-option Type de fichier

All Scene Reference Lens

Network Client 
Mode

Setting Oui* Non Non Non

Preset 
Select

Oui* Non Non Non

Preset 1 Display Name Oui* Non Non Non

CCM Address Oui* Non Non Non

CCM Port Oui* Non Non Non

User Name Non Non Non Non

Password Non Non Non Non

NCM with Proxy Oui* Non Non Non

Camera Control Oui* Non Non Non

Camera Setting Non Non Non Non

Preset 2 Identique à Preset 1

Preset 3 Identique à Preset 1

File Transfer File Transfer – – – –

Remote File Transfer Oui* Non Non Non

Auto Upload (Proxy) Oui* Non Non Non

Default Upload Server Oui* Non Non Non

Clear Completed Jobs – – – –

Clear All Jobs – – – –

View Job List – – – –

Streaming Setting Non Non Non Non

Preset Select Oui* Non Non Non

Preset1 Size Oui* Non Non Non

Bit Rate Oui* Non Non Non

Type Oui* Non Non Non

Destination 
Address

Oui* Non Non Non

Destination Port Oui* Non Non Non

Preset2 Identique au Preset1

Preset3 Identique au Preset1

Audio Channel Oui* Non Non Non

Clock Set Date Mode Oui Non Non Non

12H/24H Oui Non Non Non

Date – – – –

Time – – – –

Language Select Oui Non Non Non

Élément Sous-option Type de fichier

All Scene Reference Lens

Hours Meter Hours (System) – – – –

Hours (Reset) – – – –

Reset – – – –

Network Reset Reset – – – –

Fan Control Setting Oui Non Non Non

VF Display 
Setting

Chara/Marker Brightness Oui Non Non Non

Version Number – – – –

Version Up – – – –

Net-Func Version Number – – – –

Net-Func Ver.Up – – – –

Menu File

Élément Sous-option Type de fichier

All Scene Reference Lens

User File Load SD Card – – – –

Save SD Card – – – –

File ID Non Non Non Non

Recall User Preset – – – –

Store User Preset – – – –

Clear User Preset – – – –

Load Customize Data Oui Non Non Non

Load White Data Oui Non Non Non

All File Load SD Card – – – –

Save SD Card – – – –

File ID Oui Non Non Non

All Preset – – – –

Store All Preset – – – –

Clear All Preset – – – –

3Sec Clear Preset Non Non Non Non
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Élément Sous-option Type de fichier

All Scene Reference Lens

Scene File Recall Internal Memory – – – –

Store Internal Memory – – – –

Load SD Card – – – –

Save SD Card – – – –

File ID Non Oui Non Non

Scene White Data Oui Non Non Non

Reference File Store Reference – – – –

Clear Reference – – – –

Load Reference(SD Card) – – – –

Save Reference(SD Card) – – – –

File ID Non Non Oui Non

Lens File Display Mode Non Non Non Non

Recall Internal Memory – – – –

Store Internal Memory – – – –

Load SD Card – – – –

Save SD Card – – – –

File ID Non Non Non Oui

File Source – – – –

Clear Lens Offset – – – –

Lens Auto Recall Oui Non Non Non

Lens Serial Number – – – –

Lens Name – – – –

Lens Manufacturer – – – –

Master V Modulation Non Non Non Oui

Lens Center H Non Non Non Oui

Lens Center V Non Non Non Oui

R Flare Non Non Non Oui

G Flare Non Non Non Oui

B Flare Non Non Non Oui

White Offset R Non Non Non Oui

White Offset B Non Non Non Oui

Shading Ch Select Oui Non Non Non

Shading H SAW Non Non Non Oui

Shading H PARA Non Non Non Oui

Shading V SAW Non Non Non Oui

Shading V PARA Non Non Non Oui

Élément Sous-option Type de fichier

All Scene Reference Lens

User Gamma Current Settings – – – –

Load SD Card – – – –

Reset – – – –
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Prise en charge des enregistrements spéciaux par format d’enregistrement

Format
Enregistrement 

normal

Enregistrement spécial 1)

Picture Cache 
Rec

Interval Rec
Slow & Quick 

Motion
Clip Continuous 

Rec
2-slot Simul Rec 1-slot Simul Rec

1-Slot Simul Rec +  
Picture Cache 

Rec

QFHD XAVC-I QFHD exFAT Oui Oui Oui Oui – – Oui 2) Oui 2)

XAVC-L QFHD Oui Oui Oui Oui – – Oui 2) Oui 2)

HD XAVC-I HD exFAT Oui Oui Oui Oui Oui Oui – –

XAVC-L 50 Oui Oui Oui Oui Oui Oui – –

XAVC-L 35 Oui Oui Oui Oui Oui Oui – –

XAVC-L 25 Oui Oui Oui – Oui Oui – –

MPEG HD422 Oui Oui Oui Oui Oui Oui – –

UDF Oui Oui Oui Oui Oui – – –

MPEG HD420 HQ exFAT Oui Oui – – – Oui – –

UDF Oui Oui – – – – – –

FAT Oui Oui – – – – – –

MPEG HD420 SP Oui Oui – – – – – –

1) Pour de plus amples informations sur les tailles d’mage, fréquences d’mages et fonctions prises en charge, consultez « Opérations avancées » (page 50).  
Un seul mode spécial d’enregistrement peut être utilisé à un moment donné.

2) Le format de sous-plans enregistrés simultanément est MPEG HD422 ou XAVC-L50.
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Réglages du mode Picture Cache Rec
Operation >Format dans le menu de 
configuration

Cache Rec Time

Frequency Rec Format 0–2 sec 2–4 sec 4–6 sec 6–8 sec 8–10 sec 10–12 sec 12–14 sec 13–15 sec

59.94
50

XAVC-I 3840×2160P Oui Oui Oui Oui Oui – – –

XAVC-I 1920×1080P Oui Oui Oui Oui Oui Oui Oui Oui

XAVC-I 1920×1080i Oui Oui Oui Oui Oui Oui Oui Oui

XAVC-L 200 2160P Oui Oui Oui Oui Oui Oui Oui Oui

XAVC-L 3840×2160P Oui Oui Oui Oui Oui Oui Oui Oui

XAVC-L 50/35/25 Oui Oui Oui Oui Oui Oui Oui Oui

MPEG HD422 Oui Oui Oui Oui Oui Oui Oui Oui

MPEG HD420 HQ/SP Oui Oui Oui Oui Oui Oui Oui Oui

29.97
25
23.98

XAVC-I 3840×2160P Oui Oui Oui Oui Oui Oui Oui Oui

XAVC-I 1920×1080P Oui Oui Oui Oui Oui Oui Oui Oui

XAVC-L 3840×2160P Oui Oui Oui Oui Oui Oui Oui Oui

XAVC-L 50/35 Oui Oui Oui Oui Oui Oui Oui Oui

MPEG HD422 Oui Oui Oui Oui Oui Oui Oui Oui

MPEG HD420 HQ Oui Oui Oui Oui Oui Oui Oui Oui

[Remarque]
En mode 1-slot Simul Rec, la valeur maximale de Cache Rec Time est de 6 à 8 secondes lorsque Rec Format est de XAVC-I 59.94/50. Dans tous les autres cas, 13 à 15 secondes.
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Durée d’enregistrement et de lecture des supports
[Remarque]
Les durées d’enregistrement et de lectures sont indiquées pour un enregistrement continu sous forme de plan unique. Les durées réelles peuvent être plus courtes, en fonction du nombre de plans enregistrés.

Format Nombre de pixels/Fréquence d’images Débit binaire maximal Durée d’enregistrement/de lecture

SBP-240F SBS-128G1C

XAVC Intra XAVC-I QFHD 3840×2160 / 59.94P 600 Mbps Environ 45 minutes –

3840×2160 / 50P 500 Mbps Environ 53 minutes –

3840×2160 / 29.97P 300 Mbps Environ 88 minutes –

3840×2160 / 25P 250 Mbps Environ 105 minutes –

3840×2160 / 23.98P 240 Mbps Environ 110 minutes –

XAVC-I HD 1920×1080 / 59.94P, 50P 222 Mbps Environ 115 minutes Environ 57 minutes

1920×1080 / 29.97P, 25P, 59.94i, 50i 111 Mbps Environ 220 minutes Environ 105 minutes

1920×1080 / 23.98P 89 Mbps Environ 270 minutes Environ 135 minutes

XAVC Long XAVC-L200 3840×2160 / 59.94P, 50P 200 Mbps Environ 130 minutes –

XAVC-L QFHD 3840×2160 / 59.94P, 50P 150 Mbps Environ 175 minutes Environ 86 minutes

3840×2160 / 29.97P, 25P, 23.98P 100 Mbps Environ 255 minutes Environ 125 minutes

XAVC-L 50 – 50 Mbps Environ 470 minutes Environ 230 minutes

XAVC-L 35 – 35 Mbps Environ 635 minutes Environ 315 minutes

XAVC-L 25 – 25 Mbps Environ 850 minutes Environ 420 minutes

MPEG-2 Long GOP MPEG HD422 – 50 Mbps Environ 445 minutes Environ 220 minutes

MPEG HD420 HQ – 35 Mbps Environ 685 minutes Environ 340 minutes
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Remarques importantes sur le fonctionnement
Le ventilateur et la batterie sont des 
consommables qui doivent être régulièrement 
remplacés.
Lorsque vous utilisez l’appareil à température 
ambiante, le cycle de remplacement est 
d’environ 5 ans.
Mais, ce cycle de remplacement ne représente 
qu’une indication et ne garantit pas la durée 
de vie de ces consommables. Pour plus de 
détails sur le remplacement de ces pièces, 
veuillez contacter votre revendeur.

La durée de vie l’adaptateur CA et du 
condensateur électrolytique est de 
5 ans environ, sous des températures de 
fonctionnement normales et pour un usage 
normal (8 heures par jour, 25 jours par 
mois). Si l’utilisation dépasse la fréquence 
d’utilisation normale, la durée de vie peut être 
réduite en conséquence.

Utilisation et rangement

Ne soumettez pas le caméscope à des chocs 
violents
ˎˎ Le mécanisme interne peut être 
endommagé ou le boîtier peut être voilé.
ˎˎ Si un accessoire installé sur la griffe 
de fixation d’accessoires est soumis à 
des chocs violents, la griffe de fixation 
d’accessoires risque d’être endommagée. 
Dans ce cas, arrêtez de l’utiliser et contactez 
votre revendeur ou un technicien Sony.

Ne recouvrez pas le caméscope pendant son 
fonctionnement
Le fait de couvrir le caméscope d’un tissu, 
par exemple, peut provoquer une surchauffe 
interne.

Après utilisation
Réglez toujours le commutateur POWER sur 
OFF.

Avant un rangement prolongé du caméscope
Retirez le pack batterie.

Transport
ˎˎ Retirez le support avant de transporter le 
caméscope.
ˎˎ Lors du transport du caméscope par camion, 
navire, avion ou autre service de transport, 
emballez-le dans le carton d’emballage 
d’origine.

Entretien du caméscope
Pour nettoyer la surface des objectifs ou des 
filtres optiques et ôter les poussières et la 
saleté, utilisez un ventilateur.
N’essayez pas de nettoyer l’intérieur de la 
caméra avec une soufflette. Toute particule 
de poussière dans l’air entrant en contact 
avec les composants peut provoquer un 
dysfonctionnement.
Si le boîtier du caméscope est sale, nettoyez-
le avec un chiffon doux et sec. Dans les cas 
extrêmes, utilisez un chiffon humidifié avec un 
détergent neutre, puis essuyez le caméscope. 
N’utilisez pas de solvants organiques comme 
de l’alcool ou du diluant, car ils peuvent 
provoquer une décoloration ou d’autres 
dommages sur la finition du caméscope.

Dans le cas de problèmes de fonctionnement
Si vous rencontrez des problèmes avec le 
caméscope, contactez un revendeur Sony.

Ne placez pas ce produit près d’appareils 
médicaux
Ce produit (y compris les accessoires) 
comporte un ou des aimants qui peuvent 
perturber les stimulateurs cardiaques, les 
valves de dérivation programmables pour 
le traitement de l’hydrocéphalie ou d’autres 
appareils médicaux. Ne placez pas ce produit 
près de personnes utilisant ce type d’appareil 
médical. Consultez votre médecin avant 

d’utiliser ce produit si vous utilisez ce type 
d’appareil médical.

Emplacements d’utilisation et de 
rangement

Rangez le caméscope dans un endroit ventilé 
et droit.
Evitez d’utiliser ou de ranger le caméscope 
dans les endroits suivants.
ˎˎ Les endroits excessivement chauds ou froids 
(plage de température de fonctionnement : 
0 °C à 40 °C (32 °F à 104 °F)) 
N’oubliez pas qu’en été, dans les climats 
chauds, la température à l’intérieur d’un 
véhicule avec les vitres fermées peut 
facilement dépasser 50 °C (122 °F).
ˎˎ Les endroits humides ou poussiéreux
ˎˎ Les endroits où le caméscope peut être 
exposé à la pluie
ˎˎ Les endroits soumis à des vibrations 
violentes
ˎˎ A proximité de champs magnétiques 
puissants
ˎˎ A proximité d’émetteurs de radio et 
de télévision produisant des champs 
électromagnétiques puissants.
ˎˎ A la lumière directe du soleil ou à proximité 
de radiateurs pendant des périodes 
prolongées

Pour empêcher les interférences 
électromagnétiques dues aux dispositifs de 
communication portables
L’utilisation des téléphones portables et 
d’autres dispositifs de communication à 
proximité du caméscope peut provoquer des 
dysfonctionnements et des interférences avec 
les signaux audio et vidéo.
Il est recommandé de désactiver les dispositifs 
de communication portables à proximité du 
caméscope.

Remarque sur les faisceaux laser

Les faisceaux laser peuvent endommager 
le capteur d’image CMOS. Si vous effectuez 
une prise de vue d’une scène comprenant 
un faisceau laser, veillez à ne pas exposer le 
capteur d’image CMOS au faisceau laser ou 
toute lumière reflétée et diffusée depuis le 
faisceau laser.

Condensation

Si l’appareil est soudainement déplacé 
d’un endroit froid à un endroit chaud, ou 
si la température ambiante augmente 
brusquement, de l’humidité peut se former 
sur la surface externe de l’appareil et/ou à 
l’intérieur de l’appareil. Ce phénomène est 
connu sous le nom de condensation. Si de 
la condensation se produit, mettez l’appareil 
hors tension et patientez le temps que la 
condensation disparaisse avant d’utiliser 
l’appareil. L’utilisation de l’appareil avec de la 
condensation pourrait endommager l’appareil.

Montage de l’objectif zoom

Il est important de monter correctement 
l’objectif sous peine d’endommager 
l’équipement. Veillez à consulter la section 
« Montage et ajustement de l’objectif » 
(page 26).

Viseur

Ne laissez pas le caméscope avec l’objectif de 
l’oculaire tourné directement vers le soleil.  
L’oculaire peut concentrer les rayons du soleil 
et faire fondre l’intérieur du viseur.

A propos des panneaux LCD

L’écran LCD intégré à cet appareil est fabriqué 
avec une technologie de haute précision, 
ce qui permet d’obtenir un taux d’au moins 
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99,99% de pixels qui fonctionnent. Ainsi, 
un infime pourcentage de pixels peut être 
« bloqué », c’est à dire toujours éteint (noir), 
toujours éclairé (rouge, vert ou bleu), ou 
clignotant. En outre, après une longue période 
d’utilisation, en raison des caractéristiques 
physiques de l’afficheur à cristaux liquides, 
de tels pixels « bloqués » peuvent apparaître 
spontanément. Ces problèmes ne sont pas 
graves. Notez que ces problèmes n’ont aucun 
effet sur les données enregistrées.

Phénomènes spécifiques aux capteurs 
d’images CMOS de caméra

[Remarque]
Les phénomènes suivants, qui peuvent se produire 
sur les images, sont propres aux capteurs d’images. Ils 
n’indiquent en aucun cas un dysfonctionnement.

Taches blanches
Bien que les capteurs soient fabriqués à 
l’aide de technologies de haute précision, 
il peut arriver (dans de rares cas) que des 
petites taches blanches apparaissent sur 
l’écran, celles-ci sont causées par les rayons 
cosmiques, etc.
Ce phénomène est inhérent à la technologie 
des capteurs d’images et ne signale en aucun 
cas un dysfonctionnement.
Les taches blanches sont surtout visibles dans 
les cas suivants :
ˎˎ Lors du fonctionnement à haute 
température ambiante
ˎˎ Lorsque vous avez augmenté le gain (la 
sensibilité)

Le problème peut être limité en effectuant un 
ajustement automatique de l’équilibre des 
noirs.

Scintillement
Si l’enregistrement est effectué sous un 
éclairage fluorescent, des lampes au sodium, 

à vapeur de mercure ou LED, l’écran peut 
scintiller ou les couleurs peuvent varier.

Fragmentation

Si vous ne pouvez pas enregistrer/reproduire 
correctement des images, essayez de formater 
les supports d’enregistrement.
Pendant la répétition de l’enregistrement/
la lecture d’images avec un certain support 
d’enregistrement pendant une période 
prolongée, les fichiers sur les supports 
peuvent être fragmentés, ce qui entrave 
l’enregistrement/le stockage. Dans de tels cas, 
effectuez une sauvegarde des plans sur les 
supports puis formatez le support à l’aide de 
Operation >Format Media (page 103) dans le 
menu de configuration.

Remarques sur la sécurité

ˎˎ Sony ne peut être tenue responsable 
de tout dommage, de quelque nature 
que ce soit, résultant d’une incapacité 
à mettre en place des mesures de 
sécurité adaptées pour les dispositifs 
de transmission, de fuites de données 
inévitables dues aux spécifications de 
transmission ou de tout autre problème 
de sécurité.
ˎˎ Selon l’environnement d’exploitation, il est 
possible que des tiers non autorisés 
sur le réseau puissent accéder à l’appareil. 
Avant de connecter l’appareil au 
réseau, vérifiez que le réseau est bien 
protégé.
ˎˎ Le contenu des communications peut être 
intercepté à votre insu par des tiers non 
autorisés à proximité des signaux. Lors de 
communications LAN sans fil, appliquez des 
mesures de sécurité adaptées pour protéger 
le contenu des communications.
ˎˎ Pour des raisons de sécurité, lors de 
l’utilisation de cet appareil connecté au 
réseau, il est fortement recommandé 

d’accéder à la fenêtre de commande via un 
navigateur Web et de modifier la limitation 
d’accès des valeurs d’usine préréglées 
(page 80). 
Il est recommandé de définir un mot 
de passe avec une chaîne de caractères 
suffisamment longue, difficile à deviner par 
les autres, et de le stocker en toute sécurité.
ˎˎ Ne consultez aucun autre site Web dans 
le navigateur Web pendant ou après la 
configuration. Étant donné que l’état de 
connexion est conservé dans le navigateur 
Web, fermez ce dernier lorsque la 
configuration est terminée pour empêcher 
tout tiers non autorisé d’utiliser l’appareil ou 
d’exécuter des programmes malveillants.

A propos du GPS

Le GPS (Global Positioning System) est un 
système qui calcule la position géographique 
grâce à des satellites américains de haute 
précision. Ce système vous permet de localiser 
votre position exacte sur la terre.
Les satellites GPS sont situés dans 6 orbites, 
20 000 km au-dessus de la terre. Le système 
de GPS comporte au moins 24 satellites GPS.
Un récepteur GPS reçoit des signaux radio 
des satellites, puis calcule la position actuelle 
du récepteur en fonction des informations 
orbitales (données d’éphéméride) et la durée 
du trajet des signaux, etc.
La détermination d’un emplacement s’appelle 
la « triangulation ». Un récepteur GPS peut 
déterminer la latitude et la longitude de la 
localisation en recevant des signaux d’au 
moins 3 satellites.
ˎˎ Comme la position des satellites GPS varie 
constamment, déterminer la localisation 
peut prendre plus de temps ou le 
récepteur risque de ne pas pouvoir du tout 
déterminer la localisation, en fonction de la 
localisation et du moment où vous utilisez le 
caméscope.

ˎˎ Le « GPS » est un système qui permet de 
déterminer la position géographique en 
triangulant les signaux radio des satellites 
GPS. Évitez d’utiliser le caméscope dans 
des endroits où les signaux radio sont 
bloqués ou réfléchis, comme dans un 
lieu ombragé entouré de bâtiments ou 
d’arbres, etc. Utilisez le caméscope dans des 
environnements à ciel ouvert.
ˎˎ Il se peut que vous ne puissiez pas 
enregistrer des informations de localisation 
à des endroits ou dans des situations où les 
signaux radio des satellites GPS n’atteignent 
pas le caméscope, par exemple :

 ‒ dans des tunnels, à l’intérieur ou à 
l’ombre des bâtiments ;

 ‒ entre des immeubles hauts ou dans des 
rues étroites entourées par des bâtiments ;

 ‒ dans des endroits souterrains, des 
endroits entourés d’arbres denses, sous 
un pont surélevé, ou dans des endroits où 
des champs magnétiques sont générés, 
tels que près de câbles à haute tension ;

 ‒ à proximité d’appareils qui génèrent des 
signaux radio de la même bande de 
fréquence que le caméscope : près de 
téléphones mobiles de la bande de 
1,5 GHz, etc.

ˎˎ Si vous téléchargez et partagez les images 
enregistrées avec « GPS » réglé sur « On », le 
lieu de l’enregistrement risque d’être visible 
sur Internet même si cela n’était pas votre 
intention. Si vous ne voulez pas enregistrer 
les informations de position, réglez « Off » 
sur « GPS » (page 110).

A propos des erreurs de triangulation
ˎˎ Si vous vous déplacez vers un autre 
emplacement juste après le réglage « GPS » 
à « On » dans le menu, le caméscope 
peut mettre plus de temps à lancer la 
triangulation que si vous restez au même 
endroit.
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ˎˎ Erreur causée par la position des satellites 
GPS 
Le caméscope triangule automatiquement 
votre position actuelle lorsque le caméscope 
reçoit des signaux radio de la part d’au 
moins 3 satellites GPS.  
L’erreur de triangulation autorisée par les 
satellites GPS est d’environ 10 m (33 pi). 
Selon l’environnement de la localisation, 
l’erreur de triangulation peut être plus 
importante. Dans ce cas, votre position 
actuelle risque de ne pas correspondre 
à la localisation sur la carte basée sur les 
informations du GPS. Pendant ce temps, les 
satellites GPS sont contrôlés par le Ministère 
de la Défense des Etats-Unis, et le degré de 
précision peut être changé volontairement.
ˎˎ Erreur lors du processus de triangulation 
Le caméscope acquiert périodiquement les 
informations de localisation au cours de la 
triangulation.

A propos de la restriction d’utilisation du GPS
Utilisez le GPS conformément aux 
réglementations relatives à la situation et au 
pays/à la région d’utilisation.

A propos du système de coordonnées 
géographiques
Le système de coordonnées géographiques 
« WGS-84 » est utilisé.
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Caractéristiques techniques

Généralités

Poids Environ 3,8 kg (8 lb 6 oz) (boîtier 
uniquement)

Dimensions
  (Appareil : mm (pouces), hors 

pièces saillantes, boîtier 
uniquement) 1)

15
0

 (6
)

26
9 

(1
0

 5 /
8
)

332 (13 1/8)

1) Les valeurs indiquées pour les dimensions sont 
approximatives.

Puissance électrique requise
  12 V (11 V à 17,0 V) CC
Consommation électrique
  Environ 41 W (boîtier uniquement, 

lors de l’enregistrement en 
XAVC-I, avec le moniteur LCD 
allumé)

  Environ 37 W (boîtier uniquement, 
lors de l’enregistrement en 
XAVC-I, avec le moniteur LCD 
allumé, le réglage de la sortie 
SDI/HDMI sur OFF)

  Environ 50 W (viseur HDVF-EL20, 
objectif, microphone, lors de 
l’enregistrement en XAVC-I, 
avec le moniteur LCD allumé)

  Environ 32 W (lors de la copie vers 
un support USB)

[Remarques]
ˎˎ Ne raccordez pas de lampe vidéo dont la consommation 

électrique est égale ou supérieure à 50 W. 
Lorsqu’une lampe vidéo de 50 W est connectée :

 ‒ Ne connectez pas d’autres périphériques aux bornes 
de sortie.

 ‒ Utilisez-la dans les conditions suivantes. 
Fixez l’objectif uniquement, format 
d’enregistrement XAVC-I HD, enregistrement proxy 
OFF, réglage de sortie SDI/HDMI OFF

ˎˎ Lors de l’utilisation d’une batterie (BP-GL95B), ne 
laissez pas la consommation électrique totale des 
périphériques connectés dépasser 43 W.
ˎˎ Lors de l’utilisation de l’AC-DN10A, ne laissez pas la 

consommation électrique totale des périphériques 
connectés dépasser 38 W.
ˎˎ Raccordez uniquement au connecteur DC OUT des 

dispositifs dont la consommation de courant est 
égale ou inférieure à 1,8 A.

Température d’utilisation
  0 °C à 40 °C (32 °F à 104 °F)
Température de rangement
  –20 °C à +60 °C (–4 °F à +140 °F)
Système de fichiers
  exFAT, UDF, FAT
Durée de fonctionnement continu
  Environ 110 minutes (lors de 

l’utilisation du BP-GL95B)
Format d’enregistrement (vidéo)
 XAVC Intra
  MPEG-4 AVC/H.264
  XAVC-I QFHD : VBR, 600 Mbps 

(max)
  XAVC-I HD : CBG, 223 Mbps (max)
 XAVC Long
  MPEG-4 AVC/H.264
  XAVC-L QFHD : VBR, 150 Mbps 

(max)
  XAVC-L200 : VBR, 200 Mbps (max)
  XAVC-L 50 : VBR, 50 Mbps (max)
  XAVC-L 35 : VBR, 35 Mbps (max)
  XAVC-L 25 : VBR, 25 Mbps (max)
 MPEG-2 Long GOP
  MPEG HD422 : CBR, 50 Mbps, 

MPEG-2 422P@HL
  MPEG HD420 HQ : VBR, 35 Mbps 

(max), MPEG-2 MP@HL

  MPEG HD420 SP : CBR, 25 Mbps, 
MPEG-2 MP@H-14

 XAVC Proxy
  AVC/H.264 Main Profile 4:2:0 Long 

GOP
  1920×1080 : 9 Mbps, 6 Mbps
  1280×720 : 9 Mbps, 6 Mbps
  640×360 : 3 Mbps
  480×270 : 1 Mbps, 500 Kbps (VBR)
Format d’enregistrement (audio)
 XAVC Intra
  LPCM 24 bits, 48 kHz, 4 canaux
 XAVC Long
  LPCM 24 bits, 48 kHz, 4 canaux
 MPEG-2 Long GOP
  MPEG HD422 : LPCM 24 bits, 48 kHz, 

4 canaux
  MPEG HD420 HQ : LPCM 16 bits,  

48 kHz, 4 canaux
 XAVC Proxy
  AAC-LC, 128 Kbps, 2 canaux
Durée d’enregistrement/lecture

Consultez « Durée d’enregistrement et de 
lecture des supports » (page 178).

Fréquence d’images d’enregistrement
 XAVC Intra
  XAVC-I QFHD
  3840×2160/59.94P, 50P, 29.97P, 25P, 

23.98P
  XAVC-I HD
  1920×1080/59.94P, 50P, 59.94i, 50i, 

29.97P, 25P, 23.98P
 XAVC Long
  XAVC-L QFHD
  3840×2160/59.94P, 50P, 29.97P, 25P, 

23.98P
  XAVC-L200
  3840×2160/59.94P, 50P
  XAVC-L 50
  1920×1080/59.94P, 50P, 59.94i, 50i, 

29.97P, 25P, 23.98P
  XAVC-L 35
  1920×1080/59.94P, 50P, 59.94i, 50i, 

29.97P, 25P, 23.98P

  XAVC-L 25
  1920×1080/59.94i, 50i
 MPEG-2 Long GOP
  MPEG HD422
  1920×1080/59.94i, 50i, 29.97P, 25P, 

23.98P
  1280×720/59.94P, 50P, 29.97P, 25P, 

23.98P
  MPEG HD420 HQ
  1920×1080/59.94i, 50i, 29.97P, 25P, 

23.98P
  1440×1080/59.94i, 50i
  1280×720/59.94P, 50P
  MPEG HD420 SP
  1440×1080/59.94i, 50i
XAVC Proxy
  Ligne principale 1920×1080 : 59.94i, 

50i, 29.97P, 25P, 23.98P
  Ligne principale 1280×720 : 59.94P, 

50P, 29.97P, 25P, 23.98P

Section d’entrée/sortie

Entrées
GENLOCK IN :
  type BNC, 1,0 Vp-p, 75 ohms, non 

équilibré
TC IN : type BNC, 0,5 V à 18 Vp-p, 

10 kilohms 
AUDIO IN CH1/CH2 :
  type XLR, 3 broches, femelle
  Commutable LINE / AES/EBU / MIC 

/ MIC+48V
  LINE : +4, 0, –3 dBu
  AES/EBU : conforme à AES3
  MIC : –70 dBu à –30 dBu
MIC IN : type XLR, 5 broches, femelle, 

–70 dBu à –30 dBu
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WRR :  D-sub à 15 broches
  Analog CH1 : –40 dBu
  Digital CH1/CH2 : –40 dBFS
SDI IN : conforme à la norme SMPTE  

ST292-1/259
  Audio 4 canaux

Sorties
SYNC OUT :
  type BNC
SDI OUT 1/2 :
  type BNC, 0,8 Vp-p, non équilibré 

(commutable 12G/3G/1.5G) 
  Conforme à la norme SMPTE 

ST424/425, ST292-1/259
  Audio 4 canaux
AUDIO OUT :
  type XLR, 5 broches, mâle, +4/0/ 

–3 dBu (équilibré)
TC OUT : type BNC, 1,0 Vp-p, 50 ohms
EARPHONE (stéréo, mini prise) :
  –12 dBu (niveau de sortie de 

référence, volume de moniteur 
maximum, puissance de 
16 ohms)

HDMI : type A, 19 broches

Autre
DC IN : type XLR, 4 broches, mâle 11 V à 

17 V CC
DC OUT : type rond 4 broches, 11 V à 17 V CC, 

courant nominal maximum de 
1,8 A

LENS : 12 broches, source d’alimentation 
de l’objectif (11 V à 17 V CC, 
courant nominal maximum de 
1,0 A)

REMOTE : 8 broches
LIGHT : 2 broches
USB : 4 broches (type A) (2), 4 broches 

(type B)
VF : type rond à 20 broches

Connecteur réseau :
  type RJ-45, 100BASE-TX (IEEE 

802.3u), 10BASE-T (IEEE 802.3)

Section de caméra

Capteur d’image
  Capteur d’image CMOS type 

2/3 pouces, « Exmor »
Filtres ND 1 : Clear
  2 : 1/4 ND
  3 : 1/16 ND
  4 : 1/64 ND
Sensibilité F10 (fréquence de système : 59.94i) 

(typique) 
(2000 lx, réflexion 89,9%, 3200K, 
High Sense Mode OFF)

  F12 (fréquence de système : 59.94i) 
(High Sense Mode ON) (typique) 
(2000 lx, réflexion 89,9%, 
3200K)

Illumination minimum
  0,019 lx (F1.4, +42 dB, accumulation 

de 16 images)
Rapport S/N de l’image
  HD : 62 dB (1920×1080 59.94i, Noise 

Suppression on, High Sense 
Mode OFF) (typique)

  4K : 60 dB (3840×2160 59.94P, 
Noise Suppression on, High 
Sense Mode OFF) (typique)

Résolution horizontale
  2000 TVL (lignes TV) ou plus 

(3840×2160P)
Niveau de noir
  3 ± 1% (Black est réglé sur [±0] dans 

le menu de configuration)
Vitesse d’obturation
  59.94i/P, 50i/P : 1/60 à 1/2000 sec.
  29.97P : 1/40 à 1/2000 sec.
  25P : 1/33 à 1/2000 sec.
  23.94P : 1/32 à 1/2000 sec.

Obturation
  2 à 8, 16 images
Plage dynamique
  600% (mode SDR)
  1300% (mode HDR)

Section audio

Fréquence d’échantillonnage
  48 kHz
Quantification
  16/24 bits
Hauteur
  20 dB (réglage d’usine par défaut) 

(20, 18, 16, 12 dB), EBUL
Réponse de fréquence
  20 Hz à 20 kHz (±3 dB ou moins)
Plage dynamique
  90 dB (typique)
Distorsion 0,08% ou moins (niveau d’entrée 

+4 dBu)
Haut parleur intégré
  Monaural, sortie 500 mW

Section d’affichage

Moniteur LCD
  Taille d’écran 

8,8 cm (3,5 pouces) en 
diagonale

  Rapport de format 
16:9

  Nombre de pixels 
960 (H) × 540 (V)

Section de support

Logements pour carte SxS
  Facteur de forme : Express Card/34
  Nombre de logements : 2
  Connecteur : conforme à PCMCIA 

Express Card
  Vitesse d’écriture : 50 Mbps ou plus
  Vitesse de lecture : 50 Mbps ou 

plus
Logements pour cartes SD
  Proxy (1), Utility (1)

Accessoires fournis

Bandoulière (1)
Kit de fixation (1)
Capuchon de la monture d’objectif
Module USB LAN sans fil (IFU-WLM3)
Capuchon protecteur (1)
Garde protectrice (1)
Avant d’utiliser cet appareil (1)
Mode d’emploi (CD-ROM) (1)
Tableau de réglage de la longueur focale 
(retour de bride) (1)

Équipement apparenté

Alimentation et équipement apparenté

Adaptateur CA
  AC-DN10A
Pack batterie
  BP-GL95B
Chargeur de batterie
  BC-L70A
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Objectif, viseur et équipement 
apparenté

Objectif Objectif à monture à baïonnette de 
type 2/3 pouce uniquement

Viseur HDVF-20A/L750/EL20/EL30
Bague de rotation du viseur
  BKW-401

Equipement de commande à distance

Télécommande
  RM-B170
  RCP-1000/1500/1530
  RCP-1001/1501

[Remarque]
L’unité de commande de réseau (CNU) n’est pas prise 
en charge.

Adaptateur de caméra HD

CA-FB70/TX70

[Remarques]
ˎˎ La connexion d’un adaptateur de caméra est prise en 

charge sur le modèle japonais uniquement.
ˎˎ Si le SDI OUT2 est utilisé lorsque le CA-FB70 est 

raccordé, utilisez un adaptateur en forme de L.

Adaptateur de support

MEAD-SD02 (pour cartes SD)

Support d’enregistrement

Cartes mémoire SxS
  Série SxS PRO X
  Série SxS PRO+
  Série SxS PRO
  Série SxS-1

Equipement audio

Microphone
  ECM-678/674/673/680S

Support de microphone
  CAC-12
Récepteur sans fil numérique
  DWR-S02DN/DWR-S03D
Tuner synthétisé UHF
  URX-S03D

Autres dispositifs périphériques

Fixation de trépied
  VCT-14/U14
Lampe vidéo
  UC-D200A (Nippon Video System - 

NIPROS)
  Ultralight (Anton Bauer)
Protège-épaule
  Protège-épaule de type souple 

CBK-SP01
Adaptateur LAN sans fil
  CBK-WA02
Kit d’adaptateur réseau
  CBK-NA1
Adaptateur USB
  CBK-DL1

Produits pour la maintenance et pour 
une utilisation/manipulation simplifiée

Support de fixation
  A-2092-367-

La conception et les spécifications sont 
sujettes à modification sans préavis.

Remarques
ˎˎ Effectuez toujours un essai 
d’enregistrement pour vérifier que 
l’enregistrement s’est fait correctement. 
Sony n’assumera pas de responsabilité 
pour les dommages de quelque sorte 
qu’ils soient, incluant mais ne se 
limitant pas à la compensation ou au 
remboursement, suite au manquement 
de cet appareil ou de son support 
d’enregistrement, de systèmes de 
mémoire extérieurs ou de tout autre 
support ou système de mémoire à 
enregistrer un contenu de tout type.
ˎˎ Vérifiez toujours que l’appareil fonctionne 
correctement avant l’utilisation. Sony 
n’assumera pas de responsabilité pour 
les dommages de quelque sorte qu’ils 
soient, incluant mais ne se limitant pas à 
la compensation ou au remboursement, 
à cause de la perte de profits actuels ou 
futurs suite à la défaillance de cet appareil, 
que ce soit pendant la période de garantie 
ou après son expiration, ou pour toute 
autre raison quelle qu’elle soit.
ˎˎ Sony n’assumera pas de responsabilité 
pour les réclamations, quelle qu’elles 
soient, effectuées par les utilisateurs de 
cet appareil ou par des tierces parties.
ˎˎ Sony n’assumera pas de responsabilité 
pour la perte, la réparation ou la 
reproduction de toutes données 
enregistrées sur le système de mémoire 
intérieur, le support d’enregistrement, les 
systèmes de mémoire extérieurs ou tout 
autre support ou système de mémoire.
ˎˎ Sony n’assumera pas de responsabilité 
pour la cessation ou l’interruption de tout 
service lié à cet appareil, résultant de 
quelque circonstance que ce soit.

Téléchargements de logiciels

Lorsque l’appareil est utilisé avec une 
connexion PC, téléchargez tous les pilotes 
du dispositif, les plug-ins et les applications 
logicielles dont avez besoin à partir des sites 
internet suivants.

Site internet Sony produits professionnels :
Japon https://www.sony.jp/professional/
Tous les autres pays
  https://pro.sony/ (cliquez sur [Change 

Country, Region or Language] en bas 
de la page et sélectionnez la région ou 
la langue)

Logiciels créatifs Sony, page de 
téléchargement du logiciel :
http://www.sonycreativesoftware.com/
download/software_for_sony_equipment

https://www.sony.jp/professional/
https://pro.sony/
http://www.sonycreativesoftware.com/download/software_for_sony_equipment
http://www.sonycreativesoftware.com/download/software_for_sony_equipment
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Liste de dispositifs périphériques et accessoires

Microphone 
ECM-680S/678/674/673 Moniteur 4K/Moniteur HD

Adaptateur de caméra HD CA-FB70 a) 

Adaptateur de caméra HD CA-TX70 a)

Pack batterie 
BP-GL95B

Chargeur de 
batterie 
BC-L70A

Adaptateur CA 
AC-DN10A

Cartes mémoire SxS
SBS-32G1C, SBS-64G1C, SBS-128G1C, 
SBP-64E, SBP-128E, SBP-256E, SBP-120F, 
SBP-240F

Adaptateur de support MEAD-SD02

Tuner synthétisé UHF 
URX-S03D
Récepteur sans fil numérique DWR-S02DN/
DWR-S03D

Support de microphone 
CAC-12

Télécommande  
RM-B170
RCP-1000/1500/1530
RCP-1001/1501

PXW-Z750

Viseur  
HDVF-20A/L750/EL20/EL30

Fixation de trépied
VCT-14

a) La connexion d’un adaptateur de caméra est prise en charge sur le modèle japonais uniquement.

Licence MPEG-4 AVC Patent 
Portfolio

CE PRODUIT EST SOUS LICENCE AVC 
PATENT PORTFOLIO POUR L’UTILISATION 
PERSONNELLE DU CONSOMMATEUR OU TOUT 
AUTRE UTILISATION N’IMPLIQUANT PAS DE 
REMUNERATION
(i) ENCODAGE VIDEO EN CONFORMITE AVEC LE 

STANDARD AVC (« AVC VIDEO ») ET/OU
(ii) DECODAGE VIDEO AVC ENCODE PAR UN 

CONSOMMATEUR ENGAGE DANS UNE 
ACTIVITE PERSONNELLE ET/OU OBTENU 
D’UN FOURNISSEUR VIDEO AYANT LA 
LICENCE DE DISTRIBUTION AVC VIDEO.

AUCUNE LICENCE N’EST ATTRIBUEE OU 
NE DOIT ETRE DESTINEE POUR TOUT 
AUTRE USAGE. DES INFORMATIONS 
SUPPLEMENTAIRES PEUVENT ETRE OBTENUES 
DE MPEG LA, L.L.C. 
VOIR HTTP://WWW.MPEGLA.COM

CONTRAT DE LICENCE 
D’UTILISATEUR FINAL

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
CAMCORDER, PLEASE READ THIS END USER LICENSE 
AGREEMENT (“EULA”) CAREFULLY. BY USING THE 
SOFTWARE YOU ARE ACCEPTING THE TERMS OF THIS 
EULA. IF YOU DO NOT ACCEPT THE TERMS OF THIS EULA, 
YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the camcorder, together with 
any updates/ upgrades provided by SONY, any printed, 
on-line or other electronic documentation for such 
software, and any data files created by operation of such 
software (collectively, the “SOFTWARE”). 

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU General 
Public license and Lesser/Library General Public License) 
shall be covered by such applicable separate end user 
license agreement in lieu of the terms of this EULA to 
the extent required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property 
laws and international treaties. 

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, animation, 
video, audio, music, text and “applets” incorporated into 
the SOFTWARE) is owned by SONY or one or more of the 
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the camcorder and only 
for your individual use. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual property 
rights) in and to the SOFTWARE that this EULA does not 
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specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt 
to derive source code, modify, reverse engineer, 
decompile, or disassemble any of the SOFTWARE, 
whether in whole or in part, or create any derivative 
works from or of the SOFTWARE unless such derivative 
works are intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. You 
may not bypass, modify, defeat or circumvent any of 
the functions or protections of the SOFTWARE or any 
mechanisms operatively linked to the SOFTWARE. You 
may not separate any individual component of the 
SOFTWARE for use on more than one camcorder unless 
expressly authorized to do so by SONY. You may not 
remove, alter, cover or deface any trademarks or notices 
on the SOFTWARE. You may not share, distribute, rent, 
lease, sublicense, assign, transfer or sell the SOFTWARE. 
The software, network services or other products 
other than SOFTWARE upon which the SOFTWARE’S 
performance depends might be interrupted or 
discontinued at the discretion of the suppliers (software 
suppliers, service suppliers, or SONY). SONY and such 
suppliers do not warrant that the SOFTWARE, network 
services, contents or other products will continue to 
be available, or will operate without interruption or 
modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, 
you acknowledge that the SOFTWARE may include 
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE 
may be covered by open source software licenses 
(“Open Source Components”), which means any 
software licenses approved as open source licenses by 
the Open Source Initiative or any substantially similar 
licenses, including but not limited to any license that, 
as a condition of distribution of the software licensed 
under such license, requires that the distributor make 
the software available in source code format. If and to 
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list 
of applicable OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the applicable 
terms and conditions governing its use. Such terms 
and conditions may be changed by the applicable 
third party at any time without liability to you. To the 
extent required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will apply in lieu 
of the terms of this EULA. To the extent the terms of the 

licenses applicable to EXCLUDED SOFTWARE prohibit 
any of the restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms 
of the licenses applicable to Open Source Components 
require SONY to make an offer to provide source code 
in connection with the SOFTWARE, such offer is hereby 
made.

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you 
to view, store, process and/or use content created by 
you and/or third parties. Such content may be protected 
by copyright, other intellectual property laws, and/
or agreements. You agree to use the SOFTWARE only 
in compliance with all such laws and agreements that 
apply to such content. You acknowledge and agree 
that SONY may take appropriate measures to protect 
the copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 
limited to, counting the frequency of your backup and 
restoration through certain SOFTWARE features, refusal 
to accept your request to enable restoration of data, and 
termination of this EULA in the event of your illegitimate 
use of the SOFTWARE.

CONTENT SERVICE
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES (“CONTENT 
SERVICE”). USE OF THE SERVICE AND THAT CONTENT IS 
SUBJECT TO THE TERMS OF SERVICE OF THAT CONTENT 
SERVICE. IF YOU DECLINE TO ACCEPT THOSE TERMS, 
YOUR USE OF THE SOFTWARE WILL BE LIMITED. You 
acknowledge and agree that certain content and 
services available through the SOFTWARE may be 
provided by third parties over which SONY has no 
control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are 
solely responsible for payment of any third party fees 
associated with your Internet connection, including 
but not limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be limited 
or restricted depending on the capabilities, bandwidth 
or technical limitations of your Internet connection 

and service. The provision, quality and security of such 
Internet connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country 
in which you reside, and not to transfer, or authorize 
the transfer, of the SOFTWARE to a prohibited country 
or otherwise in violation of any such restrictions or 
regulations. 

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-line 
control equipment in hazardous environments requiring 
fail-safe performance, such as in the operation of 
nuclear facilities, aircraft navigation or communication 
systems, air traffic control, direct life support machines, 
or weapons systems, in which the failure of the 
SOFTWARE could lead to death, personal injury, or 
severe physical or environmental damage (“HIGH RISK 
ACTIVITIES”). SONY, each of the THIRD-PARTY SUPPLIERS, 
and each of their respective affiliates specifically 
disclaim any express or implied warranty, duty or 
condition of fitness for HIGH RISK ACTIVITIES. 

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE 
is at your sole risk and that you are responsible for use 
of the SOFTWARE. The SOFTWARE is provided “AS IS,” 
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS 
(for purposes of this Section, SONY and each of 
the THIRD-PARTY SUPPLIERS shall be collectively 
referred to as “SONY”) EXPRESSLY DISCLAIM ALL 
WARRANTIES, DUTIES OR CONDITIONS, EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT 
AND FITNESS FOR A PARTICULAR PURPOSE. SONY 
DOES NOT WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE FUNCTIONS 
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B) 
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS 
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL 
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 
THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 

AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN 
BY SONY OR AN AUTHORIZED REPRESENTATIVE OF SONY 
SHALL CREATE A WARRANTY, DUTY OR CONDITION OR 
IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. 
SHOULD THE SOFTWARE PROVE DEFECTIVE YOU ASSUME 
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR 
OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW 
THE EXCLUSION OF IMPLIED WARRANTIES, SO THESE 
EXCLUSIONS MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER 
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE, 
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES 
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE, 
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR 
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER’S 
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, 
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO 
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION 
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information collected 
from the SOFTWARE, including but not limited to 
information about (i) the SOFTWARE and (ii) the 
software applications, contents and peripheral devices 
that interact with your camcorder and the SOFTWARE 
(“Information”). Information includes, but is not limited 
to: (1) unique identifiers relating to your camcorder and 
its components; (2) performance of the camcorder, the 
SOFTWARE and their components; (3) configurations 
of your camcorder, the SOFTWARE and the software 
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applications, contents and peripheral devices that 
interact with the camcorder and the SOFTWARE; 
(4) use and frequency of use of the functions of (x) 
the SOFTWARE, and (y) the software applications, 
contents and peripheral devices that interact with the 
SOFTWARE; and (5) location data, as indicated below. 
SONY and its affiliates, partners and agents may use 
and disclose Information subject to applicable laws in 
order to improve its products and services or to provide 
products or services to you. Such uses include, but 
are not limited to: (a) administering the functionalities 
of the SOFTWARE; (b) to improve, service, update or 
upgrade the SOFTWARE; (c) improving, developing and 
enhancing the current and future products and services 
of SONY and other parties; (d) to provide you with 
information about the products and services offered by 
SONY and other parties; (e) complying with applicable 
laws or regulations; and (f) to the extent offered, 
providing you with location-based services of SONY 
and other parties, as indicated below. In addition, SONY 
retains the right to use Information to protect itself and 
third parties from illegal, criminal or harmful conduct.

Certain services available through the SOFTWARE 
may rely upon location information, including, but not 
limited to, the geographic location of the camcorder. 
You acknowledge that for the purpose of providing 
such services, SONY, the THIRD-PARTY SUPPLIERS or 
their partners may collect, archive, process and use such 
location data, and that such services are governed by 
the privacy policies of SONY or such third party. By using 
any such services, you agree that you have reviewed the 
privacy policies applicable to such services and consent 
to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify 
the owner or user of the SOFTWARE without your 
knowledge or consent. Any use of Information will be 
in accordance with the privacy policies of SONY or such 
third party. Please contact applicable contact address of 
each area or country for SONY’s current privacy policy.

Please contact applicable third parties for privacy 
policies relating to personally identifiable and other 
information you provide when you use or access third 
party software or services.

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 

legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical and 
organizational steps to prevent unauthorized access to 
or disclosure of Information, but does not warrant it will 
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE 
From time to time, SONY or the THIRD-PARTY SUPPLIERS 
may automatically update or otherwise modify the 
SOFTWARE, including, but not limited to, for purposes 
of enhancement of security functions, error correction 
and improvement of functions, at such time as you 
interact with SONY’s or third parties’ servers, or 
otherwise. Such updates or modifications may delete 
or change the nature of features or other aspects of the 
SOFTWARE, including, but not limited to, functions you 
may rely upon. You acknowledge and agree that such 
activities may occur at SONY’s sole discretion and that 
SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 
update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By acceptance of 
this EULA, you consent to such update/ modification. 

ENTIRE AGREEMENT, WAIVER, SEVERABILITY 
This EULA and SONY’s privacy policy, each as amended 
and modified from time to time, together constitute the 
entire agreement between you and SONY with respect 
to the SOFTWARE. The failure of SONY to exercise or 
enforce any right or provision of this EULA shall not 
constitute a waiver of such right or provision. If any part 
of this EULA is held invalid, illegal, or unenforceable, 
that provision shall be enforced to the maximum extent 
permissible so as to maintain the intent of this EULA, 
and the other parts will remain in full force and effect. 

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 
This EULA shall be governed by the laws of Japan, 
without regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be subject to the 
exclusive venue of the Tokyo District Court in Japan, and 
the parties hereby consent to the venue and jurisdiction 
of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or non-compliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 

would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that SONY 
deems necessary or appropriate in such circumstances. 
SONY may also take any legal and technical remedies 
to prevent violation of and/or to enforce this EULA, 
including, but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any other 
remedies SONY may have at law, in equity or under 
contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its 
terms. In case of such termination, you must: (i) cease 
all use, and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section below 
entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED 
BY YOU, BY PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES 
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, you 
should promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective date 
of any such notice shall be deemed your agreement to 
be bound by such amendment. 

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
third-party beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to the 
SOFTWARE of such party.

Should you have any questions concerning this EULA, 
you may contact SONY by writing to SONY at applicable 
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Licences de logiciels libres

Sur la base des contrats de licence entre 
Sony et les détenteurs des droits d’auteur du 
logiciel, ce produit utilise open software.
Pour satisfaire les exigences des détenteurs 
des droits d’auteur du logiciel, Sony a 
l’obligation de vous informer du contenu de 
ces licences.
Pour le contenu de ces licences, consultez 
« License1.pdf » dans le dossier « License » du 
CD-ROM fourni.
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Marques commerciales

ˎˎ XDCAM est une marque commerciale de 
Sony Corporation.
ˎˎ XAVC et  sont des marques déposées 
de Sony Corporation.
ˎˎ Android et Google Chrome sont des 
marques commerciales ou des marques 
déposées de Google, Inc.
ˎˎ Microsoft et Windows sont des marques 
déposées soit des marques commerciales 
de Microsoft Corporation aux États-Unis et/
ou d’autres pays.
ˎˎ Apple, Macintosh, Safari et iPhone et leurs 
logos sont des marques commerciales 
ou des marques déposées d’Apple Inc. 
déposées aux États-Unis et d’autres pays.
ˎˎ Les termes HDMI et High-Definition 
Multimedia Interface ainsi que le logo 
HDMI sont des marques commerciales ou 
des marques déposées de HDMI Licensing 
Administrator, Inc. aux États-Unis et dans 
d’autres pays.
ˎˎ Wi-Fi, le logo Wi-Fi et Wi-Fi Protected Setup 
sont des marques commerciales ou des 
marques déposées de Wi-Fi Alliance.
ˎˎ Le N-Mark est une marque commerciale ou 
une marque déposée de NFC Forum, Inc. 
aux États-Unis et dans d’autres pays.
ˎˎ QR Code est une marque commerciale de 
Denso Wave Inc.
ˎˎ Tous les noms de système et les noms de 
produit sont des marques déposées ou des 
marques commerciales de leur propriétaire 
respectif. Les éléments de marques 
commerciales ne sont pas indiqués par les 
symboles ® ou ™ dans ce document.
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